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1
DR Series 시스템 소개
DR Series 시스템 문서에는 Dell DR Series 시스템을 사용하여 데이터 스토리지 작업을 수행하고 스토리지 및 복
제 컨테이너를 관리하는 방법을 설명하는 주제가 있습니다. DR Series 시스템 주제에서는 백업 및 복제 작업을 
관리하는 데 사용할 수 있는 DR Series 시스템 그래픽 사용자 인터페이스(GUI)를 소개하고 설명합니다. 포괄적인 
GUI 기반 절차에 따라 지원되는 웹 브라우저에서 모든 관리 기능에 액세스할 수 있습니다. 이 안내서는 중요한 
관리 작업이 DR Series 시스템 GUI에서 지원되지 않을 경우에 활용할 수 있도록 해당 명령행 인터페이스(CLI) 명
령을 제공하고 설명합니다. DR Series 시스템 CLI 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 
안내서를 참조하십시오.

DR Series 시스템 GUI 설명서 정보

DR Series 시스템 설명서에서는 그래픽 사용자 인터페이스(GUI)와 메뉴, 탭, 옵션을 사용하여 광범위한 데이터 스
토리지 작업을 수행하고 관련 스토리지 및 복제 컨테이너를 관리하는 방법을 설명합니다.

관리 최종 사용자를 위해 작성된 이 설명서는 백업 및 중복 제거 작업을 쉽게 관리하기 위해 DR Series 시스템 

GUI 요소를 사용하는 절차를 소개하고 제공합니다. 포괄적인 GUI 기반 절차에 따라 지원되는 웹 브라우저에서 

모든 주요 관리 기능에 액세스할 수 있습니다.

이 안내서는 중요한 관리 작업이 DR Series 시스템 GUI에서 지원되지 않을 경우에 활용할 수 있도록 해당 DR 
Series 시스템 명령행 인터페이스(CLI) 명령을 제공하고 설명합니다.

노트: DR Series 시스템에 사용할 수 있는 지원되는 웹 브라우저에 대한 자세한 내용은 support.dell.com/
manuals에서 Dell DR Series 시스템 상호 운용성 안내서를 참조하십시오.

What's New In This Release
The following features have been added to the DR Series systems for this release:

Advanced 
Networking

Advanced networking feature allows you to modify the default bonded network configuration 
of your DR Series system. It allows you to create and manage multiple bonds on the same 
system to support your data, management and replication traffic. You must use the CLI to set 
up advanced networking. However, you can view and edit the NIC bonding configuration using 
the web user interface.

Rapid Data 
Storage Protocol

Rapid Data Storage (RDS) is developed by Dell Quest and provides a logical disk interface for 
use with network storage devices. RDS allows for better coordination and integration between 
DR Series system backup, restore, and optimized duplication operations with Dell Quest 
NetVault Backup (NVBU). You can back up, complete optimized replication, and restore data 
from DR Series systems using the Rapid Data Access protocol using the Dell Quest NetVault 
Backup DMA.

Daily Status 
Reporting

Daily status reporting feature allows you to configure daily system statistics for container 
status information on bytes ingested, deduplicated, and replicated.

Security 
Questions for 
Password Reset

Security questions for password reset allow you to add security questions to reset your DR 
Series system password.
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노트: The maintenance mode User interface for the DR Series systems is updated in this release.

기타 필요한 정보

경고: 시스템과 함께 제공되는 안전 및 규정 정보를 참조하십시오. 보증 정보는 이 문서 안에 포함되어 있거

나 별도의 문서로 제공될 수 있습니다.

• Dell DR Series 시스템 소유자 매뉴얼은 솔루션 기능에 대한 정보를 제공하고 DR Series 시스템 구성요소
를 설치하거나 교체하는 방법에 대해 설명합니다. 이 문서는 support.dell.com/manuals에서 볼 수 있습니
다.

• Dell DR Series 시스템 명령행 참조 안내서는 DR Series 시스템 명령행 인터페이스(CLI)를 사용하여 DR 
Series 시스템 데이터 백업 및 복제 작업 관리에 대한 정보를 제공합니다. 이 문서는 support.dell.com/
manuals에서 볼 수 있습니다.

• Dell DR Series 시스템 시작하기 안내서는 DR Series 시스템 설정에 대한 개요를 제공하며 기술 사양이 포
함되어 있습니다. 이 문서는 support.dell.com/manuals에서 볼 수 있습니다.

• Dell DR4100 시스템 설정은 Dell DR4100 시스템 초기화에 필요한 네트워크, 초기 설정, 사용자 계정 설정에 
대한 정보를 제공합니다. 이 문서는 support.dell.com/manuals에서 볼 수 있습니다.

• Dell DR Series 시스템 상호 운용성 안내서는 DR Series 시스템에서 사용할 수 있는 지원되는 하드웨어 및 
소프트웨어에 대한 정보를 제공합니다. 이 문서는 support.dell.com/manuals에서 볼 수 있습니다.

• Dell PowerVault MD1200 및 MD1220 스토리지 인클로저 하드웨어 소유자 매뉴얼은 DR Series 시스템에서 
사용할 수 있는 지원되는 외부 데이터 스토리지 확장 선반 하드웨어(인클로저)에 대한 정보를 제공합니
다. 이 문서는 support.dell.com/manuals에서 볼 수 있습니다.

• 운영 체제, 시스템 관리 소프트웨어, 시스템 업데이트 및 시스템과 함께 구입한 시스템 구성 요소와 관련
된 설명서 및 도구를 비롯하여 시스템을 구성 및 관리하는 데 필요한 설명서 및 도구를 제공하는 모든 미
디어가 시스템과 함께 제공됩니다.

노트: support.dell.com/manuals에서 설명서 업데이트가 있는지 항상 확인하십시오. 이러한 업데이트 문서는 

다른 문서의 정보를 대체하는 경우가 많으며 최신 업데이트 버전의 문서가 포함되어 있으므로 먼저 읽어보

시기 바랍니다.

노트: support.dell.com/manuals에서 릴리스 정보가 있는지 항상 확인하십시오. 릴리스 정보에 특정 제품 릴
리스에 대해 알려진 문제에 대한 가장 최근에 문서화된 정보가 포함되어 있으므로 먼저 읽어보시기 바랍니

다.

소스 코드 가용성

DR Series 시스템 소프트웨어의 일부에는 공개 소스 소프트웨어가 포함되어 있으며 공개 소스 소프트웨어가 배
포되는 특정 라이센스의 조건 하에 사용할 수 있습니다.

특정 공개 소스 소프트웨어 라이센스를 사용할 경우 해당 소스 파일을 확보할 수도 있습니다. 이에 대한 자세한 

내용 또는 각 프로그램의 해당 호스 파일을 찾아보려면 Dell opensource.dell.com 웹 사이트를 참조하시기 바랍니

다.

10



2
Understanding the DR Series System
The DR Series system is a high-performance, disk-based backup and recovery appliance that is simple to deploy and 
manage, and offers unsurpassed Total Cost of Ownership benefits. Features such as innovative firmware and an all-
inclusive licensing model ensure optimal functionality and the assurance of no hidden costs for desired future features.

노트: Unless otherwise noted, later references to "the system" or "DR Series system" are used interchangeably to 
represent the Dell DR Series system.

The DR Series system has a simple installation process with full, intuitive remote setup and management capabilities. It 
is available in the following drive capacities—2.7 Terabytes (TB), 5.4 TB, 9 TB, 18 TB, and 27 TB (the 27 TB drive capacity 
was added in Release 2.0), and is ideal for both small enterprise and remote office environments. The DR Series system 
and corresponding drive capacities are as follows:

• 300 Gigabyte (GB) drive capacity: 2.7 TB system (this system version does not support the addition of expansion 
shelf enclosures)

• 600 GB drive capacity: 5.4 TB system

• 1 TB drive capacity: 9 TB system

• 2 TB drive capacity: 18 TB system

• 3 TB drive capacity: 27 TB system

노트: To better understand the drive capacity and the available physical capacity for the drive types available in 
the DR Series system, see Drive and Available Physical Capacities.

노트: Release 2.0 also supports using an external data storage expansion shelf (also known as expansion 
enclosures). The DR Series system supports up to two expansion enclosures per system. An added expansion shelf 
enclosure must be equal to or greater than each DR Series system internal drive slot capacity (0–11). For more 
information about expansion enclosures, see Installing an Expansion Shelf License, DR Series System - Expansion 
Shelf Cabling, and Expansion Shelf Licenses.

Using Dell deduplication and compression algorithm technology, this system can achieve data reduction levels ranging 
from 10:1 to 50:1. This reduction in data results in less incremental storage needs and a smaller backup footprint. By 
removing redundant data, the system provides deduplication and compression that delivers:

• Fast, reliable backup and restore functionality

• Reduces media usage and power and cooling requirements

• Improves overall data protection and retention costs

The benefits of data deduplication can be extended across the enterprise—through the deduplicated replication 
function—to provide a complete backup solution for multi-site environments.

The shorter Recovery Time Objectives (RTO) and more attainable Recovery Point Objectives (RPO) can also be assured 
as critical backup data remains on disk and online longer. Capital and administrative costs are diminished at the same 
time as internal service level agreements (SLAs) are more easily met.

The DR Series system includes the following:

• Advanced data protection and disaster recovery

• Simple management interface (using the system GUI)
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• Wide variety of data backup installations and environments

The Dell DR Series system contains data backup and management software preinstalled on a Dell hardware appliance, 
which provides you with a robust disk-based data backup capability installed on a deduplication-enabled appliance.

The system supports two interface types, and the system software manages the storage containers using the following 
interfaces:

• A command line interface (CLI)

• A graphical user interface (GUI)

About the DR Series System
The Dell DR Series system is a solution designed to reduce your backup data footprint using a number of comprehensive 
backup and deduplication operations that optimize storage savings. Collectively, the DR Series system comes in two 
types:

• DR4000 system: this is preinstalled DR4000 system software on a Dell PowerEdge R510 appliance platform

• DR4100 system: this is preinstalled DR4000 system software on a Dell PowerEdge R720xd appliance platform

The DR Series system consists of the following components:

• Software — the system software supports record linkage and context-based lossless data compression 
methods.

• Hardware — there are two appliance types that support the DR Series:

– DR4000 system: includes twelve 3.5 inch SAS or Nearline SAS chassis drives that are hot-swappable, 
two power supplies for power redundancy, and two cabled 2.5-inch SAS drives for the operating 
system. The operating system is installed on two 2.5–inch internal drives that are in a RAID 1 
configuration in the DR4000 system.

– DR4100 system: includes twelve 3.5 inch SAS or Nearline SAS chassis drives that are hot-swappable, 
two power supplies for power redundancy, and includes two 2.5-inch drives that are hot-pluggable in 
the rear.

노트: For slot locations for the twelve 3.5–inch drives in the DR Series system types, see DR Series System 
and Data Operations.

• Expansion shelf—the system appliance supports the addition of up to two external Dell PowerVault MD1200 
data storage expansion shelf enclosures. Adding an expansion shelf provides additional data storage for the DR 
Series system and also requires a license. Each added expansion shelf enclosure must be equal to or greater 
than each DR Series system internal drive slot capacity (0–11).

노트: The 300 Gigabyte (GB) drive capacity (2.7TB) version of the DR Series system does not support the 
addition of expansion shelf enclosures.

For more information, see Expansion Shelf Licenses. For more general information about the supported storage 
enclosures, see “DR Series Expansion Shelf” in DR Series System and Data Operations, and support.dell.com/
manuals.

드라이브 및 사용 가능한 실제 용량

표 1은 릴리스 1.0.1.2 이상의 DR4000 시스템의 내부 시스템 드라이브 용량 및 사용 가능한 실제 용량(10진수 및 2
진수 값으로 표기)을 정의합니다. 릴리스 2.0부터 DR Series 시스템은 다음과 같은 두 가지 유형으로 제공됩니다.

• DR4000 시스템 - 수정된 Dell R510 어플라이언스 플랫폼에 미리 설치된 DR4000 시스템 소프트웨어로 구성
됩니다.

• DR4100 시스템 - 수정된 Dell R720xd 어플라이언스 플랫폼에 미리 설치된 DR4000 시스템 소프트웨어로 구
성됩니다.
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내부 드라이브 용량

표 1에 나열된 용량 값은 DR4000/DR4100 시스템 릴리스에서 관련 오버헤드에 맞게 조정된 내부 드라이브 및 사용 

가능한 실제 용량을 나타냅니다.

노트: 표 1에서 TB 및 GB는 각각 10진수 값의 테라바이트와 기가바이트를 나타내며 TiB는 2진수 값의 테비

바이트를 나타냅니다. 테비바이트는 표준 기반의 다중 2진 바이트로서 디지털 정보 스토리지의 단위입니

다.

표 1. 내부 드라이브 용량 및 사용 가능한 실제 용량

DR Series 시스템 드라이브 용량 사용 가능한 실제 용량(10진수) 사용 가능한 실제 용량(2진수)

3 TB (DR4100 시스템에만 해당) 26.79 TB 23.8 TiB

2 TB 17.9 TB 15.9 TiB

1 TB 8.89 TB 7.9 TiB

600 GB 5.29 TB 4.6 TiB

300 GB 2.47 TB 2.2 TiB

확장 선반 인클로저에서 지원하는 외부 데이터 스토리지 용량에 대한 일반적인 정보를 보려면 DR Series 시스템 

및 데이터 작업의 "DR Series 확장 선반" 절을 참조하십시오.

외부 드라이브 용량 

표 2에 나열된 용량 값은 DR4000 또는 DR4100 시스템에 지원되는 확장 선반 인클로저를 추가할 때 사용 가능한 외
부 드라이브의 추가적인 스토리지 용량을 나타냅니다. 추가적인 데이터 스토리지는 확장 선반 인클로저를 사용

하여 1 TB, 2 TB 또는 3 TB 용량 단위로 추가할 수 있습니다. 확장 선반 인클로저에 대한 자세한 내용은 DR Series 
시스템 확장 선반 추가, 확장 선반 라이센스 설치 및 DR Series 시스템 - 확장 선반 케이블 연결을 참조하십시오.

표 2. 외부 드라이브 용량 및 사용 가능한 실제 용량

DR Series 시스템 드라이브 용량 사용 가능한 실제 용량(10진수) 사용 가능한 실제 용량(2진수)

1 TB 8.89 TB 7.9 TiB

2 TB 17.89 TB 15.9 TiB

3 TB 26.79 TB 23.8 TiB

Data Storage Terminology and Concepts
This topic presents several key data storage terms and concepts that help you to better understand the role that the DR 
Series system plays in meeting your data storage needs.
Data Deduplication and Compression: The DR Series system design draws upon a wide variety of data-reduction 
technologies that include the use of advanced deduplication algorithms, in addition to the use of generic and custom 
compression solutions that are effective across a large number of differing file types. The system uses a concept of 
content-awareness where it analyzes data to better learn and understand the structure of your files and data types.

Once this is learned, it uses this method to improve your data reduction ratios while reducing resource consumption on 
the host. The system uses block deduplication to address the increasing data growth, and this is well suited to providing 
the best results for routine and repeated data backups of structured data. Block-level deduplication works efficiently 
where there are multiple duplicate versions of the same file. This is because it looks at the actual sequence of the data–
the 0s and 1s–that comprise the data.
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Whenever a document is repeatedly backed up, the 0s and 1s stay the same because the file is simply being duplicated. 
The similarities between two files can be easily identified using block deduplication because the sequence of their 0s 
and 1s remain exactly the same. In contrast to this, there are differences in online data. Online data has few exact 
duplicates. Instead, online data files include files that may contain a lot of similarities between each file. For example, a 
majority of files that contribute to increased data storage requirements come pre-compressed by their native 
applications, such as:

• Images and video (such as the JPEG, MPEG, TIFF, GIF, PNG formats)

• Compound documents (such as .zip files, email, HTML, web pages, and PDFs)

• Microsoft Office application documents (including PowerPoint, MS-Word, Excel, and SharePoint)

노트: The DR Series system experiences a reduced savings rate when the data it ingests is already 
compression-enabled by the native data source. It is highly recommended that you disable data 
compression used by the data source, and especially for first-time backups. For optimal savings, the native 
data sources need to send data to the DR Series system in a raw state for ingestion.

Block deduplication is not as effective on existing compressed files due to the nature of file compression because its 0s 
and 1s change from the original format. Data deduplication is a specialized form of data compression that eliminates a 
lot of redundant data. The compression technique improves storage utilization, and it can be used in network data 
transfers to reduce the number of bytes that must be sent across a link. Using deduplication, unique chunks of data, or 
byte patterns, can be identified and stored during analysis. As the analysis continues, other chunks are compared to the 
stored copy and when a match occurs, the redundant chunk is replaced with a small reference that points to its stored 
chunk. This reduces the amount of data that must be stored or transferred, which contributes to network savings. 
Network savings are achieved by the process of replicating data that has already undergone deduplication.

By contrast, standard file compression tools identify short repeated substrings inside individual files, with the intent of 
storage-based data deduplication being to inspect large volumes of data and identify large amounts of data such as 
entire files or large sections of files that are identical. Once this has been done, this process allows for the system to 
store only one copy of the specific data. This copy will be additionally compressed using single-file compression 
techniques. For example, there may be cases where an email system may contain 100 or more emails where the same 1 
Megabyte (MB) file is sent as an attachment and the following shows how this is handled:

• Without data deduplication, each time that email system is backed up, all 100 instances of the same attachment 
are saved, which requires 100 MB of storage space.

• With data deduplication, only one instance of the attachment is actually stored (all subsequent instances are 
referenced back to the one saved copy), with the deduplication ratio being approximately 100 to 1). The unique 
chunks of data that represent the attachment are deduplicated at the block chunking level.

노트: The DR Series system does not support deduplication of any encrypted data, so there will be no 
deduplication savings derived from ingesting encrypted data. The DR Series system cannot deduplicate 
data that has already been encrypted because it considers that data to be unique, and as a result, cannot 
deduplicate it.

In cases where self encrypting drives (SEDs) are used, when data is read by the backup application, it is decrypted by 
the SED or the encryption layer. This works in the same way as if you were opening an MS-Word document that was 
saved on a SED. This means that any data stored on a SED can be read and deduplicated. If you enable encryption in the 
backup software, you will lose deduplication savings because each time the data is encrypted, the DR Series system 
considers it to be unique.

Replication: Replication is the process by which the same key data is saved from multiple storage devices, with the goal 
of maintaining consistency between redundant resources in data storage environments. Data replication improves the 
level of fault-tolerance, which improves the reliability of maintaining saved data, and permits accessibility to the same 
stored data. The DR Series system uses an active form of replication that lets you configure a primary-backup scheme. 
During replication, the system processes data storage requests from a specified source to a specified destination (also 
known as a target) that acts as a replica of the original source data.
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노트: Starting with Release 2.0, the DR Series system software includes version checking that limits replication 
only between other DR Series systems that run the same system software release version (DR Series systems 
running Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

노트: It is important to distinguish the difference between data that has been processed by backup and data that 
has been processed by replication, since backup saves a copy of data that remains unchanged for a long period of 
time.

Targets with replica data are read-only, and are updated with new or unique data during scheduled or manual 
replications. The DR Series system can be considered to act as a form of the storage replication where the backed up 
and deduplicated data is replicated in real-time or via a scheduled window. In a replication relationship between two DR 
Series systems, this means that a relationship exists between a pair of systems, one acting as the source and the other 
as a target in the replication pair (for example, with acme-west and acme-east). When this type of replication 
relationship exists between distinct containers on two distinct DR Series systems, it can be considered bidirectional in 
the sense that:

• West1 container on the acme-west source system can replicate data to a separate East1 container on the 
acme-east target system.

• The East2 container on the target acme-east system can also replicate data back to the West2 container on the 
source acme-west system.

This form of replication involves separate containers on two distinct DR Series systems. Target containers in replication 
must always act as read-only, while source containers can act as read-write. Unlike NFS and CIFS containers, OST and 
RDS container replication is handled by the two supported Data Management Applications (DMAs) on media servers. 
For more information on OST, see Understanding OST. For more information on RDS, see Configuring and Using Rapid 
Data Storage.

노트: OST and RDS containers are categorized as Rapid Data Access (RDA) containers in DR Series systems.

This release of the DR Series system supports the 32:1 replication of data, whereby up to 32 source DR Series systems 
can write data to different individual containers on a single, target DR Series system. This supports the use case where 
branch or regional offices can each write their own data to a separate, distinct container on a main corporate DR Series 
system.

노트: Be aware that the storage capacity of the target DR Series system is directly affected by the number of 
source systems writing to its containers, and by the amount being written by each of the source systems.

If the source and target systems in a replication pair reside in different Active Directory (AD) domains, then the data that 
resides on the target DR Series system may not be accessible. When AD is used for authentication for DR Series 
systems, the AD information is saved with the file. This can serve to restrict user access to the data based on the type of 
AD permissions that are in place.

노트: This same authentication information is replicated to the target DR Series system when you have replication 
configured. To prevent domain access issues, ensure that both the target and source systems reside in the same 
Active Directory domain.

Reverse Replication: The concept of reverse replication is not supported on DR Series systems. This is because replica 
containers are always in a R-O (read-only) mode on the DR Series system, thus making write operations a non-
supported operation. Under very specific conditions, it might be possible for replica containers to support a type of write 
operation whose sole function is to restore data from an archival target. For example, data could be replicated back to 
the remote site where a data management application (DMA), also known as backup software, is connected to allow 
this data to be restored directly.
This specific case applies only to configurations where data is backed up from a remote location to a local container, 
and then replicated over a WAN to a replica container that is backed up to tape backup. The data needs to be restored 
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from the tape backup to the original location; first, restore the data back to a DR Series system replica container, and 
then restore it back to the original source location of the data on the other side of the WAN link.

노트: If you choose to use this alternate workaround method, you must set up a new data storage unit in the DMA 
and import the images before a restore to the original location can occur.

To support this effort to leverage deduplication across the WAN to allow this scenario, complete the following:

1. Make sure that the replication operation has completed (between source and target).

2. Delete current replication relationship, and re-create replication relationship (reversing the source and target 
roles).

3. Restore data to the original source container (now the target).

4. Make sure that the replication operation has completed.

5. Delete replication relationship and re-create replication relationship (restoring original source and target 
destinations).

Under this scenario, a fraction of the data to be recovered is sent across the WAN link. This could speed up a remote 
restore significantly. However, there are some downsides to this type of scenario:

• If step 1 is not followed correctly, any changes not fully replicated are lost.

• During steps 2 and 3, any data that is written to the original DR Series system source container may be lost.

• During step 4, if the data is not fully replicated back before the switch is made, it may be lost.

Alternatively, you still could support this effort by completing the following:

1. Create a new container on the target DR Series system.

2. Set up replication from this container back to the source DR Series system container.

3. Set up a new disk storage unit in the DMA and make sure that the DMA is aware of any new images.

4. Import the old images back into the DMA from the target DR Series system (the original source location).

5. Use a new disk storage unit in the DMA, and then restore the data back to the original client.

Data Deduplication and Compression

The DR Series system design uses various data-reduction technologies, including advanced deduplication algorithms, in 
addition to the generic and custom compression solutions that prove effective across many differing file types. Data 
deduplication and compression is addressed in the following areas:

• DR4000/DR4100 — The DR Series system backup and recovery appliances provide both efficient and high-
performance disk-based data protection to leverage the advanced deduplication and compression capabilities 
in the DR Series system software. Based on technology that is now part of the Dell Fluid Data Architecture, the 
DR Series systems provide a key component that performs backup, recovery, and data protection operations.

• Deduplication — This technology eliminates redundant copies of data and in the process it decreases disk 
capacity requirements and reduces the bandwidth needed for data transfer. Deduplication can be a major asset 
for companies that are dealing with increasing data volumes and require a means for optimizing their data 
protection.

• Compression — This technology reduces the size of data that is stored, protected, and transmitted. 
Compression helps companies improve their backup and recovery times while helping reduce infrastructure and 
network resource constraints.

In general, DR Series systems (DR4000 and DR4100) are disk-based data protection appliances that offer advanced 
deduplication and compression capabilities to reduce the time and cost associated with backing up and restoring data. 
Based on deduplication and compression technology, the DR Series systems eliminate the need to maintain multiple 
copies of the same data. This lets customers keep more data online longer and reduce the need for tape backup 
dependency.
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Using its deduplication and compression technology, DR Series systems can help achieve an expected data reduction 
ratio of 15:1. Achieving this reduction in data means that you need fewer incremental storage operations to run and it 
provides you with a smaller backup footprint. By removing redundant data, DR Series systems deliver fast reliable 
backup and restore functionality, reduce media usage and power and cooling requirements, and improve your overall 
data protection and retention costs.
You can extend the benefits of data deduplication across the enterprise as well–using the DR Series system 
deduplication replication function–to provide a complete backup solution for multi-site environments. With 32:1 
deduplicated replication, up to 32 nodes can be replicated simultaneously to separate, individual containers on one 
node. The DR Series systems use compression with replication to shrink the data that is needed to be moved across the 
wire to a container.
Replication can be scheduled based on your settings to occur during non-peak periods. The replication schedule you 
create can be set and prioritized to ingest data over replication data to ensure the most optimal back up windows based 
on your needs. The DR Series systems are Symantec OpenStorage Technology (OST) certified to provide tight 
integration with its NetBackup and Backup Exec DMA products to allow them to control when backup images are 
created, compressed, duplicated, and deleted, so that customers using these products can leverage the DR Series 
system appliance as a disk.
The DR Series systems also provide seamless integration with a number of data management applications (DMA), 
including Dell Quest NetVault Backup, CommVault replicated disk libraries, IBM Tivoli Storage Manager (TSM), EMC 
Networker, ARCserve, and Veeam backup software applications. Ideal for both small-sized and medium-sized 
companies as well as remote offices, the DR Series system provides data deduplication and compression support for 
four data capacity points: 35 Terabytes (TB), 70 TB, 130 TB, or 270 TB.

노트: For a complete list of supported DMAs in the 2.1 release of the DR Series system, see the Dell DR Series 
System Interoperability Guide for details.

노트: The DR Series system does not support deduplication of any encrypted data. So, there will be no 
deduplication savings derived from ingesting encrypted data. The DR Series system cannot deduplicate data that 
has already been encrypted because it considers that data to be unique, and as a result, it cannot deduplicate it.

Replication

Replication is the process by which the same key data is saved from multiple storage locations, with the goal being to 
maintain its consistency between redundant resources in data storage environments. Data replication improves the 
level of fault-tolerance, which improves the reliability of maintaining saved data, and permits accessibility to the same 
stored data. The DR Series system uses an active form of replication that lets you configure a primary-backup scheme. 
During replication, the system processes data storage requests from a specified source to a specified destination (also 
known as a target) that acts as a replica of the original source data.

노트: Starting with Release 2.0, the DR Series system software includes version checking that limits replication 
only between other DR Series systems that run the same system software release version (DR Series systems 
running Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

노트: It is important to distinguish the difference between data that has been processed by backup, and data that 
has been processed by replication. This is because backup saves a copy of data that generally remains unchanged 
for a long period of time.

Targets with replication data are read-only, and are updated with new or unique data during scheduled or manual 
replications. The DR Series system can be considered to act as a form of a storage replication process in which the 
backup and deduplication data is replicated in real-time or via a scheduled window in a network environment. In a 
replication relationship between two DR Series systems, this means that a relationship exists between a pair of systems. 
One system acts as the source and the other as a target in this replication pair (for example, acme-west and acme-east). 
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When this type of relationship exists between distinct containers on two distinct DR Series systems, it can be 
considered bidirectional in the sense that:

• The West1 container on the acme-west source system can replicate data to a separate East1 container on the 
acme-east target system.

• The East2 container on the target acme-east system can also replicate data back to the West2 container on the 
source acme-west system.

This form of replication involves separate containers on two distinct DR Series systems. Target containers in replication 
must always act as read-only, while sources containers can act as read-write. Unlike NFS and CIFS containers, OST and 
RDS container replication is handled by the two supported Data Management Applications (DMAs) on media servers. 
For more information on OST, see Understanding OST. For more information on RDS, see Configuring and Using Rapid 
Data Storage.

노트: OST and RDS containers are categorized as Rapid Data Access (RDA) containers in DR Series systems.

The DR Series system supports the 32:1 replication of data, whereby up to 32 source DR Series systems can write data 
to different individual containers on a single, target DR Series system. This supports the use case where branch or 
regional offices can each write their own data to a separate, distinct container on a main corporate DR Series system.

노트: Be aware that the storage capacity of the target DR Series system is directly affected by the number of 
source systems writing to its containers, and by the amount being written by each of the source systems.

However, if the source and target systems in a replication pair are in different Active Directory (AD) domains, then the 
data that resides on the target system may not be accessible. When AD is used to perform authentication for DR Series 
systems, the AD information is saved with the file. This can act to restrict user access to the data based on the type of 
AD permissions that are in place.

노트: This same authentication information is replicated to the target DR Series system when you have replication 
configured. To prevent domain access issues, ensure that both the target and source systems reside in the same 
Active Directory domain.

역방향 복제

역방향 복제 개념은 DR Series 시스템에서 지원되지 않습니다. DR Series 시스템에서는 복제 컨테이너가 항상 R-
O(읽기 전용) 모드에 있기 때문에 쓰기 작업을 수행할 수 없습니다.

보관 대상에서 데이터를 복원하는 단독 기능이 있는 쓰기 작업 유형을 복제 컨테이너가 지원하는 특수한 경우도 

있습니다. 예를 들어, 백업 소프트웨어라고도 하는 DMA(데이터 관리 응용프로그램)가 연결되어 데이터가 직접 

복원되도록 하는 원격 사이트에는 데이터를 다시 복제할 수 있습니다.

이와 같은 특수한 경우는 데이터가 원격 위치에서 로컬 컨테이너로 백업된 후에 WAN을 통해 복제 컨테이너에 

복제되어 테이프에 백업되는 구성에만 적용됩니다. 이 데이터를 테이프 백업에서 원래 위치로 복원해야 합니다. 
먼저, 데이터를 DR Series 시스템 복제 컨테이너에 다시 복원한 다음 WAN 링크의 다른 쪽에 있는 데이터의 원래 

소스 위치에 복원합니다.

노트: 대체 해결 방법을 사용하도록 선택할 경우 DMA에 새 데이터 스토리지 단위를 설정하고 이미지를 가
져와야만 원래 위치로 복원할 수 있습니다.

WAN에서 이러한 유형의 중복 제거를 사용하려면 다음을 수행합니다.

1. 소스와 대상 사이에 복제 작업이 완료되었는지 확인합니다.

2. 현재 복제 관계를 삭제하고 복제 관계를 다시 생성합니다(소스 및 대상 역할을 서로 바꿈).

3. 원래 소스 컨테이너에 데이터를 복원합니다(현재는 대상 컨테이너).

4. 복제 작업이 완료되었는지 확인합니다.

5. 복제 관계를 삭제하고 복제 관계를 다시 생성합니다(원래 소스 및 대상 목적지 복원).
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이 상황에서, 복원되는 데이터의 일부가 WAN 링크를 통해 전송됩니다. 그러면 원격 복원 속도가 현저히 빨라질 

수 있습니다. 하지만 몇 가지 문제점도 있습니다.

• 1단계를 제대로 따르지 않으면 완전하게 복제되지 않은 모든 변경사항이 유실됩니다.

• 2단계와 3단계에서, 원래 DR Series 시스템 소스 컨테이너에 작성되는 모든 데이터가 유실될 수 있습니
다.

• 4단계에서, 전환이 이루어지기 전에 완전하게 다시 복제되지 않은 데이터가 유실될 수 있습니다.

다음을 수행하여 이러한 문제를 해결할 수도 있습니다.

1. 대상 DR Series 시스템에 새 컨테이너를 만듭니다.

2. 이 컨테이너에서 소스 DR Series 시스템 컨테이너로의 복제를 설정합니다.

3. DMA에 새 디스크 스토리지 단위를 설정하고 DMA에서 새 이미지를 인식하는지 확인합니다.

4. 대상 DR Series 시스템(원래 소스 위치)에서 DMA로 이전 이미지를 다시 가져옵니다.

5. DMA의 새 디스크 스토리지 단위를 사용한 다음 원래 클라이언트에 데이터를 다시 복원합니다.

역방향 복제: 대체 방법

역방향 복제의 대체 방법을 지원하려면 다음을 수행합니다.

1. 대상 DR Series 시스템에 새 컨테이너를 만듭니다.

2. 이 컨테이너에서 소스 DR Series 시스템 컨테이너로의 복제를 설정합니다.

3. DMA에 새 디스크 스토리지 단위를 설정하고 DMA에서 새 이미지를 인식하는지 확인합니다.

4. 대상 DR Series 시스템(원래 소스 위치)에서 DMA로 이전 이미지를 다시 가져옵니다.

5. DMA의 새 디스크 스토리지 단위를 사용한 다음 원래 클라이언트에 데이터를 다시 복원합니다.

Supported File System Protocols
The DR Series system supports the following file system protocols:

• Network File System (NFS)

• Common Internet File System (CIFS)

• Rapid Data Access (RDA)

– OpenStorage Technology (OST)

– Rapid Data Storage (RDS)

노트: The DR Series system supports three container connection types: NFS, CIFS, and RDA. OST and RDS provide 
a logical disk interface that can be used with network storage devices to store data and support data storage 
operations.

For more information on OST, see Understanding OST, Creating an OST or RDS Connection Type Container, and Creating 
an NSF or CIFS Connection Type Container.

For more information on NFS and CIFS, see NFS, and CIFS. For more information on RDS, see Configuring and Using 
Rapid Data Storage.

NFS

NFS(네트워크 파일 시스템)는 파일 서버 표준이 되도록 설계된 파일 시스템 프로토콜로서, 컴퓨터 간에 RPC(원
격 프로시저 호출) 통신 방법을 사용합니다. 클라이언트는 로컬 스토리지에 액세스하는 방법과 유사한 방법으

로 네트워크를 통해 파일에 액세스할 수 있습니다.
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NFS는 클라이언트가 로컬 시스템에서와 같이 원격 시스템에서 파일을 보고, 저장하며, 업데이트할 수 있는 클라

이언트측 응용프로그램입니다. 시스템 또는 네트워크 관리자는 파일 시스템의 모든 부분을 장착할 수 있으며 각 

파일에 할당된 권한을 통해 장착된 파일 시스템(또는 파일 시스템 부분)에 액세스할 수 있습니다. NFS 프로토콜

은 Unix, Macintosh, OpenVMS 및 Microsoft Windows 운영 체제를 지원합니다.

CIFS

CIFS(Common Internet File System) 원격 파일 액세스 프로토콜은 DR Series 시스템에서 지원되며 SMB(Server 
Message Block)라고도 합니다. SMB는 Microsoft Windows 운영 체제를 실행하는 시스템의 NFS(Network File 
System) 프로토콜보다 더 일반적으로 사용됩니다. CIFS를 통해 프로그램이 원격 컴퓨터에서 파일이나 서비스를 

요청할 수 있습니다.

또한 CIFS는 클라이언트-서버 프로그래밍 모델을 사용하므로 클라이언트가 서버에서 실행 중인 프로그램에 메
시지를 전달하거나 파일에 액세스할 수 있습니다. 서버는 요청된 모든 작업을 검토하고 응답을 보냅니다. CIFS
는 Microsoft가 개발하여 사용한 SMB의 공용(개방형) 변형입니다.

노트: DR Series 시스템은 현재 Server Message Block(SMB), 버전 2.0을 지원하지 않습니다.

노트: CIFS 기능 제한사항에 대한 자세한 내용은 support.dell.com/manuals에서 Dell DR Series 시스템 상호 운
용성 안내서를 참조하십시오.

CIFS ACL 지원

DR4000 시스템 릴리스 1.1부터 DR Series 시스템 소프트웨어에서 CIFS 및 공유 레벨 권한에 ACL(액세스 제어 목록)
을 사용할 수 있습니다. ACL은 모든 네트워크 리소스와 관련될 수 있는 권한의 목록입니다.

각 ACL에는 개별 사용자 또는 사용자 그룹의 권한을 정의하거나 설명하는 ACE(액세스 제어 항목)가 포함될 수 

있습니다. ACL은 영(0) 항목으로 구성되거나(모든 사용자가 액세스 권한을 가짐) 사용자별 또는 그룹별로 특정 

권한을 정의하는 여러 개의 ACE로 구성될 수 있습니다.

노트: ACE 목록이 비어 있으면(즉, 0 항목이 포함됨) 모든 액세스 요청이 허용됩니다.

ACL은 특정 리소스에 액세스할 수 있도록 허용되는 엔터티를 설명하며 Windows 운영 체제에 기본으로 제공되

는 액세스 제어 메커니즘입니다. DR Series 시스템에서의 ACL 지원은 다음 두 컨테이너 유형에 영향을 주는 방법

에 따라 구분됩니다.

• 새 컨테이너

• 기존 컨테이너

노트: DR Series 시스템은 Microsoft Windows 관리 도구를 사용하여 CIFS 공유를 위한 공유 레벨 권한 설정을 

지원합니다. 공유 레벨 권한을 통해 공유에 대한 액세스를 제어할 수 있습니다. 자세한 내용은 공유 레벨 보
안 구성을 참조하십시오.

노트: BUILTIN\관리자 그룹에 속하는 모든 사용자는 CIFS 공유에서 ACL을 편집할 수 있습니다. 로컬 DR 
Series 시스템 관리자는 BUILTIN\관리자 그룹에 포함됩니다. BUILTIN\관리자 그룹에 도메인 그룹을 추가하

려면 Windows 클라이언트의 컴퓨터 관리자(Computer Manager) 도구를 사용하여 도메인 관리자로 DR 
Series 시스템에 연결하고 원하는 그룹을 추가할 수 있습니다. 이 기능을 사용하면 도메인 관리자 이외의 사
용자가 필요에 따라 ACL을 수정할 수 있습니다.

Access Control List Support in Containers

All containers created with the 1.1 release and later versions of the DR4000 system software (or pre–1.1 version system 
software that was upgraded to 1.1 or later), applies a default Access Control List (ACL) at the root of the container. This 
default ACL is the same as that which would be created by a Microsoft Windows 2003 Server. Therefore, these new 
containers with the default ACL support the following permission types:
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노트: Any user that is part of BUILTIN\Administrators can edit ACLs on CIFS shares. The local DR Series system 
administrator is included in the BUILTIN\Administrators group. To add additional domain groups to the BUILTIN
\Administrators group, you can use the Computer Manager tool on a Windows client to connect to the DR Series 
system as Domain administrator and add any groups you want. This capability allows users other than the Domain 
administrator to modify an ACL as needed.

• BUILTIN\Administrators:

Allows Full access, object inherit, and container inherit.

Applies to This folder, subfolders, and files.

• CREATOR OWNER:

Allows Full access, inherit only, object inherit, and container inherit.

Applies to Subfolders and files only.

• EVERYONE:

Allows Traverse folders, execute files, list folders, read data, read attributes, and read 
extended attributes.

Applies to This folder only.

• NT AUTHORITY\SYSTEM:

Allows Full access, object inherit, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Create folders and append data, inherit-only, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Read and execute, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Create files and write data, object inherit, and container inherit.

Applies to Subfolders only.

노트: If these permissions are unsuitable for your needs, you can modify the default ACL to suit your own 
requirement using the Windows ACL Editor (for example, using Properties → Security from Windows Explorer).

노트: Beginning with the 1.1 release, the system does not understand the Owner Rights permission and sets the 
owner of new files/folders created by the Domain Administrators as DOM\Administrator rather than as BUILTIN
\Administrators.

기존 컨테이너(1.1 이전 릴리스)

릴리스 1.1부터 DR Series 시스템 소프트웨어에 CIFS 및 공유 레벨 권한에 ACL(액세스 제어 목록)을 사용할 수 있
습니다. ACL은 모든 리소스와 관련될 수 있는 권한의 목록입니다. 각 ACL에는 개별 사용자 또는 사용자 그룹의 

권한을 정의하거나 설명하는 ACE(액세스 제어 항목)가 포함될 수 있습니다. ACL은 영(0) 항목으로 구성되거나(모
든 사용자가 액세스할 수 있음) 사용자별 또는 그룹별로 특정 권한을 정의하는 여러 개의 ACE로 구성될 수 있습

니다.
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릴리스 1.1 이전에 생성된 기존 컨테이너의 경우, 지정된 DR Series 시스템에 로그인하는 모든 사용자가 모든 파
일에 액세스할 수 있습니다. 1.1 이전 릴리스 컨테이너에 있는 연관된 ACL은 다음과 같은 권한만 지원합니다.

• 모든 사용자:

– 허용되는 작업: 전체 액세스

– 적용 대상: 이 폴더, 하위 폴더 및 파일

• BUILTIN\관리자:

– 허용되는 작업: 전체 액세스, 개체 상속, 컨테이너 상속

– 적용 대상: 이 폴더, 하위 폴더 및 파일

하지만 기존 컨테이너에 고유한 ACL을 적용할 수도 있습니다. 지정된 컨테이너의 공유 루트를 탐색하고 디렉터

리 트리의 ACL을 따르면 됩니다. 이 작업을 완료하는 데 필요한 시간은 컨테이너에 상주하는 파일 및 폴더 수에 

따라 다릅니다.

로컬 사용자를 생성하면 BUILTIN\사용자에 추가됩니다. 관리자 계정은 BUILTIN\관리자의 구성원이므로 컨테이

너의 ACL에 문제가 발생할 경우(예: ACL이 적용된 후 해당 관리자 또는 도메인 관리자가 잠기는 경우) 클라이언

트를 통해 MACHINE\관리자로 연결할 수 있습니다.

이때 ACL을 편집할 수 있습니다(BUILTIN\관리자 계정에 TakeOwnership 권한이 있음). 대규모 ACL에서는 컨테이

너에 추가적인 아이노드(inode)가 있다고 간주할 수 있으므로 컨테이너에 있는 파일 및 폴더 수가 매우 많을 경우

에는 문제가 발생할 수 있습니다. 소규모 ACL(최대 10개 ACE)은 아이노드(inode)의 예비 공간에 상주할 수 있으며 

대규모 ACL은 추가적인 아이노드(inode)를 사용할 수 있습니다. 아이노드(inode)는 Linux(또는 Unix와 유사한 운
영) 체제 파일 시스템에서 데이터 구조 역할을 하며 파일의 이름 및 실제 데이터를 제외한 파일의 모든 정보가 저
장됩니다.

노트: 관리자는 기본값이 새 컨테이너에 설정되는 방법과 비슷하게 기존 컨테이너에 권한 세트를 적용하는 

것이 좋습니다. 하지만 개별 사용자의 특정 보안 요구사항을 해결하는 액세스를 허용할 때는 주의해야 합
니다.

Unix Permissions Guidelines

For a user to create, delete, or rename a file or a directory requires Write access to the parent directory that contains 
these files. Only the owner of a file (or the root user) can change permissions.

Permissions are based on the user IDs (UIDs) for the file Owner and group IDs (GIDs) for the primary group. Files have 
owner IDs and group owner IDs. To enable Unix access, the DR Series system supports three levels of users:

• Owner (of the file)
• Group (group in which the owner belongs)
• Other (other users with an account on the system)

Each of these three user types support the following access permissions:

• Read (read access that allows user to read files)
• Write (write access that allows user to create or write to a file)
• Execute (access that allows user to execute files or traverse directories in the filesystem)

노트: A root user has all levels of permission access, and a user can be a member of a single group or of multiple 
groups (up to 32 groups are allowed in Unix).

Windows 권한 지침

Windows 액세스를 활성화하기 위해 DR Series 시스템은 ACE(액세스 제어 항목)가 없거나 여러 개 있는 ACL(액세

스 제어 목록)을 지원합니다. 비어 있는 ACE 목록은 모든 액세스 요청을 허용합니다. Windows NTFS(New 
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Technology File System)에서는 ACL을 보안 설명자(SD) 프로세스의 일부로 사용하므로 파일 시스템 개체를 파일 

및 디렉터리로 액세스하기 위한 권한이 필요합니다. ACL에서는 다음과 같은 두 가지 유형의 사용자가 지원됩니

다.

• 소유자

• 그룹

소유자와 그룹에는 개체 소유자 또는 개체를 소유하고 있는 그룹을 정의하고 식별하는 보안 ID(SID)가 있습니다. 
ACL의 ACE는 액세스를 허용하거나 정의하고 적용되는 상속 설정을 정의하는 특정 권한인 SID로 구성됩니다.

• IO - 상속만: 액세스 확인에 사용되지 않음

• OI - 개체 상속: 새 파일에 이 ACE가 추가됨

• CI - 컨테이너 상속: 새 디렉터리에 이 ACE가 추가됨

Windows NTFS ACL에는 다음과 같은 읽기, 쓰기, 추가, 실행, 삭제 권한이 포함되어 있습니다.

• 동기화 액세스

• 데이터 읽기 또는 디렉터리 나열

• 데이터 쓰기 또는 파일 추가

• 데이터 추가 또는 폴더 추가

• 확장 속성(EA) 읽기

• EA 쓰기

• 파일 실행 또는 폴더 트래버스

• 하위 폴더 삭제 또는 폴더 삭제

• 파일 삭제

소유자는 다음 두 권한을 보유합니다.

• 임의의 ACL 쓰기

• 제어 읽기

OpenStorage Technology (OST): DR Series System
OpenStorage Technology (OST) is developed by Symantec and provides a logical disk interface for use with network 
storage devices. The DR Series system appliance can use OST via plug-in software to integrate its data storage 
operations with a number of data management applications (DMAs).

OST allows for better coordination and integration between DR Series system backup, restore, and optimized duplication 
operations and the following supported DMA types:

• NetBackup

• Backup Exec

Integration is done via a Dell OST plug-in developed for the DR Series system, through which NetBackup and Backup 
Exec can control when the backup images are created, duplicated, and deleted. The major benefit of OST is that it 
allows the deduplication operations to happen on the client-side so that network traffic can be reduced.

OST via the Dell OST plug-in allows NetBackup and Backup Exec to take full advantage of such DR Series system 
features as data deduplication, replication, and energy efficiency. DR Series systems can access the OpenStorage API 
code through the plug-in, which can be installed on the media server platform choice you make (Windows or Linux). The 
OST protocol allows the supported backup applications to communicate directly with the DR Series system and 
determine whether a specific chunk of data already exists on the system. This process means that if the data already 
exists, only the pointers need to be updated on the DR Series system, and the duplicate chunk of data does not need to 
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be transferred to the system. This process provides two benefits: it improves the overall backup speed, and also reduces 
the network load.

When OST is used with the DR Series system, it offers the following benefits:

• OST protocol provides faster and improved data transfers:

– Focused on backups with minimal overhead

– Accommodates larger data transfer sizes

– Provides throughput that is significantly better than CIFS or NFS

• OST and DMA integration:

– OpenStorage API enables the DMA-to-media server software communications

– DR Series system storage capabilities can be used without extensive changes to DMAs

– Backup and replication operations are simplified by using built-in DMA policies

• DR Series System and OST:

– Control channel uses TCP port 10011

– Data channel uses TCP port 11000

– Optimized write operations enable client-side deduplication

• Replication operations between DR Series systems:

– No configuration required on source or target DR Series systems

– Replication is file-based, not container-based

– Triggered by DMA optimized duplication operation

– DR Series system transfers the data file (not the media server)

– After duplication, DR Series system notifies DMA to update its catalog (acknowledging the second 
backup)

– Supports different retention policies between source and replica

노트: This capability to use OST, also known as DR Rapid Data Access within Dell, adds tighter integration with 
backup software applications, such as the two Symantec OpenStorage-enabled backup applications supported in 
this release: NetBackup and Backup Exec.

OpenStorage Technology(OST) API

OpenStorage Technology(OST) API는 DR Series 시스템과 같은 디스크 기반 장치가 두 개의 지원되는 Symantec 
DMA(Data Management Applications), NetBackup 및 Backup Exec와 기본적으로 통합되도록 하는 응용프로그램 프
로그래밍 인터페이스입니다. 예를 들어, DR Series 시스템은 데이터 중복 제거와 복제 둘 다 지원하기 때문에 

OST API를 사용하면 지원되는 DMA에서 DR Series 시스템 어플라이언스 기능을 사용하여 스토리지 어플라이언

스 간에 최적화된 데이터를 복제할 수 있습니다.

OST API를 사용하면 데이터 쓰기 작업이 가능합니다. 다음 예에서 그림으로 설명된 바와 같이, OST API를 사용하

여 NetBackup(DMA)이 DR Series 시스템(데이터 백업 및 중복 제거 장치)과 상호 작용합니다.

• NetBackup은 파일을 디스크에 저장해야 합니다. 이렇게 하기 위해 NetBackup은 백업해야 할 파일과 파일
의 어떤 이름으로 지정할지를 OST API를 통해 DR Series 시스템에 알립니다.

• DR Series 시스템은 이 파일을 수락하고 이를 파일 시스템에 저장합니다.

• 그러면 NetBackup은 저장된 특정 파일을 사용하여 다음과 같은 세 가지 작업 중 하나를 수행할 수 있습니
다.

– 파일 만료

– 파일에서 복원
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– 파일 복사 또는 복제

• NetBackup이 OST API를 사용하여 저장된 파일이 DR Series 시스템에서 만료되도록 하는 경우 파일 시스
템에서 파일을 삭제합니다.

• 마찬가지로, NetBackup이 OST API를 사용하여 저장된 파일에서 복원하려는 경우 복원할 파일을 DR 
Series 시스템에 알려주고 복원할 수 있도록 저장된 파일을 NetBackup에 전달하도록 지시합니다.

노트: OST에는 최적화된 중복이라고 하는 기능이 있습니다. 예를 들어, 최적화된 중복에서 DMA(NetBackup)
는 장치 A가 장치 B에서 최적화된 중복을 수행하도록 지시합니다. 장치 A와 B는 상호 통신하여 장치 B에 사
용하기 위해 A에서 B로 복제해야 할 파일의 데이터 세그먼트를 결정하여 장치 B에 완전한 전체 중복 데이

터 파일이 포함되도록 합니다. 이 작업에 성공하면, DMA는 이 데이터 파일의 두 사본을 인식하게 되어 장치 

B에 상주하는 다른 데이터 파일처럼 이 파일을 사용할 수 있습니다.

Software Components and Operational Guidelines

To better coordinate and integrate OpenStorage Technology (OST) with the DR Series system data storage operations, 
the following guidelines list the supported software, required components, optimal performance, and supported 
operations:

• OST Media Server Component:

– An OST server component resides on the DR Series system
– For Linux media server installations, use the Linux OST plug-in and the Red Hat Package Manager (RPM) 

installer
– For Windows media server installations, use the Windows OST plug-in and the Microsoft (MSI) installer

• Supported Windows-based OST plug-in releases:

노트: The DR Series system supports both the 32–bit and 64–bit versions for NetBackup, and the 64–bit 
version for Backup Exec.

– Windows Server 2003
– Windows Server 2008
– Windows Server 2008 Release 2

• Supported Linux-based 64-bit OST plug-in releases:

– Red Hat Enterprise Linux, version 5.x
– Red Hat Enterprise Linux, version 6.x
– Red Hat Enterprise Linux, version 10 and 11

• Supported Symantec OpenStorage (OST) protocol:

– Symantec, version 9
– Symantec, version 10

• Supported Symantec DMAs:

– NetBackup: version 7.1 (Windows Server 2003, 32–bit), 7.1 (Windows Server 2008 R2, 64–bit), 7.5 
(Windows Server 2008, 32–bit), 7.5 (Windows Server 2008 R2, 64–bit), 7.1 (Red Hat Enterprise Linux 5.x, 
64–bit), and 7.5 (SUSE Linux Enterprise Server 11 SP2, 64–bit).

– Backup Exec: version 2010 Release 3 (Windows Server 2008 R2, 64–bit), and 2012 (Windows Server 2008 
R2, 64–bit).

노트: The Dell DR Series system licensing is all-inclusive, so that no additional Dell licensing is 
required to use OST or the optimized duplication capability. The Dell OST plug-in that gets installed 
on a supported Linux or Windows media server platform is a free download from Dell. However, 
Symantec NetBackup requires that you purchase a Symantec OpenStorage Disk Option license. 
Similarly, Symantec Backup Exec requires that you purchase the Deduplication Option to enable 
the OST feature.
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• Backup, restore, and optimized duplication operations need to be performed via the OST plug-in
• Optimal supported aggregated throughput rates:

– 3 Terabytes per hour (TB/hr) for passthrough write operations
– 4 TB/hr for optimized write operations

노트: Passthrough writes are when data is sent from a media server to the DR Series system 
without applying any optimization to the data. By contrast, optimized writes are when data is sent 
from a media server to the DR Series system after optimization is applied to the data.

• Supported OST operations

– Backup (Passthrough writes and Optimized writes)
– Restore
– Replication

노트: To check for the latest supported OST software components and operating guidelines, see the Dell DR Series 
System Interoperability Guide. This document is available at support.dell.com/manuals.

Rapid Data Storage (RDS): DR Series System
Rapid Data Storage (RDS) is developed by Dell Quest and provides a logical disk interface for use with network storage 
devices. RDS allows for better coordination and integration between DR Series system backup, restore, and optimized 
duplication operations with Dell Quest NetVault Backup (NVBU).

The DR Series system and NVBU integration is done using the Rapid OFS (ROFS) plugin developed by Dell. The ROFS 
plugin allows NVBU control over backup image creation, deletion, and duplication. RDS allows deduplication and 
compression operations to happen on the client-side so that network traffic can be reduced.

The RDS protocol allows the supported backup applications to communicate directly with the DR Series system and 
determine whether a specific chunk of data already exists on the system. If the data already exists, only the pointers 
need to be updated on the DR Series system, and the duplicate chunk of data does not need to be transferred to the 
system. This process provides two benefits: it improves the overall backup speed, and also reduces the network load.

Rapid OFS (ROFS) API

노트: Rapid OFS (ROFS) is an internal API used by RDS. The term ROFS is not used in the web user interface or CLI.

The Rapid OFS (ROFS) API is an application programming interface that allows disk-based devices like the DR Series 
system to natively integrate with the Dell Quest NetVault Backup. For example, because the DR Series system supports 
both data deduplication and replication, the ROFS API allows these supported DMAs to use the DR Series system 
appliance features and duplicate the optimized data from one storage appliance to another.

Unlike replication configured directly on the DR4x00 for CIFS and NFS, the ROFS API allows the Data Management 
Application (DMA) to be aware of the replication copy. The ROFS API allows the DMA to restore directly from any 
DR4x00 that are on the same subnet and can communicate with each other.

The ROFS API enables the writing of data to disk and allows NVBU (the DMA) to interact with the DR Series system (the 
data backup and deduplication device) using the ROFS API.

DR Series System and Data Operations
Data is stored and resides on the Dell DR Series system, a two-rack unit (RU) appliance, which comes preinstalled with 
the system software. Starting with the 2.0 release. the DR Series system comes in two types:

• DR4000 system: This consists of preinstalled DR4000 system software on a Dell PowerEdge R510 appliance 
platform.
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• DR4100 system: This consists of preinstalled DR4000 system software on a Dell PowerEdge R720xd appliance 
platform.

The DR Series system consists of a total of 14 drives. Two of these drives are 2.5-inch drives that are configured as a 
Redundant Array of Independent Disks (RAID) 1 on the RAID Controller and this is considered to be volume 1. In the 
DR4000 system, these drives are internal, while in the DR4100 system, these drives are accessible from the rear. The 
data that is being backed up is stored on the 12 virtual disks that reside on the DR Series system appliance. This release 
also supported additional storage in the form of external expansion shelf enclosures (see the DR Series Expansion Shelf 
section in this topic). The hot-swappable data drives that are attached to the RAID controller are configured as:

• 11 drives that operate as RAID 6, which act as virtual-disks for data storage (drives 1–11).

• The remaining drive (drive 0) acts as the dedicated hot-spare drive for RAID 6 for the system.

The DR Series system supports RAID 6, which allows the appliance to continue read and write requests to the RAID 
array virtual disks even in the event of up to two concurrent disk failures, providing protection to your mission-critical 
data. In this way, the system design supports double-data drive failure survivability.

If the system detects that one of the 11 virtual drives has failed, then the dedicated hot spare (drive slot 0) becomes an 
active member of the RAID group. Data is then automatically copied to the hot spare as it acts as the replacement for 
the failed drive. The dedicated hot spare remains inactive until it is called upon to replace a failed drive. This scenario is 
usually encountered when a faulty data drive is replaced. The hot spare can act as replacement for both internal 
mirrored drives and the RAID 6 drive arrays.

그림 1 . DR4000/DR4100 System Drive Slot Locations

Drive 0 (top) Drive 3 (top) Drive 6 (top) Drive 9 (top)

Drive 1 (middle) Drive 4 (middle) Drive 7 (middle) Drive 10 (middle)

Drive 2 (bottom) Drive 5 (bottom) Drive 8 (bottom) Drive 11 (bottom)

DR Series Expansion Shelf

Each DR Series system appliance supports the installation and connection of up to two Dell PowerVault MD1200 data 
storage expansion shelf enclosures. Each expansion shelf contains 12 physical disks in an enclosure, which provides 
additional data storage capacity for the basic DR Series system. The supported data storage expansion shelves can be 
added in 1 Terabyte (TB), 2 TB, or 3 TB hard drive capacities.

The physical disks in each expansion shelf are required to be Dell-certified Serial Attached SCSI (SAS) drives, and the 
physical drives in the expansion shelf uses slots 1–11 configured as RAID 6, with slot 0 being a global hot spare (GHS). 
When being configured, the first expansion shelf is identified as Enclosure 1 (in the case where two enclosures are 
added, these would be Enclosure 1 and Enclosure 2). Adding an expansion shelf to support the DR Series system 
requires a license. For more information, see Expansion Shelf Licenses. For more general information about the 
supported storage enclosures, see support.dell.com/manuals.

노트: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition 
of expansion shelf enclosures.

27



노트: If you are running a DR4000 system with an installed release of system software prior to 2.1, and you intend 
to upgrade to release 2.1 system software and install an external expansion shelf (or shelves), Dell recommends 
that you observe the following best practice sequence of operations to avoid any issues:

• Upgrade the DR4000 system with the release 2.1 system software

• Power off the DR4000 system (required for 2.1 with Dell OpenManage 7.1)

• Connect the external expansion shelf (or shelves) with cabling to the DR4000 system

• Power on the external expansion shelf (or shelves)

• Power on the DR4000 system

노트: If you install an expansion shelf enclosure to support a DR Series system, each shelf must use physical disks 
that have a capacity equal to or greater than each DR Series system internal drive slot capacity (0–11) that they are 
supporting.

그림 2 . DR4100 System Expansion Shelf (MD1200) Drive Slot Locations

Drive 0 (top) Drive 3 (top) Drive 6 (top) Drive 9 (top)

Drive 1 (middle) Drive 4 (middle) Drive 7 (middle) Drive 10 (middle)

Drive 2 (bottom) Drive 5 (bottom) Drive 8 (bottom) Drive 11 (bottom)

Understanding About Adding a DR Series Expansion Shelf

The 2.0 release of the DR Series system appliance allows you to connect up to two Dell PowerVault MD1200 data 
storage expansion shelf enclosures to provide additional data storage capacity beyond the capacity of the basic DR 
Series system. Supported data storage expansion shelves can be added in 1 Terabyte (TB), 2 TB, or 3 TB hard drive 
capacities. The process for adding an expansion shelf requires the following:

노트: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition 
of expansion shelf enclosures.

• Physically adding or installing the expansion shelf (for more information, see Adding a DR Series System 
Expansion Shelf)

• Cabling the expansion shelf to the DR Series system (for more information, see DR Series System - Expansion 
Shelf Cabling)

• Installing the license for an expansion shelf (for more information, see Installing an Expansion Shelf License)

Supported Software and Hardware
For a complete list of the latest supported software and hardware for the DR Series system, Dell recommends that you 
see the Dell DR Series System Interoperability Guide at support.dell.com/manuals. For example, the Dell DR Series 
System Interoperability Guide lists the following supported hardware and software categories:
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• Hardware

– BIOS
– RAID controllers
– Hard drives (internal)
– Hard drives (external)
– USB flash drives
– Network interface controllers
– iDRAC Enterprise
– Marvell WAM controller

• Software

– Operating System
– Supported backup software
– Network file protocols and backup client operating systems
– Supported web browsers
– Supported system limits
– Supported OST software and components
– Supported RDS software and components

Terminal Emulation Applications

To access the DR Series system command line interface (CLI), the following terminal emulation applications can be 
used:

• FoxTerm
• Win32 console
• PuTTY
• Tera Term Pro

노트: The listed terminal emulation applications are not the only ones that works with the DR Series system. This 
list is only intended to provide examples of terminal emulation applications that can be used.

DR Series — Expansion Shelf Cabling
Each DR Series system appliance is capable of supporting additional storage capacity and install and connect up to two 
Dell PowerVault MD1200 data storage expansion shelf enclosures. Each of the expansion shelf enclosures contains 12 
physical disks that provide additional data storage capacity for a basic DR Series system. The supported data storage 
expansion shelves can be added in 1 Terabyte (TB), 2TB, or 3TB hard drive capacities. figure 1and Figure 2display the 
recommended method for cabling between the DR4000/DR4100 PERC controller card to the appropriate connectors on 
the rear of the Dell PowerVault MD1200 expansion shelf enclosure.

노트: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition 
of expansion shelf enclosures.

Make sure that the Dell PowerVault MD1200 front panel selector switch is set to its Unified mode (with the switch set to 
its “up” position, indicated by a single Volume icon). figure 1 shows the SAS In ports on the Enclosure Management 
Module (EMM) on the rear of the Dell MD1200. Figure 2 shows the recommended redundant path cabling configuration, 
which includes cable connections from both PERC H800 connectors on the DR4000 system (or the PERC H810 on a 
DR4100 system) to the two SAS In ports on the EMM rear chassis of the Dell PowerVault MD1200.

If you plan on installing the second of the two supported expansion shelf enclosures in Release 2.0, then the two SAS In 
ports on the rear chassis of the EMM on the second enclosure are daisy-chained to the two SAS Out ports on the EMM 
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rear chassis on the first enclosure. This is considered a redundant mode connection via the SAS In/Out connectors on 
the enclosures with the DR Series system appliance.

If you install a second enclosure and cable it as described here, make sure to set the enclosure mode switch on the 
MD1200 front chassis to the top (unified mode) positions. For more information, see Dell PowerVault MD1200 and 
MD1220 Storage Enclosures Hardware Owner's Manual at support.dell.com/manuals.

그림 3 . Dell PowerVault MD1200 Rear Chassis

그림 4 . Unified Mode Daisy-Chained Redundant Path Dell PowerVault MD1200 Enclosures
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그림 5 . SAS Port and Cable Connections (Dell PowerVault MD1200 EMM)

1. SAS cable
2. pull-tab

DR Series 시스템 확장 선반 추가

DR Series 시스템에서 확장 선반 인클로저 구성과 연관된 세 가지 작업이 있습니다. 이러한 작업을 수행해야 추
가적인 데이터 스토리지 용량을 사용할 수 있습니다.

• DR Series 시스템에 확장 선반 인클로저를 연결하는 모든 케이블을 설치합니다(자세한 내용은 DR Series 
시스템 - 확장 선반 케이블 연결 참조).

• Storage(스토리지) 페이지를 사용하여 확장 선반 인클로저를 추가하고 활성화합니다(이 주제에 설명되
어 있음).

• 확장 선반 인클로저의 Dell 라이센스를 설치합니다(자세한 내용은 확장 선반 라이센스 추가 참조).

DR Series 시스템에 확장 선반 인클로저를 추가하려면 다음을 수행합니다.

1. 탐색 패널에서 Storage(스토리지)를 클릭합니다.
Storage(스토리지) 페이지가 표시됩니다(이 단계에서는 모든 확장 선반 인클로저 케이블 연결을 완료했다

고 간주함).

2. Physical Storage(실제 스토리지) 창의 실제 스토리지 요약 표에서, 추가할 인클로저에 해당하는 
Configured(구성됨) 열의 Add(추가)를 클릭합니다(인클로저의 표시된 상태는 Not Configured(구성되지 않음)).
인클로저가 추가되는 동안에는 시스템의 모든 입력/출력이 중지됨을 알려주는 Enclosure Addition(인클로저 

추가) 대화상자가 표시됩니다. OK(확인)를 클릭하여 계속 진행하거나 Cancel(취소)을 클릭하여 프로세스를 

중지하라는 메시지가 표시됩니다.

3. DR Series 시스템에 인클로저 추가를 계속 진행하려면 OK(확인)를 클릭합니다.
Cancel(취소)을 클릭하면 추가 프로세스가 중지되고 Storage(스토리지) 페이지가 표시됩니다.

4. OK(확인)를 클릭하면 이 프로세스를 완료하는 데 최대 10분이 걸린다는 메시지가 포함된 Enclosure 
Addition(인클로저 추가) 대화상자가 표시됩니다.
다음과 같은 메시지가 있는 System Status(시스템 상태) 대화상자가 표시됩니다. The system is currently 
adding an enclosure. Please wait for this process to complete and the system to become operational(시스템이 현
재 인클로저를 추가하고 있습니다. 이 프로세스가 완료되어 시스템이 작동될 때까지 잠시 기다려 주십시
오.)
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5. 인클로저가 추가되었는지 확인하려면 Dashboard(대시보드)→ Health(상태)를 클릭합니다.
Health(상태) 페이지가 표시되고, 올바르게 케이블 연결되어 활성화된 각 확장 선반 인클로저의 해당 탭에 

녹색 상태 확인 표시가 나타납니다. 예를 들어, 2개의 인클로저를 설치하면 Enclosure 1(인클로저 1) 탭과 

Enclosure 2(인클로저 2) 탭이 표시됩니다.

노트: Enclosure(인클로저) 탭에 녹색 상태 확인 표시가 나타나지 않으면 인클로저에 문제가 있는 것입

니다(예: 올바르게 연결 또는 활성화되지 않음).

6. 확장 선반 인클로저를 추가한 후에는 확장 선반 라이센스를 추가해야 합니다.
자세한 내용은 확장 선반 라이센스 추가를 참조하십시오.
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3
Setting Up the DR Series System
Before you can interact with the DR Series system using one of its two supported methods: the web-based DR Series 
system graphical user interface (GUI) using a web browser or the command line interface (CLI) and a terminal emulator 
application (for example, PuTTY), you must first ensure that it is properly set up. For more information about properly 
setting up the DR Series system, see the following links. For more information on the DR Series system CLI commands, 
see the Dell DR Series System Command Line Reference Guide.
관련 링크

Logging in Using a Web Interface
Interacting with the DR Series System
Logging in and Initializing the DR Series System
Networking Preparations for the DR Series System

Interacting With the DR Series System
You interact with the DR Series system using its web-based graphical user interface (GUI) through a browser-based 
connection. The DR Series system GUI provides a single, comprehensive data management interface that lets you 
create new data containers, modify or delete existing containers, and perform a number of data-related operations 
using its features and settings.

노트: A second method for interacting with the DR Series system is by using its command-line interface (CLI) via a 
terminal emulator application (for example, PuTYY).

You can create and manage containers that are the repositories where you store your backup and deduplicated data. A 
data container is a shared file system that is imported using a client, and is accessible via NFS or CIFS filesystem 
protocols.

The DR Series system provides real-time summary tables, detail tables, and graphs that let you monitor the status of the 
data capacity, storage savings, and the throughput of the containers you are managing using its set of GUI features.

Networking Preparations for the DR Series System

Before you can start using the DR Series system, ensure that you have satisfied the following networking prerequisites:

• Network: An active network is available using Ethernet cables and connections.

노트: If your DR Series system is equipped with a 1-GbE NIC, Dell recommends using CAT6 (or CAT6a) 
copper cabling. If your DR Series system is equipped with a 10-GbE NIC, Dell recommends using CAT6a 
copper cabling.

노트: If your DR Series system is equipped with a 10-GbE enhanced small form-factor pluggable (SFP+) 
NIC, you must use Dell-supported SFP+ LC fiber-optic transceivers or twin-axial cabling.

• IP Addresses: You need to make sure to have IP addresses that you use for the DR Series system. The DR Series 
system ships with a default IP address and subnet mask address, which should only be used for an initial system 
configuration.

노트: You need to have an IP address available to replace the default IP address if you choose the static 
mode of IP addressing, or select to use the DHCP mode of IP addressing.
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To perform an initial configuration, you need:

– An IP address for the system

– A subnet mask address

– A default gateway address

– A DNS suffix address

– A primary DNS server IP address

– (Optional) A secondary DNS server IP address

• NIC Connections: To configure NIC connection bonding remember that, by default, the DR Series system will 
configure its NIC interfaces together as a bonded team (and only one IP address is needed because the bonded 
NICs assume the primary interface address). NIC connection bonding can use either of these configurations:

– Adaptive load balancing (ALB), which is the default setting, does not require any special network switch 
support. Ensure that the data source system resides on the same subnet as the DR Series system. For 
more information, see Configuring Networking Settings.

– 802.3ad or dynamic link aggregation (using the IEEE 802.3ad standard). 802.3ad requires special switch 
configuration before using the system (contact your network administrator for an 802.3ad configuration).

노트: To configure a 10-GbE NIC or 10-GbE SFP+ bonded configuration, connect only the 10-GbE/10-GbE 
SFP+ NICs. You can use the new Advanced Networking feature available on the command line interface to 
modify the default factory configuration.

• DNS: you need a DNS domain available, and you need to know the primary DNS server IP address (and a 
secondary DNS server IP address, if you choose to configure one).

• Replication ports: the replication service in the DR Series system requires that enabled fixed ports be configured 
to support replication operations that are to be performed across firewalls (TCP ports 9904, 9911, 9915, and 9916).
For more information about replication ports, see Managing Replication Operations, and for more information 
about system ports, see Supported Ports in a DR Series System.

노트: For the latest details about supported hardware and software for the Dell DR Series system, see the 
Dell DR Series System Interoperability Guide at support.dell.com/manuals.

노트: For information about ports needed for OST operations, see Understanding OST.

Connections for Initializing a DR Series System
There are two supported methods for connecting to the DR Series system for logging in and performing the initial system 
configuration via the DR Series system CLI:

• Local console connection: this is a local access connection made between a local workstation and the DR 
Series system (with one connection made to a USB keyboard port on the DR Series front/rear chassis, and a 
second connection made to the VGA monitor port on the DR Series system rear chassis. (See Figure 3 for 
locations in the DR Series System Rear Chassis Port Locations in the Local Console Connection.)

• iDRAC connection: this is a remote access connection made between an integrated Dell Remote Access 
Controller (iDRAC) and the dedicated management port on the DR Series system rear chassis. (See Figure 3 for 
locations in the DR Series System Rear Chassis Port Locations in the Local Console Connection.)
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DR Series 시스템 초기화

DR Series 시스템 그래픽 사용자 인터페이스(GUI)를 처음으로 사용하려는 경우 시스템을 올바르게 초기화해야 

합니다. DR Series 시스템을 초기화하려면 다음을 수행합니다.

1. 로컬 콘솔 KVM(키보드-비디오 모니터) 연결 또는 iDRAC 연결을 사용하여 DR Series 시스템 CLI에 로그인합
니다. 자세한 내용은 로컬 콘솔 연결 또는 iDRAC 연결을 참조하십시오.

2. Initial System Configuration Wizard(초기 시스템 구성 마법사)를 사용하여 시스템 네트워크 설정을 구성합니
다. 자세한 내용은 DR Series 시스템에 로그인 및 초기화를 참조하십시오.

초기 시스템 구성 마법사를 사용하면 다음과 같은 네트워크 설정을 구성하여 시스템의 최초 초기화를 완료할 수 

있습니다.

• IP 주소 지정 모드

• 서브넷 마스크 주소

• 기본 게이트웨이 주소

• DNS 접미사 주소

• 기본 DNS 서버 IP 주소

• (선택사항) 보조 DNS 서버 IP 주소

• 시스템의 호스트 이름

기본 IP 주소 및 서브넷 마스크 주소

이 주제에서는 DR Series 시스템 초기화에 사용할 수 있는 다음과 같은 기본 주소 값을 제시합니다.

• IP 주소 - 10.77.88.99
• 서브넷 마스크 주소 — 255.0.0.0

기본 주소 값 및 DR Series 시스템 초기화와 관련된 두 가지 주요 요소가 있습니다.

• 로컬 콘솔 사용

• DHCP를 사용하여 MAC 주소 예약

시스템이 상주하게 될 네트워크에 DHCP가 없거나 지원되지 않을 경우, DR Series 시스템은 초기화용으로 제공

된 기본 IP(10.77.88.99) 및 서브넷 마스크(255.0.0.0) 주소를 사용할 수 있습니다. 시스템이 상주하게 될 네트워크에 

DHCP 서버에서 NIC의 MAC 주소에 대한 IP 주소 예약 기능이 없거나 지원되지 않을 경우, DHCP는 초기화 중에 알 

수 없는(따라서 사용할 수 없음) 임의의 IP 주소를 할당합니다.

따라서 네트워크에서 DHCP를 지원하지 않거나 DHCP 네트워크 인터페이스 카드(NIC)의 특정 MAC 주소를 위한 

IP 주소를 예약할 수 없을 경우에는 로컬 콘솔 연결 방법과 초기 시스템 구성 마법사를 사용하는 것이 좋습니다.

노트: 시스템을 성공적으로 초기화하고 구성한 후 IP 주소를 수정하여 정적 IP 주소를 사용하거나 동적 IP 
주소 지정(DHCP)을 사용하고 네트워크에서 지원하는 서브넷 마스크 주소로 수정할 수 있습니다.

노트: 동일한 네트워크에 설치될 하나 이상의 DR Series 시스템에서 초기 시스템 구성 마법사를 실행하지 

않은 경우, 모든 시스템에 동일한 기본 IP 주소(10.77.88.99)가 제공될 수 있습니다. 기본 IP 주소는 사용자가 

구성할 수 없으며 여러 시스템을 사용하는 경우에 IP 주소가 중복될 수 있습니다.

초기화 중에 발생할 수 있는 문제로서, 네트워크의 전원이 중단되거나 초기 시스템 구성 마법사를 실행하지 않
은 경우 네트워크 상에 있는 DHCP 서버가 잘못 구성될 수 있습니다.

네트워크에서 기본 서브넷 마스크 주소(255.0.0.0)를 수락하지 않을 경우 DR Series 시스템과 랩탑 워크스테이션 

간에 연결을 설정할 수 있습니다. 이 경우, SSH를 사용하고 기본 IP 주소를 사용하여 초기 시스템 구성 마법사를 

실행해야 합니다.
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알려진 정적 IP 주소를 사용하고 있는 경우 초기 시스템 구성 마법사 실행을 건너뛰고 해당 사용자 인터페이스

를 사용하여 DR Series 시스템을 직접 구성할 수 있습니다.

DR Series 시스템을 구성하려면 System Configuration(시스템 구성) → Networking(네트워킹) 을 선택하고 원하는 

네트워킹 설정을 구성합니다. 자세한 내용은 네트워킹 설정 구성을 참조하십시오.

노트: 로그인 및 초기 시스템 구성 마법사 사용에 대한 자세한 내용은 네트워킹 설정 구성을 참조하십시오.

Local Console Connection

To configure a local console connection, you must make the following two rear chassis cable connections:

• VGA port and your video monitor

• USB port and your keyboard

To make local console cable connections for the DR4000 and DR4100 system appliances, complete the following:

1. (DR4000 system appliance) Locate the VGA monitor port and the USB ports on the back of your system. See Figure 3 
for the VGA and USB port locations and complete steps 1 to 4. For the DR4100 system appliance, skip to step 5.

2. Connect the video monitor to the VGA port on the back of your system (see item 1 in the DR4000 System Rear 
Chassis Port Locations table).

3. Connect the USB keyboard to one of the two USB ports on the back of your system (see item 3 in DR4000 System 
Rear Chassis Port Locations table).

4. You are now ready to perform initialization using the DR Series system CLI login process. For more information, see 
Logging in and Initializing the DR Series System.

그림 6 . DR4000 System Rear Chassis Port Locations

Item Indicator, Button, or Connector Icon Description

1 Video connector Connects a VGA display to the system.

2 iDRAC6 Enterprise port Dedicated management port for the iDRAC6 
Enterprise card.

3 USB connectors (2) Connects USB devices to the system. The ports are 
USB 2.0-compliant.

4 Ethernet connectors (2) Embedded 10/100/1000 NIC connectors.

5 Ethernet Connectors (2) on 
expansion card

1-GbE/10-GbE/10-GbE SFP+ Ethernet Port

To make local console cable connections for the DR4100 system appliance, complete the following:
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노트: The DR4000 system supports up to four 1–GbE ports or up to two 10–GbE ports; for the 1–GbE ports, 
these are two internal LAN on Motherboard (LOM) ports referenced in item 4 above that reside on the 
motherboard, and two ports on an expansion card referenced in item 5 above. If the DR4000 system is using 
the two 10–GbE ports, these reside on an expansion card referenced in item 5 above.

5. (DR4100 system appliance) Locate the VGA monitor port and the USB ports on the back of your system. See Figure 3 
for the VGA and USB port locations and complete steps 5 to 8.

6. Connect the video monitor to the VGA port on the back of your system (see item 2 in the DR4100 System Rear 
Chassis Port Locations table).

7. Connect the USB keyboard to one of the two USB ports on the back of your system (see item 3 in the DR4100 
System Rear Chassis Port Locations table).

8. You are now ready to perform initialization using the DR Series system CLI login process. For more information, see 
Logging in and Initializing the DR Series System.

그림 7 . DR4100 System Rear Chassis Port Locations

Item Indicator, Button, or Connector Icon Description

1 iDRAC7 Enterprise port Dedicated management port for the iDRAC7 
Enterprise card (port is available only if an iDRAC7 
Enterprise license is installed on your system).

2 Video connector Connects a VGA display to the system.

3 USB connectors (2) Connects USB devices to the system. The ports are 
USB 2.0-compliant.

4 Ethernet connectors (4) Four integrated 10/100/1000 NIC connectors, or four 
integrated connectors that include:

– Two 10/100/1000 Mbps NIC connectors
– Two 100 Mbps/1 Gbps/10 Gbps SFP+/10-

GbE T connectors

5 PCIe expansion card slots (3) Connect up to three full-height PCI Express 
expansion cards

6 Hard drives (2) Provides two hot-swappable 2.5-inch hard drives

노트: The DR4100 system supports up to six 1–GbE ports or up to two 10–GbE ports. For the 1–GbE ports, these 
are four internal LAN on Motherboard (LOM) ports referenced in item 4 above that reside on the network 
daughter card (NDC), and two additional ports on a PCI Express expansion card referenced in item 5 above. If 
the DR4100 system is using the two 10–GbE ports, these ports reside on the NDC.
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iDRAC Connection

The iDRAC connection requires a network connection between the integrated Dell Remote Access Control (iDRAC) 
management port on the DR Series system and another computer running the iDRAC remote console session in a 
supported browser. The iDRAC provides remote console redirection, power control, and the out-of-band (OOB) system 
management functions for the DR Series system. iDRAC connections are configured using console redirection and the 
iDRAC6/7 web interface. The login values you can use for making iDRAC connections are:

• Default username: root

• Default password: calvin

• Default static IP address: 192.168.0.120

For information on how to configure the iDRAC, see the Dell RACADM Reference Guides at support.dell.com/manuals 
and Accessing iDRAC6/iDRAC7 Using RACADM.

When the Dell DR Series System splash screen is displayed, you are ready to begin initialization using the DR Series 
system CLI login process. For more information, see Logging in and Initializing the DR Series System.

Logging in and Initializing the DR Series System

Use the DR Series system CLI and the Initial System Configuration Wizard to log in to and initialize the system. After 
completing a local console or iDRAC connection, log in to the DR Series system CLI:

1. Launch a terminal emulator application (like PuTTY), and type the default IP address for the DR Series system (if 
you are not using iDRAC or local console).

2. At the login as: prompt, type administrator, and press <Enter>.

3. At the administrator@<system_name> password: prompt, type the default administrator password (St0r@ge!), and 
press <Enter>.
The Initial System Configuration Wizard window is displayed.

그림 8 . Initial System Configuration Wizard Window

4. To configure the network settings, type y (for yes), and press <Enter>.

5. To configure the use of the default IP address that ships with the system, choose to use static IP addressing.
To do this, at the DHCP prompt, type no (this selects static IP addressing), and press <Enter>.

노트: When you select static IP addressing, you are prompted to type the static IP address (for example, you 
could use the default IP, 10.77.88.99) for the system, and press <Enter>. If your network supports the use of 
DHCP, type yes at the DHCP prompt, press <Enter>, and respond to any prompts.

6. To configure a subnet mask address, type the subnet mask address you want to use (for example, you could use 
the default subnet mask address, 255.0.0.0), and press <Enter>.
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7. To configure a default gateway address, type the default gateway address you want to use (for example, 
10.10.20.10), and press <Enter>.

8. To configure a DNS Suffix, type the DNS suffix you want to use (for example, storage.local), and press <Enter>.

9. To configure a primary DNS server IP address, type an IP address you want to use for the primary DNS server (for 
example, 10.10.10.10), and press <Enter>.

10. (Optional) To configure a secondary DNS server IP address, type y (for yes), and press <Enter>.
If you responded yes, type an IP address you want to use for the secondary DNS server (for example, 10.10.10.11), 
and press <Enter>.

11. To change the default host name (for example, the serial number of the DR Series hardware appliance), type y (for 
yes) and press <Enter>.
If you responded yes, type the host name you want to use, and press <Enter>. After you configure your host name 
response, the current system settings are displayed.

12. To accept these settings, type y (for yes), and press <Enter>.

13. If you want to change any of these settings, type n (for no), and press <Enter>. Modify the settings as needed, and 
press <Enter>.
When completed, a successful initialization message is displayed.

14. At the prompt, type exit and press <Enter> to end the DR Series system CLI session.

You are now ready to log in to the system using the DR Series system GUI.

노트: Before you log into the system using the DR Series system GUI, make sure to register it in the local Domain 
Name System (DNS) for your network so that it is a DNS-resolvable entry.

노트: At this point, you could modify the bonding mode to use 802.3ad, if this configuration is available in your 
network.

RACADM을 사용하여 iDRAC6/iDRAC7에 액세스

SSH 기반 또는 Telnet 기반 인터페이스를 통해 RACADM 유틸리티를 사용하여 iDRAC6/iDRAC7에 액세스할 수 있
습니다. RACADM(원격 액세스 컨트롤러 관리)은 Dell의 명령행 유틸리티로서 대역외 관리 기능을 제공하도록 

iDRAC(integrated Dell Remote Access Control) 인터페이스 카드를 설정하고 구성할 수 있습니다.

iDRAC 카드에는 고유한 프로세서, 메모리, 네트워크 연결 및 시스템 버스에 대한 액세스의 컨트롤러가 포함되어 

있습니다. 이를 통해 시스템 또는 네트워크 관리자는 로컬 콘솔에서 지원되는 웹 브라우저 또는 명령행 인터페

이스를 사용하여 전원 관리, 가상 매체 액세스 및 원격 콘솔 기능으로 시스템을 구성할 수 있습니다.

iDRAC 구성에 사용할 수 있는 로그인 값은 다음과 같습니다.

• 기본 사용자 이름: root

• 기본 암호: calvin

• 기본 정적 IP 주소: 192.168.0.120

자세한 내용은 support.dell.com/manuals에서 iDRAC용 RACADM 참조 안내서, iDRAC6(Integrated Dell Remote 
Access Controller 6) 사용 설명서 또는 iDRAC7(Integrated Dell Remote Access Controller 7) 사용 설명서를 참조하십

시오.

Logging in Using a Web Interface
To log in to the DR Series system using a browser-based connection, complete the following:
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노트: This procedure describes the logging in process from a first-time perspective, starting with the Customer 
Registration and Notification page, the completion of the Initial System Configuration Wizard process, and the 
Initial Software Upgrade page.

1. In a supported web browser, type the IP address or hostname of the system in the browser Address bar, and press 
<Enter>.
The DR Series System Login page is displayed.

노트: The DR Series System Login page may display a warning message if the web browser you are using 
does not properly support the DR Series system. If you are running a Microsoft Internet Explorer (IE) 8 or later 
web browser, make sure that you disable the Compatibility View. For more information about disabling the 
Compatibility View settings, see Disabling the Compatibility View Settings. For more information about the 
supported web browsers, see the Dell DR Series System Interoperability Guide, Release 2.0.0.0.

노트: For best results when using IE web browsers in combination with supported Windows-based servers, 
ensure that Active Scripting (JavaScript) is enabled on the Windows client. This setting is often disabled by 
default on Windows-based servers. For more information on enabling Active Scripting, see Enabling Active 
Scripting in Windows IE Browsers.

노트: If you want to reset your login password, click Reset Password on the DR Series System Login page. 
The Reset Password dialog is displayed.

The reset options displayed depend on the password reset option you configured earlier. For more information 
see, Modifying Password Reseting Options.

By default, the service tag option is displayed. In Service Tag, enter the service tag number ID for the system, 
and click Reset Password to reset the system password back to its default setting (or click Cancel to return to 
the DR Series System Login page).

2. In Password, type St0r@ge! and click Log in or press <Enter>.
The Customer Registration and Notification page is displayed. Before you can begin using the DR Series system 
graphical user interface (GUI), you need to properly register the system with Dell. In addition, this page also allows 
you to sign up for notifications about appliance alerts and system software updates. For more information, see 
Registering a DR Series System.

3. In the Settings pane of the Customer Registration and Notification page, complete the following:
a) In Contact Name, enter a system contact name.
b) In Relay Host, enter a hostname or IP address for the relay host.
c) In Email Address, enter an email address for the contact.
d) Select Notify me of DR4000 appliance alerts to be notified about system appliance alerts.
e) Select Notify me of DR4000 software updates to be notified about system software updates.
f) Select Don't show me this again to not display the Customer Registration and Notification page again.
g) Click Confirm to have the DR Series system accept your settings (or click Skip without configuring any settings) 

to proceed with initialization.

The Initial System Configuration Wizard page is displayed.

4. To start the initial system configuration process, click Yes.
The Initial Configuration — Change Administrator Password page is displayed.

노트: If you click No, you will bypass the initial system configuration process, and the DR Series system 
Dashboard page is displayed. However, when you next log in to the DR Series system, you will be prompted to 
perform the initial system configuration process again with the Initial System Configuration Wizard page is 
displayed.

5. In the Settings pane of the Initial Configuration — Change Administrator Password page, complete the following:
a) In Current Password, enter the current administrator password.
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b) In New Password, enter the new administrator password.
c) In Retype New Password, enter the new administrator password again to confirm it.
d) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 

click Exit to close the Initial System Configuration Wizard).
The Initial Configuration — Networking page is displayed.

6. In the Settings pane of the Initial Configuration — Networking page, complete the following:
a) In Hostname, enter a hostname that meets the hostname naming convention: A-Z, a-z, 0–9, the dash special 

character (-), within a maximum 19 character limit.
b) In IP Address, select the Static or DHCP mode of IP addressing, and if planning to use a Secondary DNS, enter 

an IP address for the secondary domain name system.
c) In Bonding, select the Mode choice from the drop-down list (ALB or 802.3ad).

Dell recommends that you verify the system can accept your bonding selection type. The connection will be 
lost unless it is correctly configured. For more information, see Configuring Networking Settings.

d) In Bonding, enter the MTU value for the maximum transmission unit (the MTU accepts values between 512 and 
9000). For more information, see Configuring Networking Settings.

e) In Active Directory, enter a fully qualified domain name for the Active Directory Services (ADS) domain in 
Domain Name (FQDN), enter an organization name in Org Unit, enter a valid ADS username in Username, and 
enter a valid ADS password in Password.
For more information, see Configuring Active Directory Settings.

노트: If an ADS domain has already been configured, you will not be allowed to change the values for the 
Hostname or IP Address settings.

f) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 
click Exit to close the Initial System Configuration Wizard).
The Initial Configuration — Date and Time page is displayed.

노트: If the Microsoft Active Directory Services (ADS) domain has already been configured, the Initial 
Configuration — Date and Time page will not display.

7. In the Settings pane, select the Mode choice (NTP or Manual).
a) If you select NTP, accept or revise the NTP servers as desired (you are limited to only three NTP servers), and 

in Time Zone, select the desired time zone from the drop-down list.
b) If you select Manual, in Time Zone, select the desired time zone from the drop-down list, click the Calendar icon 

and select the desired day in the month, and adjust the Hour and Minute sliders to the desired time (or click 
Now to choose the current date and time), and click Done.

c) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 
click Exit to close the Initial System Configuration Wizard)

For more information, see Configuring System Date and Time Settings.

노트: Dell recommends using NTP when the DR Series system is part of a workgroup and not part of an 
domain. When the DR Series system is joined to a domain, such as the Microsoft Active Directory Services 
(ADS) domain, NTP is disabled.

The Initial Configuration — Summary page is displayed.

8. The Initial Configuration — Summary page displays a summary of all of the initial configuration changes you have 
made. Click Finish to complete the Initial System Configuration Wizard (or click Back to return to a previous page to 
change a setting).
The Initial Software Upgrade page is displayed and prompts you to verify the current installed system software 
version.

9. Click Dashboard in the navigation panel,
The DR Series system main window consists of the following components:

– Navigation panel
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– System Status bar
– System Information pane
– Command bar

노트: Located on the DR Series System Dashboard page command bar, you can display the Help system 
documentation by clicking Help, or logout of the system by clicking Log out.

노트: When logged in, a Logout Confirmation dialog is displayed after 45 minutes of non-use. This dialog displays 
for 30 seconds before the DR Series system performs a forced timeout. Click Continue to reset the 45-minute logout 
timer. If you do not click Continue before the 30-second interval elapses, the DR Series system logs you out. You 
must log in again to resume using the DR Series system features and GUI.

Before managing data using the system navigation panel options, you should understand the options and capabilities 
you can use. The navigation panel contains the following sections that let you manage your data:

• Dashboard
• Storage
• Schedules
• System Configuration
• Support

Registering a DR Series System

Before you can start using the DR Series system using its graphical user interface (GUI) for the first time, you must 
properly register the system with Dell by completing the Customer Registration and Notification page. In addition to 
registering your system, you can also sign up to be notified about appliance alerts and system software updates. The 
Customer Registration and Notification page is displayed when you initially log into a Release 2.0 DR Series system using 
a web interface connection, and it consists of the following text boxes and check boxes in the Settings pane:

• Contact Name
• Relay Host
• Email Address
• Notify me of DR4100 appliance alerts

노트: If this check box is selected, you are notified of all warning and critical severity system alerts, which 
are the types that may require user action. For more information, see Displaying System Alerts.

• Notify me of DR4100 software updates

노트: If this check box is selected, you are notified by Dell about any new system software upgrades or 
maintenance releases. For more information, see Software Upgrade Page and Options.

• Don't show me this again

노트: DR4000 systems that run system software versions earlier than 2.1 that later upgrade to the 2.1 release see 
this screen display when logging into the DR Series system after the upgrade process.

To register a DR Series system:

1. In Contact Name, enter the name of the DR Series system contact.
2. In Relay Host, enter the hostname or IP address for the DR Series system email relay host.
3. In Email Address, enter an email address for the system contact.
4. To be notified about DR4000 appliance alerts, select the Notify me of DR4000 appliance alerts check box.
5. To be notified about DR4000 software updates, select the Notify me of DR4000 software updates check box.
6. To not display the Customer Registration and Notification page again, select the Don't show me this again check 

box.
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7. Click Confirm for the DR Series system to accept your values (or click Skip) to proceed to the Initial System 
Configuration Wizard page.

Windows IE 브라우저에서 액티브 스크립팅 활성화

Microsoft Windows Internet Explorer(IE) 웹 브라우저에서 액티브 스크립팅(JavaScript)을 활성화하려면 다음을 완
료합니다.

노트: 이 절차에서는 액티브 스크립팅(JavaScript)을 활성화하도록 Windows IE 웹 브라우저를 구성하는 방
법에 대해 설명합니다. Windows 기반 서버에서 이 설정이 기본적으로 비활성화되는 경우가 많습니다.

1. IE 웹 브라우저를 실행하고 Tools(도구)→ Internet Options(인터넷 옵션)를 클릭합니다.
Internet Options(인터넷 옵션) 페이지가 표시됩니다.

2. Security(보안) 탭에서 Custom level...(레벨 사용자 지정...)을 클릭합니다.
Security Settings — Local Intranet Zone(보안 설정 - 로컬 인트라넷 영역) 페이지가 표시됩니다.

3. 오른쪽 스크롤 막대를 사용하여 Settings(설정) 항목에서 Scripting(스크립팅)까지 아래로 스크롤합니다.

4. Active scripting(액티브 스크립팅)에서 Enable(활성화)을 클릭합니다.

5. OK(확인)를 클릭하여 웹 브라우저에서 JavaScript 및 액티브 스크립팅 기능을 활성화합니다.
Internet Options(인터넷 옵션) 페이지가 표시됩니다.

6. OK(확인)를 클릭하여 Internet Options(인터넷 옵션) 대화상자를 닫습니다.

호환성 보기 설정 비활성화

로그인하여 DR Series 시스템 그래픽 사용자 인터페이스(GUI)에 액세스하는 데 사용하는 IE 웹 브라우저의 

Compatibility View(호환성 보기) 설정을 비활성화하려면 다음을 수행합니다.

노트: 이 절차에서는 DR Series 시스템에 액세스하는 데 사용하는 여러 가지 버전의 Microsoft Internet 
Explorer(IE) 웹 브라우저가 충돌하지 않도록 Compatibility View(호환성 보기) 설정을 비활성화하는 방법을 설
명합니다. 호환성 보기 설정을 비활성화하려면 Compatibility View Settings(호환성 보기 설정) 페이지의 

Display all websites in Compatibility View(호환성 보기에 모든 웹 사이트 표시) 확인란을 선택 취소하고 이 페
이지의 호환성 보기 목록에 나열된 시스템과 연관된 DR Series 시스템 또는 도메인이 없어야 합니다.

1. IE 웹 브라우저를 실행하고 Tools(도구)→ Compatibility View settings(호환성 보기 설정)를 클릭합니다.
Compatibility View Settings(호환성 보기 설정) 페이지가 표시됩니다.

2. Display all websites in Compatibility View(호환성 보기에 모든 웹 사이트 표시) 확인란 옵션이 선택되어 있으면 
선택 취소합니다.

3. 호환성 보기 목록에 DR Series 시스템이 나열되어 있으면 해당 항목을 선택하고 Remove(제거)를 클릭합니
다.
나열된 다른 DR Series 시스템에 대해 이 단계를 반복합니다.

4. Close(닫기)를 클릭하고 Compatibility View Settings(호환성 보기 설정) 페이지를 종료합니다.

대시보드 페이지 및 옵션

기본적으로, 로그온하면 표시되는 Dashboard(대시보드) 페이지는 다음과 같은 현재 시스템 관련 정보를 보여줍

니다.

• 시스템 상태 

– 시스템 상태

– HW(하드웨어) 상태
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– 경고 수

– 이벤트 수

• 용량

• 스토리지 저장량

• 처리량

• 시스템 정보

노트: Storage Savings(스토리지 저장량) 및 Throughput(처리량)에 나열되는 값을 새로 고치려면 을 클릭

합니다.

노트: DR Series 시스템 탐색 패널에서, Dashboard(대시보드) 섹션은 다음과 같은 메뉴 옵션으로 구성되어 

있으며 옵션을 선택하면 해당 페이지가 표시됩니다.

• Alerts(경고)

• Events(이벤트)

• Health(상태)

• Usage(사용량)

• Statistics: Container(통계: 컨테이너)

• Statistics: Replication(통계: 복제)

자세한 내용은 다음 절을 참조하십시오.

• 대시보드 옵션 이해

• 대시보드 경고 페이지 사용

• 대시보드 이벤트 옵션 사용

• 대시보드 페이지를 사용하여 시스템 상태 모니터링

• 대시보드를 사용하여 시스템 이벤트 표시

대시보드 옵션 이해

DR Series 시스템에 로그인하면 시스템에 대한 최신 정보를 보고 액세스할 수 있는 메커니즘이 제공됩니다. 탐색 

패널(Dashboard(대시보드) 페이지가 기본적으로 표시됨)의 Dashboard(대시보드) 섹션에는 현재 시스템 상태가 

나열되고 다음과 같은 메뉴 옵션이 제공됩니다. 옵션을 선택하면 해당 페이지가 표시됩니다.

• Alerts(경고)

• Events(이벤트)

• Health(상태)

• Usage(사용량)

• Statistics: Container(통계: 컨테이너)

• Statistics: Replication(통계: 복제)

시스템 경고 표시

Alerts(경고) 페이지를 표시하려면 Dashboard(대시보드) → Alerts(경고)를 클릭하거나 Dashboard(대시보드) 페이

지에서 Number of Alerts(경고 수) 링크를 클릭합니다.

Alerts(경고) 페이지에는 현재 시간대(예: 미국/태평양), 경고 수, 시스템 경고 요약 표가 표시됩니다. 이 표에는 색
인 번호, 타임스탬프, 경고에 대해 설명하는 간략한 메시지별로 총 시스템 경고 수가 나열됩니다.

해결되지 않은 위험 이벤트는 시스템 경고가 되며 문제가 해결되면 지워집니다. 자세한 내용은 시스템 경고 모
니터링을 참조하십시오.
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이벤트

DR Series 시스템은 Events(이벤트) 페이지에 현재 시스템 이벤트를 표시하는 두 가지 방법을 제공합니다.

• Dashboard(대시보드)→ Events(이벤트)를 클릭합니다.

• Dashboard(대시보드) 페이지에서 Number of Events(이벤트 수) 링크를 클릭합니다.

Events(이벤트) 페이지는 Event Filter(이벤트 필터) 창을 제공합니다. 이 창에서는 선택한 이벤트 심각도, 시작 및 

종료 날짜 설정값에 따라 특정 검색 기준을 설정할 수 있습니다. 검색 기준을 설정한 후에 Start Filter(필터 시작)
를 클릭하여 값과 일치하는 이벤트를 표시합니다.

일치하는 이벤트가 이벤트 요약 표에 표시됩니다. 이 표에는 정의한 검색 기준과 일치하는 총 시스템 이벤트 수
를 나열하며 다음과 같은 기준에 따라 일치하는 각 시스템 이벤트를 정의합니다.

• 색인 번호

• 이벤트 심각도: 위험, 경고 또는 정보

• 타임스탬프

• 메시지(시스템 이벤트에 대한 간략한 설명)

Events(이벤트) 페이지에서, 다음을 기준으로 특정 시스템 이벤트 유형(또는 기록된 모든 시스템 이벤트)에 대한 

검색 기준을 설정합니다.

• Event Severity(이벤트 심각도)의 풀다운 목록 옵션에서 검색할 이벤트 심각도를 선택합니다(ALL, 
CRITICAL, WARNING, INFO).

• Message Contains(메시지에 포함)의 이벤트 메시지 텍스트에 검색할 단어 또는 문자열을 입력합니다(DR 
Series 시스템은 입력된 항목을 기준으로 대소문자를 구분하지 않고 일치하는 항목을 검색함).

• Timestamp From(타임스탬프 시작)에서, 필드에 시작 시간을 입력하거나 달력 아이콘을 클릭하여 날짜를 
선택하거나, Hour(시간) 및 Minute(분) 슬라이더를 사용하여 시작 시간을 입력하거나 Now(현재)를 클릭하
여 현재 시간을 설정하고 Done(완료)을 클릭합니다.

• Timestamp To(타임스탬프 종료)에서, 필드에 시작 시간을 입력하거나 달력 아이콘을 클릭하여 날짜를 선
택하거나, Hour(시간) 및 Minute(분) 슬라이더를 사용하여 종료 시간을 입력하거나 Now(현재)를 클릭하여 
현재 시간을 설정하고 Done(완료)을 클릭합니다.

• 선택한 기준과 일치하는 모든 검색 결과를 표시하려면 Start Filter(필터 시작)를 클릭하고 모든 검색 설정
을 기본값으로 되돌리려면 Reset(재설정)을 클릭합니다.

위험 수준의 모든 시스템 이벤트는 이벤트 목록에 시스템 내역 레코드로 남아 있게 됩니다. 자세한 내용은 시스

템 이벤트 모니터링 및 이벤트 필터 사용을 참조하십시오.

상태

Health(상태) 페이지를 사용하여 DR Series 시스템, DR4000 및 DR4100의 현재 상태를 표시하고 확인할 수 있습니다

(그림 1 및 2 참조).

Health(상태) 페이지를 표시하려면 Dashboard(대시보드) → Health(상태)를 클릭하거나 Dashboard(대시보드) 페이

지에서 HW State(HW 상태) 링크를 클릭합니다. 이 페이지는 시스템 하드웨어 및 설치된 모든 데이터 스토리지 

확장 선반 인클로저의 현재 상태를 보여줍니다.

지원되는 최대 수의 확장 선반이 설치되어 있을 경우 Health(상태) 페이지에 3개의 탭이 포함됩니다(예: 
System(시스템), Enclosure 1(인클로저 1) 및 Enclosure 2(인클로저 2)). 확장 선반이 설치되어 있지 않으면 1개 탭만 

표시됩니다(System(시스템)).
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상태 페이지: DR4000 시스템

그림 1 상태 페이지(DR4000 시스템 및 구성요소)

상태 페이지: DR4100 시스템

그림 2 상태 페이지(DR4100 시스템 및 구성요소)

기본적으로, System(시스템) 탭이 먼저 표시되고 각 하드웨어 구성요소에 대해 다음과 같은 속성이 나열됩니다.

DR Series 시스템 구성요소

Health(상태) 페이지의 System(시스템) 탭에서, 다음과 같은 이미지 및 시스템 하드웨어 상태 표에 시스템 구성요

소의 상태가 표시됩니다(특정 위치는 그림 1과 2 참조).

• 섀시 전면 모습(이미지) - 0 -11 드라이브 위치 및 상태 표시

• 섀시 후면 모습(이미지) - 전원 공급 장치의 위치와 상태, 후면 패널 커넥터의 위치 표시

• OS 내부 드라이브(이미지) - 운영 체제 내부 드라이브의 상태 표시
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• 시스템 하드웨어 상태(표) - 어플라이언스의 모든 주요 하드웨어 하위 구성요소의 현재 상태 표시

– 전원 공급 장치 - 상태, 이름 및 위치

– 팬 - 상태, 이름, 속도 및 식별자

– 온도 - 상태, 이름 및 온도

– 스토리지 - 스토리지 컨트롤러, 스토리지 가상 디스크, 스토리지 실제 디스크, 스토리지 컨트롤러 
배터리 및 스토리지 캐시

노트: 스토리지 컨트롤러 배터리 상태는 Ready(준비) 또는 Charging(충전 중) 중 하나로 표시
됩니다(Charging(충전 중)은 시스템이 다시 부팅된 후 스토리지 컨트롤러 배터리가 완전히 
충전될 때까지 표시됨).

– 전압 - 상태, 이름, 전압 및 프로브 이름

– NIC(네트워크 인터페이스 카드) - 상태, 이름, 유형 및 속도

– CPU(중앙 처리 장치) - 상태 및 이름

– DIMM(이중 인라인 메모리 모듈) - 상태, 이름 및 커넥터 이름

– NVRAM(비휘발성 임의 액세스 메모리) — NVRAM의 경우 상태, 이름, 오류, 온도, SSD 상태, SSD 
펌웨어 버전, 일련 번호 및 펌웨어 버전, NVRAM 슈퍼 커패시터의 경우 상태, 이름, 전압 및 최대 
설계 전압

노트: 현재 상태, 이름 및 섀시 구성요소의 상태를 표시하려면 스크롤하여 원하는 구성요소에 마우스를 올
려 놓습니다.

모든 시스템 하드웨어 구성요소가 구성요소 이름, 상태 및 기타 특성별로 System Hardware Health(시스템 하드웨

어 상태) 창에 나열됩니다. 다음 표에서는 상태를 반영하는 세 가지 색상 코드 아이콘 중 하나로 구성요소의 현재 

상태를 식별합니다.

아이콘 설명

이 색상 코드 아이콘은 구성요소 상태가 최적의 상태에서 작동 중임을 나타냅니다.

이 색상 코드 아이콘은 구성요소 상태가 경고 상태에서 작동 중임을 나타냅니다(단순 오류

가 감지됨).

이 색상 코드 아이콘은 구성요소 상태가 오류 또는 작동 불가능한 상태에서 작동 중임을 나
타냅니다(중대 오류가 감지됨).

구성요소 카테고리를 확장하여 관련된 각 하위 구성요소의 자세한 상태를 표시하려면 System Hardware 
Health(시스템 하드웨어 상태) 창에서 +("더하기 부호" 아이콘)를 클릭합니다. 확장된 구성요소 카테고리를 축소

하려면 —("빼기 부호" 아이콘)를 클릭하십시오. 자세한 내용은 시스템 상태 모니터링을 참조하십시오.

DR Series 시스템 인클로저 

Health(상태) 페이지의 Enclosure(인클로저) 탭에서, 다음과 같은 이미지 및 시스템 하드웨어 상태 표에 확장 선반 

인클로저 구성요소의 상태가 표시됩니다(특정 위치는 그림 3 참조).

47



그림 3 확장 선반 구성요소

• 섀시 전면 모습(이미지) - 1 -11 드라이브 위치 및 상태 표시, 드라이브 0은 RAID 6 전용 핫 스페어

• 섀시 후면 모습(이미지) - 냉각 팬의 위치와 상태, 후면 패널 커넥터의 위치 표시

• 서비스 태그 - 선택한 확장 선반의 서비스 태그 나열

• 시스템 하드웨어 상태(표) - 확장 선반의 모든 주요 하드웨어 하위 구성요소의 현재 상태 표시

– 전원 공급 장치 - 상태, 이름 및 위치

– 팬 - 상태, 이름, 속도 및 식별자

– 온도 - 상태, 이름 및 온도

– 스토리지 - 스토리지 실제 디스크(상태, 슬롯, 일련 번호, GHS 상태, 스페어 상태, 스마트 경고 및 
크기)

– 인클로저 관리 모듈(상태, 이름, 식별자 및 Nexus ID)

사용량

Usage(사용량) 페이지를 표시하려면 Dashboard(대시보드) → Usage(사용량)를 클릭합니다. Usage(사용량) 페이

지는 옵션, 풀다운 목록, 탭으로 구성되어 있어 DR Series 시스템 사용량 통계를 필터링할 수 있습니다.

• Latest Range(최근 범위) 및 Display last...(다음까지 표시...) - 이 옵션은 선택된 Latest Range(최근 범위) 또는 
Time Range(시간 범위)를 기준으로 시스템 사용량 세부정보를 표시합니다.

• System Usage(시스템 사용량) 탭 - 선택된 Latest Range(최근 범위) 또는 Time Range(시간 범위) 옵션을 기
준으로 시스템 사용량을 표시합니다. CPU Load(CPU 로드), System(시스템), Memory(메모리), Active 
Processes(활성 프로세스), Protocols(프로토콜), Network(네트워크), Disk(디스크), All(모두) 탭으로 구성되
어 있습니다.

노트: All(모두) 탭을 클릭하면 선택한 범위 및 표시 옵션과 구성한 파일 시스템 프로토콜에 의해 정의된 시
스템 사용량이 표시됩니다. 표시된 사용량 카테고리를 모두 보려면 페이지 오른쪽에 있는 스크롤 막대를 

사용하십시오.

Viewing the Latest Range

The Usage page lets you filter the system usage statistics you want to view. To view the Latest Range statistics, 
complete the following:
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노트: The Usage page also displays the Current Time Zone in use for the system.

1. Click the Latest Range option.

2. Select the desired Hours, Days, or Months duration in the Range pull-down list.

3. Enter the desired value in the Display last... drop-down list.
For the Hours duration, enter between 1 and 24 hours; for the Days duration, enter between 1 and 31 days; for the 
Months duration, enter between 1 and 12.

4. Click Apply.

5. To view a specific set of usage statistics, click one of the seven desired tabs, or click All to display the entire set of 
system usage statistical graphs.
The Usage page tabs include:

– CPU Load

– System

– Memory

– Active Processes

– Protocols

– Network

– Disk

– All

If you click All, the following set of statistics are displayed:

• CPU Load

• System Usage

• Memory Usage - Total

• Memory Usage - Real

• Active Processes - Total

• NFS Usage - Total

• CIFS Usage - Total

• OST Usage - Total

• RDS Usage - Total

• Network Usage

• Socket Usage

• Active Connections

• Disk Usage - Meta Data

• Disk Usage - Data Storage

• Meta Data - Storage Capacity

• Local Data - Storage Capacity

For information on viewing specific Time Range statistics on the Usage page, see Viewing a Specific Time Range.

Viewing a Specific Time Range

The Usage page lets you filter the system usage statistics you want to view. To view a specific Time Range, complete 
the following:
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노트: The Usage page also displays the Current Time Zone in use for the system.

1. In the Usage page, select the Time Range option.

2. Type the desired start date in Start Date (or click the calendar icon and make your date selection), or click Now to 
select the current time (or use the Hour and Minute sliders to set a desired time), and click Done.

3. Type the desired end date in End Date (or click the calendar icon and make your date selection), or select the Set 
“End Date” to current time to set the end date to the current day and time, or click Now to select the current time 
(or use the Hour and Minute sliders to set a desired time), click Done, and click Apply.
The Usage page tabs include:

– CPU Load

– System

– Memory

– Active Processes

– Protocols

– Network

– Disk

– All

If you click All, the following set of statistics are displayed:

• CPU Load

• System Usage

• Memory Usage - Total

• Memory Usage - Real

• Active Processes - Total

• NFS Usage - Total

• CIFS Usage - Total

• OST Usage - Total

• RDS Usage - Total

• Network Usage

• Socket Usage - Total

• Active Connections

• Disk Usage - Meta Data

• Disk Usage - Data Storage

• Local Data Storage Capacity

For information on viewing the Latest Range statistics on the Usage page, see Viewing the Latest Range.

System Usage

This Usage page is where the DR Series system usage is displayed based on the Latest Time or Time Range values you 
selected. System usage statistics are grouped and represented by the following tabs:

• CPU Load

• System

• Memory

• Active Processes
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• Protocols
• Network
• Disk
• All

노트: If you click All, this displays system usage defined by the range and display options you select, and the file 
system protocols you have configured. To view all of the displayed usage categories, use the scroll bar on the 
right-hand side of the page.

The All tab displays the entire set of system status categories in graphic screen format (depending upon your file system 
protocol type):

• CPU Load
• System Usage
• Memory Usage - Total
• Memory Usage - Real
• Active Processes - Total
• NFS Usage - Total
• CIFS Usage - Total
• OST Usage - Total
• RDS Usage - Total
• Network Usage
• Socket Usage - Total
• Active Connections
• Disk Usage - Meta Data
• Disk Usage - Data Storage

For more information, see Monitoring System Usage.

Statistics: Container Page

To display the Statistics: Container page, click Dashboard → Statistics: Container . This page lets you select from the 
Container Name drop-down list, and based on the container you select, displays a variety of statistics for the specified 
container:

노트: The DR Series system polls for statistics every 30 seconds.

• Backup Data pane: displays the current number of active files ingested (based on time/minutes) and the current 
number of active bytes (mebibytes/MiB) ingested based on time in minutes. You can choose to click Zoom to 
view the backup data active files and active bytes statistics in other than the default mode of 1h (1–hour). The 
other selectable viewing options are 1d (1–day), 5d (5–day), 1m (1–month), and 1y (1–year).

• Throughput pane: displays the current number of Mebibytes/second (MiB/s) for read operations (based time/
minutes) and the current number of MiB/s for write operations (based on time/minutes). You can choose to click 
Zoom to view the throughput statistics in other than the default mode of 1h (1–hour). The other viewing options 
are 1d (1–day), 5d (5–day), 1m (1–month), and 1y (1–year) that you can select.

노트: To refresh the values listed in the Backup Data and Throughput panes, click .
• Marker Type and Connection Type pane: displays the marker type associated with the selected container (for 

example CommVault, Networker, TSM (Tivoli Storage Manager), NetVault Backup, HP Data Protector, or 
ARCserve, and the Connection Type (NFS, CIFS, RDS, or OST).

• If the selected container includes an NFS connection type, there will be an NFS Connection Configuration pane 
that displays the following categories: NFS Access Path, Client Access, NFS Options, and Map Root To.
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• If the selected container includes a CIFS connection type, there will be a CIFS Connection Configuration pane 
that displays the following categories: CIFS Share Path and Client Access.

• If the selected container includes an OST or RDS connection type, the OST or RDS login entry user is listed (for 
example, backup_user), and there are three tabs: Capacity, Duplication, and Client Statistics. The Capacity tab 
displays a Capacity pane with the following categories: Status, Capacity, Capacity Used, and Total Images. The 
Duplication tab displays a Duplication Statistics pane with the following Inbound and Outbound categories: 
Bytes Copied (logical), Bytes Transferred (actual), Network Bandwidth Savings, Current Count of Active Files, 
and Replication Errors. In addition, this tab also displays a Recent Number of Optimized Copies table, that lists 
the file name, peer IP, peer ID, logical bytes to send, replication rate, savings, and replicated at location. The 
Client Statistics tab displays a Client Statistics pane with the following categories: Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest Errors, 
Bytes Ingested, Bytes Transferred, and Network Savings.

• (Optional) Replication pane: displays the Replication Configuration and Replication Status panes. The 
Replication Configuration pane identifies whether the current container state (Enable or Disable), Role (source 
or target), Remote Container Name, Bandwidth, and the Encryption being used. The Replication Status pane 
identifies the Peer State, Replication State, Replication Average Transfer Rate, Replication Peak Transfer Rate, 
Network Average Transfer Rate, Network Peak Transfer Rate, Network Bytes Sent, Estimated Time to Sync (in 
days, hours, minutes, and seconds), Savings (in percentage), Last Insync Time (in timestamp format), and 
Schedule Status.

노트: The Replication pane is only displayed in the Statistics: Container page if the selected container is 
configured for replication.

백업 데이터 창

Statistics: Container(통계: 컨테이너) 페이지의 Backup Data(백업 데이터) 창에는 다음과 같은 그래프 정보가 표시

됩니다.

• 분 단위 시간을 기반으로 통합된 현재 활성 파일의 수

• 분 단위 시간을 기반으로 통합된 현재 활성 바이트 수(메비바이트/MiB)

활성 파일 및 활성 바이트 그래프에 기본값인 1시간(1h), 1일(1d), 5일(5d), 1개월(1m), 1년(1y) 증분 단위로 정보가 표
시되도록 선택할 수 있습니다.

노트: Backup Data(백업 데이터) 및 Throughput(처리량) 창에 나열된 값을 새로 고치려면 을 클릭합니

다.

처리량 창

Statistics: Container(통계: 컨테이너) 페이지의 Throughput(처리량) 창에는 Container Name(컨테이너 이름) 드롭다

운 목록에서 선택할 수 있는 기존의 모든 컨테이너에 대한 다음과 같은 통계가 표시됩니다.

• 분 단위 시간을 기반으로 읽기 작업에 대한 초당 현재 메비바이트 수(MiB/s)

• 분 단위 시간을 기반으로 쓰기 작업에 대한 MiB/s

노트: Backup Data(백업 데이터) 및 Throughput(처리량) 창에 나열된 값을 새로 고치려면 을 클릭합니

다.

복제 창

Statistics: Container(통계: 컨테이너) 페이지의 Replication(복제) 섹션은 Replication Configuration(복제 구성)과 

Replication Status(복제 상태) 두 개의 창으로 구성되어 있습니다. 이 페이지에 있는 Replication(복제) 섹션은 복제

에 사용할 수 있도록 구성되어 선택된 컨테이너에 대한 복제 통계가 있을 경우에만 표시됩니다.
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복제 구성 창
이 창에는 다음과 같은 필드가 포함되어 있습니다.

• Enable(활성화) - 예: Yes(예) 또는 No(아니오)

• Role(역할) - 예: Source(소스) 또는 Target(대상)

• Remote Container Name(원격 컨테이너 이름) - 예: IP Address(IP 주소) 또는 hostname(호스트 이름)

• Bandwidth(대역폭) - 예: 기본값, KiB/s, MiB/s 및 GiB/s

• Encryption(암호화) - 예: None(없음), AES 128비트 또는 AES 256비트

복제 상태 창
이 창에는 다음과 같은 필드가 포함되어 있습니다.

• Peer State(피어 상태) - 예: 온라인

• Replication State(복제 상태) - 예: 비동기

• Replication Average Transfer Rate(복제 평균 전송 속도) - 예: 1005 KiB/s

• Replication Peak Transfer Rate(복제 피크 전송 속도) - 예: 2253 KiB/s

• Network Average Transfer Rate(네트워크 평균 전송 속도) - 예: 2024 KiB/s

• Network Peak Transfer Rate(네트워크 피크 전송 속도) - 예: 2995 KiB/s

• Network Bytes Sent(전송된 네트워크 바이트 수) - 예: 69.79 KiB

• Estimated Time to Sync(예상 동기화 시간) - 예: 14일 32시간 46분, 33초

• Savings(저장량) - 예: 27.99 %

• Last INSYNC Time(마지막 비동기 시간) - 예: 2012–11–04 16:45:53

• Schedule Status(예약 상태) - 예: 범위 외: 2일, 1시간, 13분, 21초 내에 시작

노트: Replication(복제) 창은 선택된 컨테이너가 복제에 사용되도록 구성된 경우에만 Statistics: Container(통
계: 컨테이너) 페이지에 표시됩니다.

Connection Type Pane

The Connection Type pane is part of the Statistics: Container page, and the information displayed in this pane depends 
upon the connection type of the selected container:

• NFS containers — lists the following NFS connection configuration information:

– NFS Access Path

– Client Access

– NFS Options

– Map Root to

• CIFS containers — lists the following CIFS connection configuration information:

– CIFS Share Path

– Client Access

• OST or RDS containers — lists the following OST or RDS connection configuration information, grouped under 
the following tabs:

– Capacity tab — Status, Capacity, Capacity Used, and Total Images.

– Duplication tab — the Duplication Statistics pane displays both Inbound and Outbound categories with 
the following statistic types: Bytes Copies-logical, Bytes Transferred-actual, Network Bandwidth 
Savings-in percentage, Current Count of Active Files, and Replication Errors. The Recent Number of 
Optimized Copies pane displays a summary table that lists each entry by the following: File Name, Peer 
IP, Peer ID, Logical Bytes to Send, Replication Rate, Savings, and Replicated at categories.
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– Client Statistics tab — contains the Client Statistics pane, which displays Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest 
Errors, Bytes Ingested, Bytes Transferred, and Network Savings (in percentage) statistics.

For more information, see Monitoring Container Statistics.

Duplication Statistics

The Duplication Statistics pane displays duplication statistics (which are also known as file copy statistics) for OST or 
RDS connection type containers. To view these duplication statistics, navigate to the Statistics: Container page, select 
an OST or RDS connection type container in the Container Name list, and select the Duplication tab. The Duplication 
Statistics pane displays the following statistics types:

• Inbound:

– Bytes Copied (logical): displayed in bytes

– Bytes Transferred (actual): displayed in bytes

– Network Bandwidth Savings: (displayed by percentage)

– Current Count of Active Files: displayed in numbers of files

– Replication Errors: displayed in numbers of errors

• Outbound:

– Bytes Copied (logical): displayed in bytes

– Bytes Transferred (actual): displayed in bytes

– Network Bandwidth Savings: (displayed by percentage)

– Current Count of Active Files: displayed in numbers of files

– Replication Errors: displayed in numbers of errors

Recent Number of Optimized Copies

When an OST or RDS container is selected in the Statistics: Container page, you can display the Recent Number of 
Optimized Copies summary table in the Connection Type: OST or Connection Type: RDS pane. This pane, its tabs, and the 
summary table are displayed only when the Duplication tab is selected and an OST or RDS connection type container is 
selected in the Container Name pull-down list.

Recent Number of Optimized Copies Summary Table
This summary table contains the following information about the optimized copies:

• File Name

• Peer IP

• Peer ID

• Logical Bytes to Send

• Replication Rate

• Savings (in percentage)

• Replicated at (in yyyy-mm-dd hh:mm:ss format)

Client Statistics

You can display client statistics in the Statistics: Container page that correspond to any container that is configured as 
an OST or RDS connection type. To display client statistics, click the name of the OST or RDS container in the Container 
Name list, and click the Client Statistics tab in the Connection Type: OST or Connection Type: RDS pane. This action 
displays the following Client Statistics types for the selected OST or RDS container:
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• Images Ingested

• Images Complete

• Images Incomplete

• Images Restored

• Bytes Restored

• Image Restore Errors

• Image Ingest Errors

• Bytes Ingested

• Bytes Transferred

• Network Savings (in percentage)

For more information, see Monitoring Container Statistics.

통계: 복제 페이지

Statistics: Replication(통계: 복제) 페이지를 표시하려면 Dashboard(대시보드) → Statistics: Replication(통계: 복제)
을 클릭합니다. 이 페이지에서는 선택하는 피어 DR Series 시스템 또는 복제 컨테이너에 대한 통계를 보고 모니

터링할 수 있습니다. 다음과 같은 두 개의 주요 창으로 구성되어 있습니다.

• Replication Filter(복제 필터) - Container Filter(컨테이너 필터)를 사용하여 하나 이상의 피어 시스템과 하나, 
여러 개 또는 모든 복제 컨테이너를 선택할 수 있으며 복제 통계 요약 표에 표시할 다양한 통계 유형을 구
성할 수 있습니다. 10개의 Headers(헤더) 확인란 중에서 선택할 수 있습니다. Peer Status(피어 상태), 
Replication Status(복제 상태), Time To Sync(동기화 시간), Progress %(진행률(%)), Replication Throughput(복
제 처리량), Network Throughput(네트워크 처리량), Network Savings(네트워크 저장량), Last Time In Sync(마
지막 동기화 시간), Peer Container(피어 컨테이너), Peer System(피어 시스템)을 선택하여 검색에 사용되는 
복제 통계 유형을 필터링합니다.

• Replication Statistics(복제 통계) - 선택한 피어 시스템 또는 컨테이너의 Replication Filter(복제 필터) 창에서 
복제 통계의 필터링 결과를 표시하는 요약 표가 포함되어 있습니다. 요약 표에는 선택된 확인란을 기준
으로 통계 카테고리가 표시됩니다.

노트: 릴리스 2.0부터 DR Series 시스템 소프트웨어에는 동일한 시스템 소프트웨어 릴리스 버전을 실행하는 

다른 DR Series 시스템 간에서만 복제가 수행되도록 제한하는 버전 확인 기능이 포함됩니다(릴리스 2.0.x 소
프트웨어를 실행하는 DR Series 시스템은 동일한 릴리스 시스템 소프트웨어를 실행하는 다른 DR Series 시
스템에서만 복제할 수 있음). 예를 들어, 릴리스 2.0.x 시스템은 릴리스 2.1 또는 릴리스 3.0 시스템에서 복제

할 수 없지만 릴리스 2.0.0.1 또는 2.0.0.2를 실행하는 시스템에서는 복제할 수 있습니다.

자세한 내용은 복제 통계 모니터링, 복제 통계 표시 및 통계: 복제 페이지 표시를 참조하십시오.

컨테이너 필터

Statistics: Replication(통계: 복제) 페이지의 Replication Filter(복제 필터) 창에는 다음과 같은 구성요소가 포함되어 

있습니다.

• 컨테이너 필터:

– All(모두) - 이 옵션을 선택하면 시스템에 있는 모든 복제 컨테이너를 선택할 수 있습니다.

– Name(이름) - 이 옵션 및 드롭다운 목록을 선택하면 복제 컨테이너를 선택할 수 있습니다.

– Peer System(피어 시스템) - 이 옵션 및 목록 상자를 선택하면 피어 DR Series 시스템을 선택할 수 
있습니다.

• Headers(헤더) - 다음과 같은 확인란을 선택하면 특정 복제 통계 유형을 필터링할 수 있습니다.

– 피어 상태

– 복제 상태
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– 동기화 시간

– 진행률(%)

– 복제 처리량

– 네트워크 처리량

– 네트워크 저장량

– 마지막 동기화 시간

– 피어 컨테이너

– 피어 시스템

노트: DR Series 시스템에서 30초마다 통계를 폴링합니다.

복제 필터 설정을 구성한 후에는 Apply Filter(필터 적용)를 클릭하여 Replication Filter(복제 필터) 요약 표에 필터링

된 복제 통계 세트를 표시합니다. Replication Filter(복제 필터) 요약 표에는 선택한 확인란에 해당하는 복제 통계

가 나열됩니다(기본적으로 피어 상태, 복제 상태, 네트워크 처리량, 네트워크 저장량, 진행률(%) 확인란이 선택

되며 표에 표시됨). 확인란 선택을 다시 설정하려면 Reset(재설정)을 클릭합니다.

노트: 6개 이상의 통계 유형을 선택하는 경우 수직 스크롤 막대를 사용하여 통계의 추가 열을 표시합니다.

자세한 내용은 복제 통계 모니터링을 참조하십시오.

스토리지 페이지 및 옵션

Storage(스토리지) 페이지를 표시하려면 Dashboard(대시보드) → Storage(스토리지)를 클릭합니다. 이 페이지에

는 다음과 같은 창에 시스템 관련 스토리지 정보가 표시됩니다.

노트: DR Series 시스템에서 30초마다 통계를 폴링하여 업데이트합니다.

• Storage Summary(스토리지 요약):

– 컨테이너 수

– 복제된 컨테이너 수

– 모든 컨테이너의 총 파일 수

– 압축 수준

• Capacity(용량):

– 백분율 및 기비비트(GiB) 또는 테비비트(TiB) 단위로 표시되는 시스템의 사용된 실제 용량 및 사용 
가능한 실제 용량입니다.

• Storage Savings(스토리지 저장량):

– 백분율 및 분 단위로 표시되는 총 저장량(중복 제거 및 압축)입니다. 1시간(1h), 1일(1d), 5일(5d), 1개
월(1m), 1년(1y) 단위로 통계를 표시할 수 있습니다. 기본값은 1시간(1h)입니다.

• Throughput(처리량):

– 초당 메비비트(MiB/s) 및 분 단위로 표시되는 읽기 및 쓰기 속도입니다. 1시간(1h), 1일(1d), 5일(5d), 
1개월(1m), 1년(1y) 단위로 통계를 표시할 수 있습니다. 기본값은 1시간(1h)입니다.

• Physical Storage(실제 스토리지):

– 유형: 내부 또는 외부 스토리지(외부는 확장 선반 인클로저)

– 원래 데이터 크기(기가비트 또는 테라바이트로 표시된 스토리지 용량)

– 사용된 비율(%)(사용된 용량의 백분율)

– 서비스 태그(7자리 숫자의 고유한 Dell ID)

– 구성됨(예, 아니오, 추가 또는 검색으로 상태가 표시됨)

56



– 상태(준비, 판독 중, 초기화 중, 재구축 중, 검색되지 않음으로 스토리지 상태가 표시됨)

노트: Storage Savings(스토리지 저장량) 및 Throughput(처리량)에 나열된 값을 새로 고치려면 를 클릭합

니다.확장 선반 인클로저를 새로 고치려면 Physical Storage(실제 스토리지) 요약 표의 Configured(구성됨) 열 

아래에서 Detect(검색)를 클릭합니다. 그러면 다음과 같은 메시지가 포함된 Enclosure Detect(인클로저 검색) 
대화상자가 표시됩니다. If the enclosure is undetected, please wait five minutes and try again. If the enclosure 
still remains undetected after an attempt, keep the enclosure powered On and reboot the appliance(인클로저가 
검색되지 않으면 5분 정도 기다린 후에 다시 시도하십시오. 인클로저가 여전히 검색되지 않으면 인클로저
의 전원을 켜진 상태로 두고 어플라이언스를 다시 부팅하십시오.).

DR Series 시스템 컨테이너 작업에 대한 자세한 내용은 컨테이너 작업 관리를 참조하십시오.

스토리지 옵션 이해

DR Series 시스템은 시스템에 통합된 백업 및 중복 해제된 데이터를 쉽게 액세스할 수 있는 스토리지 컨테이너에 

저장할 수 있는 메커니즘을 제공합니다. DR Series 시스템 그래픽 사용자 인터페이스(GUI)는 시스템 스토리지 프
로세스를 통해 이러한 유형의 데이터를 저장하는 과정을 간소화합니다. 탐색 패널의 Storage(스토리지) 섹션에

서는 다음과 같은 메뉴 옵션을 식별하고 옵션이 선택되면 해당 페이지를 표시합니다.

• 컨테이너

• 복제

• 압축 수준

• 클라이언트

Containers

To display the Containers page, click Storage→ Containers. This page displays the total number of containers (Number 
of Containers) and the container path (Container Path: /containers). This page lets you perform the following tasks using 
its options: Create, Edit, Delete, and Display Statistics. These options let you do the following:

• Create new containers

• Edit existing containers

• Delete existing containers

• Display container, connection, and replication statistics

The Containers page also displays a Containers summary table that displays the following types of container-related 
information:

• Containers — lists containers by name

• Files — lists the number of files in each container

• File type — lists the connection type per container:

– Network File System (NFS)

– Common Internet File System (CIFS)

– Rapid Data Access (RDA)

• Replication status — lists the current replication state per container:

– Not Configured

– Stopped

– Disconnected
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– Trying to Connect

– Online

– N/A

– Marked for Deletion

노트: For newly created OST or RDS containers, the Replication status displays N/A. When replication data has 
been deleted from an existing OST or RDS container, the Replication status also displays N/A. For existing 
containers that are in the process of deleting a large amount of data, the Replication status displays Marked for 
Deletion to indicate that the data deletion process has not yet completed.

노트: Use Select to identify the container on which you want to perform an action. For example, click Select, and 
click Display Statistics to display the Statistics: Container page for the container you selected.

복제 페이지

Replication(복제) 페이지를 표시하려면 Storage(스토리지) → Replication(복제)을 클릭합니다. Replication(복제) 페
이지에는 소스 복제 수, 로컬 및 원격 컨테이너의 이름, 피어 상태, 컨테이너당 선택된 대역폭이 표시됩니다. 
Replication(복제) 페이지에서 다음과 같은 작업을 수행할 수 있습니다.

• 새 복제 관계를 생성하고(소스 및 대상 쌍) 사용할 암호화 유형 선택

• 기존 복제 관계 편집 또는 삭제

• 복제 쌍 간의 복제 시작 또는 중지

• 복제 프로세스의 대역폭(또는 속도 한도) 설정

• 기존 복제 관계의 통계 표시

Replication(복제) 페이지에는 다음과 같은 복제 관련 정보가 나열된 복제 요약 표가 있습니다.

• Local Container Name(로컬 컨테이너 이름) - 로컬 컨테이너 이름(IP 주소 또는 호스트 이름)

• Role(역할) - 복제 프로세스에서 소스 또는 대상

• Remote Container Name(원격 컨테이너 이름) - 원격 컨테이너 이름(IP 주소 또는 호스트 이름)

• Peer State(피어 상태) - 온라인, 오프라인, 일시중지됨 또는 연결 끊김

노트: 복제가 시작되면, 선택한 컨테이너의 상태가 Peer State(피어 상태)에 Online(오프라인)으로 표
시됩니다. 중지되면, 피어 상태가 처음에는 Paused(일시중지됨)로 표시되었다가 Offline(오프라인)으
로 변경됩니다.

• Bandwidth(대역폭) - 초당 키비바이트(KiB/s), 초당 메비바이트(MiB/s), 초당 기비바이트(GiB/s) 또는 기본
값(무제한 대역폭 설정)

노트: Select(선택)를 클릭하여 작업을 수행할 복제 관계를 식별합니다. 예를 들어, Select(선택)→ 
Display Statistics(통계 표시)를 클릭하여 선택한 컨테이너의 Statistics: Replication(통계: 복제) 페이지
를 표시합니다. 자세한 내용은 통계: 복제 페이지를 참조하십시오.

압축 수준

Compression Level(압축 수준) 페이지를 표시하려면 Storage(스토리지) → Compression Level(압축 수준) 을 클릭합

니다. 이 페이지에서는 DR Series 시스템이 백업하고 중복 해제하는 모든 수신 데이터에서 사용할 수 있는 데이

터 압축 수준을 설정하거나 편집할 수 있습니다. 기본 설정에 따라 다음 옵션 중 하나를 사용하여 압축 수준 설정

을 선택합니다.

• Fast(고속) - 백업 시간이 단축되어 더 적은 공간이 사용됩니다(기본 설정).

• Best(최상) - 공간을 최대한 절약할 수 있지만 백업 시간은 더 길어집니다.

자세한 내용은 압축 수준 설정 구성을 참조하십시오.
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Clients

To display the Clients page, click Storage → Clients. This page displays the total number of clients that are connected to 
the DR Series system, which can be a combination of NFS, CIFS, RDS, and OST clients, and this total is listed above the 
three Client tabs (NFS, CIFS, and RDA tabs).

In addition, depending upon the tab type you select, the number of clients for each connection type is displayed. For 
example, in the Clients page, if the RDA tab is selected, this displays the number of current OST or RDA clients that 
correspond to this type (OpenStorage Technology or Rapid Data Storage clients) that are connected to the system, and 
provides the following information client-related information:

• Number of RDA Clients — lists number of OST and RDS clients

• Name — lists each client by name

• Type — lists the type of RDA clients

• Plug-In — lists the plug-in type installed on each client

• Backup Software — lists the backup software used with each client

• Idle Time — lists the idle time (non-activity) for each client

• Connection — lists the number of connections for each client

• Mode — lists the current mode type for each client

To perform one of the possible actions on a client, click Select to identify the client, and then click the desired option (for 
example, the RDA tab provides three options: Update Client, Edit Password, or Download Plug-In. For more information 
about using this page and its tabs, see Clients Page (Using the NFS or CIFS Tab) or Clients Page (Using the RDA Tab).

Clients Page (Using the NFS or CIFS Tab)

To display the Clients page, click Storage→ Clients. This page displays the total number of clients that are connected to 
the DR Series system, and this number reflects all of the clients based listed under the Clients tabs (NFS, CIFS, and RDA). 
Using this page and the NFS or CIFS tab lets you perform the following tasks for NFS or CIFS clients (for information 
about RDA clients, see Clients Page (Using the RDA Tab). The Clients page displays a summary of the NFS (or CIFS) 
clients, and lists the following types of NFS and CIFS client-related information:

• Number of NFS (or CIFS) Clients — lists number of NFS (or CIFS) clients

• Name — lists each client by name

• Idle Time — lists idle time (nonactivity) for each client

• Connection Time — lists connection time for each client

Clients Page (Using the RDA Tab)

To display the Clients page, click Storage→ Clients. This page displays the total number of clients that are connected to 
the DR Series system, and this number reflects all of the clients based listed under the Clients tab (NFS, CIFS, and RDA). 
Using this page and the RDA tab lets you perform the following tasks for RDS or OST clients:

• Update a client (you are limited to modifying the mode type)

• Edit a client password

• Download a client plug-in

노트: The RDA plug-in is installed by default if you are running the latest version of Dell Quest NetVault 
Backup (NVBU). You must download and install the RDA plug-in for NVBU only if there is a plug-in version 
mismatch between the DR Series system software and NVBU.
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This page displays an RDS or OST Clients Summary table that lists the following types of RDs or OST client-related 
information:

• Name — lists client by name

• Type — lists client type

• Plug-In — lists plug-in type that is installed on the client

• Backup Software — lists backup software used with this client

• Idle Time — lists the idle time for this client

• Connection — lists the number of connections for this client

• Mode — lists the mode types that can be set for this client:

– Auto

– Passthrough

– Dedupe (deduplication)

노트: If an OST or RDS client has four or more CPU cores, it is considered to be dedupe-capable. However, 
the OST or RDS client operating mode depends upon how it is configured in the DR Series system (Dedupe 
is the default RDA client mode). If the administrator did not configure an OST or RDS client to operate in a 
specific mode and it is dedupe-capable, it will run in the Dedupe mode. If an OST or RDS client is not 
dedupe-capable (meaning the OST or RDS client has less than four CPU cores), and the administrator sets 
it to run in the Dedupe mode, it will only run in the Passthrough mode. If an OST or RDS client is set to run 
in Auto mode, the OST or RDS client will run in the mode setting determined by the media server. The 
following table shows the relationship between the configured OST or RDS client mode types and the 
supported client mode based on client architecture type and corresponding number of CPU cores.

표 3. Supported OST or RDS Client Modes and Settings

OST or RDS Client 
Mode Settings

32–Bit OST or RDS 
Client (4 or more 
CPU cores)

64–Bit OST or RDS 
Client (4 or more 
CPU cores)

32–Bit OST or RDS 
Client (Less than 4 
CPU cores)

64–Bit OST or RDS 
Client (Less than 4 
CPU cores)

Auto Passthrough Dedupe Passthrough Passthrough

Dedupe Not Supported Supported Not Supported Not Supported

Passthrough Supported Supported Supported Supported

노트: Click Select to identify the OST or RDS client on which you want to perform an action. For example, click 
Select → Download Plug-In to display the Download Plug-Ins page for the client you selected. Select the plug-in 
for the relevant client and protocol.

About the Schedules Page and Options
To display the Schedules page, click Dashboard → Schedules . This page displays any existing Replication or Cleaner 
operations that have been set up for the DR Series system. If no times are listed, this indicates there are no scheduled 
Replication or Cleaner operations. The Replication and Cleaner operations will automatically run whenever the DR 
Series system detects a window of inactivity when there are no other major system operations running.

노트: Replication schedules can only be set on individual replication-enabled source containers.

The Schedules page lets you create a new schedule for running Replication or Cleaner operations, or you can modify an 
existing schedule for either of these operations. For more information about scheduling Replication or Cleaner 
operations, see Creating a Cleaner Schedule and Creating a Replication Schedule.

노트: Cleaner operations are system processes that reclaim disk space from containers where files were deleted. 
When no Cleaner schedule is set, the Cleaner process will run as needed.
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The Schedules page displays the following:

• System Time Zone: using the following format (US/Pacific, Tue May 1 10:33:45 2012)

• Scheduled Replication operations: with day of the week (Sunday through Saturday), start time, and stop time

• Scheduled Cleaner operations: with day of the week (Sunday through Saturday), start time, and stop time

노트: Schedules only control the source container in scheduled Replication operations; the target container is 
passive in these operations.

복제 스케줄 설정

Schedules(스케줄) 페이지에서 복제 스케줄을 설정하려면 다음을 수행합니다.

노트: 복제 스케줄은 개별 복제를 수행할 수 있는 소스 컨테이너에만 설정할 수 있습니다.

노트: 릴리스 2.0부터 DR Series 시스템 소프트웨어에는 동일한 시스템 소프트웨어 릴리스 버전을 실행하는 

다른 DR Series 시스템 간에서만 복제가 수행되도록 제한하는 버전 확인 기능이 포함됩니다(릴리스 2.0.x 소
프트웨어를 실행하는 DR Series 시스템은 동일한 릴리스 시스템 소프트웨어를 실행하는 다른 DR Series 시
스템에서만 복제할 수 있음). 예를 들어, 릴리스 2.0.x 시스템은 릴리스 2.1 또는 릴리스 3.0 시스템에서 복제

할 수 없지만 릴리스 2.0.0.1 또는 2.0.0.2를 실행하는 시스템에서는 복제할 수 있습니다.

1. 옵션 모음에서 Replication(복제)을 클릭합니다. 그러면 Replication Schedule(복제) 페이지가 표시됩니다.
Schedules(스케줄) → Replication Schedule(복제 스케줄)을 클릭하여 Replication Schedule(복제 스케줄) 페이

지를 표시할 수도 있습니다.

2. Container(컨테이너)의 드롭다운 목록에서 복제를 수행할 수 있는 소스 컨테이너를 선택합니다.

3. Schedule(스케줄)을 클릭하여 Set Replication Schedule(복제 스케줄 설정) 창을 표시하고 복제를 예약할 요일
마다 Start Time(시작 시간) 및 Stop Time(중지 시간)을 입력합니다(시 및 분 풀다운 목록 사용).
복제 스케줄에 대한 자세한 내용은 복제 스케줄 생성을 참조하십시오.

노트: Create(생성) 또는 Edit Schedule(스케줄 편집) 옵션이 비활성화(회색으로 표시)되어 있으면 복제 

스케줄을 생성할 복제 수행 가능한 소스 컨테이너가 없는 것입니다. 먼저 복제할 수 있는 소스 컨테이

너를 만들어야 합니다. 자세한 내용은 복제 관계 생성을 참조하십시오.

클리너 스케줄 설정

Schedules(스케줄) 페이지에서 클리너 스케줄을 설정하려면 다음을 수행합니다.

노트: 새 클리너 스케줄 설정 또는 기존 클리너 스케줄 수정에 대한 자세한 내용은 클리너 스케줄 생성을 참
조하십시오.

1. 탐색 패널에서 Schedules(스케줄)→ Cleaner Schedule(클리너 스케줄)을 클릭하거나 Schedules(스케줄) 페이
지에서 Cleaner(클리너)를 클릭하여 Cleaner Schedule(클리너 스케줄) 페이지를 표시합니다.

2. 클리너 스케줄이 없는 경우 Schedule(스케줄)을 클릭하여 Set Cleaner Schedule(클리너 스케줄 설정) 창을 표
시하고 시 및 분 풀다운 목록을 사용하여 예약할 요일마다 Start Time(시작 시간) 및 Stop Time(중지 시간)을 
입력합니다.
수정할 기존 클리너 스케줄이 있는 경우 Edit Schedule(스케줄 편집)을 클릭하고 변경을 수행하십시오.

About the System Configuration Page and Options
To display the System Configuration page, click Dashboard → System Configuration . The System Configuration page 
displays the current DR Series system configuration information in the following panes:

• Networking
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• Active Directory

• Local Workgroup Users

• Email Alerts

• Password

• Admin Contact Info

• Email Relay Host

• Date and Time

노트: Each pane title in the System Configuration page serves as a link. To display the corresponding page that 
provides more detailed information and the related options you can use, click the pane title link. For example, to 
display the Date and Time page, click the Date and Time pane title link.

The System Configuration page provides three options that let you:

• Edit the current system password

• Shut down the system

• Reboot the system

The System Configuration page provides the means for managing configuration settings for the Networking, Active 
Directory, Local Workgroup Users, Email Alerts, Admin Contact Info, Email Relay Host, and Date and Time pages in the 
system.

노트: For example, to manage the date and time configuration settings, click Date and Time to display the Date and 
Time page. You can then add or edit the following date and settings: Mode, Time Zone, and Date and Time. If the 
DR Series system is part of a workgroup and not joined to a Microsoft Active Directory Services (ADS) domain, you 
will also be able to add or edit the Network Time Protocol (NTP) servers associated with the system. However, 
when the DR Series system is joined to a domain, the NTP Servers setting on the Date and Time page is disabled 
and is not displayed.

노트: Dell recommends using NTP servers when the DR Series system will be running as part of a workgroup and 
not joined to a domain. The use of NTP servers as a reference time source is disabled when the DR Series system 
is joined to a domain.

System Configuration Page and Options

To display the System Configuration page, click Dashboard → System Configuration . This page displays the following 
pane title-enabled links that allow you to display more detailed system configuration information for the following 
categories:

• Networking

• Active Directory

• Local Workgroup Users

• Email Alerts

• Password

• Admin Contact Info

• Email Relay Host

• Date and Time
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Networking
The Networking pane displays the currently configured Mode, Hostname, IP Address, Bonding, Domain Suffix, and 
Primary DNS settings for the DR Series system. The Networking pane title acts as a link to the Networking page:

• This page lists the Hostname, IP Address, DNS, Bonding, and installed NICs. The Networking page provides Edit 
Hostname, Edit IP Address, Edit DNS, Edit Bonding, and Edit MTU options.

• This page also displays the interfaces showing bonds and other Ethernet connections.

Active Directory
The Active Directory pane displays the current status of the Domain Name for the DR Series system (not configured or 
listing the configured domain name). The Active Directory pane title acts as a link to the Active Directory page:

• This page contains a Settings and a CIFS Container Share Path pane. The Settings pane lists the configuration 
status, and lists the FQDN domain name (Fully Qualified Domain Name) of the Microsoft Active Directory 
Services (ADS) domain. The CIFS Container Share Path pane lists the current CIFS container share path 
locations. The Active Directory page provides the Join and Leave options.

Local Workgroup Users
The Local Workgroup Users pane displays the current configured local workgroup users (CIFS) for the DR Series 
system. The Local Workgroup Users pane title acts as a link to the Local Workgroup Users (CIFS) page:

• This page lists the configured local CIFS users by user name that belongs to the local workgroup in the DR 
Series system. The Local Workgroup Users (CIFS) page provides the Create, Edit, and Delete options (by which 
you manage the users that belong to this local workgroup. To edit or delete an existing local workgroup user, 
click Select to identify the local user you wish to modify or delete.

Email Alerts
The Email Alerts pane displays the current number of email notification recipients configured for the DR Series system. 
The Email Alerts pane title acts as a link to the Email Alerts page:

• This page lists all currently configured recipient email addresses. The Email Alerts page provides Add, Edit, 
Delete, and Send Test Message options. To create an email recipient, click Add to display the Add Recipient 
Email Address dialog, in Email Address enter a valid email address for your email system, and click Submit. To 
edit or delete an existing email recipient, click Select to identify the email recipient in which you wish to modify, 
delete, or send a test message.

Admin Contact Info
The Admin Contact Info pane displays the current information associated with the administrator configured for the DR 
Series system. The current information is contained in the Contact Information and Notification panes. The Contact 
Information pan includes the Contact Information, Company Name, Email, Work Phone, and Comments categories. The 
Notification pane displays the status of the DR Series system appliance alerts and system software updates (disabled or 
enabled). The Admin Contact Info pane title acts as a link to the Administrator Contact Information page:

• This page contains contact information for the DR Series system administrator and is sent with all system alert 
email messages. The Administrator Contact Information page provides the Add Contact Information option 
(which after you configure it, this option changes to Edit Contact Information). Click the Edit Contact Information 
option to display the Edit Administrator Contact Information dialog where you can enter information or select a 
check box:

– Administrator Name

– Company Name

– Email

– Work Phone
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– Comments

– Notify me of DR4000 appliance alerts

– Notify me of DR4000 software updates

Password
The Password Management pane displays the current Reset Password Option set for the system. The Reset Password 
Option can be:

• Service Tag Only

• Service Tag and Administrator Email

노트: To select the option Service Tag and Administrator Email, you must first configure the e-mail relay 
host and administrator contact e-mail.

In the Password Management pane you can edit the current password and edit the password reset options.

Email Relay Host
The Email Relay Host pane displays the current email relay host configured for the DR Series system. The Email Relay 
Host pane title acts as a link to the Email Relay Host page:

• This page lists the configured email relay host by its IP address or hostname that is responsible for email in the 
DR Series system. The Email Relay Host page provides the Add Relay Host option (which after you configure it, 
this option changes to Edit Relay Host).

Date and Time
The Date and Time pane displays the current Mode configured for the DR Series system (Manual or NTP), the current 
Time Zone, and the current Date and Time (in mm/dd/yy hh:mm:ss format, for example: 12/11/12 14:58:22 PST). The Date 
and Time pane title acts as a link to the Date and Time page:

• This page contains a Settings pane that lists the Mode used. The system uses Network Time Protocol (NTP) 
servers if the system is part of a workgroup and not joined to an Active Directory Services (ADS) domain. If the 
system is joined to an ADS domain, then the NTP servers setting is disabled and the system uses the ADS 
domain time. The Settings pane also displays the current Time Zone, and current Date and Time. The Date and 
Time page provides the Edit option for changing the date and time settings.

노트: Dell recommends using the Network Time Protocol (NTP) servers when the DR Series system is part of a 
workgroup and not part of a domain. The NTP time mode is disabled when the DR Series system is joined to an 
Active Directory Services (ADS) domain. Any attempt to enable the NTP time mode when you are joined to an ADS 
domain displays an error message indicating this is not possible.

Understanding the System Configuration Page Options

The System Configuration page contains three key system options:

• Password Management

• Shutdown

• Reboot

Edit Password
Edit Password—click this option to display the Edit Password dialog, where you can change the login password for the 
DR Series system

노트: To change CIFS login credentials, you can use the DR Series system CLI command, authenticate –set –user . 
For details, see the Dell DR Series System Command Line Reference Guide.
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노트: Editing your existing login password is different than resetting your login password. Click Edit Password in 
the System Configuration page to edit your login password to reflect any value that meets the system password 
requirements (for more information, see Modifying the System Password. Click Reset Password in the Login page 
to reset your login password to the system default value, which requires you to provide the service tag for your 
system. For more information, see Resetting the Default System Password.

Shutdown
Shutdown—click this option to display the Shutdown System dialog, where you can shut down the DR Series system.

주의: Shutdown powers Off the appliance on which the system software is installed. Once in a powered Off state, 
you can power it On at its physical location or using an iDRAC configuration to the system.

Reboot
Reboot—click this option to display the Reboot System dialog, where you can reboot the DR Series system.

지원 페이지 및 옵션

Dashboard(대시보드) → Support(지원)를 클릭하여 Support(지원) 페이지를 표시합니다. Support(지원) 페이지는 

Support Information(지원 정보) 창에 시스템에 대한 현재 지원 관련 정보를 표시합니다.

노트: 표시되는 이더넷 목록(MAC 및 속도)의 정확한 수는 시스템에 설치된 이더넷 포트의 수와 유형에 따라 

다릅니다. 예를 들어 DR4000 시스템은 최대 4개의 1–GbE 포트 또는 최대 2개의 10–GbE 포트를 지원할 수 있
고, DR4100 시스템은 최대 6개의 1–GbE 포트(NDC(Network Daughter Card)에 내부 1–GbE 포트 4개, PCI Express 
확장 카드에 1–GbE 포트 2개) 또는 2개의 10–GbE 포트를 지원할 수 있습니다. 다음 예는 4개의 포트(eth0부터 

eth3)를 보여줍니다.

• 제품 이름

• 소프트웨어 버전

• 서비스 태그

• 마지막 진단 실행

• BIOS 버전

• MAC 주소

• iDRAC IP 주소

• eth0 MAC

• eth0 속도 

• eth1 MAC

• eth1 속도

• eth2 MAC

• eth2 속도

• eth3 MAC

• eth3 속도

또한 이 페이지는 DR Series 시스템의 지원, 업그레이드 및 추가 스토리지 라이센스에 사용할 수 있는 옵션 

Diagnostic(진단), Software Upgrade(소프트웨어 업그레이드) 및 License(라이센스)를 제공합니다. 자세한 내용은 
지원 페이지 옵션 이해를 참조하십시오.
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지원 페이지 옵션 이해

탐색 패널에 표시되는 Support(지원) 페이지는 3개의 중요한 옵션인 Diagnostics(진단), Software Upgrade(소프트

웨어 업그레이드) 및 License(라이센스)를 제공합니다. 이 세 옵션을 사용하여 다음과 같은 작업을 수행할 수 있
습니다.

• 진단 로그 파일 생성, 다운로드 또는 삭제

• 최신 버전의 DR Series 시스템 소프트웨어 업그레이드

• 추가된 모든 데이터 스토리지 확장 선반의 라이센스 파일 설치

진단

진단 - 이 옵션을 클릭하면 Diagnostics(진단) 페이지가 표시됩니다. 이 페이지에는 파일 이름, 크기, 시간 및 진단 

로그 번들이 생성된 날짜, 진단 로그 번들이 생성된 이유, 상태별로 진단 항목 수가 나열됩니다. Diagnostics(진단) 
페이지는 Generate(생성), Download(다운로드) 및 Delete(삭제) 옵션을 제공합니다.

로그 파일의 진단 번들은 관리자가 DR Series 시스템 작업을 수행하는 동안 발생된 문제로 감지되었거나 관리자

가 보고한 시스템 상태를 Dell 지원팀에서 진단하는 데 사용됩니다.

노트: Select(선택)를 클릭하여 작업을 수행할 진단 로그 파일을 식별합니다. 예를 들어, Select(선택) → 

Download(다운로드)를 클릭하여 다운로드할 진단 로그 파일의 File Download(파일 다운로드) 대화상자를 표
시합니다.

노트: 진단 번들은 관리자 생성 및 자동 생성 두 가지 모드에서 생성될 수 있습니다. 자동 생성에서는, 프로

세스 또는 서비스에 장애가 발생할 경우 DR Series 시스템이 백그라운드 작업으로 시스템 관련 정보를 수집

하기 시작합니다. 수집이 완료되면 DR Series 시스템이 시스템 이벤트를 생성합니다. 관리자의 요청이 없음

에도 진단 번들이 자주 생성될 경우에는 Dell 지원팀에 도움을 요청해야 합니다.

Diagnostics(진단) 페이지 및 Diagnostics(진단) 서비스에 대한 자세한 내용은 진단 페이지 및 옵션 및 진단 서비스 

정보를 참조하십시오.

소프트웨어 업그레이드

소프트웨어 업그레이드 - 이 옵션을 클릭하면 Software Upgrade(소프트웨어 업그레이드) 페이지가 표시됩니다. 
이 페이지에는 Upgrade File Location(업그레이드 파일 위치) 및 Software Information(소프트웨어 정보) 창이 있습

니다. Software Upgrade(소프트웨어 업그레이드) 페이지를 사용하면 소프트웨어 업그레이드 파일을 탐색하여 찾
을 수 있습니다. 이 파일을 찾으면 Start Upgrade(업그레이드 시작)를 클릭하여 업그레이드 프로세스를 시작하거

나 DR Series 시스템의 현재 버전과 업그레이드 내역을 확인합니다. Start Upgrade(업그레이드 시작) 페이지는 

Reboot(재부팅) 옵션을 제공합니다.

노트: DR Series 시스템의 소프트웨어 업그레이드를 준비할 때, 소프트웨어 업그레이드 파일을 다운로드해

야 하며 DR Series 시스템 GUI를 실행하는 시스템에서 로컬로 이 파일에 액세스할 수 있어야 합니다.

시스템 소프트웨어 업그레이드에 대한 자세한 내용은 소프트웨어 업그레이드 페이지 및 옵션을 참조하십시오.

라이센스

라이센스 - 이 옵션을 클릭하면 License(라이센스) 페이지가 표시됩니다. 이 페이지에는 License File Location(라이

센스 파일 위치) 및 Number of Installed Licenses(설치된 라이센스 수) 두 개의 창이 있습니다. License(라이센스) 페
이지에서는 설치된 데이터 스토리지 확장 선반에 해당하는 라이센스 파일을 찾을 수 있습니다.

License File Location(라이센스 파일 위치) 창에서, 확장 선반 라이센스 파일을 다운로드한 로컬 디스크의 위치 또
는 알려진 네트워크 위치(일반적으로 /store/license)를 입력하거나 Browse...(찾아보기...)를 클릭하여 라이센스 파
일(license.xml)이 있는 다른 디렉터리/폴더 경로 위치를 탐색합니다. 파일 위치를 찾은 후에는 Install License(라이

센스 설치)를 클릭하여 설치된 데이터 스토리지 확장 선반의 라이센스 파일을 설치하고 유효성을 검사합니다.

라이센스 파일을 설치하고 유효성을 검사한 후에는 License(라이센스) 페이지에 License file has been successfully 
installed(라이센스 파일 설치 완료) 대화상자가 표시되며, 설치된 라이센스 수 요약 표가 방금 설치한 새 라이센
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스 파일로 업데이트됩니다. Number of Installed Licenses(설치된 라이센스 수) 창에는 ID, 설명, 권한 ID 및 현재 상
태별로 식별된 설치된 라이센스가 나열됩니다.

지원되는 데이터 스토리지 확장 선반 또는 확장 선반에 필요한 라이센스에 대한 자세한 내용은 확장 선반 라이

센스 및 확장 선반 설치를 참조하십시오.

Expansion Shelf Licenses
This topic introduces the license required for adding external data storage in the form of Dell MD1200 storage arrays 
that are referred to as expansion shelf enclosures. Expansion shelf enclosures allow you to add supplemental data 
storage capacity to support DR Series system operations. The DR Series system supports up to maximum of two 
enclosures per system, and any expansion shelf enclosure that is added must be equal to or greater than each DR 
Series system internal drive slot capacity (0–11). Expansion shelf enclosures can be added to the internal data storage 
to create up to 9, 18, or 27 Terabyte (TB) hard drive capacities, and expansion shelf enclosures can be added in 1 TB, 2 
TB, or 3 TB capacities. Licenses define the expansion shelf enclosure size in a license = size format (for example, shelf = 
18TB), and licenses are added on a per-shelf basis.
표 4. Expansion Shelf Capacities in the DR Series System

System/Expansion Shelf Enclosure Size Maximum Data Storage Capacity Options

600 Gigabyte (GB) expansion shelf • 9 TB
• 18 TB
• 27 TB

1 TB expansion shelf • 9 TB
• 18 TB
• 27 TB

2 TB expansion shelf • 18 TB
• 27 TB

3 TB expansion • 27 TB

Licenses
Adding an expansion shelf enclosure requires that you order a license for each enclosure from a Dell Account 
representative at the time that you order the DR Series system. You can also order this at a later date when you want to 
add additional external storage to your base DR Series system. To obtain the license, you can download it from the 
support.dell.com/ website using your service tag or use an email link from your Dell Account representative.

If you already have a Dell MD1200 storage array, the order process supports licensing for existing hardware that you 
want to add to a base DR Series system. Each license supports one expansion shelf enclosure, and the system supports 
up to two enclosures using the DR Series system service tag. Because the licenses are tied to the system service tag, if 
the internal drives are moved to another system chassis, this would require a new license. For more information about 
the expansion shelf enclosures, see “DR Series Expansion Shelf” in DR Series System and Data Operations.

노트: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition 
of expansion shelf enclosures to add external storage to the base system.

확장 선반 라이센스 추가

확장 선반의 라이센스의 위치를 찾은 후에 라이센스를 설치하고 유효성을 검사해야 합니다.

DR Series 시스템의 확장 선반 라이센스를 설치하려면 다음을 수행합니다.
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노트: 300 GB 드라이브 용량(2.7 TB) 버전의 DR Series 시스템은 확장 선반 인클로저 추가가 지원되지 않습니

다.

1. 탐색 패널에서 Support(지원) → License(라이센스)를 선택하거나 License(라이센스)를 두 번 클릭합니다.
License File Location(라이센스 파일 위치) 및 Number of Installed Licenses(설치된 라이센스 수) 창이 있는 

License(라이센스) 페이지가 표시됩니다.

2. License File Location(라이센스 파일 위치) 창에서, 라이센스 파일이 있는 경로를 입력하거나(일반적으로 /
store/license) Browse...(찾아보기...)를 클릭하여 라이센스 파일 위치를 탐색합니다.

3. Install License(라이센스 설치)를 클릭하고 모든 프롬프트를 따릅니다.
작업에 성공하면 License has been successfully installed(라이센스 파일 설치 완료) 대화상자가 표시되며, 새 

라이센스가 Number of Installed Licenses(설치된 라이센스 수) 창에 나타납니다. Number of Installed 
Licenses(설치된 라이센스 수) 창에는 설치된 총 라이센스 수가 나열되며 설치된 각 라이센스는 라이센스의 

ID, 간략한 설명, 권한 ID(라이센스 태그) 및 상태별로 정의됩니다.
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4
Configuring the DR Series System Settings
This topic introduces the concept that before you can run any DR Series system operations, you first need to understand 
the following key tasks:

• How to initialize the system

• How to shut down or reboot the system

• How to manage the system password

Initializing the DR Series system requires that you configure and manage a number of very important system settings.

노트: Dell recommends that you use the Initial System Configuration Wizard to configure your DR Series system. 
Changing some of the system settings using the DR Series system GUI (such as bonding, MTU, hostname, IP 
address, and DNS) can cause issues that may affect your DR Series system GUI access.

For more information about initializing the system, see Initializing the DR Series System.

For more information about shutting down or rebooting the system, see Shutting Down the DR Series System and 
Rebooting the DR Series System.

For more information about managing the system password, see Managing the DR Series System Password.

Configuring Networking Settings
You can configure the networking settings that were configured using the Initial System Configuration Wizard process 
for the DR Series system in the following tabs:

노트: For the Ethernet port settings on the NICs, this example only shows Eth0 and Eth1 (depending upon your 
system configuration, you could have NICs configured with Ethernet port settings in the Eth0–Eth5 range). The 
DR4000 system supports up to four 1–GbE ports or up to two 10–GbE ports, while the DR4100 system supports up to 
six 1–GbE or up to two 10–GbE ports. For more information, see Local Console Connection.

• Hostname

– Hostname (FQDN)

– iDRAC IP Address

• DNS 

– Domain Suffix

– Primary DNS

– Secondary DNS

• Interfaces

– Device

– Mode

– MAC Address

– MTU (maximum transmission unit)

– Bonding Option
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– Slave Interfaces

• Eth0

– MAC

– Maximum Speed

– Speed

– Duplex

• Eth1

– MAC

– Maximum Speed

– Speed

– Duplex

To configure new networking settings (or to change from those set using the Initial System Configuration Wizard), 
complete the following:

1. Select System Configuration → Networking.
The Networking page is displayed. Select settings for hostname, IP Address, DNS, Bonding, or to view the Ethernet 
port settings (Eth0-Eth3) for the DR Series system.

– To configure hostname, skip to step 2.

– To configure IP addressing, skip to step 5.

– To configure DNS, skip to step 10.
2. To change the current Hostname, select the Hostname tab and click Edit Hostname on the options bar.

The Edit Hostname dialog is displayed.

3. Type a hostname in Hostname that meets the following supported character types and length:

– Alphabetic—allows A-Z, a-z, or a combination of upper and lower case alphabetic characters.

– Numeric—allows numerals zero (0) through 9.

– Special characters—allows only the dash (-) character.

– Length limit—hostnames cannot exceed the maximum length of 19 characters.
4. Click Submit to set the new hostname for your system.

5. To change the current IP address settings for the selecte NIC bond or Ehternet port, select the Interfaces tab and 
click Edit Interfaces on the options bar.
The Edit Interface — <bond or Ethernet port number> dialog is displayed.

6. Under IP Address, in Mode, select Static (to set static IP addressing for your system), or select DHCP (to set 
dynamic IP addressing for your system).

노트: To select the DHCP mode of IP addressing, select DHCP, and click Submit. The remaining substeps in 
this step only need to be completed if you selected the Static mode of IP addressing for the DR Series system.

a) In New IP Address, type an IP address that represents the new IP address for your system.
b) In Netmask, type an netmask address value that represents your system (the system IP address and netmask 

identify the network to which your system belongs).
c) In Gateway, type an IP address for the gateway associated with your system.

7. Under MTU, in MTU, enter the value you want to set as the maximum.

노트: Ensure that the value that you enter in MTU is the same for the clients, Ethernet Switch, and the 
appliance. The connection between the clients, the Ethernet switches, and the appliance will break if the 
MTU number is not the same on all the components.
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노트: In computer networking, jumbo frames are Ethernet frames with more than 1500 bytes of payload (but in 
some cases, jumbo frames can carry up to 9000 bytes of payload). Many Gigabit Ethernet switches and 
Gigabit Ethernet network interface cards support jumbo frames. Some Fast Ethernet switches and Fast 
Ethernet network interface cards also support jumbo frames.

Some computer manufacturers use 9000 bytes as the conventional limit for jumbo frame sizes. To support jumbo 
frames used in an Internet Protocol subnetwork, both the host DR Series system (initiator or source) and the target 
DR Series system have to be configured for 9000 MTU.

Consequently, interfaces using a standard frame size and those using the jumbo frame size should not be in the 
same subnet. To reduce the chance of interoperability issues, network interface cards capable of supporting jumbo 
frames require specific configurations to use jumbo frames.

To verify that the destination system can support a specific frame size, use the DR Series system CLI command 
network --ping --destination <IP address> --size <number of bytes>.

For more information, contact Dell Support for assistance (for details, see Contacting Dell).

노트: Make sure that if you are using any Dell network switches that you take full advantage of the latest 
switch firmware upgrades and application notes. The application notes provide procedures that assist you in 
performing switch firmware upgrades and saving configuration files (for complete details, see 
support.dell.com/ and navigate to Drivers and Downloads for your system type).

노트: When setting or changing the MTU value, make sure that you verify that the Ethernet network switch is 
capable of supporting an MTU size that is equal to or larger than the value you are setting. Any mismatch in 
MTU values between the clients, Ethernet network switch, and the DR Series system appliance will make it 
inoperable.

Dell suggests that you observe standard best practices when deploying jumbo frames in networks, and 
recommends using jumbo frames with the DR Series system because this frame size typically provides the best 
performance. However, for networks that do not support jumbo frames, the DR Series system also supports using 
the standard frame size.

8. Under Bonding, from the Bonding configuration list, select the appropriate bonding configuration.

노트: You may lose the connection to the system if you change the bonding configuration. Change the 
bonding configuration only if the system accepts the new bonding type.

– TLB — configures transmit load balancing.

– ALB—configures adaptive load balancing (ALB), which is the default setting.

노트: ALB load balancing does not balance the load properly when your backup servers are on a 
remote subnet. This is because ALB uses the address resolution protocol (ARP) and ARP updates are 
subnet-specific. Because this is the case, ARP broadcasts and updates are not sent across the 
router. Instead, all traffic is sent to the first interface in the bond. To resolve this ARP-specific issue, 
make sure that your data source systems reside on the same subnet as the DR Series system.

– 802.3ad—configures dynamic link aggregation using the IEEE 802.ad standard.

주의: If you change the existing bonding setting, the connection to the DR Series system may be lost 
unless you are sure that the system can accept this bonding type.

9. Click Submit to have the DR Series system accept the new values (or click Cancel to display the Networking page).
The Updated IP Address dialog is displayed when the selection is successful (if you change the static IP address 
manually, you need to use this IP address in the browser when you log back into the DR Series system).

10. To configure DNS settings for your system, select the DNS tab and click Edit DNS on the options bar.
The Edit DNS dialog is displayed.

11. In Domain Suffix, type a domain suffix to use.
For example, acme.local. This is a required field.
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12. In Primary DNS, type an IP address that represents the primary DNS server for your system; this is a required field.

13. For Secondary DNS, type an IP address that represents the secondary DNS server for your system; this is an 
optional field.

14. Click Submit to have the DR Series system accept the new values (or click Cancel to display the Networking page).
The Updated DNS dialog is displayed when the selection is successful.

Networking Page and Ethernet Port Values

The Networking page displays the currently configured multiple Ethernet ports for the DR Series system in a series of 
panes. For 1–Gigabit Ethernet (GbE) ports in the DR4000 system this could be Eth0, Eth1, Eth2, and Eth3, and in the 
DR4100 system this could be Eth0, Eth1, Eth2, Eth3, Eth4, and Eth5. For 10-GbE/10-GbE SFP+ NICs, this means that the two 
ports are bonded together into a single interface. For example, the DR Series system port configuration is as follows:

• In a 1-GbE NIC configuration: the DR4000 system supports up to four 1–GbE ports, which consists of up to two 
internal LAN on Motherboard (LOM) ports and two ports on an expansion card that are bonded together. The 
DR4100 system supports up to six 1–GbE ports, which consists of up to four internal LOM ports on the network 
daughter card (NDC) and two ports on a PCI Express expansion card.

• In a 10-GbE or 10-GbE SFP+NIC configuration: the DR4000 system supports up to two 10–GbE or 10–GbE SFP+ 
ports on an expansion card that are bonded together. The DR4100 system supports up to two 10-GbE or 10-GbE 
SFP+ ports that reside on the NDC that are bonded together.

노트: For more information on advanced networking options see the Command Line Interface Guide available at 
dell.com/support/manuals.

The ports for bonded NICs display: MAC address, port speed in megabtyes per second (MB/s), maximum speed, and 
duplex setting. The following example shows Ethernet port values for the four ports in a 1-GbE NIC bonded configuration 
on a DR4000 system:

Eth0:

• MAC: 00:30:59:9A:00:96

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth1:

• MAC: 00:30:59:9A:00:97

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth2:

• MAC: 00:30:59:9A:00:98

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth3:

• MAC: 00:30:59:9A:00:99

• Speed: 1000Mb/s
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• Max Speed: 1000baseT/Full

• Duplex: Full

DR Series 시스템 암호 관리

DR Series 시스템에 로그인할 때 사용되는 로그인 암호를 다음 두 가지 방법으로 관리할 수 있습니다.

• System Configuration(시스템 구성) 페이지에서 Edit Password(암호 편집) 옵션을 사용하여 기존 로그인 암
호를 수정합니다. 자세한 내용은 시스템 암호 수정을 참조하십시오.

• DR Series System Login(DR Series 시스템 로그인) 페이지에서 Reset Password(암호 재설정) 옵션을 사용하
여 로그인 암호를 기본값으로 재설정합니다. 자세한 내용은 기본 시스템 암호 재설정을 참조하십시오.

Modifying the System Password

To configure a new password or to modify an existing password for logging in to the DR Series system, complete the 
following:

1. To change the system password, do one of the following:.

– In the navigation panel, select System Configuration, the System Configuration page is displayed. Click 
Password Management.

– In the navigation panel, select System Configuration → Password, the Password Management page is 
displayed.

2. Click Edit Password.
The Edit Password dialog is displayed.

3. In Current password, type the current password for the system.

4. In New password, type the new system password.

5. In Confirm password, retype the new password to confirm this as the new password replacing the existing system 
password.

6. Click Change Password (or click Cancel to display the System Configuration page).
If successful, a Password change was successful dialog is displayed.

Resetting the Default System Password

To reset the system to use the default password (St0r@ge! ) for logging in, complete the following:

1. In the Login window, click Reset Password.
The Reset Password dialog is displayed.

If the password reset option is set to Service Tag, proceed to step 2.

If the password reset option is set to Service Tag and Administrator Email, proceed to step 4.

2. In Service Tag, type the Service Tag associated with your system, and click Reset Password.

노트: If you are unsure of the Service Tag associated with your DR Series system, it can be found on the 
Support page (click Support in the navigation panel to display the Support Information pane, which displays 
the Service Tag).

The Login window is displayed, and a Password has been reset dialog is displayed.

3. To log in using the default password, type St0r@ge! , and click Login.

노트: After you have reset the login password to its default and logged in to the DR Series system, Dell 
recommends for security reasons that you create a new unique login password.
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4. In Service Tag, type the Service Tag associated with your system.

노트: If you are unsure of the Service Tag associated with your DR Series system, it can be found on the 
Support page (click Support in the navigation panel to display the Support Information pane, which displays 
the Service Tag).

5. In Administrator Email enter the email address of the administrator of this system.
The Administrator Email that you enter must match the administrator email address configured in the DR Series 
system. If you have set security questions, the security questions are displayed.

6. Enter the answers to the configured security questions in Answer 1 and Answer 2.

7. Click Send Now.
An email with a unique code, used to reset the password, is sent only to the configured administrator email 
address. The code is valid for only 15 minutes. The password rest code expires after 15 minutes and cannot be 
used. You must repeat the password reset procedure to regenerate the code again.

DR Series 시스템 종료

필요할 경우 System Configuration(시스템 구성) 페이지에서 Shutdown(종료)을 클릭하여 DR Series 시스템을 종료

할 수 있습니다. 하지만 시스템을 종료하기 전에 이 동작이 시스템 작업에 어떠한 영향을 주는지 파악해야 합니

다.

주의: DR Series 시스템 소프트웨어가 설치된 어플라이언스의 전원을 끕니다. 전원이 꺼지면 어플라이언스

의 실제 위치에서만 전원을 다시 켤 수 있습니다. 또는 DR Series 시스템에 iDRAC 연결을 사용해야 합니다.

DR Series 시스템을 종료하려면 다음을 수행합니다.

1. 탐색 패널에서 System Configuration(시스템 구성)을 선택합니다.
System Configuration(시스템 구성) 페이지가 표시됩니다.

2. System Configuration(시스템 구성) 페이지 옵션 모음에서 Shutdown(종료)을 클릭합니다.
Shutdown confirmation(종료 확인) 대화상자가 표시됩니다.

3. Shutdown System(시스템 종료)을 클릭하여 시스템 종료를 계속 진행하거나 Cancel(취소)을 클릭하여 System 
Configuration(시스템 구성) 페이지로 돌아갑니다.

DR Series 시스템 재부팅

필요한 경우, System Configuration(시스템 구성) 페이지에서 Reboot(재부팅) 옵션을 선택하여 DR Series 시스템을 

다시 부팅할 수 있습니다. 시스템을 다시 부팅하려면 다음을 수행합니다.

1. 탐색 패널에서 System Configuration(시스템 구성)을 선택합니다.
System Configuration(시스템 구성) 페이지가 표시됩니다.

2. System Configuration(시스템 구성) 페이지 옵션 모음에서 Reboot(재부팅)를 클릭합니다.
Reboot System(시스템 재부팅) 확인 대화상자가 표시됩니다.

3. Reboot System(시스템 재부팅)을 클릭하여 시스템 재부팅을 계속 진행하거나 Cancel(취소)을 클릭하여 
System Configuration(시스템 구성) 페이지로 돌아갑니다.
재부팅한 후 System has successfully rebooted(시스템 재부팅 완료) 대화상자가 표시됩니다. 시스템 재부팅

을 완료하는 데 최대 10분이 소요됩니다.

압축 수준 설정 구성

DR Series 시스템이 백업하고 중복 해제하는 모든 수신 데이터에 사용할 데이터 압축을 구성할 수 있습니다.
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노트: 이 설정은 시스템의 전역 압축 수준입니다. 압축 수준 설정을 변경한 후에는 새로운 수신 데이터(새 

설정을 사용하여 작성된 데이터)에만 변경이 적용됩니다. 시스템에 있는 기존의 모든 데이터는 통합되었을 

때의 설정이 적용된 상태로 남아 있게 됩니다(새 압축 수준 설정을 사용하여 다시 작성되지 않음).

다음 항목을 선택하여 Compression Level(압축 수준) 페이지에서 압축 수준 설정을 구성합니다.

• Fast(고속) - (기본값) 이 옵션을 선택하면 Best(최상) 옵션을 선택했을 때보다 시스템 백업이 빠르게 수행
됩니다. 하지만 공간 저장량이 감소됩니다.

• Best(최상) - 이 옵션을 선택하면 시스템 백업 시에 전반적으로 최상의 공간 저장량을 확보할 수 있습니
다. 하지만 백업 프로세스를 완료하는 데 시간이 더 걸립니다.

시스템의 압축 수준 설정을 구성하려면 다음을 수행합니다.

1. Storage(스토리지) → Compression Level(압축 수준)을 선택합니다.
Compression Level(압축 수준) 페이지가 표시됩니다.

2. Compression Level(압축 수준) 설정을 구성하려면 옵션 모음에서 Edit(편집)를 클릭합니다.
Compression Level Settings(압축 수준 설정) 대화상자가 표시됩니다.

3. Compression Level(압축 수준) 목록에서 모든 수신 데이터에 사용할 압축 수준 유형인 Fast(고속) 또는 Best(최
상) 중 하나를 선택합니다.

4. Set Compression Level(압축 수준 설정)을 클릭하여 이 설정을 통해 시스템을 구성하거나 Cancel(취소)을 클
릭하여 Compression Level(압축 수준) 페이지를 표시합니다.
선택을 완료하면 Updated Compression(업데이트된 압축) 대화상자가 표시됩니다.

노트: 시스템에 구성하는 압축 수준 설정은 전역 설정입니다. 압축 수준 설정을 변경하면 새 설정을 사
용하여 작성되는 새 수신 데이터에만 변경이 적용됩니다. 시스템에 있는 기존의 모든 데이터는 통합되

었을 때의 이전 설정 상태로 남아 있게 됩니다(새 압축 수준 설정을 사용하여 다시 작성되지 않음). 새 

수신 데이터에 체크섬이 수행되므로 압축 설정을 변경해도 시스템의 스토리지 용량에는 악영향을 주
지 않습니다.

Active Directory 설정 구성

DR Series 시스템이 Microsoft ADS(Active Directory Services)가 포함된 도메인에 가입하거나 탈퇴하도록 하려면 

Active Directory 설정을 구성해야 합니다. ADS 도메인에 가입하려면 다음 절차의 1-4단계를 완료하고 ADS 도메

인에서 탈퇴하려면 5단계로 건너뜁니다. DR Series 시스템을 ADS 도메인에 가입하면 NTP(Network Time Protocol) 
서비스가 비활성화되며 도메인 기반 시간 서비스가 대신 사용됩니다.

ADS를 사용하여 도메인에 대한 DR Series 시스템을 구성하려면 다음을 수행합니다.

1. System Configuration(시스템 구성) → Active Directory를 선택합니다.
Active Directory 페이지가 표시됩니다.

노트: ADS 설정을 아직 구성하지 않은 경우 정보 메시지가 Active Directory 페이지의 Settings(설정) 창
에 표시됩니다.

2. 옵션 모음에서 Join(가입)을 클릭합니다.
Active Directory Configuration(Active Directory 구성) 대화상자가 표시됩니다.

3. Active Directory Configuration(Active Directory 구성) 대화상자에 다음 값을 입력합니다.

– Domain Name (FQDN)(도메인 이름(FQDN))에서, ADS의 정규화된 도메인 이름(예: AD12.acme.com)을 
입력합니다. 이 필드는 필수입니다.

노트: 지원되는 도메인 이름은 최대 64자이며 A-Z, a-z, 0-9, 3개의 특수 문자 대시(-), 마침표(.), 밑
줄(_)을 조합하여 사용할 수 있습니다.

– Username(사용자 이름)에서, ADS의 사용자 이름 지침에 맞는 유효한 사용자 이름을 입력합니다. 이 
필드는 필수입니다.
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노트: 지원되는 사용자 이름은 최대 64자이며 A-Z, a-z, 0-9, 3개의 특수 문자 대시(-), 마침표(.), 밑
줄(_)을 조합하여 사용할 수 있습니다.

– Password(암호)에서, ADS의 암호 지침에 맞는 유효한 암호를 입력합니다. 이 필드는 필수입니다.
– Org Unit(조직 단위)에서, ADS의 조직 이름 지침에 맞는 유효한 조직 이름을 입력합니다. 이 필드는 

필수입니다.

4. Join Domain(도메인 가입)을 클릭하여 이러한 ADS 설정으로 시스템을 구성하거나 Cancel(취소)을 클릭하여 
Active Directory 페이지를 표시합니다.
성공하면 Successfully Configured(구성 완료) 대화상자가 표시됩니다.

노트: CIFS 컨테이너 공유 경로를 구성한 경우 Active Directory 페이지의 CIFS Container Share Path(CIFS 
컨테이너 공유 경로) 창에 표시됩니다.

5. ADS 도메인에서 탈퇴하려면 Active Directory 페이지에서 Leave(탈퇴)를 클릭합니다.
Active Directory Configuration(Active Directory 구성) 대화상자가 표시됩니다.

6. 구성된 ADS 도메인에서 탈퇴하려면 다음을 입력해야 합니다.
a) Username(사용자 이름)에서, ADS 도메인에 유효한 사용자 이름을 입력합니다.
b) Password(암호)에서, ADS 도메인에 유효한 암호를 입력합니다.

7. Leave Domain(도메인 탈퇴)을 클릭하여 DR Series 시스템이 ADS 도메인에서 탈퇴하도록 하거나 Cancel(취
소)을 클릭하여 Active Directory 페이지를 표시합니다.
성공하면 Successfully Configured(구성 완료) 대화상자가 표시됩니다.

로컬 작업 그룹 사용자 설정 구성

CIFS 인증된 사용자의 로컬 작업 그룹을 생성하도록 설정을 구성해야 합니다. 이 기능을 사용하면 작업 그룹에 

사용자를 새로 추가하거나 기존 사용자를 편집 또는 삭제할 수 있는 로컬 작업 그룹(로컬 작업 그룹 사용자)을 생
성할 수 있습니다.

로컬 작업 그룹 사용자를 위해 DR Series 시스템을 구성하려면 다음을 수행합니다.

1. System Configuration(시스템 구성) → Local Workgroup Users(로컬 작업 그룹 사용자)를 선택합니다.
Local Workgroup Users (CIFS)(로컬 작업 그룹 사용자(CIFS)) 페이지가 표시됩니다.

2. 사용자의 로컬 작업 그룹에 새 CIFS 사용자를 생성하려면 옵션 모음에서 Create(생성)를 클릭합니다.
Create a local workgroup user for CIFS authentication(CIFS 인증을 위한 로컬 작업 그룹 사용자 생성) 대화상자

가 표시됩니다.

a) User Name(사용자 이름)에 이 사용자의 유효한 사용자 이름을 입력합니다.
b) Password(암호)에 이 사용자의 유효한 암호를 입력합니다.
c) Add CIFS User(CIFS 사용자 추가)를 클릭하여 시스템의 로컬 작업 그룹 사용자에 새 사용자를 생성하거

나 Cancel(취소)을 클릭하여 Local Workgroup Users (CIFS)(로컬 작업 그룹 사용자(CIFS)) 페이지로 돌아갑
니다.

작업에 성공하면 Added CIFS user(CIFS 사용자 추가됨) 확인 대화상자가 표시됩니다.

3. 이 로컬 작업 그룹 사용자에서 기존 CIFS 사용자를 편집하려면 Select(선택)를 클릭하여 로컬 작업 그룹 사용
자 요약 표에서 수정할 사용자를 식별하고 옵션 모음에서 Edit(편집)를 클릭합니다.
Edit a local workgroup user for CIFS authentication(CIFS 인증을 위한 로컬 작업 그룹 사용자 편집) 대화상자가 

표시됩니다.

a) Password(암호)에 이 사용자의 유효한 다른 암호를 입력합니다.
이 사용자의 사용자 이름은 수정할 수 없으며 암호만 수정할 수 있습니다. 사용자에게 다른 사용자 이름

을 지정하려면 사용자를 삭제한 다음 원하는 사용자 이름으로 새 사용자를 생성해야 합니다.
b) Edit CIFS User(CIFS 사용자 편집)를 클릭하여 시스템의 로컬 작업 그룹 사용자에서 기존 사용자의 암호를 

수정하거나 Cancel(취소)을 클릭하여 Local Workgroup Users (CIFS)(로컬 작업 그룹 사용자(CIFS)) 페이지
로 돌아갑니다.
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4. 이 로컬 작업 그룹 사용자에서 기존 CIFS 사용자를 삭제하려면 Select(선택)를 클릭하여 로컬 작업 그룹 사용
자 요약 표에서 삭제할 사용자를 식별하고 옵션 모음에서 Delete(삭제)를 클릭합니다.
Delete user(사용자 삭제) 확인 대화상자가 표시됩니다.

a) OK(확인)를 클릭하여 로컬 작업 그룹 사용자 요약 표에서 선택한 사용자를 삭제하거나 Cancel(취소)을 
클릭하여 Local Workgroup Users (CIFS)(로컬 작업 그룹 사용자(CIFS)) 페이지로 돌아갑니다.

작업에 성공하면 Deleted CIFS user(CIFS 사용자 삭제됨) 확인 대화상자가 표시됩니다.

이메일 경고 설정 구성

DR Series 시스템 이메일 경고를 보낼 사용자의 받는 사람 이메일 주소를 생성하고 관리할 수 있습니다. Email 
Alerts(이메일 경고) 페이지에는 받는 사람 이메일 주소를 새로 추가하거나 Recipient Email Address(받는 사람 이
메일 주소) 창에 나열된 기존의 받는 사람 이메일 주소를 편집 또는 삭제하거나 텍스트 메시지를 보낼 수 있는 옵
션이 있습니다.

노트: Email Alerts(이메일 경고) 페이지에는 받는 사람 이메일 주소를 관리하고 메시지 보내기 기능을 테스

트할 수 있는 모든 옵션이 있습니다.

받는 사람 이메일 주소 추가

받는 사람 이메일 주소를 새로 구성하거나 추가하려면 다음을 수행합니다.

1. System Configuration(시스템 구성) → Email Alerts(이메일 경고)를 선택합니다.
Email Alerts(이메일 경고) 페이지가 표시됩니다.

2. 옵션 모음에서 Add(추가)를 클릭합니다.
Add Recipient Email Address(받는 사람 이메일 주소 추가) 대화상자가 표시됩니다.

3. Email Address(이메일 주소)에 이메일 시스템에서 지원하는 주소 형식으로 유효한 이메일 주소를 입력합니
다.

4. Submit(제출)를 클릭하여 받는 사람 이메일 주소를 구성하거나 Cancel(취소)을 클릭하여 Email Alerts(이메일 
경고) 페이지를 표시합니다.
Email Alerts(이메일 경고) 페이지가 표시되고 완료되면 Added email recipient(이메일 받는 사람 추가됨) 대화

상자가 표시됩니다.

5. 추가적인 받는 사람 이메일 주소를 만들려면 2단계에서 4단계를 반복합니다.

노트: 이메일 경고 메시지를 보내서 하나 이상의 이메일 받는 사람을 테스트하는 방법에 대해서는 테스트 

메시지 보내기를 참조하십시오.

Editing or Deleting a Recipient Email Address

To edit or delete an existing recipient email address:

1. Select System Configuration→ Email Alerts.
The Email Alerts page is displayed.

노트: To edit or delete an existing recipient email address, you must first click Select in the Recipient Email 
Address pane to indicate the address that you want to edit or delete. To edit an existing email address, 
proceed to step 2, or to delete an existing email address, skip to step 4. For more information about adding 
email recipients, see Adding a Recipient Email Address.

2. To edit an existing recipient email address, click Select to indicate the recipient email address entry that you want 
to change, and click Edit on the options bar.
The Edit Recipient Email Address dialog is displayed.
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3. Modify the existing email address you selected as needed, and click Submit.
The Email Alerts page is displayed, and a Successfully updated email recipient dialog is displayed when 
successful. To edit additional recipient email addresses, repeat steps 2 and 3.

4. To delete an existing recipient email address, click Select to indicate the recipient email address entry that you 
want to delete, and click Delete on the options bar.
The Delete Confirmation dialog is displayed.

5. Click OK to delete the selected email recipient address (or click Cancel to display the Email Alerts page).
The Email Alerts page is displayed, and a Deleted email recipient dialog is displayed when successful. To delete 
additional recipient email addresses, repeat steps 4 and 5.

테스트 메시지 보내기

DR Series 시스템은 구성된 모든 받는 사람 이메일 주소에 테스트 메시지를 보내는 방법을 제공합니다. 이 과정

에서 시스템 경고 메시지 보내기를 관리할 수 있으며 이러한 메시지를 수신하도록 구성된 모든 이메일 받는 사
람을 확인할 수 있습니다.

노트: 필요한 경우, 구성된 이메일 릴레이 호스트가 있는지 확인합니다. 이메일 릴레이 호스트에 대한 자세

한 내용은 이메일 릴레이 호스트 추가를 참조하십시오.

1. System Configuration(시스템 구성)→ Email Alerts(이메일 경고)를 선택합니다.
Email Alerts(이메일 경고) 페이지가 표시됩니다.

2. 옵션 모음에서 Send Test Message(테스트 메시지 보내기)를 클릭합니다.
Send Test Email(테스트 이메일 보내기) 확인 대화상자가 표시됩니다.

3. OK(확인)를 클릭하거나 Cancel(취소)을 클릭하여 Email Alerts(이메일 알림) 페이지를 표시합니다.
Email Alerts(이메일 알림) 페이지가 표시되고 완료되면 Successfully sent email(이메일 전송 완료) 대화상자가 

표시됩니다.

4. 모든 받는 사람 이메일 주소가 테스트 이메일을 수신했는지 확인합니다.

관리자 연락처 정보 구성

DR Series 시스템을 관리자처럼 적극적으로 관리하거나 담당하는 사람을 식별하기 위해 관리자 연락처 정보를 

구성할 수 있습니다. 이렇게 하려면 Edit Contact Information(연락처 정보 편집) 옵션을 사용하여 Administrator 
Contact Information(관리자 연락처 정보) 페이지에 관리자의 연락처 정보를 입력하십시오.

Dashboard(대시보드) 페이지의 탐색 패널에서 System Configuration(시스템 구성) → Admin Contact Info(관리자 연
락처 정보)를 클릭하여 Administrator Contact Information 페이지를 표시합니다.

관리자 연락처 정보에 대한 자세한 내용은 관리자 연락처 정보 편집 및 관리자 연락처 정보 추가를 참조하십시

오.

다음과 같은 정보 카테고리가 Administrator Contact Information(관리자 연락처 정보) 페이지의 Contact 
Information(연락처 정보) 및 Notification(알림) 페이지에 표시됩니다. 이 정보는 모든 시스템 경고 이메일과 함께 

전송됩니다.

• 연락처 정보

– 관리자 이름

– 회사 이름

– 이메일

– 회사 전화번호

– 설명
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• 알림

– Notify me of DR4000 appliance alerts(DR4000 어플라이언스 경고 알림) 확인란 상태(활성화됨 또는 
비활성화됨)

– Notify me of DR4000 software updates(DR4000 소프트웨어 업데이트 알림) 확인란 상태(활성화됨 또
는 비활성화됨)

관리자 연락처 정보 추가

시스템 관리자의 연락처 정보를 구성하려면 다음을 수행합니다.

1. System Configuration(시스템 구성) → Admin Contact Info(관리자 연락처 정보)를 선택합니다.
Administrator Contact Information(관리자 연락처 정보) 페이지가 표시됩니다.

2. 옵션 모음에서 Add Contact Information(연락처 정보 추가)을 클릭합니다.
Add Administrator Contact Information(관리자 연락처 정보 추가) 대화상자가 표시됩니다.

3. Administrator Name(관리자 이름)에 이 어플라이언스의 관리자 이름을 입력합니다.

4. Company Name(회사 이름)에 관리자와 연관된 회사 이름을 입력합니다.

5. Email(이메일)에 이메일 시스템에서 지원하는 이메일 주소 형식을 사용하여 관리자의 이메일 주소를 입력
합니다.

6. Work Phone(회사 전화번호)에 관리자의 전화번호를 입력합니다.

7. Comments(설명)에 이 관리자를 고유하게 식별하는 몇 가지 정보를 입력하거나 설명을 추가합니다.

8. 시스템 경고에 대한 알림을 받으려면 Notify me of DR 4000 appliance alerts(DR 4000 어플라이언스 경고 알림) 
확인란을 클릭합니다.

9. 시스템 소프트웨어 업데이트에 대한 알림을 받으려면 Notify me of DR 4000 software updates(DR 4000 소프트
웨어 업데이트 알림) 확인란을 클릭합니다.

10. Submit(제출)를 클릭하거나 Cancel(취소)을 클릭하여 Administrator Contact Information(관리자 연락처 정보) 
페이지를 표시합니다.
Administrator Contact Information(관리자 연락처 정보) 페이지가 표시되고 작업에 성공하면 Updated 
administrator contact information(관리자 연락처 정보 업데이트됨) 대화상자가 표시됩니다.

관리자 연락처 정보 편집

기존 시스템 관리자의 연락처 정보를 편집하려면 다음을 수행합니다.

1. System Configuration(시스템 구성)→ Admin Contact Info(관리자 연락처 정보)를 선택합니다.
Administrator Contact Information(관리자 연락처 정보) 페이지가 표시됩니다.

2. 옵션 모음에서 Edit Contact Info(연락처 정보 편집)를 클릭합니다.
Edit Administrator Contact Information(관리자 연락처 정보 편집) 대화상자가 표시됩니다.

3. 해당 정보 필드에서 필요에 따라 관리자 연락처 정보를 수정합니다.

4. Notify me of DR Series appliance alerts(DR Series 어플라이언스 경고 알림) 확인란을 선택하여 이 옵션을 선택
하거나 선택되어 있으면 클릭하여 선택 취소합니다.

5. Notify me of DR Series software updates(DR Series 소프트웨어 업데이트 알림) 확인란을 선택하여 이 옵션을 
선택하거나 선택되어 있으면 클릭하여 선택 취소합니다.

6. Submit(제출)를 클릭하거나 Cancel(취소)을 클릭하여 Administrator Contact Information(관리자 연락처 정보) 
페이지를 표시합니다.
Administrator Contact Information(관리자 연락처 정보) 페이지가 표시되고 작업에 성공하면 Updated 
administrator contact information(관리자 연락처 정보 업데이트됨) 대화상자가 표시됩니다.
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Managing Passwords
You can edit the system password and system password reset configuration on this page.

Modifying the System Password

To configure a new password or to modify an existing password for logging in to the DR Series system, complete the 
following:

1. To change the system password, do one of the following:.

– In the navigation panel, select System Configuration, the System Configuration page is displayed. Click 
Password Management.

– In the navigation panel, select System Configuration → Password, the Password Management page is 
displayed.

2. Click Edit Password.
The Edit Password dialog is displayed.

3. In Current password, type the current password for the system.

4. In New password, type the new system password.

5. In Confirm password, retype the new password to confirm this as the new password replacing the existing system 
password.

6. Click Change Password (or click Cancel to display the System Configuration page).
If successful, a Password change was successful dialog is displayed.

Modifying Password Reset Options

To modify the password reset options:

1. Select System Configuration → Password.
The Password Management page is displayed.

2. Click Edit Password Reset Options.
The Edit Password Reset Options dialog is displayed.

3. To use service tag only, select Service Tag Only and click Submit.

노트: To select the option Service Tag and Administrator Email, you must first configure the e-mail relay host 
and administrator contact e-mail.

4. To use the service tag and administrator e-mail, select Service Tag and Administrator Email.
The optional security questions area is displayed.

5. To set the optional security questions, under Optional Security Question 1 and Optional Security Question 2 in 
Question enter the security question.

6. In Answer , enter the answer to your security question.

노트: Save the answer in a secure location, you will need these answers to reset the DR Series system 
password.

7. Click Submit.
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이메일 릴레이 호스트 구성

네트워크 이메일 시스템에서 필요할 경우 외부 이메일 릴레이 호스트를 DR Series 시스템에 사용할 수 있도록 구
성할 수 있습니다. 이메일 릴레이 호스트는 일반적으로 DR Series 시스템에서 지정된 각 받는 사람 이메일 주소

로 이메일 경고를 전달하는 외부 메일 서버입니다.

이렇게 하려면 Email Relay Host(이메일 릴레이 호스트) 페이지의 옵션 모음에서 Add Relay Host(릴레이 호스트 추
가)를 클릭하여 새 이메일 릴레이 호스트를 정의합니다(또는 Edit Relay Host(릴레이 호스트 편집)를 클릭하여 기
존 이메일 릴레이 호스트 편집). 기존 이메일 릴레이 호스트 편집에 대한 자세한 내용은 이메일 릴레이 호스트 편
집을 참조하십시오.

이메일 릴레이 호스트 추가

DR Series 시스템의 새 이메일 릴레이 호스트를 구성하려면 다음을 수행합니다.

노트: 기존 이메일 릴레이 호스트를 편집하려면 이메일 릴레이 호스트 편집을 참조하십시오.

1. System Configuration(시스템 구성) → Email Relay Host(이메일 릴레이 호스트)를 선택합니다.
Email Relay Host(이메일 릴레이 호스트) 페이지가 표시됩니다.

2. 옵션 모음에서 Add Relay Host(릴레이 호스트 추가)를 클릭합니다.
Add Relay Host(릴레이 호스트 추가) 대화상자가 표시됩니다.

3. Relay Host(릴레이 호스트)에 DR Series 시스템의 이메일 릴레이 호스트 역할을 할 외부 메일 서버의 호스트 
이름이나 IP 주소를 입력합니다.

4. Submit(제출)를 클릭하거나 Cancel(취소)을 클릭하여 Email Alerts(이메일 경고) 페이지를 표시합니다.
Email Alerts(이메일 경고) 페이지가 표시되고 완료되면 Updated external email server information(외부 이메일 

서버 정보 업데이트됨) 대화상자가 표시됩니다.

5. 테스트 메시지를 보내서 이메일 릴레이 호스트가 올바르게 작동되는지 확인합니다.
자세한 내용은 테스트 메시지 보내기를 참조하십시오.

6. 모든 받는 사람 이메일 주소가 테스트 이메일을 수신했는지 확인합니다.

이메일 릴레이 호스트 편집

DR Series 시스템의 기존 이메일 릴레이 호스트를 편집하려면 다음을 수행합니다.

1. System Configuration(시스템 구성)→ Email Relay Host(이메일 릴레이 호스트)를 선택합니다.
Email Relay Host(이메일 릴레이 호스트) 페이지가 표시됩니다.

2. 옵션 모음에서 Edit Relay Host(릴레이 호스트 편집)를 클릭합니다.
Edit Relay Host(릴레이 호스트 편집) 대화상자가 표시됩니다.

3. Relay Host(릴레이 호스트)에서, 필요에 따라 외부 메일 서버의 이메일 릴레이 호스트 이름이나 IP 주소를 수
정합니다.

4. Submit(제출)를 클릭하거나 Cancel(취소)을 클릭하여 Email Alerts(이메일 경고) 페이지를 표시합니다.
Email Alerts(이메일 경고) 페이지가 표시되고 완료되면 Updated external email server information(외부 이메일 

서버 정보 업데이트됨) 대화상자가 표시됩니다.

시스템 날짜 및 시간 설정 구성

도메인에서 실행 중인 다른 DR Series 시스템 또는 클라이언트와 동기화하기 위해 시스템에 사용되는 날짜 및 시
간 설정을 구성하거나 관리해야 할 경우 Date and Time(날짜 및 시간) 페이지를 탐색하여 Edit(편집)를 클릭합니
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다. Date and Time(날짜 및 시간) 페이지에는 다음과 같은 날짜 및 시간 관련 설정이 포함된 Settings(설정) 창이 포
함됩니다(초기 시스템 시작 시에 다음과 같은 날짜 및 시간 설정이 기본값으로 설정되어 있음).

• Mode(모드) - 수동 및 NTP(Network Time Protocol) 중 하나를 선택합니다.

노트: DR Series 시스템이 작업 그룹에는 속하지만 도메인에 속하지 않을 경우에는 NTP를 사용하는 
것이 좋습니다. DR Series 시스템이 Microsoft ADS(Active Directory Services)와 같은 도메인에 가입되
어 있는 경우 NTP가 비활성화되며 DR Series 시스템에서 도메인 시간을 사용합니다.

• Time Zone(시간대) - NTP 모드에서, GMT(그리니치 표준시)를 기반으로 시간대 옵션 목록에서 선택합니다
(예: GMT-8:00, 태평양 표준시 (미국과 캐나다)).

• NTP Servers(NTP 서버) - NTP 모드를 사용할 경우, NTP 서버의 인터넷 프로토콜을 선택합니다(최대 3개의 
NTP 서버를 정의할 수 있음). Settings(설정) 창에 이 설정이 표시되지 않으면 해당 모드가 ADS(Active 
Directory Services) 도메인에 가입되어 있음을 나타냅니다. 도메인에 가입되어 있는 경우 DR Series 시스
템에 NTP가 비활성화됩니다.

• Set Date and Time(날짜 및 시간 설정) - Manual(수동) 모드를 사용할 경우, 달력 아이콘을 클릭하고 24시간 
형식으로 월, 일, 시간을 선택하여 날짜 및 시간을 구성합니다. 달력의 슬라이더 컨트롤을 사용하여 월, 
일, 시간 및 분을 선택합니다. 현재 시간을 설정하려면 Now(현재)를 클릭합니다. 날짜 및 시간 값 설정을 
마치면 Done(완료)을 클릭합니다. 그러면 시간이 나타납니다(예: 12/12/12 14:05:45). 모든 날짜 및 시간 설정
이 구성되면 Submit(제출)를 클릭하여 DR Series 시스템이 새 값을 수락하도록 합니다.

노트: 적절한 데이터 보관 및 복제 서비스 작업을 수행하려면 시스템을 동기화해야 합니다.

NTP 모드를 사용하여 시스템 클록을 동기화하면 안정적인 타임스탬프를 사용할 수 있습니다. 이는 작업 그룹 내
에서 파일 교환, 네트워크 로그 조정 및 확인, 리소스 액세스 요청을 성공적으로 수행하는 데 매우 중요합니다.

노트: 작업 그룹 내에서 더 나은 복제 서비스 작업을 수행할 수 있도록 하려면 NTP 모드를 사용할 것을 권장

합니다. Date and Time(날짜 및 시간) 페이지의 Edit(편집) 옵션을 사용하여 DR Series 시스템의 기존 날짜 및 

시간 설정을 구성하거나 수정할 수 있습니다. 하지만 도메인에 가입되어 있으면 NTP 서비스가 비활성화되

며 도메인 시간 관리가 사용되므로 NTP를 활성화할 수 없습니다.

Editing System Date and Time Settings

To modify the default time and date settings for your DR Series system, complete the following:

1. Select System Configuration → Date and Time.
The Date and Time page is displayed.

2. Click Edit on the options bar.
The Edit Date and Time dialog is displayed.

노트: If the DR Series system is joined to a Microsoft Active Directory Services (ADS) domain, the Edit option 
will be disabled (grayed out) and the Mode, Time Zone, or Date and Time values cannot be changed in the 
Settings pane. This is because whenever a DR Series system is joined to a domain, the Network Time Protocol 
(NTP) is disabled and the DR Series system uses the domain-based time service. NTP is used in the Mode 
setting when the DR Series system is part of a workgroup and not joined to a domain. To be able to modify or 
edit any of the Settings pane values when the DR Series system is joined to an ADS domain, you would first 
need to leave the ADS domain before you could modify any of the date and time settings. For more 
information, see Configuring Active Directory Settings.

3. In Mode, select either Manual or NTP.
If you select Manual, continue on with the tasks in step 3.

If you select NTP, skip to step 4.

a) Select Manual.
The Edit Date and Time dialog is displayed.

b) Click the Time Zone drop-down list and choose the desired time zone.
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c) Click the Calendar icon (adjacent to Set Date and Time), and select the desired day in the month (the system 
prevents the selection of unsupported days).

d) Adjust the Hour and Minute sliders to the desired time (or click Now to set the date and time to be the current 
date and time in hours and minutes).

a) Click Done.
The Edit Date and Time dialog is displayed with your new settings.

4. Select NTP.
The Edit Date and Time dialog is displayed.

– Click the Time Zone drop-down list and select the desired time.

– Edit or revise the NTP servers as desired (you are limited to selecting only three NTP servers).

5. Click Submit (or click Cancel).
The Date and Time page is displayed, and an Enabled NTP service dialog is displayed when successful (and this 
was your selected mode).

Creating Containers
After initialization, the DR Series system contains a single default container named backup. Containers function like a 
shared file system, which can be assigned a connection type of None (to be defined later), NFS/CIFS, or RDA (includes 
both OST and RDS clients). Containers can then be accessed using NFS, CIFS, or RDA.

If needed, you can also create additional system containers for storing your data. For more information about creating a 
storage container or specific connection type containers, see Creating Storage Containers, Creating an NSF or CIFS 
Connection Type Container, or Creating an OST or RDS Connection Type Container.

Configuring Share-Level Security
The DR Series system supports setting up share-level permissions for CIFS shares using the standard Microsoft 
Windows administrative tool, Computer Management. Computer Management is a component that is built into the 
Microsoft Windows 7, Vista, and XP operating systems.

노트: Any user that is part of BUILTIN\Administrators can edit ACLs on CIFS shares. The local DR Series system 
administrator is included in the BUILTIN\Administrators group. To add additional domain groups to the BUILTIN
\Administrators group, you can use the Computer Manager tool on a Windows client to connect to the DR Series 
system as Domain administrator and add any groups you want. This capability allows users other than the Domain 
administrator to modify an ACL as needed.

This administrative tool lets you control access to shares and also configure read-only or read-write access to user 
groups or individual users within the Active Directory Service (ADS) when joined to an ADS domain.

To implement share-level security on a DR Series system that has been joined to an ADS domain, make sure that you 
have mapped a drive on the DR Series system using an account with DOMAIN\Administrator credentials (or by using an 
account that is equivalent to a domain administrator). For more information about joining to an ADS domain, see 
Configuring Active Directory Settings.

노트: If you do not use an account with sufficient privileges, you will not be able to see the shares or you may 
experience other problems.

1. Click Start → Control Panel → Administrative Tools → Computer Management.
The Computer Management page is displayed.

2. Click Action → Connect to another computer... .
The Select Computer dialog is displayed.
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3. Click Another computer, type the hostname or IP address for this DR Series system, and click OK.
The Computer Management page is displayed with the designated DR Series system listed in the left pane.

4. Click System Tools, and click Shared folders.
The Shares, Sessions, and Open Files folders are displayed in the main pane of the Computer Management page.

5. Click Shares to display a list of the shares managed by the DR Series system.
6. Right-click on the share of interest, and select Properties.

The specified share Properties page is displayed.

7. Click the Share Permissions tab in the specified share Properties page.
The Share Permissions view in the Properties page is displayed.

8. To remove existing access permissions to the share, or add additional groups or user that can access the share, 
complete the following:

– To add access for a new group or user, click Add... to display the Select Users or Groups dialog.

– Click Object Types..., choose the object types you want to select (Built-in security principals, Groups, or 
Users), and click OK.

– Click Locations... and define the root location from which to begin your search, and click OK.

– In the Enter the object names to select list box, enter any object name(s) you want to find.

노트: You can search for multiple objects by separating each name with a semicolon, and by using 
one of the following syntax examples: DisplayName, ObjectName, UserName, 
ObjectName@DomainName, or DomainName\ObjectName.

– Click Check Names to locate all matching or similar object names that are listed in the Enter the object 
names to select list box, by using the object types and directory locations you selected.

9. Click OK to add the object to the Group or user names list box.
10. In the Permissions pane for the selected object, select the Allow or Deny check box to configure the following 

permissions:

– Full Control

– Change

– Read
11. Click OK to save the selected share permission settings associated with the selected object.
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5
Managing DR Series Storage Operations

Managing Container Operations
This topic introduces the concept of using the DR Series system to manage all of your data storage and replication 
operations. Data storage operations can include tasks such as creating new containers, managing or deleting existing 
containers, moving data into containers, and displaying current container statistics. Replication operations can include 
such tasks as creating new replication relationships, managing or deleting existing replication relationships, starting 
and stopping replication, setting a replication bandwidth limit per host, displaying current replication statistics, and 
setting a replication schedule.

Creating Storage Containers

By default, the DR Series system provides a container named backup for your use after you complete the basic system 
configuration and initialization process. You can also create additional containers to store your data as needed.

노트: The DR Series system does not support creating container names that begin with a 0 (zero). In addition, many 
of the DR Series system GUI and CLI operations will not work when a container name begins with a 0.

Containers function like a shared file system that can be accessed using the following connection types:

• NFS/CIFS

• NFS

• CIFS

• RDA (Rapid Data Access)

– OST (OpenStorage Technology)

– RDS (Rapid Data Storage)

• None (an unassigned connection type)

Choosing the None or unassigned connection type lets you create containers that can be configured later as needed. To 
modify a container configured with a None connection type, select the container, click Edit, and start configuring it as 
desired.

Creating an NFS or CIFS Connection Type Container

To create an NFS or a CIFS connection type container, complete the following:

1. Select Storage → Containers.
The Containers page is displayed, which includes a Containers summary table listing all existing containers.

2. Click Create.
The Create New Container dialog is displayed.

3. In Container Name, type the name of the container.
Container names cannot exceed 32 characters in length, and can be composed of any combination of the following 
characters:
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노트: The DR Series system does not support the use of the following special characters in container 
names: /, #, or @.

– A-Z (uppercase letters)

– a-z (lowercase letters)

– 0-9 (numbers)

– dash (-) or underscore (_) special characters

4. In Marker Type, select from the following choices: None, Auto, CommVault, Networker, TSM, or ARCserve.
If you select the Auto marker type, this will enable all marker types to be detected. As a best practice, if you have 
only one type of DMA with traffic directed to a container, it is best to select the corresponding marker type (for 
example, CommVault). Conversely, as a best practice, if you have traffic from a DMA that is not one of the 
supported marker types, it is best to disable marker detection for the container by selecting the None marker type.

5. In Connection Type, select NFS/CIFS.
This displays the following in the NFS and CIFS panes:

– NFS access path: <system name>/containers/<container name>

– CIFS share path: <system name>\<container name>

노트: To create an NFS connection type, skip to step 6. To create a CIFS connection type, skip to step 10.

6. To select an NFS connection type, click Enable NFS in the NFS pane.
The Client Access, NFS Options, and Map root to panes are displayed, and is where you configure this container to 
use NFS to backup Unix or Linux clients.

7. In the Client Access pane, define a specific NFS client (or all clients) that can access the NFS container or manage 
clients who can access this container:

– To allow open access for all clients to the NFS container you create, select Open Access (all clients have 
access). When you select this setting, this action removes the Add client (IP or FQDN Hostname) and 
Clients text boxes. Select this check box only if you want to enable access for all clients to this NFS 
container.

– To define a specific client that can access the NFS container you create, type the IP address (or its FQDN 
hostname) in the Add clients (IP or FQDN Hostname) text box, and click Add. The “added” client appears in 
the Clients list box.

– To delete an existing client from the NFS Clients list box, select the IP address (or FQDN hostname) of the 
client you want to delete, and click Remove. The “deleted” client disappears from the list box.

8. In the NFS Options pane, define which NFS options to use for the client, by selecting from the NFS Options choices: 
rw (allows read-write access), ro (allows read-only access), or insecure (allows for replies being made to requests 
before the changes in the request are committed to disk).

노트: The DR Series system always commits writes to NVRAM first before committing any changes to disk.

9. In the Map root to pane, select the user level you want mapped to this container from one of the following options 
from the drop-down list and skip to step 12.

– nobody represents a user on the system without root access permissions

– root represents a remote user with root access to read, write, and access files on the system

– administrator represents the system administrator

노트: The DR Series system administrator that manages the system has a different set of privileges than does 
the CIFS administrator user. Only the DR Series system administrator can change the password for the CIFS 
administrator user. To change the password that allows access for the CIFS administrator user, use the 
authenticate --set --user administrator commands. For more information, see the Dell DR Series System 
Command Line Reference Guide.
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10. To select a CIFS connection type, click Enable CIFS in the CIFS pane.
The Client Access pane is displayed, which allows you to configure this container to use CIFS to backup Microsoft 
(MS) Windows clients.

11. In the Client Access pane, define a specific CIFS client (or all clients) that can access the CIFS container or 
manage clients who can access this container:

– To allow open access for all clients to the CIFS container you created, select Open Access (all clients have 
access). When you select this setting, this action removes the Add clients (IP or FQDN Hostname) and 
Clients text boxes. Select this check box only if you want to enable access for all clients to this CIFS 
container.

– Type the IP address (or its FQDN hostname) in the Add clients (IP or FQDN Hostname) text box, and click 
Add. The “added” client appears in the Clients list box.

– To delete an existing client from the Clients list box, click to select the IP address (or FQDN hostname) of 
the client you want to delete, and click Remove. The “deleted” client disappears from the list box.

12. Click Create a New Container (or click Cancel to display the Containers page).
The Containers page is displayed, along with a Successfully Added dialog. The list of containers in the Containers 
summary table is now updated with your new container.

Creating an OST or RDS Connection Type Container

To create an OST or RDS connection type container:

1. Select Storage → Containers.
The Containers page displays all existing containers.

2. Click Create.
The Create New Container dialog is displayed.

3. In Container Name, type the name of the container.
Container names cannot exceed 32 characters in length, and can be composed of any combination of the following 
characters:

– A-Z (uppercase letters)

– a-z (lowercase letters)

– 0-9 (numbers)

– dash (-) or underscore (_) special characters

노트: The DR Series system does not support the use of the following special characters in container 
names: /, #, or @.

4. In Marker Type, select Auto.
Selecting Auto marker type enables all marker types to be detected. As a best practice, if you have only one type of 
DMA with traffic directed to a container, it is best to select the corresponding marker type (for example, 
CommVault). As a best practice, if you have traffic from a DMA that is not one of the supported marker types, it is 
best to disable marker detection for the container by selecting the None marker type.

5. In Connection Type, select RDA .
The RDA pane is displayed.

6. In RDA type, select either OST or RDS.

7. In Capacity, select one of the following options allowed per container:

노트: If you select RDS, by default, Unlimited is selected. Under Capacity the Size field is inactive.

– Unlimited: this defines the allowed amount of incoming raw data per container (based on the physical 
capacity of the container).
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– Size: this defines a set limit in Gibibytes (GiB) for incoming raw data allowed per container.
8. Click Create a New Container (or click Cancel to display the Containers page).

After creating the new container, the Containers page is displayed and includes a Successfully Added dialog. The 
list of containers in the Containers summary table is updated with your new container (and its new status is 
reflected as N/A in the Replication column of this table).

할당되지 않은 연결 유형 컨테이너 생성

정의된 연결 유형 없이(None) DR Series 시스템에서 할당되지 않은 컨테이너를 생성하려면 다음을 수행합니다.

노트: DR Series 시스템을 사용하면 특정 연결 유형으로 구성하지 않고도 컨테이너를 생성할 수 있습니다. 
나중에 할당되지 않은 컨테이너를 구성할 준비가 되면 컨테이너 요약 표에서 해당 컨테이너를 선택하고 

Edit(편집)를 클릭한 후 원하는 연결 유형으로 구성합니다.

1. Storage(스토리지) → Containers(컨테이너)를 선택합니다.
기존 컨테이너가 모두 표시되는 Containers(컨테이너) 페이지가 표시됩니다.

2. Create(생성)를 클릭합니다.
Create New Container(새 컨테이너 생성) 대화상자가 표시됩니다.

3. Container Name(컨테이너 이름)에 컨테이너 이름을 입력합니다.
컨테이너 이름은 최대 32자이며 다음과 같은 문자를 조합하여 사용할 수 있습니다.

노트: DR Series 시스템에서는 컨테이너 이름에 /, # 또는 @ 특수 문자를 사용할 수 없습니다.

– A-Z(대문자)
– a-z(소문자)
– 0-9(숫자)
– 대시(-) 또는 밑줄(_) 특수 문자

4. Marker Type(마커 유형)에서 None, Auto, CommVault, Networker, TSM 또는 ARCserv를 선택합니다.
Auto 마커 유형을 선택하면 모든 마커 유형이 검색됩니다. 모범 사례로서, 컨테이너로 유도되는 트래픽에 

한 가지 유형의 DMA를 사용할 경우에는 해당 마커 유형(예: CommVault)을 선택하는 것이 가장 좋습니다. 이
와 반대되는 모범 사례로서, 지원되는 마커 유형이 아닌 DMA의 트래픽을 사용하는 경우 None 마커 유형을 

선택하여 컨테이너에 대해 마커 검색을 비활성화하는 것이 가장 좋습니다.

5. 할당되지 않은 컨테이너 유형으로 컨테이너를 생성하려면 None을 선택하여 나중에 구성할 수 있는 컨테이
너를 생성하거나 컨테이너에 대해 모든 특정 마커 유형을 비활성화합니다.

6. Create a New Container(새 컨테이너 생성)를 클릭하거나 Cancel(취소)을 클릭하여 Container Summary(컨테이
너 요약) 페이지를 표시합니다.
새 컨테이너가 생성되면 Containers(컨테이너) 페이지가 표시되고 Successfully Added(추가 완료) 대화상자

가 표시됩니다. 컨테이너 요약 표의 컨테이너 목록이 새로운 할당되지 않은 컨테이너로 업데이트됩니다.

Editing Container Settings

To modify any of the settings for an existing container, complete the following:

1. Select Storage→ Containers.
The Containers page is displayed, and lists all current containers.

2. Click Select to identify the container in the list that you want to modify, and click Edit.
The Edit Container dialog is displayed.

3. Modify the marker type options for the selected container as needed (containers support None, Auto, CommVault, 
Networker, TSM (Tivoli Storage Manager), or ARCserve.
If you select the Auto marker type, this will enable all marker types to be detected. As a best practice, if you have 
only one type of DMA with traffic directed to a container, it is best to select the corresponding marker type (for 
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example, CommVault). Conversely, as a best practice, if you have traffic from a DMA that is not one of the 
supported marker types, it is best to disable marker detection for the container by selecting the None marker type.

4. Modify the connection type options for the selected container as needed (containers support None, NFS/CIFS, and 
RDA).

– If you want to modify an existing NFS/CIFS, NFS, or CIFS connection type container settings, see the NFS/
CIFS, NFS-only, and CIFS-only options available in Creating an NSF or CIFS Connection Type Container, and 
make the corresponding changes.

– If you want to modify the existing OST or RDS connection type container settings, see the options available 
in Creating an OST or RDS Connection Type Container , and make the corresponding changes.

– If you want to modify the existing unassigned (None) connection type container settings, see the options 
available in Creating An Unassigned Connection Type Container, and make the corresponding changes.

노트: If you select Open Access in the Client Access pane, the Add clients (IP or FQDN Hostname) and Clients 
panes are hidden and you cannot create or modify these options.

노트: The DR Series system always commits writes to NVRAM first before committing any changes to disk.

노트: The DR Series system administrator that manages the DR Series system has a different set of privileges 
than the CIFS administrator user. Only the DR Series system administrator can change the password for the 
CIFS administrator user. To change the password that allows access for the CIFS administrator user, use the 
DR Series system CLI authenticate --set --user administrator command. For more information, see the Dell DR 
Series System Command Line Reference Guide at dell.com/support/manuals.

5. Once the container type settings have been modified, click Modify this Container (or click Cancel to display the 
Containers page).
The Successfully updated container dialog is displayed. The list of containers in the Containers summary table is 
updated with the newly modified container.

컨테이너 삭제

컨테이너를 삭제하기 전에, 컨테이너의 데이터를 유지해야 하는지 여부를 신중하게 고려해야 합니다. 데이터가 

포함된 기존 컨테이너를 삭제하려면 다음을 수행합니다.

주의: 중복 제거된 데이터가 포함된 DR Series 컨테이너를 삭제하기 전에 다른 장기 보유 방법을 사용하여 

데이터를 유지할 수 있는 조치를 취하는 것이 좋습니다. 컨테이너가 삭제되면 중복 제거된 데이터를 검색

할 수 없습니다. 이 릴리스의 DR Series 시스템부터는 하나의 작업을 수행하여 지정된 모든 컨테이너 및 해
당 콘텐츠를 삭제할 수 있습니다.

1. Storage(스토리지) → Containers(컨테이너)를 선택합니다.
Containers(컨테이너) 페이지가 표시되고 현재 컨테이너가 모두 나열됩니다.

2. Select(선택)를 클릭하여 삭제할 컨테이너를 식별하고 Delete(삭제)를 클릭합니다.
삭제하려고 선택한 이름의 특정 컨테이너에 대한 정보를 보여주는 Delete Confirmation(삭제 확인) 대화상자

가 표시됩니다.

3. Delete Confirmation(삭제 확인) 대화상자에서 OK(확인)를 클릭하거나 Cancel(취소)을 클릭하여 Containers(컨
테이너) 페이지를 표시합니다.
Successfully removed container(컨테이너 제거 완료) 대화상자가 표시됩니다. 컨테이너 요약 표의 컨테이너 

목록이 업데이트되며 삭제된 컨테이너가 더 이상 표시되지 않습니다.
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Moving Data Into a Container

To move data into an existing DR Series system container, complete the following:

1. Click Start → Windows Explorer → Network .
The Network page is displayed, which lists all current computers.

2. In the browser Address bar, click Network to select your DR Series hostname or IP address.
The Network page is displayed, which lists all current storage and replication containers.

노트: However, if your DR Series system is not listed, you can enter its hostname or IP Address preceded by 
"https://" and followed by the container name in the Address bar to access it (for example in this format, 
https://10.10.20.20/container-1). The DR Series system only supports the Hypertext Transfer Protocol Secure 
(HTTPS) form of IP addressing.

3. Move data from the source location to the destination container using your regular DMA or backup application 
process.

노트: If any file ingested by the DR Series system by a DMA or backup application is renamed or deleted 
without using the DMA or backup application’s process, the corresponding catalog must be updated 
accordingly. Failure to do so may prevent the DMA or backup application from being able to access the data.

4. Verify that the data recently moved now resides in the destination container (or click Dashboard → Statistics: 
Container, select the destination container in the Container Name drop-down list, and view the following 
information panes for recent container activity:

– Backup Data

– Throughput

– Connection Type

– Replication

Displaying Container Statistics

To display the current statistics for an existing container that stores your data, complete the following:

노트: An alternate method to display statistics for any current container is to select that container by name in the 
Container Name drop-down list in the Statistics: Container page (Dashboard Statistics: Container).

1. Select Storage → Containers.
The Containers page is displayed, and the Containers summary table lists all of the current containers in the 
system.

2. Click Select to identify the container to display, and click Display Statistics in the options bar.
The Statistics: Container page is displayed which shows the current backup data (number of active files and active 
bytes ingested in the Backup Data pane), and read and write throughput (in the Throughput pane). The system polls 
for and updates the displayed statistics every 30 seconds.

노트: To display statistics for another container, select that container by name in the Container Name drop-
down list.

This page also displays the marker type and connection type for the selected container, and the displayed statistics 
depends upon the connection type container. For more information, see Statistics: Container Page, Connection 
Type Pane, and Monitoring Container Statistics.

In addition, you can also display the set of system statistics by using the DR Series system CLI stats --system 
command to show the following categories of system statistics:
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– Capacity Used (system capacity used in Gibibytes or GiBs)

– Capacity Free (system capacity free in GiBs)

– Read Throughput (read throughput rate in Mebibytes or MiB/s)

– Write Throughput (write throughput rate in MiB/s)

– Current Files (current number of files in system)

– Current Bytes (current number of ingested bytes in system)

– Post Dedupe Bytes (number of bytes after deduplication)

– Post Compression Bytes (number of bytes after compression)

– Compression Status (current compression status)

– Cleaner Status (current space reclamation process status)

– Total Inodes (total number of data structures)

– Dedupe Savings (deduplication storage savings by percentage)

– Compression Savings (compression storage savings by percentage)

– Total Savings (total storage savings by percentage)

CLI를 사용하여 DR Series 시스템 통계 표시

현재 DR Series 시스템 통계를 확인하는 또 다른 방법은 DR Series 시스템 CLI stats --system 명령을 사용하여 다음

과 같은 시스템 통계 카테고리를 표시하는 것입니다.

• 사용된 용량(사용된 시스템 용량(기비바이트 또는 GiB))

• 사용 가능한 용량(사용 가능한 시스템 용량(GiB))

• 읽기 처리량(읽기 처리 속도(메비바이트 또는 MiB/s))

• 쓰기 처리량(쓰기 처리 속도(MiB/s))

• 현재 파일(시스템의 현재 파일 수)

• 현재 바이트(시스템의 현재 통합 바이트 수)

• 게시물 중복 제거 바이트(중복 제거 후 바이트 수)

• 게시물 압축 바이트(압축 후 바이트 수)

• 압축 상태(현재 압축 상태)

• 클리너 상태(현재 공간 확보 프로세스 상태)

• 총 아이노드(inode)(총 데이터 구조 수)

• 중복 제거 저장량(중복 제거 스토리지 저장량(%))

• 압축 저장량(압축 스토리지 저장량(%))

• 총 저장량(총 스토리지 저장량(%))

DR Series 시스템 CLI 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

CLI를 사용하여 컨테이너별 통계 표시

DR Series 시스템 CLI stats --container --name <컨테이너 이름> 명령을 통해 다음과 같은 통계 카테고리로 컨테이

너별 통계 세트를 표시할 수 있습니다.

• 컨테이너 이름(컨테이너의 이름)

• 컨테이너 ID(컨테이너와 연관된 ID)

• 총 아이노드(inode) 수(컨테이너의 총 데이터 구조 수)

• 읽기 처리량(컨테이너의 읽기 처리량 속도(메비바이트 또는 MiB/s))

• 쓰기 처리량(컨테이너의 쓰기 처리량 속도(MiB/s))

• 현재 파일 수(컨테이너의 현재 파일 수)
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• 현재 바이트 수(컨테이너의 현재 통합 바이트 수)

• 클리너 상태(선택된 컨테이너의 현재 공간 확보 프로세스 상태)

DR Series 시스템 CLI 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

Managing Replication Operations
If you plan on performing replication operations across a firewall, the DR Series system replication service requires that 
the following fixed TCP ports be configured to support replication operations:

노트: To allow replication storage information to be viewed by a corresponding data management agent (DMA), 
the target DR Series system needs to reside in the same domain as the source DR Series system in the replication 
relationship.

• port 9904

• port 9911

• port 9915

• port 9916

노트: If there are no existing containers, replication relationships, or any scheduled replication operations, the 
only Replication-related option that is enabled is Create. The Edit, Delete, Stop, Start, Bandwidth, and Display 
Statistics options are disabled (grayed out).

In the 2.0 release, DR Series systems support 32:1 replication of data. This means that multiple source DR Series systems 
(up to 32) can write data to different individual containers on a single, target DR Series system.

노트: Starting with release 2.0, the DR Series system software includes version checking that limits replication 
only between other DR Series systems that run the same system software release version (DR Series systems 
running Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

노트: You need to be aware that the storage capacity of the target DR Series system is directly affected by the 
number of source systems writing to its containers, and also by the amount being written by each of these source 
systems.

복제 관계 생성

새 복제 관계를 생성하려면 다음을 수행합니다.

1. Storage(스토리지) → Replication(복제)을 선택합니다.
Replication(복제) 페이지가 표시됩니다. 이 페이지에는 다음과 같은 카테고리에 따라 현재 모든 복제 항목이 

나열되어 있습니다.

– 로컬 컨테이너 이름

– 역할(대상 또는 소스)

– 원격 컨테이너 이름

– 피어 상태(온라인 또는 오프라인)

– 대역폭(복제 대역폭 제한)
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노트: 대역폭은 초당 키비바이트(KiBps), 초당 메비바이트(MiBps), 초당 기비바이트(GiBps) 또는 무제한 

대역폭(기본값)으로 설정할 수 있는 복제 대역폭 한도입니다.

2. 옵션 모음에서 Create(생성)를 클릭합니다.
Create Replication(복제 생성) 페이지가 표시됩니다.

3. 1단계: 로컬 컨테이너 선택에서, 사용 가능한 컨테이너 목록에서 로컬 컨테이너를 선택합니다.

4. 2단계: 암호화 선택에서 None(없음), 128–bit(128비트) 또는 256–bit(256비트). 중 하나를 선택합니다.

5. 3단계: 역할 선택에서, Source(소스) 또는 Target(대상)을 선택합니다.

6. 4단계: 원격 컨테이너 설정에서, 다음 두 가지 옵션 중 하나를 선택합니다.

– Create container on remote system(원격 시스템에 컨테이너 생성). 이 옵션을 선택한 경우 원격 시스템
에 컨테이너 생성(복제)를 참조하십시오. 이 주제에서는 원격 시스템에 컨테이너 생성 과정에 대해 
설명합니다.

– Map to container on remote system(원격 시스템의 컨테이너에 매핑). 이 옵션을 선택한 경우 원격 시
스템의 컨테이너에 매핑(복제)를 참조하십시오. 이 주제에서는 원격 시스템의 컨테이너에 매핑 생
성 과정에 대해 설명합니다

7. 4단계: Username(사용자 이름), Password(암호), Peer System(피어 시스템) 및 Peer Container Name(피어 컨테
이너 이름) 필드에 필요한 정보를 입력합니다.
자세한 내용은 선택한 옵션에 따라 원격 시스템에 컨테이너 생성(복제) 또는 원격 시스템의 컨테이너에 매
핑(복제)을 참조하십시오.

8. Create Replication(복제 생성)을 클릭하거나 Cancel(취소)을 클릭하여 Replication(복제) 페이지를 표시합니다.
성공하면 Successfully added replication(복제 추가 완료) 대화상자가 표시됩니다.

Creating a Container on a Remote System (Replication)

This topic describes the process for creating a replication relationship with a container on a remote system using the 
Replication page. For more information, see Creating Replication Relationships. The following procedure assumes you 
have completed the Step 1, Step 2, and Step 3 tasks for creating replication relationships, and you are selecting the 
Create container on a remote system option in Step: 4 Remote container settings.

To create a replication relationship with a container on a remote system, complete the following tasks:

노트: Exercise care when configuring the direction of replication for source and target containers. For example, 
target containers can have their contents deleted if they contain existing data.

1. In Username, type a valid user name for the peer system (for example, administrator).

2. In Password, type a valid password for the peer system (for example, St0r@ge!).

3. In Peer System, type the IP address that represents this peer system (for example, 10.10.10.10).

4. In Peer Container Name, type a name for the new container (for example, StorageReplica2), or choose from an 
existing container on the peer system.

5. Click Create Replication (or click Cancel to display the Replication page).
The Successfully added replication dialog is displayed when successful.

원격 시스템의 컨테이너에 매핑(복제)

이 주제에서는 Replication(복제) 페이지를 사용하여 원격 시스템의 컨테이너에 매핑함으로써 새로운 복제 관계

를 생성하는 과정에 대해 설명합니다. 자세한 내용은 복제 관계 생성을 참조하십시오. 다음 절차에서는 복제 관
계 생성 1단계, 2단계, 3단계 작업을 완료했으며 4단계: 원격 컨테이너 설정에서 Map to container on a remote 
system(원격 시스템의 컨테이너에 매핑) 옵션을 선택했다고 간주합니다.

원격 시스템의 컨테이너에 매핑하여 복제 관계를 생성하려면 다음을 수행합니다.
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노트: 소스 및 대상 컨테이너의 복제 방향을 구성할 때 주의해야 합니다. 예를 들어, 대상 컨테이너에는 삭
제된 해당 콘텐츠가 있을 수 있습니다(기존 데이터가 있을 경우).

1. Map to container on remote system(원격 시스템의 컨테이너에 매핑)을 클릭합니다.

2. Username(사용자 이름)에 피어 시스템에 대해 유효한 사용자 이름을 입력합니다(예: administrator).

3. Password(암호)에 피어 시스템에 대해 유효한 암호를 입력합니다(예: St0r@ge!).

4. Peer System(피어 시스템)에 피어 시스템을 나타내는 IP 주소를 입력합니다(예: 10.10.10.10).

5. Remote Container(원격 컨테이너)에서 Retrieve Container(s)(컨테이너 검색)를 클릭하여 목록 상자에 원격 컨
테이너를 표시합니다.

6. Retrieve Container(s)(컨테이너 검색) 목록 상자에서 원하는 원격 컨테이너를 선택합니다.

7. Create Replication(복제 생성)을 클릭하거나 Cancel(취소)을 클릭하여 Replication(복제) 페이지를 표시합니다.
성공하면 Successfully added replication(복제 추가 완료) 대화상자가 표시됩니다.

복제 관계 편집

기존 복제 관계 설정을 수정하려면 다음을 수행합니다.

노트: 소스 및 대상 컨테이너의 복제 방향을 구성할 때 주의해야 합니다. 예를 들어, 대상 컨테이너에는 삭
제된 해당 콘텐츠가 있을 수 있습니다(기존 데이터가 있을 경우).

1. Storage(스토리지)→ Replication(복제)을 선택합니다.
Replication(복제) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 수정할 복제 관계를 식별하고 옵션 모음에서 Edit(편집)를 클릭합니다.
Edit Replication(복제 편집) 대화상자가 표시됩니다.

3. Step 2: Select Encryption(2단계: 암호화 선택)에서 필요에 따라 다음 값을 수정합니다.

– 없음

– 128비트

– 256비트

4. Step 4: Remote container settings(4단계: 원격 컨테이너 설정)에서 필요에 따라 다음 값을 수정합니다.

– 사용자 이름

– 암호

– 피어 시스템

노트: 복제 관계에 대해 기존에 정의된 역할(소스 또는 대상)은 수정할 수 없기 때문에, 필요할 경우에

는 기존 복제 관계를 삭제하고 원하는 특정 소스 및 대상 역할을 사용하여 새 관계를 다시 만들어야 합
니다.

5. Save Replication(복제 저장)을 클릭하거나 Cancel(취소)을 클릭하여 Replication(복제) 페이지를 표시합니다.
성공하면 Successfully updated replication(복제 업데이트 완료) 대화상자가 표시됩니다.

복제 관계 삭제

기존 복제 관계를 삭제하려면 다음을 수행합니다.

1. Storage(스토리지) → Replication(복제)을 선택합니다.
Replication(복제) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 삭제할 관계를 식별하고 옵션 모음에서 Delete(삭제)를 클릭합니다.
Delete Replication(복제 삭제) 대화상자가 표시됩니다.
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3. Delete replication(복제 삭제) 대화상자에서 OK(확인)를 클릭하거나 Cancel(취소)을 클릭하여 Replication(복
제) 페이지를 표시합니다.
성공하면 Successfully deleted replication(복제 삭제 완료) 대화상자가 표시됩니다.

복제 시작 및 중지

기존 복제 관계에서 복제를 시작하거나 중지하려면 다음을 수행합니다.

노트: 복제 스케줄 설정에 대한 자세한 내용은 복제 스케줄 생성을 참조하십시오.

1. Storage(스토리지) → Replication(복제)을 선택합니다.
Replication(복제) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 복제 프로세스를 중지하거나(3단계 참조) 시작할(4단계 참조) 복제 관계를 식별합
니다.

3. 예약된 복제 프로세스를 중지하려면 Stop(중지)을 클릭하고 OK(확인)를 클릭하여 복제를 중지합니다. 
Replication(복제) 페이지를 표시하려면 Cancel(취소)을 클릭합니다.
Successfully stopped replication(복제 중지 완료) 대화상자가 표시됩니다.

4. 예약된 복제 프로세스를 시작하려면 Start(시작)를 클릭하고 OK(확인)를 클릭하여 복제를 시작합니다. 
Replication(복제) 페이지를 표시하려면 Cancel(취소)을 클릭합니다.
Successfully started replication(복제 시작 완료) 대화상자가 표시됩니다.

복제 대역폭 설정

DR Series 시스템에 복제 대역폭을 설정하려면 다음을 수행합니다.

1. Storage(스토리지)→ Replication(복제)을 선택합니다.
Replication(복제) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 복제 대역폭 속도를 설정할 복제 관계를 식별하고 Bandwidth(대역폭)를 클릭합니
다.
Replication Bandwidth Throttling(복제 대역폭 사용량 조절) 대화상자가 표시됩니다.

3. Peer System(피어 시스템) 드롭다운 목록에서 피어 시스템의 IP 주소를 선택합니다.

4. Set bandwidth throttling speed(대역폭 사용량 조절 속도 설정)에서, 다음과 같은 복제 대역폭 한도를 선택합
니다

– KBps(초당 킬로바이트)를 클릭하고 Rate(속도) 상자에 값을 입력하여 속도를 KBps 단위로 설정합니
다.

– MBps(초당 메가바이트)를 클릭하고 Rate(속도) 상자에 값을 입력하여 속도를 MBps 단위로 설정합
니다.

– GBps(초당 기가바이트)를 클릭하고 Rate(속도) 상자에 값을 입력하여 속도를 GBps 단위로 설정합니
다.

– Default (not limited)(기본값(제한 없음))를 클릭하여 무제한 복제 대역폭 속도를 선택합니다.

노트: 구성할 수 있는 최대 허용 복제 대역폭 설정은 192 KBps입니다.

5. Set Bandwidth(대역폭 설정)를 클릭하거나 Cancel(취소)을 클릭하여 Replication(복제) 페이지를 표시합니다.
성공하면 Successfully set replication bandwidth(복제 대역폭 설정 완료) 대화상자가 표시됩니다.

복제 통계 표시

기존 복제 관계의 통계를 표시하려면 다음을 수행합니다.

1. Storage(스토리지) → Replication(복제)을 선택합니다.
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Replication(복제) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 복제 통계를 표시할 복제 관계를 식별하고 Display Statistics(통계 표시)를 클릭하여 
다음 항목이 포함된 Statistics: Replication(통계: 복제) 페이지를 표시합니다.

– Replication Filter(복제 필터) - 이 창의 Container Filter(컨테이너 필터) 섹션에서 하나 이상의 복제 컨테
이너, 모든 복제 컨테이너, 하나 이상의 피어 DR Series 시스템을 선택할 수 있습니다. Headers(헤더) 
섹션에서는 복제 통계 요약 표에 표시하기 위해 선택할 10개의 통계 유형 확인란을 선택할 수 있습
니다. 기본적으로 Peer Status(피어 상태), Replication Status(복제 상태), Network Throughput(네트워크 
처리량), Network Savings(네트워크 저장량), Progress %(진행률 %) 5개의 확인란이 선택됩니다.

– Replication Statistics Summary(복제 통계 요약) - 이 창에는 Replication Filter(복제 필터) 창에서 선택한 
확인란과 해당 표 열 아래에 나열된 컨테이너 또는 피어 시스템 선택 항목을 기반으로 필터링된 통
계 결과가 표시됩니다. 선택하는 확인란의 개수에 따라 모든 통계 열을 표시하려면 수직 스크롤 막
대를 사용해야 합니다.

3. Replication Filter(복제 필터) 창에서, 복제 통계 선택 항목을 표시할 컨테이너 필터 항목을 선택합니다.

– All(모두) 클릭 - 시스템에 현재 구성된 모든 컨테이너의 복제 통계를 표시합니다.

– Name(이름)을 클릭하고 Name(이름) 드롭다운 목록에서 개별 컨테이너 선택 - 단일 컨테이너의 복제 
통계가 표시됩니다. 둘 이상의 컨테이너를 표시하려면 Name(이름) 드롭다운 목록에서 Ctrl 키를 클
릭한 상태에서 포함할 추가 컨테이너를 선택합니다.

– Peer System(피어 시스템)을 클릭하고 Peer System(피어 시스템) 목록 상자에서 개별 피어 DR Series 
시스템 선택 - 단일 피어 시스템의 복제 통계가 표시됩니다. 둘 이상의 피어 시스템을 표시하려면 
Peer System(피어 시스템) 목록 상자에서 Ctrl 키를 클릭한 상태에서 포함할 추가 피어 시스템을 선택
합니다.

4. Replication Filter(복제 필터) 창에서, 선택한 컨테이너에 대해 필터링하여 복제 통계 요약 표에 표시할 다음
과 같은 Headers(헤더) 확인란을 선택합니다.

노트: 다른 DR Series 시스템 소프트웨어 버전을 실행하는 소스 시스템(예: 한 시스템에서는 1.0.1.2 소프

트웨어 실행, 다른 시스템에서는 1.1.1.0 소프트웨어 실행)의 경우 소스 어플라이언스에 사용된 시스템 

소프트웨어 버전이 다르기 때문에 Containers: Statistics(컨테이너: 통계) 및 Statistics: Replication(통계: 
복제) 페이지에 몇 가지 단순한 복제 통계 차이점이 표시됩니다.

– Peer Status(피어 상태) - 현재 피어 상태를 나타냅니다(비동기, 일시중지됨, 복제 중).

– Replication Status(복제 상태) - 현재 복제 상태를 나타냅니다(오프라인, 온라인, 연결 끊김, 연결 시도 
중, 중지됨).

– Time to Sync(동기화 시간) - 시스템이 동기화될 때까지의 시간을 나타냅니다(일/시/분/초 단위).

– Progress (%)(진행률(%)) - 현재 복제 진행률을 백분율 단위로 나타냅니다.

– Replication Throughput(복제 처리량) - 현재 복제 처리량을 백분율 단위로 나타냅니다.

– Network Throughput(네트워크 처리량) - 현재 네트워크 처리량을 백분율 단위로 나타냅니다.

– Network Savings(네트워크 저장량) - 복제를 사용하는 현재 네트워크 저장량을 백분율 단위로 나타
냅니다.

– Last Time in Sync(마지막 동기화 시간) - 시스템 동기화가 발생한 마지막 시간을 나타냅니다.

– Peer Container(피어 컨테이너) - 복제 관계에 있는 피어 컨테이너를 나타냅니다.

– Peer System(피어 시스템) - 복제 관계에 있는 피어 시스템의 IP 주소를 나타냅니다.

자세한 내용은 통계: 복제 페이지 표시를 참조하십시오.

Creating a Replication Schedule

Replication schedules can only be set on individual replication-enabled source containers. To create a Replication 
schedule on a replication-enabled source container, complete the following:
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노트: If there is no Replication schedule set, but there is pending data that can be replicated, replication will run 
when it detects the following: 1) there are no active data ingests, and 2) five minutes of system idle time have 
elapsed since the last data file ingest completed.

노트: The Replication Schedule page displays the current DR Series system time zone and current timestamp 
(using this format: US/Pacific, Tue Oct 28 14:53:02 2012).

To schedule Replication operations on your system, complete the following:

1. Select Schedules → Replication Schedule.
The Replication Schedule page is displayed.

2. Click to select the replication-enabled source container in the Container drop-down list.
The Replication schedule table is displayed with columns that identify the week day, start time, and stop time.

3. Click Schedule to create a new schedule (or click Edit Schedule to modify an existing Replication schedule).
The Set Replication Schedule page is displayed.

4. Select (or modify) the Start Time and Stop Time setpoint values using the Hour and Minutes pull-down lists to 
create a Replication schedule. For an example, see Daily Replication Schedule Example and Weekly Replication 
Schedule Example.

노트: You must set a corresponding Stop Time for every Start Time in each Replication schedule you set. The 
DR Series system will not support any Replication schedule that does not contain a Start Time/Stop Time pair 
of setpoints (daily or weekly).

5. Click Set Schedule for the system to accept your Replication schedule (or click Cancel to display the Replication 
Schedule page).

노트: To reset all of the values in the current Replication schedule, click Reset in the Set Replication 
Schedule dialog. To selectively modify values in the current schedule, make your changes to the 
corresponding hours and minutes pull-down lists for the Start Time and Stop Time you wish to modify, and 
click Set Schedule.

Dell recommends that you do not schedule the running of any Replication operations during the same time period 
when Cleaner or ingest operations will be running. Failure to follow this practice will affect the time required to 
complete the system operations and/or impact your DR Series system performance.

Daily Replication Schedule Example

The daily Replication schedule example in this topic illustrates the process for setting up a replication schedule that 
uses a 24-hour clock (the time keeping convention where time of day is defined on a 24–hour basis). You set or view a 
Replication schedule in the Replication Schedule page. For more information, see Creating a Replication Schedule.

노트: Replication schedules can only be set on individual replication-enabled source containers.

To set a daily replication schedule that starts at 16:00 hours (which is 4:00 PM in a 12–hour clock format) and stops at 
23:00 hours (which is 11:00 PM in a 12–hour clock format) on Mondays, click Edit Schedule (if modifying an existing 
schedule) or Schedule (if creating a new schedule):

• Select 16 in the hours pull-down list and 00 in the minutes pull-down list to set a Start Time of 16:00 on Monday.
• Select 23 in the hours pull-down list and 00 in the minutes pull-down list to set a Stop Time of 23:00 for Monday.
• Set the Start Time and Stop Time setpoints for any remaining days of the week on which you want to schedule 

replication.

노트: You must set a corresponding Stop Time for every Start Time in each Replication schedule you set. The DR 
Series system will not support any Replication schedule that does not contain a Start Time/Stop Time pair of 
setpoints (daily or weekly).
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Weekly Replication Schedule Example

The following example shows how to set up a weekly Replication schedule with a start time at 01:00 am on Saturday and 
a stop time at 01:00 am on Sunday. The DR Series system uses the 24-hour clock convention for its time keeping in which 
each day is divided into twenty-four 1-hour segments.

노트: Replication schedules can only be set on individual replication-enabled source containers that you select 
from the Container drop-down list.

• Select 01 in the hours pull-down list and 00 in the minutes pull-down list to set a Start Time of 01:00 for Saturday.

• Select 01 in the hours pull-down list and 00 in the minutes pull-down list to set a Stop Time of 01:00 for Sunday

노트: You need to click Set Schedule for the DR Series system to accept your Replication schedule.

For more information on Replication schedules, see Creating a Replication Schedule.
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6
DR Series 시스템 모니터링
이 주제에서는 탐색 패널의 Dashboard(대시보드) 페이지 옵션을 사용하여 DR Series 시스템 작업의 현재 상태를 

모니터링하는 방법을 소개합니다. Dashboard(대시보드) 페이지에는 현재 시스템 상태 카테고리의 요약(System 
State(시스템 상태), HW State(HW 상태), Number of Alerts(경고 수), Number of Events(이벤트 수)와 Capacity(용량), 
Storage Savings(스토리지 저장량), Throughput(처리량))이 표시되며 System Information(시스템 정보) 창이 포함되

어 있습니다. 구성요소 상태별로 현재 시스템 상태를 표시하고 DR Series 시스템의 현재 시스템 경고 수와 현재 

시스템 이벤트 수를 표시하는 데 사용할 수 있는 다른 시스템 페이지(Health(상태), Alerts(경고), Events(이벤트) 페
이지)로 이동되는 링크가 있습니다.

Monitoring Operations Using the Dashboard Page
The Dashboard page contains system status indicators for the current state of the DR Series system (System State), 
current hardware state (HW State), current number of system alerts (Number of Alerts), and current number of system 
events (Number of Events). The Dashboard page also contains data graphs that display:

• Capacity—used space and free space available in percentage and total (in Gibibytes or Tebibytes)

• Storage Savings—total savings in percentage based on time (in minutes), which can be displayed in 1h (1–hour, 
which is the default), 1d (1–day), 5d (5–day), 1m (1–month), or 1y (1–year) durations.

• Throughput—for reads and writes in volume based on time (in minutes), which can be displayed in 1h (1–hour, 
which is the default), 1d (1–day), 5d (5–day), 1m (1–month), or 1y (1–year) durations.

The Dashboard page also displays a System Information pane that lists key information about this DR Series system 
(such as product name, system name, software version, and a number of other key categories). For details about the 
System Information pane, see System Information Pane.

시스템 상태 표시줄

Dashboard(대시보드) 페이지에는 현재 시스템 상태를 나타내는 아이콘이 있는 System Status(시스템 상태) 창이 

포함되어 있으며 DR Series 시스템의 추가적인 상태 정보를 볼 수 있는 링크를 제공합니다.

• 시스템 상태

• HW 상태 (Health(상태) 페이지로 이동되는 링크 포함)

• 경고 수 (Alerts(경고) 페이지로 이동되는 링크 포함)

• 이벤트 수 (Events(이벤트) 페이지로 이동되는 링크 포함)

System Status(시스템 상태) 창 아이콘에 대한 자세한 내용은 다음 주제를 참조하십시오.

• 시스템 상태, 시스템 사용량 모니터링을 참조하십시오.

• HW 상태, 시스템 상태 모니터링을 참조하십시오.

• 경고 수, 시스템 경고 모니터링을 참조하십시오.

• 이벤트 수, 시스템 이벤트 모니터링을 참조하십시오.
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위치 상태 아이콘 설명

시스템 상태 표시줄 최적의 상태를 나타냅니다.

시스템 상태 표시줄 경고 상태를 나타냅니다(단순한 오류가 감지됨).

시스템 상태 표시줄 작동 가능한 상태를 나타냅니다(위험 수준의 오류가 감
지됨).

노트: 현재 HW 상태에 대한 특정 정보를 표시하려면 링크를 클릭하여 Health(상태) 페이지를 표시합니다. 
Health(상태) 페이지에 전면 및 후면 섀시 모습, 하드 드라이브 표시, 전원 공급 장치, 냉각팬, 연결 위치 등 

DR Series 시스템 하드웨어 및 확장 선반 인클로저(설치된 경우)의 현재 상태가 표시됩니다. DR Series 시스

템의 System Hardware Health(시스템 하드웨어 상태) 창은 전원 공급 장치, 냉각팬, 온도, 스토리지, 전압, 네
트워크 인터페이스 카드(NIC), CPU, DIMM 및 NVRAM의 상태를 제공합니다. 외부 확장 선반 인클로저의 

System Hardware Health(시스템 하드웨어 상태) 창은 전원 공급 장치, 냉각팬, 온도, 스토리지 및 인클로저 관
리 모듈(EMM)의 상태를 제공합니다.

노트: 현재 경고 수에 대한 자세한 정보를 표시하려면 링크를 클릭하여 Alerts(경고) 페이지를 표시합니다. 
Alerts(경고) 페이지에 총 경고 수가 표시되며 색인 번호, 타임스탬프, 경고 상태를 간략히 설명하는 메시지

와 함께 각 시스템 경고가 나열됩니다.

노트: 현재 이벤트 수에 대한 자세한 정보를 표시하려면 링크를 클릭하여 Events(이벤트) 페이지를 표시합

니다. Events(이벤트) 페이지에 총 이벤트 수가 표시되며 색인 번호, 심각도(위험, 경고, 정보), 타임스탬프, 
이벤트 상태를 간략히 설명하는 메시지와 함께 각 시스템 이벤트가 나열됩니다.

DR Series 시스템과 용량, 스토리지 저장량, 처리량 창

Dashboard(대시보드) 페이지에는 용량, 스토리지 저장량, 처리량에 대한 현재 DR Series 시스템 상태를 보여주는 

데이터 그래프를 표시하는 세 개의 중앙 창이 있습니다.

• Capacity(용량) - 실제 스토리지의 사용된 공간 및 여유 공간을 백분율 및 볼륨(기비바이트(GiB) 또는 테비
바이트(TiB))로 표시합니다.

• Storage Savings(스토리지 저장량) - 분 단위의 일정 기간 동안 총 저장량을 백분율로 표시합니다(중복 제
거 및 압축 혼합 사용).

• Throughput(처리량) - 분 단위의 일정 기간 동안 읽기 및 쓰기 작업에 대한 처리량 볼륨을 초당 메비바이트
(MiB/s)로 표시합니다.

노트: Storage Savings(스토리지 저장량) 및 Throughput(처리량) 데이터 그래프의 경우 기본값인 1h(1시간)와 

1d(1일), 5d(5일), 1m(1개월), 1y(1년)로 기간 내에서 현재 값을 표시할 수 있습니다.

시스템 정보 창

Dashboard(대시보드) 페이지 하단의 System Information(시스템 정보) 창에 다음과 같은 현재 시스템 정보 카테고

리가 표시됩니다.

• 제품 이름 

• 시스템 이름

• 소프트웨어 버전

• 현재 날짜/시간

• 현재 시간대
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• 클리너 상태

• 총 저장량(%)

• 모든 컨테이너의 총 파일 수

• 컨테이너 수

• 복제된 컨테이너 수

• 현재 활성 바이트 수(최적화 전의 총 바이트 수)

노트: DR Series 시스템 GUI의 특정 요소에 대한 추가적인 정보를 표시하려면 해당 물음표(?) 아이콘을 클릭

하십시오.

시스템 경고 모니터링

탐색 패널, Dashboard(대시보드) 페이지 및 해당 옵션을 사용하여 DR Series 시스템 경고를 모니터링하고 시스템

의 현재 상태를 표시할 수 있습니다.

• Dashboard(대시보드) 페이지의 Number of Alerts(경고 수) 링크를 통해 Alerts(경고) 페이지에 액세스할 수 
있습니다.

• Dashboard(대시보드)→ Alerts(경고)를 사용하여 탐색 패널에서 Alerts(경고) 페이지에 액세스할 수 있습니
다.

• Alerts(경고) 페이지에는 시스템 경고 수와 현재 시간대가 나열되며 색인 번호, 시스템 경고의 타임스탬
프, 경고에 대한 간략한 설명으로 정의된 경고의 요약 표가 제공됩니다. 자세한 내용은 시스템 경고 표시
를 참조하십시오.

대시보드 경고 페이지 사용

Dashboard(대시보드) 페이지를 사용하여 현재 시스템 경고 수를 표시하려면 다음을 수행합니다.

노트: 이 방법은 Dashboard(대시보드) 페이지에서 시스템 경고에 대한 추가 정보를 신속하게 표시하려는 경
우에 유용합니다.

1. Dashboard(대시보드) 페이지에서 Number of Alerts(경고 수)를 클릭합니다.
System State(시스템 상태) 표시줄의 Number of Alerts(경고 수)에 경고 수를 나타내는 링크가 제공됩니다. 이 

경우에는 Number of Alerts(경고 수): 2 링크에 2개 경고가 나열됩니다.

2. Number of Alerts(경고 수) 링크를 클릭합니다(이 예에서는 2).
Alerts(경고) 페이지가 표시됩니다.

3. 시스템 경고 요약 표에서 시스템 경고 목록을 확인합니다. 색인 번호, 타임스탬프 및 경고에 대한 간략한 설
명 메시지로 식별되어 표시됩니다.
자세한 내용은 대시보드 페이지 및 옵션과 시스템 경고 표시를 참조하십시오.

시스템 경고 보기

DR Series 시스템 탐색 패널을 사용하여 현재 시스템 경고 수를 표시하려면 다음을 수행합니다.

1. 탐색 패널에서 Dashboard(대시보드) → Alerts(경고)를 클릭합니다.
시스템 경고 요약 표에 시스템 경고 수가 나열된 Alerts(경고) 페이지가 표시됩니다. 이 페이지에는 현재 시
간대(예: 미국/태평양)도 표시됩니다.

2. 시스템 경고 요약 표에 나열된 시스템 경고를 다음 항목에 따라 식별하여 검토합니다.

– 색인 번호(예: 1, 2, ...).

– 타임스탬프(yyyy-mm-dd hh:mm:ss 형식, 예: 2012–10–30 10:24:53).
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– 메시지(경고에 대한 간략한 설명, 예: Network Interface Controller Embedded (LOM) Port 2 disconnected. 
Connect it to a network and/or check your network switches or routers for network connectivity issues(내
장형 네트워크 인터페이스 컨트롤러(LOM) 포트 2 연결 끊김. 이 포트를 네트워크에 연결하고 네트워
크 연결 문제가 있는지 네트워크 스위치 또는 라우터를 확인하십시오.)

시스템 이벤트 모니터링

DR Series 시스템 이벤트를 모니터링하고 Events(이벤트) 페이지의 Event Filter(이벤트 필터) 창을 사용하여 표시

할 이벤트를 필터링할 수 있습니다. 이 페이지에 All(모든) 시스템 이벤트가 표시될 수 있습니다. Info(정보), 
Warning(경고) 또는 Critical(위험) 유형의 이벤트 중 하나로만 이벤트를 제한할 수도 있습니다.

Events(이벤트) 페이지를 사용하면 시스템 이벤트를 검색하고 검색 기준과 일치하는 시스템 이벤트에 따라 DR 
Series 시스템의 현재 상태를 모니터링할 수 있습니다. Event Filter(이벤트 필터) 창 사용 방법에 대한 자세한 내용

은 이벤트 필터 사용을 참조하십시오.

시스템을 모니터링하려면 다음 방법 중 하나로 Events(이벤트) 페이지를 표시합니다.

• Dashboard(대시보드) 페이지의 Events(이벤트) 페이지에서 Number of Events(이벤트 수) 링크를 클릭합니
다.

• 탐색 패널에서 Dashboard(대시보드) → Events(이벤트)를 클릭하여 Events(이벤트) 페이지를 표시합니다.

대시보드를 사용하여 시스템 이벤트 표시

Dashboard(대시보드) 페이지를 사용하여 현재 시스템 이벤트 수(Number of Events(이벤트 수))를 표시하려면 다
음을 수행합니다.

노트: 이 방법은 Dashboard(대시보드) 페이지에서 현재 시스템 이벤트를 표시하려는 경우 유용합니다.

1. Dashboard(대시보드) 페이지에서 System Status(시스템 상태) 표시줄의 Number of Events(이벤트 수) 링크를 
클릭합니다(예: 이벤트 수: 2).
Events(이벤트) 페이지가 표시되고 현재 총 이벤트 수, 이벤트 필터, 이벤트 요약 표, 현재 시간대가 나열됩니

다.

2. Event Filter(이벤트 필터) 창에서, Event Severity(이벤트 심각도) 풀다운 목록을 사용하고 Timestamp From(타
임스탬프 시작) 및 Timestamp To(타임스탬프 종료) 시작 및 중지 설정 지점을 설정하여 이벤트를 필터링하도
록 선택할 수 있습니다.

3. Event Severity(이벤트 심각도) 풀다운 목록에서, 필터링하여 표시할 이벤트의 심각도 수준을 선택합니다
(All(모두), Critical(위험), Warning(경고) 또는 Info(정보)).

4. Message Contains(메시지에 포함)의 Message(메시지) 텍스트 필드에 검색할 단어 또는 문자열을 입력합니
다. DR Series 시스템은 입력된 항목을 기준으로 대소문자를 구분하지 않고 일치하는 항목을 검색합니다(다
른 검색 옵션은 지원되지 않음). 일치 항목은 이벤트 요약 표에 표시됩니다.

5. Timestamp From(타임스탬프 시작)에서 필드를 클릭하거나 달력 아이콘을 클릭하여 현재 날짜를 표시합니
다.

– 현재 월 스케줄에서 날짜를 클릭하여 선택합니다(또는 월 제목에서 왼쪽 및 오른쪽 화살표를 사용
하여 이전 월 또는 이후 월 선택).

– Hour(시간) 및 Minute(분) 슬라이더를 사용하여 시간 및 분 단위로 원하는 시간을 설정하거나 Now(현
재)를 클릭하여 현재 시간을 사용합니다.

– 구성을 마치면 Done(완료)을 클릭합니다.

6. Timestamp To(타임스탬프 종료)에서 필드를 클릭하거나 달력 아이콘을 클릭하여 현재 날짜를 표시합니다.

– 현재 월 스케줄에서 날짜를 클릭하여 선택합니다(또는 월 제목에서 왼쪽 및 오른쪽 화살표를 사용
하여 이전 월 또는 이후 월 선택).

– Hour(시간) 및 Minute(분) 슬라이더를 사용하여 시간 및 분 단위로 원하는 시간을 설정하거나 Now(현
재)를 클릭하여 현재 시간을 사용합니다.
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– 구성을 마치면 Done(완료)을 클릭합니다.

7. Start Filter(필터 시작)를 클릭하여 선택한 설정을 기반으로 이벤트 요약 표에 시스템 이벤트를 표시합니다.
이벤트 요약 표에는 색인, 심각도, 타임스탬프, 메시지(이벤트에 대한 간략한 설명)를 기반으로 시스템 이벤

트가 표시됩니다. 이벤트 요약 표의 결과를 탐색하여 표시하려면 다음을 수행합니다.

– 페이지별로 표시할 이벤트 수를 설정합니다. 표 오른쪽 하단에서 Events per page(페이지당 이벤트)
를 클릭하고 페이지당 표시할 25개 또는 50개 이벤트를 선택합니다.

– 스크롤 막대를 사용하여 각 시스템 이벤트의 전체 페이지를 표시합니다.

– 시스템 이벤트의 다른 페이지를 표시하려면 prev(이전) 또는 next(다음)를 클릭하거나, 특정 페이지 
번호를 클릭하거나, Goto page(페이지로 이동)에 페이지 번호를 입력하고 Go(이동)를 클릭하여 시스
템 이벤트의 해당 페이지를 표시합니다.

8. 현재 필터 설정을 지우려면 Reset(재설정)을 클릭하고 3-6단계에 설명된 과정에 따라 새 필터 값을 설정합니
다.
Events(이벤트) 페이지에서 Event Filter(이벤트 필터) 사용에 대한 자세한 내용은 이벤트 필터 사용을 참조하

십시오.

대시보드 이벤트 옵션 사용

DR Series 시스템 탐색 패널을 사용하여 현재 시스템 이벤트 수를 표시하려면 다음을 수행합니다.

1. 탐색 패널에서 Dashboard(대시보드) → Events(이벤트)를 클릭합니다.
시스템 이벤트 요약 표에 시스템 이벤트 수가 나열된 Events(이벤트) 페이지가 표시됩니다. 이 페이지에는 

현재 시간대(예: 미국/태평양)도 표시됩니다.

2. 시스템 이벤트 요약 표에서 현재 시스템 이벤트 목록을 확인합니다. 색인 번호, 심각도, 타임스탬프, 이벤트
에 대한 간략한 설명 메시지로 그룹화되어 표시됩니다.

3. Event Filter(이벤트 필터)를 사용하여 선택한 기준(이벤트 심각도, 메시지 내용, 타임스탬프 시작 범위, 타임
스탬프 종료 범위)과 일치하는 이벤트를 검색합니다.
Event Filter(이벤트 필터) 사용에 대한 자세한 내용은 이벤트 필터 사용 및 대시보드를 사용하여 시스템 이벤

트 표시를 참조하십시오.

이벤트 필터 사용

Events(이벤트) 페이지에는 이벤트 요약 표에 표시할 시스템 이벤트의 유형을 필터링할 수 있는 Event Filter(이벤

트 필터) 창이 있습니다. 이벤트 필터링은 심각도 수준을 선택하고 타임스탬프를 사용하여 수행합니다. Event 
Severity(이벤트 심각도) 드롭다운 목록에서 심각도 수준을 선택하고 Timestamp From(타임스탬프 시작) 및 

Timestamp To(타임스탬프 종료)에서 특정 시작 및 종료 설정 지점을 선택하여 검색을 구체화합니다.

이벤트 요약 표에 표시할 시스템 이벤트를 필터링하려면 다음을 수행합니다.

1. Dashboard(대시보드) → Events(이벤트)를 클릭합니다(또는 Number of Events(이벤트 수) 링크를 통해 
Events(이벤트) 페이지에 액세스).
시스템의 현재 이벤트 수가 나열되어 있고 현재 시간대가 설정된 Events(이벤트) 페이지가 표시됩니다.

2. Event Filter(이벤트 필터) 창의 Event Severity(이벤트 심각도) 드롭다운 목록에서 원하는 심각도를 선택합니
다.
시스템 이벤트의 심각도는 다음과 같습니다.

– All(모두) - 네 가지 유형의 시스템 이벤트를 모두 표시합니다(모두, 위험, 경고, 정보).

– Critical(위험) - 위험 이벤트만 표시합니다(빨간색).

– Warning(경고) - 경고 이벤트만 표시합니다(노란색).

– Info(정보) - 정보 이벤트만 표시합니다.
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3. Message Contains(메시지에 포함)의 Message(메시지) 텍스트 필드에 검색할 단어 또는 문자열을 입력합니
다. DR Series 시스템은 입력된 항목을 기준으로 대소문자를 구분하지 않고 일치하는 항목을 검색합니다(다
른 검색 옵션은 지원되지 않음). 일치 항목은 이벤트 요약 표에 표시됩니다.

4. Timestamp From(타임스탬프 시작) 옆의 Calendar(달력) 아이콘을 클릭하여 시작 설정 지점을 구성합니다.
시작 설정 지점을 구성하려면 다음을 수행합니다.

– 현재 월에서 원하는 날짜를 선택하거나 월 제목 표시줄에서 왼쪽 또는 오른쪽 화살표를 클릭하여 이
전 월 또는 이후 월을 선택합니다.

– Hour(시간) 및 Minute(분) 슬라이더를 원하는 시간으로 조정하거나 Now(현재)를 클릭하여 날짜 및 시
간을 현재 날짜 및 시간(시간 및 분)으로 설정합니다.

– Done(완료)을 클릭합니다.
5. Timestamp To(타임스탬프 종료) 옆의 Calendar(달력) 아이콘을 클릭하여 종료 설정 지점을 구성합니다.

종료 설정 지점을 구성하려면 다음을 수행합니다.

– 현재 월에서 원하는 날짜를 선택하거나 월 제목 표시줄에서 왼쪽 또는 오른쪽 화살표를 클릭하여 이
전 월 또는 이후 월을 선택합니다.

– Hour(시간) 및 Minute(분) 슬라이더를 원하는 시간으로 조정하거나 Now(현재)를 클릭하여 날짜 및 시
간을 현재 날짜 및 시간(시간 및 분)으로 설정합니다.

– Done(완료)을 클릭합니다.
6. Start Filter(필터 시작)를 클릭합니다. 또는 Reset(재설정)을 클릭하여 모든 값을 기본값으로 되돌립니다.

필터 선택 항목에 따라 검색 결과가 이벤트 요약 표에 표시됩니다.

이벤트 요약 표 사용에 대한 자세한 내용은 대시보드를 사용하여 시스템 이벤트 표시를 참조하십시오.

시스템 상태 모니터링

DR Series 시스템에서 다음 두 가지 방법 중 하나로 시스템 하드웨어의 현재 상태를 모니터링하고 표시할 수 있
습니다.

• Dashboard(대시보드)→ Health(상태)를 사용하여 탐색 패널에서 Health(상태) 페이지에 액세스할 수 있습
니다.

• Dashboard(대시보드) 페이지에서 HW State(HW 상태) 링크를 통해 Health(상태) 페이지에 액세스할 수 있
습니다.

Health(상태) 페이지에 대한 자세한 내용은 상태를 참조하십시오.

대시보드 페이지를 사용하여 시스템 상태 모니터링

Dashboard(대시보드) 페이지를 사용하여 현재 DR Series 시스템 하드웨어 상태를 표시하고 모니터링하려면 다음

을 수행합니다.

1. 탐색 패널에서 Dashboard(대시보드)를 클릭합니다.
Dashboard(대시보드) 페이지에 System State(시스템 상태) 표시줄의 HW State(HW 상태) 링크가 표시되어 제
공됩니다(예: HW State: optimal(HW 상태: 최적)). Dashboard(대시보드)→ Health(상태)를 클릭하여 Health(상
태) 페이지에 액세스할 수도 있습니다.

2. HW State(HW 상태) 링크(예: optimal(최적))를 클릭하여 Health(상태) 페이지를 표시합니다.
Health(상태) 페이지에는 System(시스템) 탭이 기본으로 제공됩니다. 인클로저가 설치되어 있으면 

Enclosure(인클로저) 탭도 포함됩니다(이 릴리스에서는 최대 2개의 확장 선반을 설치할 수 있음). System(시
스템) 탭에는 전면의 디스크 드라이브 위치(0–11), OS 내부 드라이브(12–13), 후면의 팬, 시스템 커넥터, 전원 

공급 장치를 보여주는 섀시 전면 및 후면 모습이 표시됩니다. Enclosure(인클로저) 탭을 클릭하면 전면의 실
제 디스크 위치(0–11)와 후면의 인클로저 커넥터, 팬, 플러그 가능한 드라이브 위치를 보여주는 인클로저 섀
시의 전면 및 후면 모습이 표시됩니다. 확장 선반의 서비스 태그도 표시됩니다. System(시스템) 및 
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Enclosure(인클로저) 탭에는 DR Series 시스템 또는 확장 선반의 모든 주요 구성요소의 현재 상태를 나열하

는 시스템 하드웨어 상태 요약 표가 표시됩니다.

노트: 이 방법은 Dashboard(대시보드) 페이지에서 현재 시스템 상태에 대한 추가 정보를 표시하려는 경
우에 유용합니다.

DR Series 시스템 — 시스템 하드웨어 상태 구성요소

– 전원 공급 장치

– 팬

– 온도

– 스토리지

– 전압

– NIC
– CPU
– DIMM
– NVRAM

인클로저 — 시스템 하드웨어 상태 구성요소

– 전원 공급 장치

– 팬

– 온도

– 스토리지

– 인클로저 관리 모듈(EMM)

대시보드 상태 옵션 사용

탐색 패널을 사용하여 설치된 DR Series 시스템 구성요소(또는 확장 선반 인클로저)의 현재 시스템 상태를 표시

하려면 다음을 수행합니다.

1. Dashboard(대시보드) → Health(상태)를 클릭합니다.
Health(상태) 페이지가 표시됩니다.

2. Health(상태) 페이지의 섀시 전면 및 후면 패널 모습에 마우스를 올려 놓으면 DR Series 시스템 디스크 드라
이브와 OS 드라이브(DR4000 및 DR4100 시스템)의 상태와 이름이 나열된 대화상자가 표시됩니다.
이와 동일한 방법으로 확장 선반 인클로저의 전원 공급 장치와 후면 패널 커넥터의 상태와 이름이 나열된 

대화상자를 표시합니다.

3. System(시스템) 또는 Enclosure(인클로저) 탭 선택에 따라 모든 DR Series 시스템 또는 확장 선반 구성요소에 
대한 상태를 시스템 하드웨어 상태 요약 표에서 볼 수 있습니다.
추가적인 정보를 표시하려면 해당 요약 표에서 각 구성요소를 클릭하여 확장합니다.

노트: Health(상태) 페이지에는 섀시 드라이브(0-11), 전원 공급 장치(PS1 및 PS2), DR4000 시스템의 OS 내
부 드라이브(12 및 13)(DR4100 시스템에서는 OS 드라이브가 후면 섀시에 있음)를 보여주는 DR Series 섀
시 전면 및 후면 모습의 상태가 표시됩니다. 또한 기타 모든 주요 DR Series 시스템 구성요소는 시스템 

하드웨어 상태 표에 나열됩니다(전원 공급 장치, 팬, 온도, 스토리지, 전압, NIC(네트워크 인터페이스 카
드), CPU, DIMM(이중 인라인 메모리 모듈), NVRAM). 설치된 각 확장 선반(Enclosure 1(인클로저 1) 및 

Enclosure 2(인클로저 2))의 경우 Health(상태) 페이지에는 섀시 드라이브(0–11)를 보여주는 확장 선반 섀
시 전면 및 후면 모습의 상태가 표시되고 서비스 태그가 나열됩니다. 인클로저의 시스템 하드웨어 상
태 표에는 전원 공급 장치, 팬, 온도, 스토리지, 인클로저 관리 모듈(EMM)이 나열됩니다.

시스템 구성요소 및 Health(상태) 페이지에 대한 자세한 내용은 상태, 시스템 상태 모니터링 및 대시보드 페이지

를 사용하여 시스템 상태 모니터링을 참조하십시오.
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Understanding DR Series System NICs And Ports

The DR Series system supports the use of the following types of NICs:

• 1-Gigabit Ethernet (GbE) two-port (10-Base T); Dell recommends using CAT6a copper cabling

• 10-GbE two-port (100-Base T); Dell recommends using CAT6a copper cabling

• 10-GbE SFP+ two-port using LC fiber-optic transceivers or twin-axial cabling

The 1-GbE, 10-GbE, and 10-GbE SFP+ NICs configurations bond multiple Ethernet ports into a single interface by default:

• For the 1-GbE ports, this means that the four ports in the DR4000 system (or the six ports in the DR4100 system) 
are bonded together to form one interface connection.

• For the 10-GbE and 10-GbE SFP+ ports, this means that to operate at maximum speed, only the two high-speed 
Ethernet ports are bonded together to form one interface connection.

The DR Series system supports configuring the NICs to use either of the two following supported bonding 
configurations:

• ALB—adaptive load balancing (ALB) is the default; this configuration does not require special switch support, 
but it does require the data source machine to be on the same subnet as the DR Series system. The ALB is 
mediated by the Address Resolution Protocol (ARP).

• 802.3ad—also known as Link Aggregation Control Protocol (LACP) is used for copper-wired Ethernet 
applications; this configuration does require special switch management (the requirement being that it be 
managed from the switch).

For more information, see Configuring Networking Settings.

ALB and the 802.3ad are link aggregation methods that aggregate or combine multiple network connections in parallel to 
increase throughput beyond what a single connection could support.

Link aggregation for Ethernet connections also provides redundancy, in case one of the links fails. The DR Series system 
also comes with a Serial-Attached SCSI (SAS) card for future enhancements.

The DR Series system ships equipped with the 1-GbE, I-GbE, or 10-GbE SFP+ NIC. To visually differentiate between the 
NIC types, observe the markings on the NICs installed in the rear chassis of the DR Series system:

• 1-GbE NIC is labeled as GRN=10 ORN=100 YEL=1000

• 10-GbE NIC is labeled as 10G=GRN 1G=YLW

노트: There are three key requirements to meet if you choose to use the 10-GbE NIC configuration: 1) use only 
CAT6a copper cabling, 2) you must have two switch ports capable of supporting 10-GbE NICs, and 3) you do not 
connect the 1-GbE ports.

노트: There are three key requirements to meet if you choose to use the 10-GbE SFP+ NIC configuration: 1) use 
only Dell-supported SFP+ transceivers, 2) you must have two switch ports capable of supporting 10-GbE SFP+ NICs 
(and LC fiber-optic or twin-axial cabling), and 3) you do not connect the 1-GbE ports.

To verify the types of NICs that are installed in your system, click System Configuration → Networking to display the NIC 
information. For more information, see Configuring Networking Settings. In addition, you can also use the DR Series 
system CLI network --show command to display other NIC-related information.

시스템 사용량 모니터링

현재 DR Series 시스템 사용량을 표시하려면 Dashboard(대시보드) → Usage(사용량)를 클릭하여 Usage(사용량) 
페이지를 표시합니다. 이 페이지에서는 적용되는 Latest Range(최근 범위) 또는 Time Range(시간 범위) 설정을 기
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반으로 시스템 상태와 현재 표시된 시스템 사용량 상태를 모니터링할 수 있습니다. 이러한 설정에 따라 

Usage(사용량) 페이지의 다음과 같은 탭 카테고리에 결과가 표시됩니다.

• CPU 로드

• 시스템

• 메모리

• 활성 프로세스

• 프로토콜

• 네트워크

• 디스크

• 모두

노트: All(모두)을 클릭하면 이 탭에 CPU 로드, 시스템 사용량, 메모리 사용량 - 총계, 메모리 사용량 - 실제, 활
성 프로세스 - 총계, NFS 사용량 - 총계, CIFS 사용량 - 총계, 네트워크 사용량, 소켓 사용량 - 총계, 활성 연결, 
디스크 사용량 - 메타데이터 및 디스크 사용량 - 데이터 스토리지와 같은 DR Series 시스템 상태 카테고리가 

표시됩니다.

Displaying Current System Usage

To display the current usage for a DR Series system, complete the following:

1. Click Dashboard → Usage.
The Usage page is displayed.

2. View the current system usage based on the current Latest Range or Time Range values in effect (the default is the 
last 1-hour period). By default, the CPU Load is always the first tab that displays when the Usage page is selected.
The tabs you can display in the Usage page include: CPU Load, System, Memory, Active Processes, Protocols, 
Network, Disk, and All. For more information, see System Usage.

3. Click any of the system usage tabs to display the current status for that tab category (or click All to display all of the 
system usage tab results).
For example, click Protocols to display the current results for the NFS Usage - Total, CIFS Usage - Total, RDS Usage 
- Total, and OST Usage - Total for the system.

최근 범위 값 설정

Latest Range(최근 범위) 값을 설정하고 이러한 설정을 기반으로 시스템 상태 결과를 표시하려면 다음을 수행합

니다.

1. Dashboard(대시보드) → Usage(사용량)를 클릭합니다.
Usage(사용량) 페이지가 표시됩니다.

2. Latest Range(최근 범위)를 클릭합니다.
3. Range(범위) 드롭다운 목록에서 원하는 기간(Hours(시간), Days(일) 또는 Months(월))을 선택합니다.

기본적으로, 드롭다운 목록의 기간 옵션으로 Hours(시간)가 먼저 표시됩니다.

4. Display last...(다음까지 표시...) 드롭다운 목록에서 선택한 Range(범위) 기간과 일치하는 값을 선택합니다.
예를 들어, 기본 표시 기간인 Hours(시간)는 1-24 중에서 선택할 수 있습니다. Days(일)의 경우 1-31 중에서 선
택할 수 있고 Months(월)는 1-12 중에서 선택할 수 있습니다.

5. Apply(적용)를 클릭합니다.
6. 선택한 설정을 기반으로 표시할 사용량 유형에 해당하는 탭을 클릭하거나 All(모두)을 클릭하여 모든 시스

템 결과를 표시합니다.
자세한 내용은 사용량 및 현재 시스템 사용량 표시를 참조하십시오.
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시간 범위 값 설정 

Time Range(시간 범위) 값을 설정하고 이러한 설정을 기반으로 시스템 상태 결과를 표시하려면 다음을 수행합니

다.

1. Dashboard(대시보드) → Usage(사용량)를 클릭합니다.
Usage(사용량) 페이지가 표시됩니다.

2. Time Range(시간 범위)를 클릭합니다.

3. Start Date(시작 날짜)에서 Start Date(시작 날짜) 필드 또는 Calendar(달력) 아이콘을 클릭하여 현재 월을 표시
합니다.
이전 월을 선택하려면 월 제목 표시줄에서 왼쪽 화살표를 클릭하여 현재 연도 또는 이전 연도에서 원하는 

월을 선택합니다.

4. 선택한 월에서 Start Date(시작 날짜)를 선택하려면 다음 두 가지 방법 중 하나를 수행합니다.

– 선택한 월에서 특정 날짜를 선택합니다.(사용 가능한 날짜만 표시됨). 이후 날짜는 사용 불가능으로 
간주되어 흐리게 표시됩니다.

– Now(현재)를 클릭하여 현재 날짜를 시간 및 분 단위로 선택하거나 Hour(시간) 및 Minute(분) 슬라이
더를 사용하여 원하는 시간 값을 선택합니다.

5. Done(완료)을 클릭하여 Start Date(시작 날짜)에 날짜 및 시간 설정을 표시합니다.
설정하는 날짜와 시간이 mm/dd/yyyy hh:mm AM/PM 형식으로 표시됩니다.

6. End Date(종료 날짜)에서 Start Date(시작 날짜)를 설정한 것과 동일한 과정을 수행하여 종료 날짜를 지정하
거나 Set “End Date” to current time("종료 날짜"를 현재 시간으로 설정)을 선택합니다.

7. Apply(적용)를 클릭합니다.

8. 선택한 설정을 사용하여 모니터링할 사용량 유형에 해당하는 탭을 클릭하거나 All(모두)을 클릭하여 선택한 
설정을 기반으로 시스템 사용량 탭 결과를 모두 표시합니다.

9. 선택한 기준에 따라 DR Series 시스템 사용량 결과를 확인합니다.
Usage(사용량) 페이지에 대한 자세한 내용은 사용량 및 현재 시스템 사용량 표시를 참조하십시오.

컨테이너 통계 모니터링

Dashboard(대시보드) → Statistics: Container(통계: 컨테이너)를 클릭하여 Container Name:(컨테이너 이름:) 드롭다

운 목록에서 선택한 컨테이너의 통계를 모니터링합니다. 다음과 같은 창에 현재 통계가 표시됩니다.

• Backup Data(백업 데이터)

• Throughput(처리량)

• Marker Type(마커 유형)

• Connection Type(연결 유형)

• 복제

자세한 내용은 백업 데이터 창, 처리량 창, 연결 유형 창, 복제 창, 통계: 컨테이너 페이지 및 컨테이너 설정 편집을 

참조하십시오.

Displaying the Statistics: Container Page

To display container statistics for a selected container, complete the following:

1. Click Dashboard→ Statistics: Container.
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The Statistics: Container page is displayed.

2. In the Container Name: drop-down list, select the container you want to monitor.

노트: When you select a container, all statistics displayed on the Statistics: Container page represent specific 
information about the backup data, throughput, replication, marker type, and connection type for the selected 
container. The displayed statistics will vary depending upon the connection type used by the specified 
container.

3. View the current statistics in the Backup Data and Throughput panes.
The Backup Data pane displays the number of active files ingested based on time (in minutes), and the number of 
active bytes ingested based on time (in minutes). The Throughput pane displays the number of read data in 
Mebibytes/per second (MiB/s) based on time (in minutes), and the number of write data in MiB/s based on time (in 
minutes).

노트: The Current Time Zone for the DR Series system is displayed below the Backup Data pane (for example, 
System Time Zone: US/Pacific).

4. In the Backup Data and Throughput panes, click Zoom to select which duration period you want to display:

– 1h (1-hour is the default duration displayed)

– 1d (1-day)

– 5-d (five-day)

– 1m (1-month)

– 1y (1-year)

노트: To refresh the values listed in the Backup Data and Throughput panes, click .

5. The Marker Type pane displays the marker type associated with the container (supported marker types include 
None, Auto, CommVault, Networker, TSM (Tivoli Storage Manager), or ARCserve.
If the Auto marker type is selected, this means all marker types will be detected. If you have a specific marker type 
selected (for example, CommVault), this means you have specified traffic to the container from that DMA type. If 
marker detection for the container is disabled, this means the None marker type is selected.

6. In the Connection Type pane, view information about the configured connection type for the selected container 
which can be NFS, CIFS, NFS/CIFS, RDS, or OST (the following example shows an NFS/CIFS container):

– NFS Connection Configuration pane—NFS access path, Client Access, NFS Options, and Map root to.

– CIFS Connection Configuration pane—CIFS share path and Client Access.

– If the container is an RDA connection type container, the Connection Type OST pane or Connection Type 
RDS — displays three tabs: Capacity, Duplication, and Client Statistics. The Capacity tab displays a 
Capacity pane with Status, Capacity, Capacity Used, and Total Images. The Duplication tab displays a 
Duplication Statistics pane with Inbound and Outbound statistics in the following categories: Bytes Copied 
(logical), Bytes Transferred (actual), Network Bandwidth Settings, Current Count of Active Files, and 
Replication Errors. The Client Statistics tab displays a Client Statistics pane with Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest 
Errors, Bytes Ingested, Bytes Transferred, and Network Savings.

7. In the Replication pane (for NFS/CIFS connection types), view the replication information for the selected container 
in the following two panels:

– Replication Configuration—Enable, Role, Remote Container Name, Bandwidth, and encryption.

– Replication Status—Peer State, Replication State, Replication Average Transfer Rate, Replication Peak 
Transfer Rate, Network Average Transfer Rate, Network Peak Transfer Rate, Estimated Time to Sync (in 
days, hours, minutes, and seconds), Savings (in percentage), Last INSYNC Time (yyyy-mm-dd hh:mm:ss), 
and Schedule Status (next starting time in days, hours, minutes, and seconds).
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복제 통계 모니터링

Dashboard(대시보드) → Statistics: Replication(통계: 복제)을 클릭하여 Replication Filter(복제 필터) 창에서 선택한 

하나 이상의 컨테이너, 하나 이상의 피어 DR Series 시스템에 대한 복제 통계를 표시하고 모니터링할 수 있습니

다. 구성된 설정에 따라 아래 항목의 복제 통계를 모니터링하고 표시할 수 있습니다.

• 모든 컨테이너

• 하나 이상의 특정 컨테이너

• 하나 이상의 다른 DR Series 시스템

Replication Filter(복제 필터) 창에는 Container Filter(컨테이너 필터)에서 선택하는 컨테이너 또는 다른 피어 DR 
Series 시스템에 대한 복제 통계를 표시할 수 있는 10개의 헤더 확인란이 있습니다.

컨테이너, 피어 시스템 및 복제 통계 카테고리를 선택한 후에 Apply Filter(필터 적용)를 클릭하여 선택한 검색 기
준에 맞게 복제 통계 결과를 표시합니다.

Statistics: Replication(통계: 복제) 페이지를 사용하여 모두, 하나 이상의 컨테이너, 하나 이상의 다른 피어 DR 
Series 시스템에 대한 특정 유형의 관련 복제 통계를 선택적으로 필터링하여 표시할 수 있습니다.

복제 통계에 대한 자세한 내용은 복제 통계 표시, 컨테이너 필터 및 통계: 복제 페이지 표시를 참조하십시오.

Displaying the Statistics: Replication Page

To display system replication container statistics for a selected container or another DR Series system, complete the 
following:

1. Click Dashboard→ Statistics: Replication.
The Statistics: Replication page is displayed.

2. To select a container or another peer DR Series system, choose the appropriate Container Filter option.

– Click All to choose all of the replication containers.

– Click Name, press Ctrl, and select the containers in the list box to select one or more containers in the list 
that you want to display.

– Click Peer System, press Ctrl, and select the peer systems in the list box to select one or more peer DR 
Series systems in the list that you want to display.

노트: Only one of the Container Filter options can be active at any one time (they are mutually exclusive).

3. Select the Header check box(es) for the replication statistics categories for which you want to filter and display in 
the Replication Statistics summary table:

– Peer Status

– Replication Status

– Time to Sync

– Progress % (percentage)

– Replication Throughput

– Network Throughput

– Network Savings

– Last Sync in Time

– Peer Container

– Peer Status
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노트: The following five types of replication statistics are enabled by default: Peer Status, Replication Status, 
Network Throughput, Network Savings, and Progress %. If you choose more than five types of statistics 
(when you select additional check boxes), a horizontal scroll bar appears at the bottom of the Replication 
Statistics table. Use this scroll bar to display the columns of additional statistics that may not display within 
the main window.

4. Click Apply Filter to display the replication statistics types you selected to filter for your container or other peer DR 
Series system choices.
The Replication Statistics summary table displays the replication statistics types you selected in the Replication 
Filter pane.

To reset the default settings in the Replication Filter pane, click Reset.

To update the Replication Filter table after making a change, click Apply Filter to display an updated set of 
replication statistics.

노트: Use the horizontal and vertical scroll bars to navigate through the columns of replication statistics 
displayed in the Replication Statistics summary table.

노트: You can set up nightly replication statistics notification mails using the alerts --email --
daily_report yes command. For more information, see the Dell DR Series Systems Command Line Interface 
Guide at dell.com/support/manuals.

CLI를 사용하여 복제 통계 표시

DR Series 시스템 GUI를 사용하여 복제 통계를 표시하는 방법 외에도, DR Series 시스템 CLI stats --replication --
name <container name> 명령을 사용하여 다음과 같은 복제 컨테이너 통계 카테고리를 표시할 수 있습니다.

• 컨테이너 이름(복제 컨테이너의 이름)

• 복제 소스 컨테이너(데이터 소스를 식별하는 이름)

• 복제 소스 시스템(데이터 소스의 IP 주소 또는 호스트 이름)

• 피어 상태(복제 피어의 현재 상태, 예: 일시중지됨)

• 복제 상태(복제 관계의 현재 상태, 예: 비동기화)

• 예약 상태(일, 시간, 분, 초 단위의 현재 상태)

• 복제 평균 처리량(초당 키비바이트, KiB/s)

• 복제 최대 처리량(KiB/s)

• 네트워크 평균 처리량(KiB/s 단위의 평균 처리량)

• 네트워크 최대 처리량(KiB/s 단위의 최대 처리량)

• 전송된 네트워크 바이트 수(메비바이트/MiB 단위의 총 네트워크 바이트 수)

• 중복 제거 네트워크 저장량(% 단위의 총 중복 제거 네트워크 저장량)

• 압축 네트워크 저장량(% 단위의 총 압축 네트워크 저장량)

• 마지막 비동기 시간(yyyy-mm-dd hh:mm:ss 형식의 마지막 동기화 작업 날짜)

• 예상 동기화 시간(다음 동기화 작업이 수행될 때까지의 시간(일, 시간, 분 및 초))

데이터 복제 내역은 복제 타임스탬프 및 기타 파일 관련 정보와 함께 파일 단위로도 표시됩니다.

DR Series 시스템 CLI 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.
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7
DR Series 시스템 지원 옵션 사용
Support(지원) 페이지와 Diagnostics(진단), Software Upgrade(소프트웨어 업그레이드), License(라이센스) 옵션을 

사용하여 DR Series 시스템의 상태를 유지할 수 있습니다. 이러한 옵션에 액세스하려면 DR Series 시스템 탐색 패
널을 사용하거나(예: Support(지원)→ Diagnostics(진단)를 클릭하여 Diagnostics(진단) 페이지 표시) Support(지원) 
페이지에서 Diagnostics(진단), Software Upgrade(소프트웨어 업그레이드) 또는 License(라이센스) 링크를 사용하

십시오.

Support Information Pane
The Support page displays the Support Information pane, which provides the following information about the DR Series 
system:

• Product Name—DR Series system product name

• Software Version—DR Series system software version installed

• Service Tag—DR Series system appliance bar code label

• Last Diagnostic Run—timestamp of latest diagnostics log file (for example, Tue Nov 6 12:39:44 2012)

• BIOS Version—current version of installed BIOS

• MAC Address—current address in standard two-digit hexadecimal grouping format

• iDRAC IP Address—current IP address of iDRAC (if applicable)

• Ethernet Ports—displays information about bonded ports only (if the 10-GbE NICs are installed, it only displays 
information about the two supported 10–GbE ports):

– Eth0 MAC address and port speed

– Eth1 MAC address and port speed

– Eth2 MAC address and port speed in

– Eth3 MAC address and port speed in

노트: This example shows four Ethernet ports bonded (such as if a DR4000 system with 1–GbE ports as a 
single interface). For more information on possible port configurations, see the system chassis 
descriptions in Local Console Connection.

노트: The Support Information pane contains important information that may be needed if you contact Dell Support 
for any technical assistance.

노트: For additional system information, click Dashboard in the navigation panel to display its System Information 
pane, which lists Product Name, System Name, Software Version, Current Date/Time, Current Time Zone, Cleaner 
Status, Total Savings (in percentage), Total Number of Files in All Containers, Number of Containers, Number of 
Containers Replicated, and Active Bytes.

진단 페이지 및 옵션

Diagnostics(진단) 페이지의 옵션을 사용하여 시스템의 현재 상태를 캡처하는 새 진단 로그 파일을 생성하거나

(Generate(생성)), 로컬 시스템에 진단 로그 파일을 다운로드하거나(Download(다운로드)), 기존 진단 로그 파일을 

삭제(Delete(삭제))할 수 있습니다.
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노트: 진단 로그 파일, 로그 파일 디렉터리 및 진단 서비스에 대한 자세한 내용은 진단 서비스 정보를 참조

하십시오.

DR Series 진단 로그 파일은 최신 시스템 설정을 기록하는 다양한 파일 유형이 포함되어 있고 이를 압축된 .lzip 파
일 형식으로 저장하는 번들입니다. Diagnostics(진단) 페이지에서는 다음과 같은 속성으로 각 진단 로그 파일을 

식별합니다.

• 파일 이름 - <hostname>_<date>_<time>.lzip 형식 사용(예: acme-sys-19_2012-10-12_13-51-40.lzip)

노트: 진단 로그 파일 이름은 128자로 제한됩니다.

• 크기 - 메가바이트(예: 58.6 MB).
• 시간 - 로그 파일이 생성된 타임스탬프(예: 10월12일 금요일 13:51:40 2012)
• 생성 이유 - 로그 파일이 생성된 이유(예: [admin-generated]: 관리자가 생성함)

노트: 진단 이유 설명은 512자로 제한되며 이 설명을 추가하려면 DR Series 시스템 CLI를 사용해야 합
니다.

• 상태 - 로그 파일의 상태(예: 완료됨)

다음과 같은 두 가지 방법으로 Diagnostics(진단) 페이지를 표시할 수 있습니다.

• Support(지원) 페이지 사용(Diagnostics(진단) 링크를 통해 Diagnostics(진단) 페이지에 액세스)
• Support(지원) → Diagnostics(진단) 사용(탐색 패널에서 Diagnostics(진단) 페이지에 액세스)

진단 로그 파일의 페이지가 여러 개일 경우 진단 요약 표 하단에 있는 컨트롤을 사용하여 다른 페이지를 탐색할 

수 있습니다.

• prev(이전) 또는 next(다음)를 클릭하여 앞 페이지 또는 뒤 페이지로 이동합니다.
• Goto page(페이지로 이동) 옆에 있는 페이지 번호를 두 번 클릭합니다.
• Goto page(페이지로 이동)에 페이지 번호를 입력하고 Go(이동)를 클릭합니다.
• 진단 요약 표 오른쪽의 스크롤 막대를 사용하여 표시할 수 있는 모든 진단 로그 파일을 확인합니다.

노트: 진단 요약 표에서 페이지당 표시할 항목 수를 설정할 수도 있습니다. View per page(페이지당 표시) 드
롭다운 목록에서 25 또는 50개를 선택하여 표시할 항목 수를 선택합니다.

Generating a Diagnostics Log File 

A DR Series diagnostics log file is a bundle that contains a variety of file types that record the latest system settings, and 
saves them in a compressed .lzip file format. The Diagnostics page identifies each diagnostics log file by the following 
attribute types:

• File name
• Size
• Time
• Reason for generation
• Status

노트: When you generate a diagnostics log file bundle, it contains all of the DR Series system information that may 
be needed when contacting Dell Support for technical assistance.

The diagnostics log file bundle collects the same type of hardware, storage, and operating system information collected 
by the Dell System E-Support Tool (DSET) from the Dell DR Series system hardware.

The diagnostics log file bundle is identical to one created using the DR Series system CLI diagnostics --collect --dset 
command. System diagnostics information can assist Dell Support when troubleshooting or evaluating your DR Series 
system.
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To generate a diagnostics log file bundle for your system, complete the following:

1. Select Support → Diagnostics in the navigation panel.
The Diagnostics page is displayed, and this page lists all current diagnostics log files.

2. Click Generate.
A New log file is scheduled dialog is displayed.

3. To verify that a new diagnostics log file is being generated, check the status of the diagnostics log file by selecting 
Support → Diagnostics.
The Diagnostics page is displayed, and a status showing In-progress indicates that a new diagnostics log file is 
being generated.

Once completed, the new diagnostics log file resides at the top of the File Name column in the table. To verify, check its 
timestamp (using its date and time), to ensure this is the latest diagnostics file created.

노트: When you generate a diagnostics log file bundle, it contains all of the DR Series system information that may 
be needed when contacting Dell Support for technical assistance. This also includes all the previous auto-
generated diagnostics log files, which are then deleted from the DR Series system.

The diagnostics log file bundle collects the same type of hardware, storage, and operating system information collected 
by the Dell System E-Support Tool (DSET) from the Dell DR Series system appliance hardware:

• To collect a DSET log file, use the DR Series system CLI command, diagnostics --collect --dset.

• To collect the comprehensive DR Series system diagnostics log file bundle (which also includes DSET 
information), use the DR Series system CLI command, diagnostics --collect.

진단 로그 파일 다운로드

Diagnostics(진단) 페이지를 표시하고 기존 진단 로그 파일을 열거나 다운로드하려면 다음을 수행합니다.

1. 탐색 패널에서 Support(지원)→ Diagnostics(진단)를 클릭합니다.
시스템에서 허용되는 현재 모든 진단 로그 파일이 나열된 Diagnostics(진단) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 다운로드할 진단 로그 파일을 식별하고 Download(다운로드)를 클릭하거나 진단 로
그 파일 이름 링크를 한 번 클릭합니다.
File Download(파일 다운로드) 대화상자가 표시됩니다.

노트: 새 진단 로그 파일 생성 중에 있으면(상태가 진행 중으로 표시됨) 진단 로그 파일 이름 링크가 활
성화되지 않으며 이 파일을 선택하려고 시도하면 Download(다운로드) 옵션이 비활성화됩니다.

3. 다음과 같은 사항에 따라 원하는 위치에 파일을 다운로드합니다.
a) Linux 기반 시스템에서 DR Series 시스템 GUI에 액세스하는 경우: Save File(파일 저장) 을 클릭하고 다른 

폴더 위치로 이동하여 새 파일 이름을 정의하거나 기존 파일 이름을 유지한 후 Save(저장)를 클릭하여 
지정된 폴더 위치에 진단 로그 파일을 저장합니다.

b) Windows 기반 시스템에서 DR Series 시스템 GUI에 액세스하는 경우: Save(저장) 또는 Save As(다른 이름
으로 저장)를 클릭하고 Downloads(다운로드) 폴더로 이동하여 진단 파일 로그를 검색합니다.

진단 로그 파일 삭제

Diagnostics(진단) 페이지의 진단 요약 표에서 기존 진단 로그 파일을 삭제하려면 다음을 수행합니다.

1. Support(지원) → Diagnostics(진단)를 선택합니다.
Diagnostics(진단) 페이지가 표시됩니다.

2. Select(선택)를 클릭하여 삭제할 진단을 선택하고 Delete(삭제)를 클릭합니다.
Delete Confirmation(삭제 확인) 대화상자가 표시됩니다.

115



3. OK(확인)를 클릭하여 선택한 진단 로그 파일을 삭제하거나 Cancel(취소)을 클릭하여 Diagnostics(진단) 페이
지를 표시합니다.
성공하면 Log file was removed successfully(로그 파일 제거 완료) 대화상자가 표시됩니다.

DR Series System Software Upgrade
When you initiate a DR Series system software upgrade, the navigation panel displays only the Support page and the 
Software Upgrade options.

The administrator that initiated the software upgrade (considered the initiator administrator) will see a System 
Information pane that displays an alert that reads IMPORTANT: Please do not navigate out of this 
screen until the upgrade is finished, and displays the upgrade status as Upgrade in 
Progress... Please wait.... The Current Version and Upgrade History versions of the DR Series system 
software are listed in the Software Info pane.

All other administrators that may be logged into DR Series system (with the exception of the initiator administrator who 
started the software upgrade), will only see a dialog that displays Status: The system is being 
upgraded. Wait for it to become operational.

There are only three possible outcomes during a DR Series system software upgrade operation:

• The upgrade operation completed successfully—no reboot is required.

• The upgrade operation completed successfully—but a reboot is required (click Reboot in the Software Upgrade 
page).

• The upgrade operation failed.

소프트웨어 업그레이드 페이지 및 옵션

Software Upgrade(소프트웨어 업그레이드) 페이지를 사용하여 Software Information(소프트웨어 정보) 창에서 설
치된 DR Series 시스템 소프트웨어의 현재 버전을 확인하거나 시스템에 업데이트를 적용할 수 있습니다. 두 가지 

방법으로 Software Upgrade(소프트웨어 업그레이드) 페이지를 표시할 수 있습니다.

• Support(지원) 페이지에서 Software Upgrade(소프트웨어 업그레이드)를 클릭합니다.

• 탐색 패널에서 Support(지원) → Software Upgrade(소프트웨어 업그레이드)를 선택합니다.

이 두 방법 모두 Software Upgrade(소프트웨어 업그레이드) 페이지를 표시하며 현재 설치된 버전 확인, 이전에 설
치된 소프트웨어 버전의 업그레이드 내역 확인, iDRAC IP 주소 확인(설치된 경우), 업그레이드 프로세스 시작 또
는 이 페이지의 옵션을 사용하여 DR Series 시스템 재부팅을 할 수 있습니다.

노트: DR Series 시스템 소프트웨어가 업그레이드되는 거의 전체 기간 동안 업그레이드 상태가 "시작 중"으
로 계속 표시됩니다. 시스템 업그레이드 프로세스가 완전히 완료되는 "거의 완료됨" 상태로 변경되지 않습

니다.

Verifying the Current Software Version 

To verify the currently installed version of the DR Series system software, complete the following:

노트: You can verify the version of the installed DR Series system software in the Dashboard page (in the System 
Information pane), the Support page (in the Support Information pane), and the Software Upgrade page (in the 
Software Information pane).

The following procedure documents the process from the Software Upgrade page.

1. In the navigation panel, select Support and click Software Upgrade (or select Support→ Software Upgrade).
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The Software Upgrade page is displayed.

2. Verify the currently installed DR Series system software version listed as Current Version in the Software 
Information pane (all previously installed versions are listed under Upgrade History, showing the version number 
and timestamp when installed).

Upgrading the DR Series System Software

To upgrade the DR Series system software, complete the following:

노트: The DR Series system only supports the copying of upgrade images and diagnostics files to and from the 
system using WinSCP. The DR Series system does not support the copying or deleting of any other file types using 
WinSCP. To use WinSCP to copy DR Series software upgrade and diagnostics log files, ensure that the File 
Protocol mode is set to SCP (Secure Copy) mode.

노트: You can use other SCP tools with the DR Series system, but you cannot use these other SCP tools to copy 
other types of files to or from the DR Series system.

1. Using the browser, go to support.dell.com, navigate to the DR4000 product page, and enter your service tag.

2. In the Dell DR Series Drivers & Downloads page, click Find Drivers & Downloads.
The Drivers & Downloads page displays a listing of downloadable firmware, utilities, applications, and drivers for 
the DR Series system.

3. Locate the IDM section of the Drivers & Downloads page, which includes the Dell-Utility (DR Series Upgrade File) in 
the format, DR4x00-x.x.x.x-xxxxx.tar.gz, and showing its release date and version.

4. Click Download File, click For Single File Download via Browser, and click Download Now.
The File Download dialog is displayed.

5. Click Save to download the latest system software upgrade file to the DR Series system that is running the browser 
session started by the DR Series administrator.

6. Using the DR Series system GUI, select Support, and click the Software Upgrade link (or select Support → 
Software Upgrade).
The Software Upgrade page is displayed.

7. Type the path of the software upgrade file in the Select the upgrade file from local disk (or click Browse..., and 
navigate to the location where you downloaded the system software upgrade file).

8. Select the software upgrade file, and click Open.

9. Click Start Upgrade.
When you initiate a DR Series system software upgrade, the navigation panel displays only the Support page and 
the Software Upgrade option.

The administrator that initiated the software upgrade (known as the initiator administrator) sees a System 
Information pane that displays an alert and upgrade status, and the Current Version and Upgrade History versions 
of the DR Series system software listed in the Software Info pane.

All other administrators that may be logged into DR Series system (excluding the initiator administrator), only.

There are only three possible outcomes during a DR Series system software upgrade operation:

– Upgrade has completed successfully—no reboot is required.

– Upgrade has completed successfully—but a reboot is required (click Reboot in the Software Upgrade 
page).

– Upgrade has failed.
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노트: If the DR Series system software upgrade operation fails, you can reboot the system and attempt 
another software upgrade operation using the DR Series system GUI. If this is unsuccessful, you can use the 
DR Series system CLI system --show command to view the current System State status. DR Series system 
software upgrades can also be performed using the DR Series system CLI. For details, see the Dell DR Series 
System Command Line Reference Guide at dell.com/support/manuals/. If both the DR Series system GUI and 
CLI attempts are unsuccessful, contact Dell Support for assistance.

Restore Manager (RM)
The Dell Restore Manager (RM) utility can be used to restore the DR Series system software. RM can be used when a 
non-recoverable hardware or software failure prevents the DR Series system from functioning correctly.

RM can also be used to reset the system back to its initial factory settings when moving it from a test environment to a 
production environment. RM supports the following two modes:

• Recover Appliance—in Recover Appliance mode, RM reinstalls the operating system and attempts to recover 
the prior system configuration and the data residing in the containers.

노트: To use the Recover Appliance mode, you must use an RM build that is compatible with the DR Series 
system software version that was running before the OS reset was attempted.

• Factory Reset—in a Factory Reset mode, RM reinstalls the operating system and resets the system 
configuration back to the original factory state. It is important to note that when doing a factory reset, all of the 
containers and the data in the containers gets deleted.

주의: Using the Factory Reset mode deletes all of the DR Series system data. The Factory Reset mode must only be 
used when the container data is no longer needed.

Downloading the Restore Manager

The Dell Restore Manager (RM) utility runs from a USB boot key that contains the RM image, which must first be 
downloaded from the Dell Support site.

1. Using a supported web browser, navigate to support.dell.com.

2. Enter the DR4100 system Service Tag to be directed to the DR Series system download page (or choose a product 
category).

3. Navigate to the Drivers & Downloads page.

4. In the Category drop-down list, select IDM.

5. If required, expand the IDM category to list the available IDM download files.

6. Locate, select, and download the DR4100 Restore Manager file (listed in the following RM filename format, "DR4000-
UM-x.x.x.xxxxx.tag.gz").

복원 관리자 USB 키 생성

복원 관리자(RM) USB 키를 생성하려면 Dell 지원 사이트에서 RM 이미지 파일(.img)을 다운로드하여 USB 키에 전
송해야 합니다. USB 키의 크기는 4 GB(기가바이트) 이상이어야 합니다. Windows USB 이미지 도구를 사용하면 다
음과 같은 조건이 충족될 때 RM 이미지를 전송할 수 있습니다.

• .img 파일 형식 사용 지원

• USB 키를 부팅할 수 있도록 블록 장치 간의 직접 복사 지원
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Linux 또는 Unix 시스템에서 RM 이미지를 USB 키로 전송하려면 다음을 수행합니다.

1. 다운로드한 RM 이미지 파일을 Linux 또는 Unix 시스템에 복사합니다.

2. Linux 또는 Unix 시스템에서 사용 가능한 USB 포트에 USB 키를 삽입합니다.
운영 체제에서 보고된 장치 이름을 기록합니다(예: /dev/sdc4).

3. 이때 파일 시스템에 USB 장치를 로컬로 장착하지 마십시오.

4. dd 명령을 사용하여 RM 이미지를 USB 키에 복사합니다.
dd if=<path to .img file> of=<usb device> bs=4096k

예를 들어, 다음과 같습니다.

dd if=/root/DR4100-UM-04.49.01.00.00.34555.img of=/dev/sdc4 bs=4096

복원 관리자(RM) 실행

Dell 복원 관리자(RM) 유틸리티를 실행하려면 RM USB 키 만들기에서 생성된 RM USB 키를 사용하여 DR Series 시
스템을 부팅하십시오.

1. 시스템에서 사용 가능한 USB 포트에 RM USB 키를 삽입합니다.
iDRAC의 가상 매체 옵션을 사용하여 원격으로 RM USB 키를 로드할 수도 있습니다. 자세한 내용은 

support.dell.com/support/edocs/software/smdrac3/에서 iDRAC6(Integrated Dell Remote Access Controller 6)에서 
가상 매체 구성 및 사용에 대한 사용 설명서를 참조하십시오.

2. RM USB 키를 사용하여 DR Series 시스템을 부팅합니다.

3. POST(Power-On Self-Test) 화면이 표시되는 동안 F11을 눌러 Boot Manager(부팅 관리자)를 로드합니다.

4. 부팅 관리자 내에서 시스템 하드 드라이브(C:)를 탐색하고USB 키를 부팅 장치로 선택한 다음 <Enter>를 누릅
니다.

5. 몇 분 후 복원 관리자가 기본 화면을 로드하고 표시합니다.

6. 원하는 Restore(복원) 모드(Recover Appliance(복구 어플라이언스) 또는 Factory Reset(공장 재설정))를 선택합
니다.

7. 확인 문자열을 입력하고 <Enter> 키를 눌러 계속해서 진행합니다.

주의: Factory Reset(공장 재설정) 모드는 모든 DR Series 데이터를 삭제합니다. Factory Reset(공장 재설

정) 모드는 컨테이너 데이터가 더 이상 필요하지 않을 때만 사용해야 합니다.

노트: 복원 관리자가 완료되면 관리자 계정만 활성 상태로 유지됩니다. 루트 또는 서비스 계정을 다시 

활성화하려면 Dell DR Series 시스템 명령행 참조 안내서에서 DR Series 시스템 CLI user --enable --user 
명령을 참조하십시오.

노트: 복원 관리자를 실행하기 이전에 DR Series 시스템이 Active Directory Services(ADS) 도메인에 가입

되어 있는 경우 복원 관리자 실행이 완료된 후에는 필요한 ADS 도메인에 수동으로 다시 가입해야 합니

다. ADS 도메인 가입에 대한 자세한 내용은 Active Directory 설정 구성을 참조하십시오.

Resetting the Boot LUN Setting in PERC H700 BIOS After Running RM

In the event that both of the 2.5-inch 300 GB 10K RPM 6 GB/s SAS internal drives (OS) in RAID1 are replaced, you must 
run the Dell Restore Manager (RM) utility to recover the DR Series system OS drives.

Following the RM recovery process, the boot logical unit number (LUN) has to be reset to VD0 RAID1. The DR Series 
system unsuccessfully attempts to boot from RAID6 instead of RAID1.
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To resolve this issue, reset the Dell PERC H700 BIOS to revise the proper boot order setting to configure the proper boot 
LUN to be RAID1. To reset the proper LUN boot order, complete the following steps:

1. Start Restore Manager.

2. Select Option 1 → Recover My Appliance.
The OS Virtual Disk is created: Warning Code 2002 dialog is displayed.

3. Click Proceed.
The Operating System installation was successful dialog is displayed.

4. Click Reboot, and during reboot, press Ctrl+R to enter the PERC BIOS.
The PERC BIOS Configuration Utility page is displayed.

5. Select Controller 0: PERC H700 in the list.

6. Press Ctrl+N twice to select the Ctrl Mgmt (Controller Management) tab.

7. Select Ctrl Mgmt, click Select bootable VD, and select VD 0 as the VD0 RAID1.

8. Click Apply, and reboot the DR Series system.
The RM Recover My Appliance mode process will then complete.

하드웨어 제거 또는 교체

DR Series 시스템 하드웨어를 올바르게 제거하거나 교체하려면 종료 및 시작 절차의 모범 사례를 검토하여 활용

해야 합니다. 단계별 지침이 있는 포괄적인 제거 및 교체 절차를 보려면 Dell DR Series 시스템 소유자 매뉴얼을 

참조하십시오.

모범 사례에 대한 자세한 내용은 DR Series 시스템: 올바른 종료 및 시작 및 DR Series 시스템 종료를 참조하십시

오.

DR Series 시스템: 올바른 종료 및 시작

DR Series 시스템에서 하드웨어 구성부품을 분리하거나 교체하기 전에 시스템을 올바르게 종료하고 시작하는 

모범 사례를 검토하십시오.

1. System Configuration(시스템 구성) 페이지에서 Shutdown(종료)을 선택하여 DR Series 시스템의 전원을 끕니
다.
자세한 내용은 DR Series 시스템 종료를 참조하십시오. DR Series 시스템 CLI 명령 system --shutdown을 사용

하여 종료할 수도 있습니다.

2. DR Series 시스템의 전원이 완전히 꺼질 때까지 기다립니다.
전원이 완전히 꺼지면 전원 공급 장치 상태 표시등이 꺼집니다.

3. 전원 콘센트에서 DR Series 시스템 전원 케이블을 분리합니다.

4. 추가 시간(최대 10분) 동안 기다리거나 시스템 섀시의 후면 패널에 있는 녹색 및 황색 NVRAM LED가 모두 꺼
져 있는지 확인합니다.

노트: NVRAM 슈퍼 커패시터를 방전시키지 않으면 나중에 DR Series 시스템의 전원을 켤 때 NVRAM 상
태가 데이터 손실로 표시됩니다.

5. 분리 래치 잠금 장치를 풀고 DR Series 시스템 덮개를 뒤로 밀어 어플라이언스 내부 구성부품에 액세스합니
다.
DR Series 시스템 내부에 액세스하려면 덮개를 제거합니다. 자세한 내용은 Dell DR Series 시스템 소유자 매
뉴얼에 설명된 절차를 참조하십시오.

6. 필요에 따라 시스템 하드웨어 구성부품을 분리하고 교체합니다.

7. 덮개를 다시 장착하고 전원 콘센트에 시스템 전원 케이블을 다시 연결합니다.

8. 전원 켜짐 표시등/전원 단추를 눌러 DR Series 시스템의 전원을 켭니다.
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DR Series 시스템 및 NVRAM:

NVRAM은 DR Series 시스템에서 FRU(Field Replaceable Unit)입니다. NVRAM DDR(double-data rate) 메모리의 동력

인 슈퍼 커패시터는 전원이 유실된 동안에 내용을 SSD(Solid State Drive)로 이동할 수 있어야 합니다.

이렇게 데이터를 전송하려면 시스템이 3분 동안 작동되도록 전원을 유지해야 합니다(일반적으로 약 1분 정도 소
요). SSD로 데이터를 백업하는 동안 문제가 발생하면 이후에 시스템을 다비 부팅하면 이를 감지합니다. 다음과 

같은 상황에서 NVRAM에 백업 오류가 발생할 수 있습니다.

• 전원이 중단된 동안 NVRAM이 데이터 백업에 실패했습니다.

• 슈퍼 커패시터가 SSD에 DDR 내용을 백업할 수 있는 충분한 전원을 유지하지 않는 경우.

• NVRAM/SSD에 줄 끝(EOL) 또는 다른 오류가 발생하는 경우.

이러한 상태가 발생하면 NVRAM에서 오류 복구 또는 교체를 수행해야 합니다.

노트: NVRAM을 교체하기 전에 DR Series 시스템 CLI 명령 system --shutdown 또는 system --reboot 중 하나를 

사용하여 NVRAM에서 RAID6으로 DR Series 시스템 데이터를 플러싱하는 것이 좋습니다.

노트: DR Series 시스템에서 NVRAM을 분리하거나 교체해야 하는 경우 DR Series 시스템 종료 및 NVRAM 현
장 교체를 참조하십시오.

NVRAM 백업 오류 복구

DR Series 시스템 섀시의 PCIe x4 또는 x8 슬롯에서 NVRAM 카드를 물리적으로 교체한 후 다음 작업을 완료하여 

NVRAM 백업 오류에서 복구할 수 있습니다.

주의: DR Series 시스템 CLI maintenance --hardware --reinit_nvram 명령을 사용하기 전에 DR Series 시스템의 

전원을 켠 후 20분 이상 기다려야 합니다. 이 기간 동안에 DR Series 시스템의 올바른 작동에 필요한 NVRAM 
카드, 슈퍼 커패시터 보정, SSD(Solid State Drive) 프로세스가 완전히 완료됩니다.

유지 관리 모드에서 DR Series 시스템은 데이터 유실을 판별, 감지, 복구합니다. 시스템이 다시 부팅되는 동안에

는 NVRAM에 중요한 데이터가 남아 있지 않은지 확인합니다.

1. DR Series 시스템 CLI 명령 maintenance --hardware --reinit_nvram을 입력합니다.
이는 SSD를 포맷하고 NVRAM을 다시 초기화하여 모든 백업 및 복원 로그를 지웁니다.

2. DR Series 시스템이 유지 관리 모드로 전환되는지 확인합니다.
NVRAM 교체에 대한 자세한 내용은 NVRAM 현장 교체 및 DR Series 시스템: 올바른 종료 및 시작을 참조하십

시오.

NVRAM 현장 교체

현장에서 DR Series 시스템 NVRAM을 교체할 때마다 모범 사례 절차를 검토해야 합니다.

주의: DR Series 시스템 CLI 명령 maintenance --hardware --reinit_nvram을 사용하기 전에 DR Series 시스템의 

전원을 켠 후 20분 이상 기다려야 합니다. 이 기간 동안에 DR Series 시스템의 올바른 작동에 필요한 NVRAM 
카드, 슈퍼 커패시터 보정, SSD 프로세스가 완전히 완료됩니다.

노트: 자세한 내용은 DR Series 시스템: 올바른 종료 및 시작을 참조하십시오.

1. DR Series 시스템 소프트웨어가 시스템의 신규 NVRAM을 감지하는지 확인합니다.

2. DR Series 시스템 CLI 명령 maintenance --hardware --reinit_nvram을 입력합니다.
이 명령은 NVRAM을 초기화하고, 새 파티션을 생성하고, DR Series 시스템 소프트웨어에서 내부적으로 사용

된 정보를 업데이트합니다.

3. DR Series 시스템이 유지 관리 모드로 전환되는지 확인합니다.
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올바르게 초기화되면 DR Series 시스템이 자동으로 유지 관리 모드로 전환됩니다. 파일 시스템 검사기가 모
든 블록맵과 데이터스토어를 조사하여 장애가 발생한 NVRAM으로 인해 얼마나 많은 데이터가 유실되었는

지 판별합니다.

122



8
OST 구성 및 사용
이 주제에서는 주요 OpenStorage Technology(OST) 작업에 대해 설명하며 이러한 작업을 수행할 수 있는 절차가 
포함된 기타 OST 관련 주제로 연결되는 링크를 제공합니다.

• OST 및 지원되는 DMA에 사용하도록 DR Series 시스템 구성. 자세한 내용은 Backup Exec GUI를 사용하여 
DR Series 시스템 구성 및 NetBackup을 사용하여 DR Series 시스템 정보 구성을 참조하십시오.

• DR Series 시스템 GUI를 사용하여 LSU(Logical Storage Unit) 구성. 자세한 내용은 LSU 구성을 참조하십시
오.

• 지원되는 매체 서버(Linux 또는 Windows)에 Dell OST 플러그인 설치. 자세한 내용은 Linux용 OST 플러그인 
설치 또는 Windows용 OST 플러그인 설치를 참조하십시오.

• 지원되는 Symantec DMA(NetBackup 및 Backup Exec)를 사용하여 백업 및 복원 작업 수행. 자세한 내용은 
다음을 참조하십시오.

– NetBackup을 사용하여 DR Series 시스템에서 데이터 백업

– NetBackup을 사용하여 DR Series 시스템에서 데이터 복원

– NetBackup을 사용하여 DR Series 시스템 간에 백업 이미지 복제

– Backup Exec을 사용하여 DR Series 시스템에서 백업 생성

– Backup Exec을 사용하여 DR Series 시스템에서 데이터 복원

– Backup Exec을 사용하여 DR Series 시스템 간에 중복 최적화

노트: Dell에서 DR 빠른 데이터 액세스라고도 하는 OST 기능은 이 릴리스에서 지원되고 Symantec 
OpenStorage 사용 가능한 두 개의 백업 응용프로그램인 NetBackup 및 Backup Exec과 같은 백업 소프트웨어 
응용프로그램과 세부적으로 통합합니다.

OST 이해

OpenStorage Technology(OST)는 네트워크 스토리지 장치에 사용할 수 있는 논리 디스크 인터페이스를 제공하며, 
DR Series 시스템에는 다음과 같은 지원되는 DMA(데이터 관리 응용프로그램)과 데이터 스토리지 작업을 통합할 
수 있는 플러그인 소프트웨어가 필요합니다.

• NetBackup

• Backup Exec

DR Series 시스템은 NetBackup 및 Backup Exec가 백업 이미지의 생성, 복제, 삭제 시기를 제어할 수 있는 Dell 
OpenStorage 플러그인을 사용하여 지원되는 DMA와 통합합니다. 플러그인을 통해 DMA는 복제 및 데이터 중복 

제거 등과 같은 주요 DR Series 시스템 기능을 활용할 수 있습니다.

DR Series 시스템은 Dell OST 플러그인을 통해 OpenStorage API 코드에 액세스합니다. 이 플러그인은 지원되는 매
체 서버 플랫폼 유형(Windows 또는 Linux)에 설치할 수 있습니다. DR Series 시스템에 OST를 사용하면 다음과 같
은 이점을 얻을 수 있습니다.

• OST는 보다 빠르고 향상된 데이터 전송을 제공합니다.

– 최소한의 오버헤드로 백업 수행 가능

– 대규모 데이터 전송 크기 관리

– CIFS 또는 NFS보다 현저히 향상된 처리량 제공
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• OST 및 DMA 통합:

– OpenStorage API를 통해 DMA와 매체 서버 소프트웨어 간의 통신 가능

– DMA를 크게 변경하지 않고도 DR Series 시스템 스토리지 기능을 사용할 수 있음

– 기본으로 제공되는 DMA 정책을 사용하여 백업 및 복제 작업이 간소화됨

• DR Series 시스템 및 OST 포트와 쓰기 작업:

– 제어 채널이 TCP 포트 10011 사용

– 데이터 채널이 TCP 포트 11000 사용

– 최적화된 쓰기 작업으로 인해 클라이언트측 중복 제거 가능

• DR Series 시스템 간의 복제 작업:

– 소스 또는 대상 DR Series 시스템에서 구성이 필요하지 않음

– 복제는 컨테이너 기반이 아닌 파일 기반

– DMA 최적화된 중복 작업에 의해 복제 트리거됨

– DR Series 시스템이 데이터 파일 전송(매체 서버 아님)

– 중복 작업 후에 DR Series 시스템이 DMA에 카탈로그를 업데이트하라고 알림(보조 백업 승인)

– 소스와 복제 간에 다양한 보존 정책 지원

– DR Series 시스템이 아닌 DMA 자체에 복제가 설정됨

OpenStorage Technology(OST) API
OpenStorage Technology(OST) API는 DR Series 시스템과 같은 디스크 기반 장치가 두 개의 지원되는 Symantec 
DMA(Data Management Applications), NetBackup 및 Backup Exec와 기본적으로 통합되도록 하는 응용프로그램 프
로그래밍 인터페이스입니다. 예를 들어, DR Series 시스템은 데이터 중복 제거와 복제 둘 다 지원하기 때문에 

OST API를 사용하면 지원되는 DMA에서 DR Series 시스템 어플라이언스 기능을 사용하여 스토리지 어플라이언

스 간에 최적화된 데이터를 복제할 수 있습니다.

OST API를 사용하면 데이터 쓰기 작업이 가능합니다. 다음 예에서 그림으로 설명된 바와 같이, OST API를 사용하

여 NetBackup(DMA)이 DR Series 시스템(데이터 백업 및 중복 제거 장치)과 상호 작용합니다.

• NetBackup은 파일을 디스크에 저장해야 합니다. 이렇게 하기 위해 NetBackup은 백업해야 할 파일과 파일
의 어떤 이름으로 지정할지를 OST API를 통해 DR Series 시스템에 알립니다.

• DR Series 시스템은 이 파일을 수락하고 이를 파일 시스템에 저장합니다.

• 그러면 NetBackup은 저장된 특정 파일을 사용하여 다음과 같은 세 가지 작업 중 하나를 수행할 수 있습니
다.

– 파일 만료

– 파일에서 복원

– 파일 복사 또는 복제

• NetBackup이 OST API를 사용하여 저장된 파일이 DR Series 시스템에서 만료되도록 하는 경우 파일 시스
템에서 파일을 삭제합니다.

• 마찬가지로, NetBackup이 OST API를 사용하여 저장된 파일에서 복원하려는 경우 복원할 파일을 DR 
Series 시스템에 알려주고 복원할 수 있도록 저장된 파일을 NetBackup에 전달하도록 지시합니다.

노트: OST에는 최적화된 중복이라고 하는 기능이 있습니다. 예를 들어, 최적화된 중복에서 DMA(NetBackup)
는 장치 A가 장치 B에서 최적화된 중복을 수행하도록 지시합니다. 장치 A와 B는 상호 통신하여 장치 B에 사
용하기 위해 A에서 B로 복제해야 할 파일의 데이터 세그먼트를 결정하여 장치 B에 완전한 전체 중복 데이

터 파일이 포함되도록 합니다. 이 작업에 성공하면, DMA는 이 데이터 파일의 두 사본을 인식하게 되어 장치 

B에 상주하는 다른 데이터 파일처럼 이 파일을 사용할 수 있습니다.
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OST 지침

최상의 결과를 위해, 다음 지침을 검토하여 DR Series 시스템의 지원되는 OpenStorage Technology(OST) 작업에서 
최적의 성능을 달성할 수 있습니다.

• 백업, 복원 및 최적화된 중복 작업은 Dell OST 플러그인을 통해 수행해야 합니다.

노트: Dell OST 플러그인은 클라이언트측 중복 제거를 지원할 수 있도록 클라이언트 시스템에 설치
해야 합니다.

• 최적의 지원되는 집계 처리 속도:

– 패스트루 쓰기 작업의 경우 3 TB/시

– 최적화된 쓰기 작업의 경우 4 TB/시

노트: 패스트루 쓰기는 데이터에 최적화를 적용하지 않고 매체 서버에서 DR Series 시스템으로 데이
터를 보내는 시점입니다. 반면에, 최적화된 쓰기는 데이터에 최적화를 적용한 후에 매체 서버에서 
DR Series 시스템으로 데이터를 보내는 시점입니다.

• 백업:

– 패스트루 쓰기

– 최적화된 쓰기

• 복원

• 복제

OST Terminology
This topic introduces and briefly defines some basic OpenStorage Technology (OST) terminology used throughout the 
DR Series system documentation.

Term Description

BE Symantec DMA, Backup Exec (BE).

DMA/DPA Data Management Application (also known as Data Protection 
Application), which are terms for the role played by the Symantec 
NetBackup or Backup Exec applications.

LSU Logical Storage Unit, which from the DR Series system perspective, 
represents any container created for data storage. LSU is a common 
storage term while container is a common term in DR Series systems 
that represents a location for storing data.

media server This is the host running the DMA media server (NetBackup and Backup 
Exec), and is where the OST plug-in is installed. The OST plug-in can 
also be installed on a NetBackup client.

NBU Symantec DMA, NetBackup (NBU).

OST The OpenStorage Technology from Symantec, which allows storage 
devices to deliver backup and recovery solutions with NetBackup. OST 
uses the OpenStorage API and a plug-in installed on either a Linux or a 
Windows-based media server platform.
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Supported OST Software and Components
This topic provides a brief listing of some of the supported OST software and components that can be used with the DR 
Series system.

노트: For the latest list of supported DMAs and OST plug-ins, see the Dell DR Series System Interoperability Guide, 
at support.dell.com/manuals.

표 5. Supported OST Software and Components

Software or Component Description

OST Server Components

Media Server Component resides on the DR Series system

• Linux installations • Uses a Linux OST plug-in and the Red Hat Package 
Manager (RPM) installer

• Windows installations • Uses a Windows OST plug-in and the Microsoft installer 
(MSI)

OST Plug-In Component

Windows-based 64–bit Supported releases:

• Windows Server 2003
• Windows Server 2008
• Windows Server 2008, Release 2

Linux-based 64–bit Supported releases:

• Red Hat Enterprise Linux, version 5.x
• Red Hat Enterprise Linux, version 6.x
• SUSE Linux Enterprise Server, version 10 and 11

OST Protocol

Symantec OpenStorage Supported releases:

• Symantec, versions 9 and 10

Supported DMAs

Symantec (Linux and Windows 64–bit versions) Supported releases:

• NetBackup

– Versions 6.5, 7.1, and 7.5 (Windows Server 2003, 
32–bit)

– Version 7.5 (Windows Server 2008, 32–bit)
– Version 7.5 (Windows Server 2008 R2, 64–bit)
– Version 7.1 (Red Hat Enterprise Linux 5.x)
– Version 7.5 (SUSE Linux Enterprise Server 11 SP2, 

64–bit)
• Backup Exec
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– Version 2010 R3 (Windows Server 2008 R2, 64–bit)
– Version 2012 (Windows Server 2008 R2, 64–bit)

노트: The Dell DR Series system licensing is all-inclusive, so that no additional Dell licensing is required to use OST 
or the optimized duplication capability. The Dell OST plug-in that gets installed on a supported Linux or Windows 
media server platform is a free download from Dell. However, Symantec NetBackup requires that you purchase a 
Symantec OpenStorage Disk Option license. Similarly, Symantec Backup Exec requires that you purchase the 
Deduplication Option to enable the OST feature.

OST Required Configurations
This topic introduces three possible required configurations to enable OpenStorage Technology (OST) operations: DR 
Series system and a DMA-based media server or client (for example, OST operations that support a NetBackup-media 
server, a Backup Exec-media server, or a Backup Exec-client).

모범 사례: OST 및 DR Series 시스템

이 주제에서는 DR Series 시스템에서 OpenStorage Technology(OST) 작업 수행에 대한 몇 가지 권장되는 모범 사례
를 소개합니다.

• OST 컨테이너와 비OST 컨테이너가 동일한 DR Series 시스템에 존재할 수 있습니다. DR Series 시스템에서
는 동일한 어플라이언스에서 OST 컨테이너와 비OST 컨테이너 둘 다 사용할 수 있도록 지원합니다. 하지
만 두 유형의 컨테이너가 동일한 기본 스토리지를 공유하므로 올바르지 않은 용량이 보고될 수 있습니
다.

• OST 복제 및 비OST 복제가 동일한 DR Series 시스템에 존재할 수 있습니다. 비OST 복제는 구성해야 하며 
컨테이너 단위로 복제됩니다. 하지만 이 유형의 복제에서는 OST 컨테이너가 복제되지 않습니다. OST 복
제는 파일을 기반으로 하며 DMA에 의해 트리거됩니다.

• 컨테이너 연결 유형을 NFS/CIFS에서 OST로 변경하지 마십시오. 비OST 컨테이너를 삭제해야 동일한 이름
으로 이 컨테이너를 OST 컨테이너로 생성할 수 있습니다.

클라이언트측 최적화 설정

클라이언트측 최적화는 백업 작업 수행 시간을 절약하고 네트워크에서 데이터 전송 오버헤드를 줄여주는 프로
세스입니다.
DR Series 시스템 CLI 명령 ost --update_client --name --mode를 사용하여 클라이언트측 최적화(클라이언트측 중복 

제거라고도 함)를 설정 또는 해제할 수 있습니다. DR Series 시스템 CLI 명령에 대한 자세한 내용은 

support.dell.com/manuals에 있는 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

Configuring an LSU
You can configure a logical storage unit (LSU) as an OpenStorage Technology (OST) connection type container for data 
storage by using the DR Series system GUI. To configure an LSU as an OST connection type container, log in to the DR 
Series system and complete the following:

1. Navigate to the Containers page (in the Dashboard navigation panel).
2. Click Create to create a new container.

The Create New Container dialog is displayed.

3. In Container Name, enter a name for the container.
4. In Marker Type, select the None marker type.

For OST operations, only the NetBackup and Backup Exec media servers are supported.
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5. In Connection Type, set the container type to OST.
The OST pane is displayed, and this is where you can set the capacity for the OST connection type container.

6. In Capacity, select either the Unlimited or Size options to set the capacity for the OST connection type container.
If you select Size, make sure to define the desired size in Gibibytes (GiB).

7. Click Create a New Container (or click Cancel to display the Containers page).

노트: For general information about creating DR Series system containers, see Creating Containers, and for 
creating an OST connection type container, see Creating an OST or RDS Connection Type Container.

노트: The capacity option in this command example sets the quota on the LSU. This is the maximum number of 
bytes (ignoring optimization) that can be written to an LSU and it is listed in the gigabytes (GB). If the capacity 
option is not specified (or if 0 is specified for the capacity), then the LSU will not have a quota. If this is the case, 
then this means that the amount of data that can be written to the LSU is limited only by the amount of free space 
on the disk.

Installing the Dell OST Plug-In
Before you can start the installation process for the Dell OST plug-in, you need to understand its role. The Dell OST plug-
in must be installed on to the media server type you choose (this DR Series system release supports Linux and 
Windows). The Dell OST plug-in software enables integration between DR Series system data storage operations and 
the supported data management applications (DMAs).

Understanding the Dell OST Plug-In (Linux)

The Dell OST plug-in must be installed on the designated Linux-based media server running the support Linux server 
operating system software in the following directory, /usr/openv/lib/ost-plug-ins. The Dell OST plug-in is installed using a 
self-extracting installer that installs the OST plug-in and all its related components. The installer supports the following 
modes, with the default being Help (-h):

노트: If no option is selected, the Help mode is displayed by default.

• Help (-h)

• Install (-install)

• Upgrade (-upgrade)

• Uninstall (-uninstall)

• Force (-force)

$> ./Dellostplugin-x86_64-38105.bin -help
Dell plug-in installer/uninstaller
usage: Dellostplugin-x86_64-38105.bin [ -h ] [ -install ] [ -uninstall ]
-h             : Displays help
-install       : Installs the plug-in
-upgrade            : Upgrades the plug-in
-uninstall     : Uninstalls the plug-in
-force                    : Forces the installation of the plug-in

You can download the Dell OST Plug-In Installer in two ways:

• Using the Dell website:

– Navigate to support.dell.com/ and locate the Drivers and Downloads location

– Locate the Dell OST plug-in for Linux and download this to your system.

• Using the DR Series system GUI:
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– Click Storage → Clients

– Click the OST tab in the Clients page, and click Download Plug-In

– Select the appropriate plug-in in the Download Plug-Ins page, and click Download

Once downloaded, run the Dell OST Plug-In Installer to install the plug-in on your designated Linux-based media server. 
For specifics, see Installing the OST Plug-In for NetBackup on Linux.

노트: The Dell OST plug-in needs to be installed on client systems to support client-side deduplication.

Understanding the Dell OST Plug-In (Windows)

This Dell OST plug-in must be installed in the following directory on the designated Windows-based media server 
running the supported Microsoft Windows server operating system software: $INSTALL_PATH\VERITAS\Netbackup\bin
\ost-plug-ins for NetBackup installations, and $INSTALL_PATH\Symantec\Backup Exec\bin\ for Backup Exec 
installations. Once downloaded, you can use SETUP to install the Dell OST plug-in. For specifics, see Installing the OST 
Plug-In for Backup Exec on Windows or Installing the OST Plug-In for NetBackup on Windows.

노트: The Dell OST plug-in needs to be installed on client systems to support client-side deduplication.

Installing the OST Plug-In for Backup Exec on Windows

This topic describes how to install the Dell OpenStorage Transport (OST) plug-in within a Microsoft Windows 
environment for performing DR Series system operations via the plug-in.

Make sure that you meet all of the following prerequisites before installing the OST plug-in:

노트: The Dell OST plug-in must be installed on client systems to support client-side deduplication.

1. The Backup Exec installation must be running on one of the supported Windows media server platforms.

2. The Windows OST installer must be present. If not, download the Windows installer (DellOSTPlug-in.msi), which is 
available at support.dell.com/drivers, to a network directory location you can access.

Version 2.0.0 of the OST plug-in supports the following versions of Backup Exec: Backup Exec 2010 (Release 3), Backup 
Exec 2012, Backup Exec 12.5. Version 2.0.0 of the OST plug-in supports the following Windows-based media servers: 
Windows 2003, Windows 2008, and Windows 2008 (Release 2).

노트: For the latest information on supported versions, see the Dell DR Series System Interoperability Guide, 
available at support.dell.com/manuals.

To install the Dell OST plug-in, complete the following:

1. Launch the Backup Exec Administrator console, select Tools, and Backup Exec Services....
The Backup Exec Services Manager page is displayed.

2. Select the server on which you want to install the Dell OST plug-in, and select Stop all services.
The Restarting Backup Exec Services page is displayed, which lists the current status of services for the selected 
server.

3. Click OK.

4. Launch the Dell Storage Plug-In for Symantec OST Setup Wizard (and accept all default values).

5. In the Welcome page, click Next to continue.
The End-User License Agreement page is displayed.

6. Click I accept the terms in the License Agreement, and click Next.

7. In the Destination Folder page, accept the default destination location, and click Next.

8. In the Ready to Install Dell Storage Plug-In for Symantec OST page, click Install.
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When the plug-in has been installed, the Completed the Dell Storage Plug-In for Symantec OST Setup Wizard page 
is displayed.

9. Click Finish to exit the wizard.

Installing the OST Plug-In for NetBackup on Windows

This topic describes how to install the Dell OST plug-in on a media server running the supported Microsoft Windows 
server operating system software (and using the NetBackup DMA).

Ensure that you have downloaded the Dell OST plug-in installer into the correct directory on the designated media 
server. The OST plug-in installer is saved as DellOSTPlugin64.msi, or DellOSTPlugin.msi (DellOSTPlugin64.msi is for 64-
bit operating systems and DellOSTPlugin.msi is for 32-bit operating systems). Ensure that the correct plug-in is 
downloaded to support your 64-bit or 32-bit systems.

노트: The Dell OST plug-in must be installed on client systems to support client-side deduplication.

1. Stop the NetBackup services if they are running, by using the following command:
Verify if a previous version is already installed. If it is, uninstall it. If SETUP performs this check, there is no need to 
do it manually.
$INSTALL_PATH\VERITAS\NetBackup\bin\bpdown.exe

2. Run SETUP to install the OST plug-in.

3. Check that the plug-in is installed by using the following NetBackup command on the Windows media server:
$INSTALL_PATH\VERITAS\NetBackup\bin\admincmd\bpstsinfo.exe -pi

This NetBackup command lists the Dell OST plug-in details along with other plug-in details, as shown in the 
following example:

– Plug-In Name: libstspiDellMT.dll

– Prefix: DELL

– Label: OST Plug-in that interfaces with the DR Series system

– Build Version: 9

– Build Version Minor: 1

– Operating Version: 9

– Vendor Version: Dell OST plug-in 10.1

4. Start the NetBackup services by using the following command:
$INSTALL_PATH\VERITAS\NetBackup\bin\bpup.exe

노트: To more information about uninstalling the Dell OST plug-in, see Uninstalling the Dell OST Plug-In for 
Windows.

Windows용 Dell OST 플러그인 제거

Windows 기반 매체 서버에서 Dell OST 플러그인을 제거해야 할 경우 다음 제거 프로세스를 따르십시오.

표준 Microsoft Windows 제거 프로세스를 사용하여 Windows 기반 매체 서버에서 Dell OST 플러그인을 제거합니

다.

노트: Dell OST 플러그인을 다시 설치해야 할 경우를 대비하여 매체 서버에 Dell OST 플러그인 설치 프로그

램을 유지하는 것이 좋습니다.

다음은 Dell OST 플러그인이 설치된 Windows 기반 매체 서버에서의 프로세스를 설명하는 예입니다.

1. 시작을 클릭한 다음 제어판을 클릭합니다.
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제어판 페이지가 표시됩니다.

2. 프로그램 및 기능 아래에서 프로그램 제거를 클릭합니다.
프로그램 제거 또는 변경 페이지가 표시됩니다.

3. 설치된 프로그램 목록에서 Dell OST 플러그인을 찾아 마우스 오른쪽 단추로 클릭한 후 제거를 선택합니다.
프로그램 및 기능 확인 대화상자가 표시됩니다.

4. Dell OST 플러그인 제거에서 예를 클릭합니다.

Linux에서 NetBackup용 OST 플러그인 설치

이 주제에서는 NetBackup DMA를 사용하여 지원되는 Red Hat Enterprise Linux 또는 SUSE Linux 서버 운영 체제 소
프트웨어를 실행하는 매체 서버에 Dell OST 플러그인을 설치하는 방법에 대해 설명합니다.

지정된 매체 서버의 올바른 디렉터리에 Dell OST 플러그인 설치 프로그램이 다운로드되어 있어야 합니다. Dell 
OST 플러그인 설치 프로그램은 Dellostplugin-x86_64-xxxxx.bin.gz으로 저장됩니다. 여기서 xxxxx는 빌드 번호를 나
타냅니다.

노트: Dell OST 플러그인은 클라이언트측 중복 제거를 지원할 수 있도록 클라이언트 시스템에 설치해야 합
니다.

1. 다음 명령을 사용하여 OST 플러그인 설치 프로그램 파일의 압축을 풉니다.
$> /bin/gunzip Dellostplugin-x86_64-xxxxx.bin.gz

2. 다음 명령을 사용하여 OST 플러그인 설치 프로그램에서 실행 파일 비트를 구성합니다.
$> /bin/chmod a+x Dellostplugin-x86_64-xxxxx.bin

3. -install 옵션을 사용하기 전에 NetBackup nbrmms 서비스를 중지합니다.
OST 플러그인 설치를 시도할 때 NetBackup nbrmms 서비스가 실행 중이면 OST 플러그인 설치 프로그램이 

오류를 반환합니다.

4. -install 옵션을 사용하여 OST 플러그인 설치 프로그램을 실행하고 다음 명령을 사용하여 플러그인을 설치합
니다.
$> ./Dellostplugin-x86_64-xxxxx.bin -install

노트: Dell OST 플러그인을 설치하기 전에 NetBackup nbrmms 프로세스를 중지해야 합니다. 또한 Dell 
OST 플러그인 설치 프로그램을 사용하여 플러그인을 제거해야 합니다. Dell OST 플러그인 설치 위치는 

사용자가 구성할 수 없습니다.

5. OST 플러그인 설치 프로그램 실행이 중지되고 시스템 프롬프트가 다시 표시되면, Linux 매체 서버에서 다음
과 같은 NetBackup 명령을 사용하여 출력을 확인한 후에 플러그인이 올바르게 로드되었는지 확인하십시
오.
$> /usr/openv/netbackup/bin/admincmd/bpstsinfo -plugininfo

이 NetBackup 명령은 다음과 같이 Dell OST 플러그인 세부정보를 나열합니다.

– 플러그인 이름: libstspiDellMT.so

– 접두사: DELL

– 레이블: Dell OpenStorage(OST) 플러그인

– 빌드 버전: 10

– 빌드 부 버전: 1

– 작동 버전: 10

– 벤더 버전: (EAR-2.0.0) 빌드: 41640

6. 플러그인을 제거해야 할 경우 나중에 사용할 수 있도록 매체 서버에 OST 플러그인 설치 프로그램을 유지합
니다.
Dell OST 플러그인 제거에 대한 자세한 내용은 Linux용 Dell OST 플러그인 제거를 참조하십시오.
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Linux용 Dell OST 플러그인 제거

Linux 기반 매체 서버에서 Dell OST 플러그인을 제거해야 할 경우 다음 제거 프로세스를 따르십시오.

1. -uninstall 옵션을 사용하기 전에 NetBackup nbrmms 서비스를 중지합니다.
OST 플러그인 제거를 시도할 때 NetBackup nbrmms 서비스가 실행 중이면 OST 플러그인 설치 프로그램이 

오류를 반환합니다.

2. -uninstall 옵션을 사용하여 OST 플러그인 설치 프로그램을 실행하고 다음 명령을 사용하여 플러그인을 제거
합니다.
$> ./Dellostplugin-x86_64-xxxxx.bin -uninstall

노트: OST 플러그인을 제거하기 전에 NetBackup nbrmms 서비스를 중지해야 합니다(플러그인을 제거

하려면 Dell OST 플러그인 설치 프로그램을 사용해야 함).

3. Linux 매체 서버에서 다음 NetBackup 명령을 사용하여 플러그인이 제거되었는지 확인합니다.
$> /usr/openv/netbackup/bin/admincmd/bpstsinfo -plugininfo

노트: -pluginfo 명령이 Dell OST 플러그인 세부정보를 반환하면 플러그인이 제거되지 않은 것입니다.

4. 플러그인을 다시 설치해야 할 경우를 대비하여 매체 서버에 OST 플러그인 설치 프로그램을 유지하는 것이 
좋습니다.

NetBackup을 사용하여 DR Series 시스템 정보 구성

이 주제에서는 NetBackup 매체 서버 명령행 인터페이스(CLI) 명령 및 그래픽 사용자 인터페이스(GUI) 메뉴, 탭, 옵
션을 사용하여 DR Series 시스템 정보 구성에 대한 개념을 소개합니다. NetBackup CLI 명령 및 GUI 메뉴, 탭, 옵션
을 사용하면 Linux 또는 Windows 매체 서버 둘 다 구성할 수 있습니다. DR Series 시스템 관리자 안내서에서는 
NetBackup CLI를 사용 작업을 설명하는 특정 주제를 볼 수 있습니다. 이러한 작업에는 각 Linux 및 Windows 매체 
서버의 NetBackup에 DR Series 시스템에 사용할 DR Series 시스템 이름 추가, NetBackup GUI를 사용하여 OST를 
통해 DR Series 시스템에서 작동되도록 구성, NetBackup GUI를 사용하여 DR Series 시스템의 LSU(Logical Storage 
Unit)에서 디스크 풀 구성, NetBackup GUI를 사용하여 DR Series 시스템의 디스크 풀을 통해 스토리지 장치 생성 
등이 있습니다.
관련 링크

DR Series 시스템용 NetBackup 구성
NetBackup 그래픽 사용자 인터페이스(GUI)를 사용하여 OST를 통해 DR Series 시스템에서 작동되도록 
구성합니다. 이 과정은 Linux 또는 Windows 플랫폼에 기본적으로 동일한 유형의 작업입니다.

Backup Exec GUI를 사용하여 DR Series 시스템 구성
Backup Exec에서는 자체 그래픽 사용자 인터페이스(GUI)만 사용하여 DR Series 시스템을 구성할 수 있
습니다. Backup Exec 2010 버전 사용에 지원되는 Backup Exec 명령행 인터페이스(CLI)가 없습니다.

NetBackup CLI를 사용하여 DR Series 시스템 이름 추가(Windows)
이 주제에서는 NetBackup CLI를 사용하여 각 Windows 기반 매체 서버에 DR Series 시스템에 사용할 DR 
Series 시스템 이름을 추가하는 방법에 대해 설명합니다.

NetBackup CLI를 사용하여 DR Series 시스템 이름 추가(Linux)
This topic describes how to use the NetBackup CLI to add the DR Series system name to each Linux-based 
media server you plan to use with the DR Series system.
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Using NetBackup CLI to Add DR Series System Name (Linux)

This topic describes how to use the NetBackup CLI to add the DR Series system name to each Linux-based media server 
you plan to use with the DR Series system.

1. Add the DR Series system name to NetBackup by using the following command:
/usr/openv/netbackup/bin/admincmd/nbdevconfig -creatests 
-storage_server servername -stype DELL -media_server mediaservername 

2. Log in to and authenticate with DR Series system by using the following command (for details, see Configuring an 
LSU).
/usr/openv/volmgr/bin/tpconfig -add -storage_server servername -stype DELL -
sts_user_id backup_user -password password

노트: On the DR Series system, only one user account exists, and the user ID for that account is backup_user. 
You can only change the password for this account; you cannot create a new account nor can the existing 
account be deleted.

NetBackup CLI를 사용하여 DR Series 시스템 이름 추가(Windows)

이 주제에서는 NetBackup CLI를 사용하여 각 Windows 기반 매체 서버에 DR Series 시스템에 사용할 DR Series 시
스템 이름을 추가하는 방법에 대해 설명합니다.

1. 다음 명령을 사용하여 NetBackup에 DR Series 시스템 이름을 추가합니다.
$INSTALL_PATH\VERITAS\NetBackup\bin\admincmd\nbdevconfig -creatests -
storage_server servername -stype DELL -media_server mediaservername

2. 다음 명령을 사용하여 DR Series 시스템에 로그인하고 인증에 유효한 자격 증명을 추가합니다(자세한 내용
은 LSU 구성 참조).
$INSTALL_PATH\VERITAS\Volmgr\bin\tpconfig -add -storage_server servername -
stype DELL -sts_user_id backup_user -password password

DR Series 시스템용 NetBackup 구성

NetBackup 그래픽 사용자 인터페이스(GUI)를 사용하여 OST를 통해 DR Series 시스템에서 작동되도록 구성합니
다. 이 과정은 Linux 또는 Windows 플랫폼에 기본적으로 동일한 유형의 작업입니다.

NetBackup에 로그인하고 다음을 수행합니다.

1. NetBackup Administrator(NetBackup 관리자) 콘솔의 기본 창에서 Configure Disk Storage Servers(디스크 스토
리지 서버 구성)를 클릭하여 스토리지 서버 구성 마법사를 시작합니다.
스토리지 서버를 추가할 수 있는 Storage Server Configuration Wizard(스토리지 서버 구성 마법사) 페이지가 

표시됩니다.

2. OpenStorage를 클릭하여 이 창에 구성할 디스크 스토리지 유형을 선택한 후 Next(다음)를 클릭합니다.
Add Storage Server(스토리지 서버 추가) 페이지가 표시됩니다.

3. 다음 값을 입력하여 스토리지 서버를 구성합니다.

– Storage server type(스토리지 서버 유형)에 DELL을 입력합니다.

– Storage server name(스토리지 서버 이름)에 DR Series 시스템의 이름을 입력합니다.

– Select media server(매체 서버 선택) 드롭다운 목록에서 OST를 구성할 매체 서버를 선택합니다.

– DR Series 시스템에서 인증하는 데 필요한 자격 증명 값을 입력합니다.

* 사용자 이름

* 암호
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* 암호 확인

자격 증명은 DR Series 시스템에 필요한 자격 증명과 동일해야 합니다. 자세한 내용은 LSU 구성을 참조하십

시오.

4. Next(다음)를 클릭합니다.
구성한 값이 나열된 Storage Server Configuration Summary(스토리지 서버 구성 요약) 페이지가 표시됩니다.

5. Next(다음)를 클릭합니다.
구성한 스토리지 서버 및 해당 자격 증명이 Storage Server Creation Status(스토리지 서버 생성 상태) 페이지

에 표시됩니다.

6. Next(다음), Finish(마침)를 차례로 클릭하여 스토리지 서버 구성 마법사를 닫습니다.
Storage server servername successfully created(스토리지 서버(서버 이름) 생성 완료) 페이지가 표시됩니다. 
이제 DR Series 시스템에 사용할 수 있도록 NetBackup이 구성되었습니다.

Creating Disk Pools From LSUs

Use the NetBackup graphical user interface (GUI) to configure disk pools from logical storage units (LSUs) on the DR 
Series system.

Log in to NetBackup, and complete the following:

1. In the main window of the NetBackup Administrator console, click Configure Disk Pools to launch the Disk Pool 
Configuration Wizard.
The Disk Pool Configuration Wizard page is displayed, which is where you define media servers for use in a disk 
pool.

2. In the Welcome to the Disk Pool Configuration Wizard page, click Next.
The Disk Pool page is displayed.

3. In Type, select OpenStorage (DELL), and click Next.
The Select Storage Server page is displayed, and contains a list of available storage servers.

4. In the Storage server list, select a server, and click Next.
The Disk Pool Properties page is displayed.

5. Select the LSUs (volumes) to include from the list, and click Next.
The Disk Pool Properties page is displayed.

6. Enter a Disk pool name, and click Next.
The Summary page for the Disk Pool Configuration Wizard is displayed.

7. Verify the disk pool configuration in the Summary page, and click Next to configure the disk pool you created.
The Performing required task page is displayed, with the status being: Configuration completed successfully. You 
have several options available at this point:

– Clear the Create a storage unit for the disk pool.

– Click Finish and close the Disk Pool Configuration Wizard.

– Click Next to create the storage unit with this disk pool.

노트: If you create the storage unit using the Disk Pool Configuration Wizard, you can skip the step where you 
create storage units using a disk pool.

8. Click Next to continue with creating a storage unit using this wizard.

9. Enter a Storage unit name, and click Next.
The Successfully Completed Disk Pool Configuration page is displayed.

10. Click Finish.
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To display the disk pool you created, click Devices → Disk Pools in the left navigation pane in the NetBackup 
Administrator console.

디스크 풀을 사용하여 스토리지 장치 생성

NetBackup GUI를 사용하여 DR Series 시스템의 디스크 풀을 통해 스토리지 장치를 생성합니다.

NetBackup에 로그인하고 다음을 수행합니다.

1. NetBackup Administrator(NetBackup 관리자) 콘솔 기본 창의 왼쪽 탐색 창에서 Storage(스토리지)를 클릭하고 
Storage Units(스토리지 장치)를 선택합니다.

2. NetBackup Administrator(NetBackup 관리자) 콘솔 기본 창의 드롭다운 목록에서 New Storage Unit(새 스토리
지 장치)를 선택합니다.

3. New Storage Unit(새 스토리지 장치) 페이지의 Storage unit name(스토리지 장치 이름)에 이름을 입력하고 
Disk pool(디스크 풀) 드롭다운 목록에서 생성한 OST 디스크 풀을 선택합니다.

4. OK(확인)를 클릭하여 새 스토리지 장치를 생성합니다.

Backing Up Data From a DR Series System (NetBackup)
This topic describes how to use NetBackup to back up data from a DR Series system.

Before backing up data, you first need to configure a policy that creates a backup on the OpenStorage Technology (OST) 
logical storage unit (LSU). This type of policy is similar to what is done for network-attached storage (NAS) shares, 
except that when defining policy attributes, you need to select the LSU that contains the OST disk pool.

To back up data from a DR Series system using a policy, complete the following:

1. Log into the NetBackup Administrator console.

2. Click NetBackup Management in the left navigation pane, and select Policies.

3. In the All Policies main window, right-click OST, and select Change Policy from the drop-down list.
The Change Policy page is displayed.

4. In the Change Policy page, click the Attributes tab, and select the settings for the policy you want to create.

5. Click OK to create the policy, which displays under OST in the main window.

6. Right-click the policy, and select Manual Backup from the drop-down list.
The Manual Backup page is displayed.

7. In the Manual Backup page, enter the name of the media server in Server, and click OK.

To monitor the status of any backup operation, click Activity Monitor in the left navigation pane of the NetBackup 
Administrator console, and select the backup job you are interested in to view details about the operation.

Restoring Data From a DR Series System Using NetBackup

This topic describes how to use NetBackup to restore data from a DR Series system. The process for restoring data from 
OpenStorage Technology (OST) logical storage units (LSUs) is similar to how restores are performed from any backup 
device.

To restore data from a DR Series system, complete the following:

1. Log into the NetBackup Administrator console.

2. Click Backup, Archive, and Restore in the left navigation pane.

3. In the Restore main window, click the Restore Files tab.

4. Select the data that you want to restore, and click OK.
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To monitor the status of any restore operation, click Activity Monitor in the left navigation pane of the NetBackup 
Administrator console, and select the restore job you are interested in to view details about the operation.

Duplicating Backup Images Between DR Series Systems Using NetBackup

Using NetBackup with the DR Series system, you can duplicate backup images from a disk pool on one DR Series 
system to a target disk pool (or a storage unit derived from it) that could be on the same DR Series system or on a 
different DR Series system.

To duplicate backup images between DR Series systems using NetBackup, complete the following:

1. Log into NetBackup Administrator console.

2. Click NetBackup Management in the left navigation pane, and select Catalog.

3. In the Catalog main window, select Duplicate from the Action drop-down list, and click Search Now.
The Search Results pane is displayed, which lists images from which you can choose to duplicate.

4. Right-click to select the image in the Search Results pane that you would like to duplicate, and select Duplicate in 
the drop-down list.
The Setup Duplication Variables page is displayed.

5. In the Setup Duplication Variables page, select the LSU that is the target DR Series system in the Storage unit drop-
down list, and click OK.

6. To monitor the status of any duplicate image operation, perform the following:
a) Click Activity Monitor in the left navigation pane of the NetBackup Administrator console.
b) Select the data duplication job in which you are interested.
c) View the operation details.

Using Backup Exec With a DR Series System (Windows)
This topic introduces the Dell OpenStorage Technology (OST) plug-in and describes its installation prerequisites for 
Backup Exec within a Microsoft Windows environment. Once installed, Backup Exec can perform DR Series system 
operations via the OST plug-in.

OST Plug-In and Supported Versions

This topic introduces the version 1.0 of the OST plug-in that supports the following versions of Backup Exec:

• Backup Exec 2010, Release 3

• Backup Exec 2012

Version 1.0 of the OST plug-in supports the following versions of the Windows media server:

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008, R2

노트: For the latest information, see the Dell DR Series System Interoperability Guide, available at 
support.dell.com/manuals.

Installation Prerequisites for the OST Plug-In for Backup Exec

This topic introduces the installation prerequisites for installing the OST plug-in for Backup Exec on Windows media 
servers. Ensure that you meet the following prerequisites prior to installing the Dell OST plug-in:
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1. The Backup Exec installation must be running on one of the supported Windows platforms.

2. Dell recommends that the DR Series system appliance have an OST container created and configured. For details, 
see Configuring an LSU.

3. The Windows OST installer must be present. If not, download the Windows installer (DellOSTPlug-in.msi), which is 
available at support.dell.com/support/drivers, to a network directory location you can access.

4. The Dell OST plug-in needs to installed in the following directory on the designated Windows-based media server 
running the supported Microsoft Windows operating system software ($INSTALL_PATH\VERITAS\NetBackup\bin
\ost-plugins) for NetBackup installations.

Backup Exec GUI를 사용하여 DR Series 시스템 구성

Backup Exec에서는 자체 그래픽 사용자 인터페이스(GUI)만 사용하여 DR Series 시스템을 구성할 수 있습니다. 
Backup Exec 2010 버전 사용에 지원되는 Backup Exec 명령행 인터페이스(CLI)가 없습니다.

Backup Exec GUI를 사용하여 DR Series 시스템을 구성하려면 다음을 수행합니다.

1. Backup Exec Administrator(Backup Exec 관리자) 콘솔을 실행하고 Tools(도구), Backup Exec Services...(Backup 
Exec 서비스...)를 차례로 선택합니다.

2. Backup Exec Services Manager(Backup Exec 서비스 관리자) 페이지에서 구성할 서버를 선택하고 Start all 
services(모든 서비스 시작)를 선택합니다.

3. 모든 서비스가 시작되었는지 확인하고 OK(확인)를 클릭합니다.

4. Connect to Media Server(매체 서버에 연결) 페이지에서, 매체 서버에 로그인하고 User name(사용자 이름), 
Password(암호)를 입력한 다음 OK(확인)를 클릭합니다.

5. Backup Exec Administrator(Backup Exec 관리자) 페이지에서 Network(네트워크), Logon Accounts(로그온 계정)
를 차례로 클릭합니다.
Logon Account Management(로그온 계정 관리) 페이지가 표시됩니다.

6. New(새로 만들기)를 클릭하여 새 로그온 계정을 만듭니다.
Add Logon Credentials(로그온 자격 증명 추가) 페이지가 표시됩니다.

7. Account Credentials(계정 자격 증명) 창에 DR Series 시스템의 User name(사용자 이름) 및 Password(암호) 계
정 자격 증명을 입력하고 OK(확인)를 클릭합니다(예: 기본 사용자 이름은 backup_user).

8. Backup Exec Administrator(Backup Exec 관리자) 페이지에서 Devices(장치) 탭을 클릭하고 루트 노드로 나열
된 로컬 시스템 이름을 마우스 오른쪽 단추로 클릭합니다.
장치 관련 옵션의 드롭다운 목록이 표시됩니다.

9. 드롭다운 목록에서 Add OpenStorage(OpenStorage 추가)를 선택합니다.
Add OpenStorage Device(OpenStorage 장치 추가) 페이지가 표시됩니다.

10. 다음과 같은 정보를 사용하여 Add OpenStorage Device(OpenStorage 장치 추가) 페이지를 구성하고 OK(확인)
를 클릭합니다.

– Server(서버) - DR Series 시스템의 호스트 이름이나 IP 주소를 입력합니다.

– Logon account(로그온 계정) - 드롭다운 목록에서 DR Series 시스템 주소 지정을 위한 자격 증명이 있
는 계정을 선택합니다.

– Server type(서버 유형) - 드롭다운 목록에서 플러그인 유형을 선택합니다(DELL OST 플러그인).

– LSU(Logical Storage Unit) - 사용할 LSU(DR Series 시스템 컨테이너) 이름을 입력합니다.

11. 새 작업의 기본 대상인 새 장치를 만들 것인지 묻는 프롬프트에서 Yes(예)를 클릭합니다.

12. Add OpenStorage Device(OpenStorage 장치 추가) 페이지를 닫습니다.
Restart Services(서비스 다시 시작) 확인 대화상자가 표시됩니다(이 대화상자에서는 현재 실행 중인 작업이 

있으면 서비스를 다시 시작하지 않을 것을 권장함).

13. Restart Now(지금 다시 시작)를 클릭하여 Backup Exec 서비스를 다시 시작합니다.
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Backup Exec을 사용하여 DR Series 시스템에서 백업 생성

이 주제에서는 Backup Exec을 사용하여 DR Series 시스템에 백업을 생성하는 방법에 대해 설명합니다.

Backup Exec을 사용하여 DR Series 시스템에 백업을 생성하려면 다음을 수행합니다.

노트: 이 절차에서는 Backup Exec 2010을 사용하여 프로세스를 설명합니다. Backup Exec 2012의 절차는 이와 

다릅니다. 특정 세부정보 및 절차를 보려면 해당 DMA 및 버전의 Symantec 제품별 문서를 참조하십시오.

1. Backup Exec Administrator(Backup Exec 관리자) 콘솔에 로그인하고 Job Setup(작업 설정) 탭을 선택합니다.

2. 왼쪽 탐색 패널에서 Backup Tasks(백업 작업)를 클릭하고 New job(새 작업)을 선택합니다.
Backup Job Properties(백업 작업 특성) 페이지가 표시됩니다.

3. Backup Job Properties(백업 작업 특성) 페이지의 왼쪽 탐색 창에서 Source(소스)를 선택한 후 Selections(선택 
항목)를 선택합니다.
Selections(선택 항목) 페이지가 표시됩니다.

4. Selections(선택 항목) 페이지의 가운데 창에서 시스템 또는 노드 이름을 선택하고 백업할 파일에 해당하는 
확인란을 클릭합니다.

5. Backup Job Properties(백업 작업 특성) 페이지 왼쪽 탐색 창에서 Destination(대상)을 선택한 후 Device and 
Media(장치 및 매체)를 선택합니다.
Device and Media(장치 및 매체) 페이지가 표시됩니다.

6. Device and Media(장치 및 매체) 페이지의 Device(장치) 창에 있는 드롭다운 목록에서 DELL OST 장치를 선택
하고 Run Now(지금 실행)를 클릭하여 백업 작업을 시작합니다.

7. Job Monitor(작업 모니터) 탭을 클릭하여 생성한 백업 작업의 진행 상태를 확인합니다.

Optimizing Duplication Between DR Series Systems Using Backup Exec

The Backup Exec DMA can work with the DR Series system to replicate backups between two DR Series systems that 
are part of a defined source and target replication pair. This process uses the deduplication and replication features of 
the DR Series system via the OpenStorage Technology (OST).

Using OST, backed up data is catalogued which makes its available from the designated media server so that a 
seamless restore can be performed from either the target or source DR Series system. This is considered an integrated 
replication, where the OST appliance does the replication. It is considered to be “optimized” because the data flows 
from the local appliance directly to the remote appliance in a deduplicated format, and it does not travel through the 
media server.

When the data is in a deduplicated format (in an optimized form), only new or unique data is copied between the two DR 
Series systems. Because the duplication job is initiated by Backup Exec, there are two entries in its catalog: one entry is 
for the source file, while the other entry is for the target file. The backup administrator can restore backup data from 
either appliance in case of data loss or disaster.

To optimize duplication between DR Series systems, create an additional OST device that points to the target DR Series 
system, and complete the following:

1. Launch the Backup Exec Administrator console, select the Devices tab, and right-click the target DR Series system.

2. Select Add OpenStorage in the drop-down list.
The Add OpenStorage Device page is displayed

3. Configure the Add OpenStorage Device page with the following information:

– Server—enter the host name or IP address of the DR Series system.

– Logon account—select the account from the drop-down list (or click ... and browse to the account 
location), which has credentials for accessing the DR Series system.

138



– Server type—select the type of server from the drop-down list (DELL).

– Logical storage unit—enter the name of the logical storage unit (LSU), also known as a DR Series system 
container, to use.

4. Click Yes in response to the prompt if you want to make the new device the default destination for new jobs.

5. Close the Add OpenStorage Device page.

6. Click the Job Setup tab.

7. In the left navigation pane, select Backup Tasks, and click New job to duplicate backup sets.
The New Job to Duplicate Backup Sets page is displayed.

8. Select Duplicate existing backup sets, and click OK.

9. Click the View by Resource tab in the Selections page, and select the dataset you want copied.

10. In the left navigation pane, select Destination, and select Device and Media.

11. In Device, select the destination device from the drop-down list (that was created in this procedure), and click Run 
Now to start the replication operation between the two DR Series systems.

12. Click the Job Monitor tab to view the progress of the replication operation you created.

Restoring Data from a DR Series System Using Backup Exec

This topic describes how to use Backup Exec to restore data from a DR Series system.

To restore data from a DR Series system using Backup Exec, complete the following:

1. Launch the Backup Exec Administrator console, and select the Job Setup tab.

2. In the left navigation pane, select Restore Tasks, and click New job.
The Restore Job Properties page is displayed.

3. Click the View by Resource tab in the Selections pane, and select the dataset to be restored.

4. Click Run Now to start the restore job.

5. Click the Job Monitor tab to view the progress of the restore job operation you created.

Understanding the OST CLI Commands
The OpenStorage Transport (OST) --mode component supported in the DR Series system command line interface (CLI) 
command supports three values, which represent optimized writes done via: deduplication (--mode dedupe), 
passthrough (--mode passthrough), and auto (--mode auto). These OST commands are used in the following format: ost 
--update_client --name --mode.

노트: If an OST client has four or more CPU cores, it is considered to be dedupe-capable. However, the OST client 
operating mode depends upon how it is configured in the DR Series system (Dedupe is the default OST client 
mode). If the administrator did not configure an OST client to operate in a specific mode and it is dedupe-capable, 
it will run in the Dedupe mode. If an OST client is not dedupe-capable (meaning the OST client has less than four 
CPU cores), and the administrator sets it to run in the Dedupe mode, it will only run in the Passthrough mode. If an 
OST client is set to run in Auto mode, the OST client will run in the mode setting determined by the media server. 
The following table shows the relationship between the configured OST client mode types and the supported client 
mode based on client architecture type and corresponding number of CPU cores.

표 6. Supported OST Client Modes and Settings

OST Client Mode 
Settings

32–Bit OST Client (4 or 
more CPU cores)

64–Bit Client (4 or 
more CPU cores)

32–Bit OST Client 
(Less than 4 CPU 
cores)

64–Bit OST Client 
(Less than 4 CPU 
cores)

Auto Passthrough Dedupe Passthrough Passthrough

139



Dedupe Not Supported Supported Not Supported Not Supported

Passthrough Supported Supported Supported Supported

Supported DR Series System CLI Commands for OST

The following are the supported DR Series system CLI commands for OST operations:
administrator@acme100 > ost
Usage:
   ost --show [--config]
              [--file_history] [--name <name>]
              [--clients]
              [--limits]

   ost --setpassword
   ost --delete_client --name <OST Client Hostname>

   ost --update_client --name <OST Client Hostname>
       --mode <auto|passthrough|dedupe>

   ost --limit --speed <<num><kbps|mbps|gbps> | default>
       --target <ip address | hostname>

   ost --help

ost <command> <command-arguments>
<command> can be one of:
   --show            Displays command specific information.
   --setpassword     Updates the OST user password.
   --delete_client   Deletes the OST client.
   --update_client   Updates attributes of the OST client.
   --limit           Limits bandwidth consumed by ost.

For command-specific help, please type ost --help <command>
For example:
     ost --help show

노트: The --files in the ost --show --file_history command represents replicated files that were processed via the 
DMA optimized duplication operation. This command displays only up to the last 10 such files. The --name in the 
ost --show --name command represents the OST container name.

노트: For more information about OST-related DR Series system CLI commands, see the Dell DR Series System 
Command Line Reference Guide.

Understanding OST Plug-In Diagnostic Logs
There are currently two supported types of OST plug-ins for which you can collect diagnostic logs: NetBackup and 
Backup Exec.

노트: The directory location, C:\ProgramData, is considered to be a hidden directory on Windows-based systems. 
However, you can copy and paste C:\ProgramData\Dell\DR\log\ into your Internet Explorer Address bar or you can 
enter this into the Windows command prompt window (Start→ All Programs→ Accessories→ Command Prompt).

For more information about OST, OST plug-ins and logs, see Understanding OST, Installing a Dell OST Plug-In, Rotating 
OST Plug-In Logs for Linux, and Rotating OST Plug-In Logs for Windows.
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Windows용 OST 플러그인 로그 회전

기본적으로, Windows 로그 회전 크기는 10메가바이트(MB)에서 설정됩니다. 로그 파일의 크기가 이 값에 도달하
면 OpenStorage Transport(OST) 플러그인이 자동으로 기존 로그 파일 이름을 libstspiDell.log에서 libstspiDell.log.old
로 변경하고 새 로그를 생성합니다.

로그 회전 크기 수정
로그 회전 크기를 수정하려면 다음 레지스트리 키 값을 편집합니다.
HKLM\Software\Dell\OST\LogRotationSize

이 값을 수정하면 새 회전 크기 값이 즉시 적용됩니다(백업 프로세스를 다시 시작할 필요가 없음).

Linux 유틸리티를 사용하여 진단 수집

Dell_diags라고 하는 Linux 유틸리티를 사용하여 Linux 전용 클라이언트에서 진단을 수집할 수 있습니다. 이 Linux 
유틸리티는 OST 플러그인에 의해 /opt/Dell 디렉터리에 설치됩니다. 이 도구는 다음과 같은 유형의 정보를 수집
합니다.

• var/log/libstspiDell.log.*
• usr/openv/netbackup/logs
• usr/openv/logs/nbemm/
• usr/openv/logs/nbrmms/

Dell_diags 진단 파일은 /var/log/diags_client location에 기록됩니다.

다음 예에서는 OST 진단 로그 수집 과정을 보여줍니다(표시된 루트 사용자 계정은 매체 서버에 있는 계정을 나
타내며 DR Series 시스템의 루트 사용자 계정이 아님).
root@oca3400-74 ~]# ./Dell_diags –collect Collecting diagnostics...Done 
Diagnostics location: /var/log/diags_client//oca3400-74_2012-02-27_23-02-13.tgz

OST 플러그인에서 기본 로그 레벨은 오류이며, 사용자가 구성할 수 있으며 DR Series 시스템 CLI 또는 GUI를 통해 

수정할 수 있습니다.

Linux용 OST 플러그인 로그 회전

OST 플러그인 로그 레벨을 중복 제거로 설정하면, 플러그인 로그의 크기가 급격히 증가합니다. 이 문제를 방지
하는 가장 좋은 방법은 Linux 기반 시스템에서 일반적으로 사용할 수 있는 logrotate 유틸리티를 사용하여 OST 플
러그인 로그를 회전하는 것입니다.

로그 회전을 구성하려면 다음을 수행합니다.

1. /etc/logrotate.d/에 파일을 생성하여 이름을 “ost”로 지정한 후 다음 항목을 추가합니다.
/var/log/libstspiDell.log { rotate 10 size 10M copytruncate }

2. /etc/cron.hourly/에 파일을 생성하여 이름을 “ost_logrotate.cron”으로 지정한 후 다음 항목을 추가합니다.
#!/bin/bash /usr/sbin/logrotate /etc/logrotate.d/ost

logrotate 유틸리티는 매시간 실행되며 로그 파일 크기가 10메가바이트(MB)를 초과할 때마다 로그를 회전합니

다. 이 절차는 OST 플러그인 설치의 일환으로 자동 수행됩니다.

매체 서버 정보 수집 지침

OpenStorage Technology(OST) 작업을 실행하는 경우, 내역 및 문제 해결 용도로 수집할 수 있는 DR Series 시스템 
진단 로그 파일 번들 및 코어 파일 외에도 몇 가지 중요한 매체 서버 관련 파일도 수집하는 것이 좋습니다. 이 주
제에서는 Linux 및 Windows 플랫폼에 상주하는 이러한 몇 가지 주요 매체 서버 파일에 대해 설명합니다.
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Linux 매체 서버의 NetBackup

Linux 매체 서버에서 실행되는 NetBackup의 경우 다음과 같은 파일을 수집할 것을 권장합니다.

• 매체 서버의 OST 플러그인 구성 파일 및 로그 파일

– 위치: /var/log/libstspiDell.log.*

• 매체 서버의 NetBackup 백업 작업 로그 및 명령 로그:

– 위치: NetBackup 로그 파일은 /usr/openv/netbackup/logs/에 있습니다. NetBackup의 각 프로세스의 
경우, 로그 디렉터리에 하위 디렉터리가 있습니다. 주요 프로세스 관련 로그에는 bptm, bpdm, 
bprd, bpcd, bpbrm이 있습니다.

– 이 5개의 디렉터리가 기본적으로 제공되지 않을 수 있으므로 매체 서버에 있는 경우에만 이러한 
로그를 수집하십시오. 로그가 생성된 경우 로그 파일이 상주하는 위치는 /usr/openv/netbackup/
logs/bptm, /usr/openv/netbackup/logs/bpdm, /usr/openv/netbackup/logs/bpcd, /usr/openv/netbackup/
logs/bprd 및 /usr/openv/netbackup/logs/bpbrm입니다.

– /usr/openv/logs/nbemm and /usr/openv/logs/nbrmms/ 디렉터리에서 로그를 수집할 것을 권장합니
다.

• NetBackup 매체 서버 또는 DR Series 시스템에 생성되어 다음과 같은 사항이 포함될 수 있는 코어 파일을 
확인합니다.

– Linux NetBackup 매체 서버의 코어 파일은 /usr/openv/netbackup/bin 디렉터리에 상주합니다. OST 
플러그인과 연결되는 대부분의 NetBackup 이진은 이 디렉터리에 있습니다.

– 클라이언트의 코어 파일 위치는 고정되어 있지 않습니다. 코어 파일이 /, /root/ 또는 /proc/sys/
kernel/core_pattern에 언급된 디렉터리에 있는지 확인하십시오. 예를 들어 /var/cores/core.%e.%p.
%t가 DR Series 시스템의 core_pattern일 경우 모든 코어 파일이 /var/cores에 상주합니다.

클라이언트의 core_pattern이 NAT에 의해 특정 디렉터리로 설정되는 경우 진단 스크립트는 관련된 모든 코어의 

디렉터리를 검토해야 합니다.

Windows 매체 서버의 NetBackup

Windows 매체 서버에서 실행되는 NetBackup의 경우 다음과 같은 파일을 수집할 것을 권장합니다.

• 매체 서버의 OST 플러그인 구성 파일 및 로그 파일:

– 위치: %ALLUSERSPROFILE%\Dell\OST\log\libstspiDell.log*

• 다음 디렉터리의 로그 파일과 함께 매체 서버의 NetBackup 작업 로그 및 명령 로그:

– C:\Program Files\Veritas\NetBackup\logs\bptm (있는 경우)

– C:\Program Files\Veritas\NetBackup\logs\bpdm (있는 경우)

– C:\Program Files\Veritas\NetBackup\logs\bpbrm (있는 경우)

– C:\Program Files\Veritas\NetBackup\logs\bprd (있는 경우)

– C:\Program Files\Veritas\NetBackup\logs\bpcd (있는 경우)

– C:\Program Files\Veritas\NetBackup\logs\nbemm

– C:\Program Files\Veritas\NetBackup\logs\nbrmms

• NetBackup 매체 서버 또는 DR Series 시스템에 생성된 모든 코어 파일.

• 서버 장애가 관련된 경우(명백하지 않은 오류 또는 자동 오류) 응용프로그램의 Windows 매체 서버 이벤
트 로그는 Administrative Tools(관리 도구) → Event Viewer(이벤트 뷰어)를 사용하여 수집할 수 있습니다. 
그런 다음 Windows Logs(Windows 로그) → Application(응용프로그램)을 선택합니다. 일반적으로 오류로 
표시된 마지막 항목이 검색 대상 항목입니다.
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– 다음 예제에서와 같이 이 텍스트를 창에 복사하여 붙여넣습니다.
Faulting application bptm.exe, version 7.0.2010.104, time stamp 
0x4b42a78e, faulting module libstspiDellMT.dll, version 1.0.1.0, 
time stamp 0x4f0b5ee5, exception code 0xc0000005, fault offset 
0x000000000002655d, process id 0x12cc, application start time 
0x01cccf1845397a42.

– 시스템이 응답하지 않으면 bptm.exe 크래시를 강제 적용하고 다음을 수행합니다.

1. Task Manager(작업 관리자)를 클릭하여 엽니다.

2. 프로세스를 찾습니다.

3. 마우스 오른쪽 단추를 클릭하고 Create Dump File(덤프 파일 생성)을 선택합니다.

4. 덤프 파일이 생성된 후 표시되는 대화상자의 지정된 위치에서 덤프 파일을 검색합니다.

Windows 매체 서버의 Backup Exec

Windows 매체 서버에서 실행되는 Backup Exec의 경우 다음과 같은 파일을 수집할 것을 권장합니다.

• 매체 서버의 OST 플러그인 구성 파일 및 로그 파일:

– 위치: %ALLUSERSPROFILE%\Dell\OST\log\libstspiDell.log*

• 매체 서버의 Backup Exec 작업 로그 및 명령 로그:

• Backup Exec 매체 서버 또는 DR Series 시스템에 생성된 모든 코어 파일.

• 크래시가 관련된 경우 %ProgramFiles%\Symantec\Backup Exec\BEDBG에 상주하는 모든 미니 덤프 파일을 
수집합니다.

• 시스템이 응답하지 않으면 pvlsvr.exe 및 bengine.exe 크래시를 강제 적용하고 다음을 수행합니다.

a. 작업 관리자를 엽니다.

b. 프로세스를 찾습니다.

c. 마우스 오른쪽 단추를 클릭하고 Create Dump File(덤프 파일 생성)을 선택합니다. 

d. 덤프 파일이 생성된 후 표시되는 대화상자의 지정된 위치에서 덤프 파일을 검색합니다.
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9
Configuring and Using Rapid Data Storage
RDS Overview
Rapid Data Storage (RDS) provides the logical disk interface that can be used with network storage devices. The Dell DR 
Series system requires the Dell Rapid OFS (ROFS) plug-in to integrate its data storage operations with the Dell Quest 
NetVault Backup (NVBU). The ROFS plug-in is installed by default on the NVBU server and the Dell DR Series system 
when the latest software updates are installed.

노트: Apart from the latest NVBU and DR Series software updates, no other software is required to activate RDS 
on your NVBU and DR Series Systems in a Windows or Linux environment.

Using the ROFS plug-in, the DMAs can take full advantage of key DR Series system features like replication and data 
deduplication.

When RDS is used with the DR Series system, it offers the following benefits:

• RDS protocol provides faster and improved data transfers:

– Focus is on backups with minimal overhead

– Accommodates larger data transfer sizes

– Provides throughput that is better than CIFS or NFS

• RDS and DMA integration:

– ROFS API enables the DMA-to-media server software communication

– DR Series system storage capabilities can be used without extensive changes to DMAs

– Backup and replication operations are simplified by using built-in DMA policies

• DR Series system and RDS ports and write operations:

– Control channel uses TCP port 10011

– Data channel uses TCP port 11000

– Optimized write operations enable client-side deduplication

• Replication operations between DR Series systems:

– No configuration is required on the source or target DR Series system

– Replication is file-based, not container-based

– Replication is triggered by DMA optimized duplication operation

– DR Series system transfers the data file (not the media server)

– Once duplication completes, DR Series system notifies DMA to update its catalog (acknowledging the 
second backup). This makes the DMA aware of the replication location. Restores from either the source 
or replication target can be used directly from the DMA.

– Supports different retention policies between source and replica

– Replication is set up in the DMA itself, not the DR Series system
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RDS Guidelines
For best results, observe the following guidelines for optimal performance with your supported RDS operations with the 
DR Series system:

• Back up, restore, and optimized duplication operations performed using the Dell ROFS plug-in

노트: The Dell ROFS plug-in is installed on client systems to support client-side deduplication.

• Optimal supported aggregated throughput rates:

– 3.8 Terabytes per hour (TB/hr) for passthrough write operations

– 7.3 TB/hr for dedupe write operations

노트: Passthrough writes are when data is sent from a media server to the DR Series system without 
applying any optimization to the data. By contrast, dedupe writes are when data is sent from a media 
server to the DR Series system after optimization is applied to the data.

• Backup:

– Passthrough writes

– Dedupe writes

• Restore

• Replication

Best Practices: RDS and the DR Series System
This topic introduces some recommended best practices for using Rapid Data Storage (RDS) operations with the DR 
Series system.

RDS and non-
RDS containers 
can exist on the 
same DR Series 
system

The DR Series system supports having both RDS and non-RDS containers on the same 
appliance. However, this can cause incorrect capacity reporting as both container types share 
the same underlying storage.

RDS replication 
and non-RDS 
replication on the 
same DR Series 
system

Non-RDS replication must be configured, and it is replicated on a per-container basis. 
However, this type of replication will not replicate RDS containers. RDS replication is file-
based and is triggered by the DMA.

Do not change 
the container 
connection type 
from NFS/CIFS to 
RDS

A non-RDS container must be deleted before this container can then be created as an RDS 
container using the same name.

Setting Client-Side Optimization
Client-side optimization is a process that can contribute to saving time performing backup operations and reducing the 
data transfer overhead on the network.
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You can turn On or turn Off client-side optimization (also known as client-side deduplication) using the DR Series system 
CLI commands, rda --update_client --name --mode. For more information about DR Series system CLI commands, see 
the Dell DR Series System Command Line Reference Guide, available at support.dell.com/manuals.

Adding RDS Devices in NVBU
To add RDS devices in the NVBU:

1. Log on to your NVBU media server and launch NVBU console.

2. Click Device Management.
The NVBU Device Management window is displayed.

3. Select Add → Add Dell RDA Device.
The Add Dell RDA Device window is displayed.

4. In Host, enter the IP address or the system host name of the DR System.

5. In Username, enter backup_user.

노트: The Username, backup_user is case-sensitive. You can configure RDS containers only while logged on 
the DR Series system with username backup_user.

6. In Password, enter the password used to access the DR Series system.

7. In LSU, enter the name of the RDS container.

노트: The RDS container name in LSU is case-sensitive. Ensure that you enter the RDS container name 
exactly as it is on the DR Series system.

8. To save the entered details and add the device to the NVBU server:

– Select File → Save

– Click the Save icon.

Removing RDS Devices From NVBU
노트: Removing an RDS device from NVBU does not delete the data stored in the RDS container on the DR Series 
system.

To remove existing RDS devices from NVBU:

1. Log on to your NVBU server and launch NVBU console.

2. Click Device Management.
The NVBU Device Management window is displayed.

3. Select the RDA device that you want to remove, right-click, and select Remove.

노트: Ensure that you remove the RDA device from NVBU before you delete the container from the DR Series 
system. You must force remove the RDS device from NVBU, if you delete an RDS container from the DR Series 
system before removing it from the NVBU server.

4. Repeat step 3 to remove additional RDS devices.

The selected RDS device is removed from NVBU. The RDS container can now be removed from the DR Series system.
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Backing Up Data on the RDS Container Using NVBU
You must back up data on the RDS container (available on the DR Series systems) using NVBU. Before you can back up 
data using the RDS protocol, you must create an RDS container on the DR Series system and add that container as an 
RDA device on NVBU. For more information see, Adding RDA Device on NVBU.

To back up data on the RDS container:

1. In the NVBU Console, click Backup.
The NVBU Backup window is displayed.

2. From the Server Location list, select the relevant NVBU server.

3. In Job Title, enter a relevant job title.

4. In the Selections tab, select the appropriate built in Netvault Backup plugin.
For example, to backup the filesystem, select the filesystem plugin.

5. Navigate to the drive or folder that you want to back up and select that drive or folder.

6. Select the Backup Options tab, under Backup Method select the relevant backup options.
You can select one of the following:

– Standard

– Volume Shadow Copy Service (VSS)

7. In Backup Type, select the relevant backup type.
You can select one of the following:

– Full

– Incremental

– Differential

8. Under Backup Options, select the relevant options.
You can select:

– Ignore Active Bit

– Check for Files Being Modified During Backup

– Backup through Mount Points

– Enable Restartable Backup

9. Under Backup Options, if necessary, enter the Path to Backup Log.

10. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a pre-specified 
Trigger name.

11. Under Job Options select the relevant options.

12. Select The Target tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

13. Select the relevant RDS device from the list of displayed devices.
You can select more than one device.
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14. Select the Advanced Options tab, and select the relevant options.
15. To run the backup job, click the Submit icon.

The backup job may take a few minutes to complete depending on the amount of data that is backed up. You can view 
the progress of the backup job on NVBU, using the Job Management section of NVBU.

노트: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Replicating Data to an RDS Container Using NVBU
Using NVBU with the DR Series system, you can run optimized replication jobs. You can replicate data in backup RDS 
containers on one DR Series system to a target RDS container that is on a different DR Series system. The two DR Series 
systems containing the source and target containers and the NVBU server must be on the same subnet. Both the source 
and target RDS containers must be added to the NVBU server as RDA devices. You can complete optimized replication 
(or optimized duplication) of backups that you complete using NVBU.

노트: You cannot replicate RDS containers using the DR Series system native replication feature.

노트: The source or backup container and the target container must use the RDS protocol.

To replicate the data available on the backup RDS container to a target RDS container:

1. In the NVBU Console, click Backup.
The NVBU Backup window is displayed.

2. From the Server Location list, select the relevant NVBU server.
3. In Job Title, enter a relevant job title.
4. In the Selections tab, select Data Copyand then Backups or Backup Sets and navigate to the backup job that you 

want to replicate.
5. Select the Backup Options tab, under Data Copy Options select the relevant options.

노트: Under Copy Type, by default, options are set for Copy and Optimized replication for the DR Series 
systems.

6. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a prespecified 
Trigger name.

7. Under Job Options select the relevant options.
8. Select the Source tab, under Device Options select, Specify Device.

The RDS devices added to NVBU are displayed.

9. Select the relevant source RDS device from the list of displayed devices.
You can select more than one device.

10. Select the Target tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

11. Select the relevant target RDS device from the list of displayed devices.
You can select more than one device.

12. Under Media Options and General Options, select the relevant option.
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13. Select the Advanced Options tab and select the relevant options.

14. To run the optimized replication job, click the Submit icon.

노트: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Restoring Data From a DR Series System Using NVBU
Use NVBU to restore data from a RDS container on a DR Series system.

To restore data from a DR Series system using NVBU:

1. In the NVBU Console, click Restore.
The NVBU Restore window is displayed.

2. From the Server Location list, select the relevant NVBU server.

3. In Job Title, enter a relevant job title.

4. In the Selections tab, navigate to the backup job that you want to restore.
By default, the data is restored into the folder that you have backed up.

5. To change the restore location, double click the backup saveset, navigate to the folder that you backed up, right 
click the folder and select Rename.
The Restore Rename window is displayed.

6. To rename the restore folder, select Rename to and enter the new name for the restore folder.

7. To relocate the restore data, select Relocate to and enter the new location for the restore folder.

8. From the Selection Method list, select Plugin, Backup Set, or Job.
By default Plugin is selected.

You can filter the backups using the Filter Options.

9. Select the Restore Options tab and select the relevant File System Plugin Restore Options.

10. Select the Source tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

11. Select the relevant source RDS device from the list of displayed devices.
You can select more than one device.

12. Select the Target Client tab.
A list of available clients is displayed.

13. From the list of available client, select the relevant target client.

14. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a prespecified 
Trigger name.

15. Under Job Options select the relevant options.

16. Select the Advanced Options tab and select the relevant options.

17. To run the restore job, click the Submit icon.
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노트: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Supported DR Series System CLI Commands for RDS
The following are the supported DR Series system CLI commands for RDS operations:

administrator@DocTeam-SW-01 > rda
Usage:
        rda --show [--config]
                 [--file_history] [--name <name>]
                 [--active_files] [--name <name>]
                 [--clients]
                 [--limits]

        rda --setpassword
        rda --delete_client --name <RDA Client Hostname>

        rda --update_client --name <RDA Client Hostname>
                 --mode <auto|passthrough|dedupe>

        rda --limit --speed <<num><kbps|mbps|gbps> | default>
                 --target <ip address | hostname>

        rda --help

   rda <command> <command-arguments>
   <command> can be one of:
                --show            Displays command specific information.
                --setpassword     Updates the Rapid Data Access (RDA) user 
password.
                --delete_client   Deletes the Rapid Data Access (RDA) client.
                --update_client   Updates attributes of a Rapid Data Access 
(RDA) client.
                --limit           Limits bandwidth consumed by Rapid Data 
Access(RDA) when replicating over a WAN link.

For command-specific help, please type rda --help <command>
        eg:
            rda --help show

노트: The --files in the rda --show --file_history command represents replicated files that were processed via the 
DMA optimized duplication operation. This command displays only up to the last 10 such files. The --name in the 
rda --show --name command represents the RDA container name. For more information about RDA-related DR 
Series system CLI commands, see the Dell DR Series System Command Line Reference Guide.
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10
Troubleshooting and Maintenance
This topic provides an overview of the basic troubleshooting and maintenance information that is available to help you 
better understand the current state of your DR Series system. The following list of information sources can aid you in 
understanding the current state of and maintaining your system:

• System alert and system event messages, for more information, see DR Series System Alert and Event 
Messages, which provides a tables that list the system alerts and system events.

• Diagnostics service, for more information, see About the Diagnostics Service.

• Maintenance mode, for more information, see About the DR Series Maintenance Mode.

• Support mode, for more information, see About the DR Series Support Mode.

• Scheduling system operations, for more information, see Scheduling DR Series System Operations.

• Scheduling Replication operations, for more information, see Creating a Replication Schedule.

• Scheduling Cleaner operations, for more information, see Creating a Cleaner Schedule.

Troubleshooting Error Conditions
To troubleshoot error conditions that disrupt your normal DR Series system operations, complete the following:

1. Generate a DR Series system diagnostics log file bundle if one has not already been automatically created.
For more information, see Generating a Diagnostics Log File.

2. Check the system alert and system event messages to determine the current status of your DR Series system.
For more information, see DR Series System Alert and Event Messages, Monitoring System Alerts, and Monitoring 
System Events.

3. Verify if the DR Series system has recovered or whether it has entered into Maintenance mode or Support mode.
For more information, see About the DR Series System Maintenance Mode and About the DR Series System 
Support Mode.

4. If you cannot resolve the issue using the information in this DR Series system documentation, then read Before 
Contacting Dell Support, and seek assistance from Dell Support.

DR Series 시스템 경고 및 이벤트 메시지

DR Series 시스템은 시스템의 현재 상태를 설명하는 다양한 시스템 경고와 시스템 이벤트 메시지 유형을 제공합
니다. 이러한 메시지를 검토하여 보고된 문제를 해결할 수 있는 조치를 취할 수 있습니다.

이 주제 및 기타 관련 주제에 있는 자료를 참조하는 것이 좋습니다.

• DR Series 시스템의 문제를 해결하기 전에.

• Dell 지원팀에 기술 지원을 문의하기 전에.

DR Series 시스템 설명서에 제공된 정보를 통해 기본적인 문제를 해결할 수도 있습니다.

일부 경고 및 이벤트 메시지는 정보용으로서 일반적인 시스템 상태를 제공합니다. 기타 경고 및 이벤트 메시지

는 특정 상태 또는 구성요소 정보를 표시하거나, 문제 해결 또는 문제의 조건 확인을 위해 수행할 수 있는 특정 

작업을 제안합니다.
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Dell 지원팀의 개입이 필요한 경우 Dell 지원팀에 도움을 요청하는 방법을 알려주는 기타 경고 및 이벤트 메시지

도 있습니다.

• 표 1은 시스템 경고 유형별로 DR Series 시스템 경고 메시지를 나열합니다(일반 시스템, 시스템 섀시, 
NVRAM, 백업 및 중복 제거 관련 작업 중에 표시될 수 있는 PERC 관련 경고 메시지).

• 표 2는 1부터 7까지 시스템 이벤트 유형별로 DR Series 시스템 이벤트 메시지를 나열합니다(백업, 복제, 중
복 제거, 진단, 클리너, DataCheck, 유지 관리, OpenStorage Technology(OST) 작업 중에 표시될 수 있는 이벤
트 메시지).

표 7. DR Series 시스템 경고 메시지

경고 메시지 설명/의미 또는 조치

일반적인 시스템 경고

파일 시스템 검색이 요청되었습니다. 시스템이 유지 관리 모드로 전환 중입니다. 파일 시스

템의 액세스 권한이 읽기 전용입니다.

NVRAM이 감지되지 않았습니다. NVRAM 카드가 올바르게 장착되어 있는지 확인하십시

오.

NVRAM 커패시터가 분리되었습니다. Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

NVRAM 커패시터의 성능이 저하되었습니다. Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

NVRAM SSD(Solid State Drive)가 분리되었습니다. Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

마지막 부팅 중에 NVRAM이 데이터를 백업하거나 복
원하지 못했습니다.

Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

NVRAM 하드웨어 오류가 발생했습니다. Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

데이터 볼륨이 없습니다. 모든 드라이브가 설치되어 

전원이 켜져 있는지 확인하십시오.
Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

여러 번 시도했지만 파일 서버 시작에 실패했습니다. Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

파일 서버에서 여러 번 실패했습니다. 유지 관리 모드

로 전환됩니다.
Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

디스크 공간이 부족합니다. 현재 파일 시스템이 읽기 전용입니다.

데이터 볼륨에서 파일 시스템 유형을 감지할 수 없습

니다.
Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

네임스페이스 볼륨에서 파일 시스템 유형을 감지할 

수 없습니다.
Dell 지원팀에 가능한 지원 또는 개입을 요청하십시오.

파일 시스템 검색에서 불일치 항목을 검색했습니다. 파일 시스템 보고서를 확인하고 제안된 조치를 수행하

십시오. Dell 지원팀에 가능한 지원 또는 개입을 요청하

십시오.

복제 피어 네트워크의 연결이 끊어졌습니다. 원격 사이트에 대한 액세스를 확인하십시오.

NVRAM이 데이터 볼륨과 일치하지 않습니다. NVRAM이 새로 교체된 경우 maintenance --hardware --
reinit_nvram 명령을 사용하여 NVRAM을 다시 초기화하

십시오.
자세한 내용은 Dell DR Series 시스템 명령행 참조 안내
서를 참조하십시오.
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경고 메시지 설명/의미 또는 조치

스토리지 사용량이 시스템 용량에 근접합니다. 파일 시스템을 정리하십시오. 문제가 지속되면 Dell 지
원팀에 가능한 지원 또는 개입을 요청하십시오.

복제 재동기화를 계속 진행할 수 없습니다. 네임스페이스 한도가 최대값에 도달했습니다.

복제 대상의 공간이 부족합니다. 파일 시스템을 정리하십시오. 문제가 지속되면 Dell 지
원팀에 가능한 지원 또는 개입을 요청하십시오.

파일 시스템이 허용되는 파일 및 디렉터리 최대 한도

에 도달했습니다. 새 파일 및 디렉터리 생성이 거부됩

니다.

파일 시스템을 정리하십시오. 문제가 지속되면 Dell 지
원팀에 가능한 지원 또는 개입을 요청하십시오.

시스템 섀시 경고

전원 공급 장치 <숫자>에서 장애를 감지했습니다. • 지정된 전원 공급 장치의 전원 케이블이 분리되
어 있으면 다시 연결하십시오.

• 전원 케이블에 입력 AC 전원이 있는지 확인하
십시오.

• 다른 전원 코드를 사용하십시오.

그래도 문제가 해결되지 않으면 지정된 전원 공급 장치

를 교체하십시오.

전원 공급 장치 <숫자>이(가) 누락되었거나 제거되었

습니다.
• 전원 공급 장치의 연결을 올바르게 설정할 수 

없습니다.
• 전원 공급 장치 슬롯에 전원 공급 장치를 다시 

장착해 보십시오.
• 지정된 전원 공급 장치의 전원 케이블이 분리되

어 있으면 다시 연결하십시오.
• 전원 케이블에 입력 AC가 있는지 확인하십시

오.
• 다른 전원 코드를 사용하십시오.

그래도 문제가 해결되지 않으면 지정된 전원 공급 장치

를 교체하십시오.

전원 공급 장치 <숫자>의 코드가 분리되었습니다. • 지정된 전원 공급 장치의 전원 케이블이 분리되
어 있으면 다시 연결하십시오.

• 전원 케이블에 입력 AC 전원이 있는지 확인하
십시오.

• 다른 전원 코드를 사용하십시오.

팬 <숫자>에 오류가 발생했습니다. • 지정된 냉각 장치가 있고 올바르게 장착되어 있
는지 확인하십시오.

• 지정된 냉각 장치가 회전되고 실행되고 있는지 
확인하십시오.

그래도 문제가 해결되지 않으면 지정된 냉각 팬을 교체

하십시오.

팬 <숫자>이(가) 누락되었습니다. 지정된 누락 냉각 팬을 연결하거나 교체하십시오.

네트워크 인터페이스 컨트롤러 <숫자>에서 비정상적

인 네트워크 오류가 발생했습니다.
네트워크 인터페이스 컨트롤러 오류는 네트워크 정체 

또는 패킷 오류로 인해 발생할 수 있습니다.
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• 네트워크를 확인하십시오. 그래도 문제가 해결
되지 않으면 NIC를 교체하십시오.

• NIC가 내장되어 있으면 DR Series 시스템 어플
라이언스에 서비스가 필요합니다.

네트워크 인터페이스 컨트롤러가 누락되었습니다. • NIC를 분리했다가 다시 삽입하십시오.
• 그래도 문제가 해결되지 않으면 NIC를 교체하

십시오.

네트워크 인터페이스 컨트롤러 <이름>의 연결이 끊어

졌습니다.
네트워크에 컨트롤러를 연결하고 네트워크 스위치 또
는 라우터에 네트워크 연결 문제가 있는지 확인하십시

오.

네트워크 인터페이스 컨트롤러 <이름>이(가) 비활성

화되었습니다.
지정된 NIC의 포트를 활성화하십시오.

네트워크 인터페이스 컨트롤러 <이름> 드라이버가 잘
못되었습니다.

DR Series 시스템 어플라이언스를 업그레이드하십시오

(소프트웨어 업그레이드 페이지에서 업그레이드 시작 

클릭).

CPU <이름>에 오류가 발생했습니다. 오류가 발생한 지정된 프로세서를 교체하십시오.

CPU <이름>이(가) 누락되었습니다. 지정된 누락 프로세서를 다시 삽입하거나 교체하십시

오.

DIMM <이름>에 오류가 발생했습니다. 오류가 발생한 지정된 DIMM(이중 인라인 메모리 모듈) 
장치를 교체하십시오.

DIMM <이름>이(가) 누락되었습니다. • 지정된 DIMM 장치를 다시 삽입하거나 교체하
십시오.

• 스토리지 어플라이언스의 메모리 용량이 올바
르게 작동되는 데 필요한 최소값 미만입니다.

• 스토리지 어플라이언스에 서비스가 필요합니
다.

온도 프로브 <이름>에 오류가 발생했습니다. 스토리지 어플라이언스에 서비스가 필요합니다.

전압 프로브 <이름>에 오류가 발생했습니다. 스토리지 어플라이언스에 서비스가 필요합니다.

온도 프로브의 온도가 범위를 벗어났습니다. • DR Series 시스템의 이벤트 페이지에서 특정 온
도 이벤트와 온도 프로브의 위치를 확인하십시
오.

• 데이터센터 에어컨, 통풍 및 내부 시스템 냉각 
팬에 문제가 있는지 확인하십시오.

• 스토리지 어플라이언스를 통과하는 공기 흐름
이 올바른지 확인하고 필요할 경우 냉각용 통풍
구를 청소하십시오.

전압 프로브의 판독값이 범위를 벗어났습니다. • DR Series 시스템의 이벤트 페이지에서 특정 전
압 이벤트와 전압 프로브의 위치를 확인하십시
오.

• 전원 공급 장치를 확인하십시오. 전원 공급 장
치에 문제가 없으면 서비스 기술자에게 문의하
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여 DR Series 시스템 어플라이언스에 서비스가 
필요한지 확인하도록 합니다.

스토리지 컨트롤러 <숫자>에 오류가 발생했습니다. DR Series 시스템의 RAID 컨트롤러를 교체하십시오.

스토리지 컨트롤러 <숫자>이(가) 누락되었습니다. DR Series 시스템의 RAID 컨트롤러를 다시 삽입하거나 

교체하십시오.

스토리지 컨트롤러 <숫자>의 구성이 잘못되었습니다. 필요한 가상 드라이브 개수가 <숫자>이지만, 실제로 발
견된 가상 드라이브 개수는 <숫자>입니다.
Dell 복원 관리자(RM) 유틸리티를 실행하여 드라이브 
구성 불일치를 복구하십시오.
필요한 인클로저 개수가 <숫자>이지만, 실제로 발견된 
인클로저 개수는 <숫자>입니다.

• 스토리지 컨트롤러와 모든 해당 인클로저 간의 
SAS 케이블 연결을 확인하십시오.

• 인클로저 전원 공급 장치의 전원 케이블 연결을 
확인하십시오.

실제 디스크 <숫자>에 장애가 발생했습니다. 오류가 발생한 실제 디스크를 교체하십시오.

실제 디스크 <숫자>이(가) 누락되었거나, 제거되었거

나, 감지되지 않습니다.
실제 디스크를 다시 삽입하거나 교체하십시오.

실제 디스크 <숫자>에서 예상 장애가 보고되었습니

다.
실제 디스크를 교체하십시오.

노트: 디스크에 아직 장애가 발생하지 않았더라도 

디스크를 교체하는 것이 좋습니다.

실제 디스크 <숫자>이(가) 지원되지 않는 유형입니다. 이 디스크 유형은 지원되지 않으므로 이 구성에 사용할 

수 없습니다.
지원되지 않는 실제 디스크를 Dell에서 지원하는 SAS 
실제 디스크로 교체하십시오.

구성 명령을 사용하여 실제 디스크 <숫자>이(가) 오프

라인으로 수동 설정되었습니다.
실제 디스크를 분리했다가 다시 삽입하십시오(이 상태

에서는 드라이브가 작동되지 않음).

실제 디스크 <숫자>이(가) 외부 디스크입니다. 이 상황은 스토리지 컨트롤러가 교체되었거나 모든 드
라이브가 다른 시스템에서 마이그레이션된 경우에 발
생할 수 있습니다. 이러한 경우에는 외부 구성을 가져

와야 합니다.
이 상황이 단일 실제 디스크에서 발생할 경우 외부 구
성을 지워야 합니다.

노트: 이 상황은 재구축이 진행되고 있는 동안 드라

이브를 분리했다가 다시 삽입할 때에도 발생할 수 

있습니다.

가상 디스크 <숫자>에 오류가 발생했습니다. 장애가 발생했거나 누락된 실제 디스크를 모두 교체하

고 Dell 복원 관리자(RM) 유틸리티를 실행하십시오.

가상 디스크 <숫자>에 유효하지 않은 레이아웃이 있
습니다.

Dell 복원 관리자(RM) 유틸리티를 실행하여 이 설치를 

복구합니다.
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<device>에 장애가 발생했습니다. • 장치가 있는지 확인하고 케이블이 올바르게 연
결되어 있는지 확인하십시오. 자세한 내용은 
Dell DR Series 시스템 소유자 매뉴얼을 참조하
여 시스템 케이블 연결이 올바른지 확인하십시
오.

• 컨트롤러 배터리와의 연결 및 배터리 상태를 확
인하십시오.

• 이러한 단계를 수행해도 문제가 해결되지 않으
면 스토리지 컨트롤러 배터리를 교체하십시오.

<device>이(가) 누락되었습니다. • 장치가 있는지 확인하고 케이블이 올바르게 연
결되어 있는지 확인하십시오. 자세한 내용은 
Dell DR Series 시스템 소유자 매뉴얼을 참조하
여 시스템 케이블 연결이 올바른지 확인하십시
오.

• 컨트롤러 배터리와의 연결 및 배터리 상태를 확
인하십시오.

노트: 배터리 충전 상태가 약하거나 감소되면 이 경
고가 발생할 수 있습니다.

스토리지 <device>에 장애가 발생했습니다. 스토리지 컨트롤러와 인클로저 또는 후면판 간의 케이

블 연결을 확인하십시오.

스토리지 <device>이(가) 누락되었습니다. 다음을 수행하십시오.

• 스토리지 컨트롤러와 인클로저 또는 후면판 간
의 SAS 및 전원 케이블 연결을 확인하십시오.

• 외부 인클로저 관리 모듈(EMM) 및 PERC 상태 
LED를 확인하십시오.

NVRAM 경고

NVRAM PCI 컨트롤러에 장애가 발생했습니다. NVRAM PCI 컨트롤러를 교체하십시오.

NVRAM PCI 컨트롤러가 누락되었습니다. NVRAM PCI 컨트롤러를 다시 삽입하거나 교체하십시

오.

NVRAM PCI 컨트롤러의 슈퍼 커패시터에 장애가 발생

했습니다.
NVRAM PCI 컨트롤러를 교체하십시오.

NVRAM PCI 컨트롤러의 슈퍼 커패시터가 누락되었습

니다.
NVRAM PCI 컨트롤러를 교체하십시오.

소프트웨어 호환성 확인에 실패했습니다. DR Series 시스템 어플라이언스를 업그레이드하십시오

(소프트웨어 업그레이드 페이지에서 업그레이드 시작 

클릭).

해당 시스템 소프트웨어 패키지가 현재 소프트웨어 

스택과 호환되지 않습니다.
DR Series 시스템 어플라이언스를 업그레이드하십시오

(소프트웨어 업그레이드 페이지에서 업그레이드 시작 

클릭).

PERC 경고

스토리지 어플라이언스가 시스템 진단을 수집하지 못
했습니다.

• DR Series 시스템 진단 로그 번들의 모든 문제를 
해결하십시오.

• 진단 로그 번들 수집을 다시 시도하십시오.
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• Dell 지원팀에 도움을 요청하십시오.

스토리지 어플라이언스 위험 오류: 이 스토리지 어플

라이언스가 제대로 작동되기 위한 BIOS 시스템 ID가 

올바르지 않습니다.

• DR Series 시스템 어플라이언스에 서비스가 필
요합니다.

• Dell 지원팀에 도움을 요청하십시오.

표 8. DR Series 시스템 이벤트 메시지

시스템 이벤트 메시지 설명/의미 또는 조치

시스템 이벤트 = 유형 1

시스템 메모리 사용량이 최적 수준으로 복귀되었

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

높은 수준의 시스템 프로세스 사용량이 감지되었

습니다. 이 상태가 지속되면 시스템 진단을 수집하

십시오.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 프로세스 사용량이 최적 수준으로 복귀되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

NVRAM PCI 컨트롤러에서 고온 판독값이 감지되었

습니다. 시스템이 읽기 전용 모드에서만 작동됩니

다. 시스템 공기 흐름을 확인하십시오.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

NVRAM PCI 컨트롤러에서 고온 판독값이 감지되었

습니다. 온도가 주변 온도인 섭씨 55도(화씨 131도)
까지 내려가야 시스템이 작동됩니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

다음 NVRAM 커패시터 상태 확인이 <변수>에 예약

됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

Windows Active Directory 클라이언트가 Active 
Directory 도메인 서버에 접속할 수 없습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

Active Directory 도메인 서버 연결이 복원됩니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 IP 주소가 <변수>에서 <변수>(으)로 변경되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

파일 시스템 검사가 요청되었습니다. 유지 관리 모
드로 전환 중입니다. 파일 시스템의 액세스 권한이 

읽기 전용입니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

NVRAM이 감지되지 않았습니다. 카드가 올바르게 

장착되어 있는지 확인하십시오.
DR Series 시스템 어플라이언스에 NVRAM 카드가 올바르

게 장착되어 있는지 확인하십시오. Dell 지원팀에 지원 또
는 개입을 요청하십시오.

NVRAM 커패시터가 분리되었습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

NVRAM 커패시터의 성능이 저하되었습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

NVRAM SSD가 분리되었습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.
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마지막 부팅 중에 NVRAM이 데이터를 백업하거나 

복원하지 못했습니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

NVRAM 하드웨어 오류가 발생했습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

데이터 볼륨이 없습니다. 모든 드라이브가 삽입되

어 전원이 켜져 있는지 확인하십시오.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

여러 번 시도했지만 파일 시스템 서버 시작에 실패

했습니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

파일 시스템 서버가 여러 번 손상되었습니다. 시스

템이 현재 유지 관리 모드로 전환 중입니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

디스크 공간이 부족합니다. 파일 시스템이 읽기 전
용 모드로 전환되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

데이터 볼륨에서 파일 시스템 유형을 감지할 수 없
습니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

네임스페이스 볼륨에서 파일 시스템 유형을 감지

할 수 없습니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

파일 시스템 검색에서 불일치 항목을 검색했습니

다.
보고서를 확인하고 권장 조치를 수행하십시오. Dell 지원

팀에 지원 또는 개입을 요청하십시오.

NVRAM이 데이터 볼륨과 일치하지 않습니다. NVRAM 장치가 새로 교체된 경우 CLI maintenance --
hardware --reinit_nvram 명령을 사용하십시오. 자세한 내
용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하

십시오.

스토리지 사용량이 DR Series 시스템 용량에 근접

합니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

네임스페이스 크기가 최대값에 도달했기 때문에 

복제 재동기화를 계속 진행할 수 없습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

파일 시스템이 허용되는 파일 및 디렉터리 최대 한
도에 도달했습니다. 충분한 공간이 확보되기 전까

지는 새 파일 및 디렉터리 생성이 거부됩니다.

파일 시스템을 정리하십시오. 문제가 지속되면 Dell 지원

팀에 지원 또는 개입을 요청하십시오.

파일 시스템이 허용되는 파일 및 디렉터리 최대 한
도에 근접합니다. 한도에 도달하면 새 파일 및 디렉

터리 생성이 거부됩니다.

파일 시스템을 정리하십시오. 문제가 지속되면 Dell 지원

팀에 지원 또는 개입을 요청하십시오.

복제에 예기치 않은 오류가 발생했습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

DataCheck에서 잠재적 손상을 감지했습니다. 처음 발생하는 기회에 데이터 일관성 확인을 실행하십시

오. 이 문제가 지속되면 Dell 지원팀에 지원 또는 개입을 요
청하십시오.

NVRAM PCI 컨트롤러에서 온도 경고가 감지되었습

니다.
데이터센터 에어 컨디션, 랙 통풍 및 내부 냉각 팬에 문제

가 있는지 확인하십시오. 스토리지 어플라이언스를 통과

하는 공기 흐름이 올바른지 확인하고 필요할 경우 시스템 

냉각용 통풍구를 청소하십시오. 문제가 지속되면 Dell 지
원팀에 지원 또는 개입을 요청하십시오.
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파일 시스템 네임스페이스 파티션이 허용되는 최
대 한도에 도달했습니다.

오래 되어 사용되지 않는 파일을 삭제하거나 복제를 비활

성화하십시오. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

파일 시스템 네임스페이스 파티션이 허용되는 최
대 한도에 근접합니다.

새 복제 재동기화가 중지됩니다. 문제가 지속되면 Dell 지
원팀에 지원 또는 개입을 요청하십시오.

하나 이상의 소프트웨어 패키지가 호환되지 않습

니다.
문제를 해결하려면 시스템 어플라이언스를 업그레이드

하십시오. DR Series 시스템 어플라이언스를 업그레이드

하십시오(소프트웨어 업그레이드 페이지에서 업그레이

드 시작 클릭).

시스템 이벤트 = 유형 2

<이름> 컨테이너가 성공적으로 생성되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너가 삭제되도록 표시되었습니다. 자세한 내용은 컨테이너 삭제를 참조하십시오. DR Series 
시스템 CLI maintenance --filesystem --reclaim_space 명령

을 사용하여 이 스토리지 공간을 복구하십시오.

컨테이너 이름이 <이름>에서 <이름>(으)로 변경되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 연결 항목이 성공적으로 

추가됨: 유형 <변수> 클라이언트 <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 연결 항목이 성공적으로 

업데이트됨: 유형 <변수> 클라이언트 <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 연결 항목이 성공적으로 

삭제됨: 유형 <변수> 클라이언트 <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 복제 항목이 성공적으로 

업데이트됨: 역할 <변수> 피어 <변수> 피어 컨테이

너 <변수>.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 복제 구성이 성공적으로 

업데이트됨: 역할 <변수> 피어 <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너에 대한 복제 구성이 성공적으로 

삭제됨: 피어 <변수> 피어 컨테이너 <이름>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

복제 <변수> 기본값이 성공적으로 업데이트됨: 역
할 <변수> 피어 <변수>.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수>의 복제 대역폭 한도가 <변수>(으)로 성공적

으로 업데이트되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수>의 복제 대역폭 한도가 성공적으로 제거되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 복제 대역폭 한도가 성공적으로 설정되었

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<이름> 컨테이너의 복제 재동기화가 성공적으로 

시작되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.
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<이름> 컨테이너의 복제 재동기화를 시작하는 중
에 오류가 발생했습니다.

자세한 내용은 복제 작업 관리를 참조하십시오.

스냅샷 <변수> → <변수>이(가) 성공적으로 생성되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

스냅샷 <변수> → <변수>이(가) 성공적으로 업데이

트되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

스냅샷 <변수> → <변수>이(가) 성공적으로 삭제되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

온라인 데이터 확인 <변수>에 성공했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수>의 <변수> 시스템 마커에 성공했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 스케줄이 성공적으로 업데이트되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이벤트 = 유형 3

시스템이 유지 관리 모드로 전환됩니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다. Dell 지
원팀에 지원 또는 개입을 요청하십시오.

시스템이 지원 모드로 전환됩니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다. Dell 지
원팀에 지원 또는 개입을 요청하십시오.

오류 - OFS 클라이언트 초기화 오류입니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

오류 - <변수>일 경우 컨테이너의 MTAB 초기화 오
류입니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

오류 - 노드 MTAB를 초기화할 수 없습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오.

컨테이너 ID <변수>에 대한 구성을 검색하는 중에 

오류가 발생했습니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

컨테이너 ID <변수>을(를) 삭제하는 중에 오류가 발
생했습니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

컨테이너 ID <변수>을(를) 중지하는 중에 오류가 발
생했습니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

컨테이너 ID <변수>의 <변수> 연결을 추가하는 중
에 오류가 발생했습니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

컨테이너 ID <변수>의 <변수> 연결을 삭제하는 중
에 오류가 발생했습니다.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

스케줄에 따라 복제가 시작되었습니다. <변수>까

지 활성 상태가 됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

스케줄에 따라 복제가 중지되었습니다. <변수>에 

다시 시작됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너에 대한 컨테이너 재생에 실패했

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다. Dell 지
원팀에 지원 또는 개입을 요청하십시오.

오류 - 네임스페이스 하위 시스템 초기화에 실패했

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다. Dell 지
원팀에 지원 또는 개입을 요청하십시오.
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네임스페이스에서 불일치 항목이 발견되었습니다. DR Series 시스템 CLI maintenance --filesystem --start_scan 
명령을 사용하여 파일 시스템 일관성 검사를 예약하십시

오.

시스템이 유지 관리 모드로 전환됩니다. 네임스페

이스 로그 재생에 실패했습니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

시스템이 유지 관리 모드로 전환됩니다. 네임스페

이스 트랜잭션 오류입니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

오류 - 네임스페이스 트랜잭션 커밋에 실패했습니

다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

파일 시스템이 지원되는 최대 네임스페이스 항목 

수에 도달했습니다.
새 파일 및 디렉터리 생성 작업이 허용되도록 파일 시스템

을 정리하십시오. 상태가 지속되면 Dell 지원팀에 지원 또
는 개입을 요청하십시오.

사용 가능한 네임스페이스 항목이 부족한 파일 시
스템이 복구되었습니다.

파일 시스템 생성 작업이 허용되지 않습니다. Dell 지원팀

에 지원 또는 개입을 요청하십시오.

일부 파일의 내부 속성이 손상되었습니다. DR 
Series 시스템에서는 속성이 손상된 파일에서 속성 

또는 ACL을 설정하거나 제거할 수 없습니다.

속성이 손상된 모든 파일을 찾아 해당 상태를 제거하려면 

DR Series 시스템 CLI maintenance --filesystem --start_scan 
명령을 사용하여 유지 관리 검사를 수행하십시오. Dell 지
원팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너의 복제 재동기화가 시작되었습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너의 복제 내부 재동기화가 시작되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너의 복제 재동기화가 완료되었습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너의 복제 내부 재동기화가 완료되

었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너에 대한 복제 스냅샷을 만드는 중
에 오류가 발생했습니다.

상태가 지속되면 아이노드(inode) 수를 줄이거나 Dell 지원

팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너에 대한 복제 스냅샷을 삭제하는 

중에 오류가 발생했습니다.
상태가 지속되면 아이노드(inode) 수를 줄이거나 Dell 지원

팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너의 복제 클라이언트가 연결되었습

니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너의 복제 클라이언트 연결이 끊어

졌습니다.
복제 작업용 포트(9904, 9911, 9915, 9916)와 OST 작업용 포트

(10011, 11000)가 활성화되어 있는지 확인하십시오. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너의 복제 서버가 연결되었습니다. 복제 작업용 포트(9904, 9911, 9915, 9916)와 OST 작업용 포트

(10011, 11000)가 활성화되어 있는지 확인하십시오. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너의 복제 서버 연결이 끊어졌습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.
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<변수> 컨테이너의 복제 이름 서비스 볼륨 작업 로
그(oplog)가 가득 찼습니다.

복제 작업용 포트(9904, 9911, 9915, 9916)와 OST 작업용 포트

(10011, 11000)가 활성화되어 있는지 확인하십시오. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

<변수> 컨테이너의 손상된 이름 서비스 볼륨 작업 

로그(oplog)로 인해 DR Series가 유지 관리 모드로 

전환됩니다.

DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

<변수> 컨테이너에 대한 복제 데이터 작업 로그

(oplog)가 가득 찼습니다.
DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

<변수> 컨테이너의 손상된 복제 데이터 작업 로그

(oplog)로 인해 DR Series가 유지 관리 모드로 전환

됩니다.

DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

컨테이너 <변수> SCID <변수>의 손상된 블록맵으

로 인해 시스템이 유지 관리 모드로 전환됩니다.
DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

손상된 데이터스토어 <변수> SCID <변수>(으)로 인
해 시스템이 유지 관리 모드로 전환됩니다.

DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

<변수> 컨테이너의 복제 전송 로그(txlog)가 가득 찼
습니다.

DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

<변수> 컨테이너의 손상된 복제 txlog로 인해 DR 
Series가 유지 관리 모드로 전환됩니다.

진단 로그 파일을 수집하고 Dell 지원팀의 도움을 받아 지
원 레코드를 여십시오.

<변수> 컨테이너의 복제 txlog 커밋 오류 <변수>(으)
로 인해 시스템이 유지 관리 모드로 전환됩니다.

진단 로그 파일을 수집하고 Dell 지원팀의 도움을 받아 지
원 레코드를 여십시오.

<변수> 컨테이너의 손상된 청크 데이터로 인해 DR 
Series가 유지 관리 모드로 전환됩니다.

진단 로그 파일을 수집하고 Dell 지원팀의 도움을 받아 지
원 레코드를 여십시오.

파일 복제를 <변수> 컨테이너에서 진행할 수 없습

니다.
진단 로그 파일을 수집하고 Dell 지원팀의 도움을 받아 지
원 레코드를 여십시오.

<변수> 컨테이너의 복제 syncmgr 종료됨, 오류 <변
수>.

진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너의 복제 syncmgr 이벤트 발생, 오
류 <변수>.

진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너의 복제 이름 서비스 종료됨, 오류 

<변수>.
진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너의 복제 데이터 복제기 종료됨, 오
류 <변수>.

진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너의 복제 프로토콜 버전 불일치, 오
류 <변수>.

진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너의 복제 삭제 정리 실패, 오류 <변
수>.

진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.
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실행 중인 복제 대상 시스템 <변수>의 공간이 부족

합니다. <변수> 컨테이너에서 복제를 계속 진행할 

수 없습니다.

정보용 메시지. Dell 지원팀에 지원 또는 개입을 요청하십

시오.

<변수> 컨테이너에서 잘못된 복제 구성이 감지되

었습니다. 대상 시스템 <변수>에서 복제 관계가 강
제로 삭제되었을 수 있습니다.

정보용 메시지. Dell 지원팀에 지원 또는 개입을 요청하십

시오.

<변수> 컨테이너의 복제 실패, 오류 <변수>. 진단 로그 파일 번들을 수집하고 Dell 지원팀의 도움을 받
아 지원 레코드를 여십시오.

<변수> 컨테이너에 대해 복제 서버가 블록맵을 커
밋하지 못했습니다. 시스템이 유지 관리 모드로 전
환됩니다.

DR Series 시스템에서 자체 수정됩니다. 상태가 지속되면 

아이노드(inode) 수를 줄이거나 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

클리너 프로세스 중에 보류 중인 파일로 인해 복제 

컨테이너 <변수>이(가) 일시중지되었습니다.
복제 컨테이너에서 클리너를 실행하십시오. 상태가 지속

되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

시스템에서 낮은 버전의 RPC가 실행 중입니다. 모
든 대상 컨테이너에서 복제가 중단됩니다.

RPC를 올바른 버전으로 업그레이드하십시오. 상태가 지
속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

NFS 클라이언트가 <변수>을(를) 성공적으로 장착

했습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

최대 NFS 연결 한도 <변수>에 도달했으며 NFS 연결 

수는 <변수>입니다.
임계값 한도에 도달했습니다. 연결 수를 줄이십시오.

NFS 서버가 성공적으로 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

CIFS 클라이언트가 <변수> 컨테이너에 성공적으로 

연결되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

최대 CIFS 연결 한도 <변수>에 도달했습니다. 임계값 한도에 도달했습니다. 연결 수를 줄이십시오.

CIFS 서버가 <변수>을(를) 시작하지 못했습니다. DR Series 시스템을 다시 부팅하십시오. 문제가 지속되면 

Dell 지원팀에 지원 또는 개입을 요청하십시오.

CIFS 클라이언트가 <변수> 컨테이너에 <변수>번 연
결되었습니다.

DR Series 시스템을 다시 부팅하십시오. 문제가 지속되면 

Dell 지원팀에 지원 또는 개입을 요청하십시오.

CIFS 서버가 성공적으로 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

온라인 데이터 확인(DataCheck)이 시작되었습니다. 정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

온라인 데이터 확인(DataCheck)이 일시중단되었습

니다.
정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

온라인 데이터 확인(DataCheck)이 중지되었습니다. 정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

온라인 데이터 확인(DataCheck)이 재개되었습니다. 정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

온라인 데이터 확인(DataCheck)에서 <변수> 손상이 

감지되었습니다.
정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.
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온라인 데이터 확인(DataCheck)에서 <변수> 손상이 

감지되었습니다.
정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

온라인 데이터 확인(DataCheck) 시작에 실패했습니

다.
정보용 메시지. 문제가 지속되면 Dell 지원팀에 지원 또는 

개입을 요청하십시오.

시스템 이벤트 = 유형 4

중복 제거 사전 <변수>을(를) 로드할 수 없습니다. DR Series 시스템 CLI maintenance --configuration --
reinit_dictionary 명령을 사용하십시오. 이 문제가 지속되

면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

중복 제거 사전 <변수>을(를) 찾을 수 없습니다. DR Series 시스템 CLI maintenance --configuration --
reinit_dictionary 명령을 사용하십시오. 문제가 지속되면 

Dell 지원팀에 지원 또는 개입을 요청하십시오.

클리너 프로세스 실행 <변수>이(가) 시작되었습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

클리너 프로세스 실행 <변수>이(가) <변수>밀리초

(ms)에 완료되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

클리너 프로세스에 입력/출력(I/O) 오류가 발생했습

니다.
DR Series 시스템에 유지 관리 기반 문제가 발생했습니다. 
유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용하

여 상태를 확인하십시오. 필요한 경우 Dell 지원팀에 문의

하십시오.

NVRAM <변수> 동기화에 실패했습니다. DR Series 시스템에 NVRAM 하드웨어 문제가 발생했습니

다. 유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용

하여 상태를 확인하십시오.

NVRAM <변수>을(를) 읽는 중에 오류가 발생했습니

다.
DR Series 시스템에 NVRAM 하드웨어 문제가 발생했습니

다. 유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용

하여 상태를 확인하십시오.

NVRAM <변수>에 쓰는 중에 오류가 발생했습니다. DR Series 시스템에 NVRAM 하드웨어 문제가 발생했습니

다. 유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용

하여 상태를 확인하십시오.

NVRAM <변수> 동기화 작성에 실패했습니다. DR Series 시스템에 NVRAM 하드웨어 문제가 발생했습니

다. 유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용

하여 상태를 확인하십시오.

<변수> 데이터스토어 길이 불일치 <변수>. DR Series 시스템에 유지 관리 기반 문제가 발생했습니다. 
유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용하

여 상태를 확인하십시오. 필요한 경우 Dell 지원팀에 문의

하십시오.

데이터 볼륨 용량 임계값에 도달했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

공간이 부족합니다. <변수> 개체에서 업데이트 롤
백에 실패했습니다. 파일 서버를 다시 시작하는 중
입니다.

DR Series 시스템에 유지 관리 기반 문제가 발생했습니다. 
유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용하

여 상태를 확인하십시오. 필요한 경우 Dell 지원팀에 문의

하십시오.
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데이터 볼륨을 읽는 중에 오류가 발생했습니다. DR Series 시스템에 유지 관리 기반 문제가 발생했습니다. 
유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용하

여 상태를 확인하십시오. 필요한 경우 Dell 지원팀에 문의

하십시오.

데이터 볼륨에 쓰는 중에 오류가 발생했습니다. DR Series 시스템에 유지 관리 기반 문제가 발생했습니다. 
유지 관리 모드 또는 DR Series 시스템 CLI 명령을 사용하

여 상태를 확인하십시오. 필요한 경우 Dell 지원팀에 문의

하십시오.

메타데이터의 체크섬 확인에 실패했습니다. Dell 지원팀에 도움을 요청하거나 파일 시스템을 복구하

십시오. 복구에 대해서는 DR Series 유지 관리 모드 정보를 

참조하십시오.

최적화 엔진 로그 재생에 실패했습니다. Dell 지원팀에 도움을 요청하거나 파일 시스템을 복구하

십시오. 복구에 대해서는 DR Series 유지 관리 모드 정보를 

참조하십시오.

데이터스토어 압축 풀기 실패 <변수>. Dell 지원팀에 지원 또는 개입을 요청하십시오.

활성 데이터스토어 <변수>을(를) 정리하지 못했습

니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

<변수> 데이터스토어의 참조 개수가 음수입니다. 
레코드 유형: <변수>. 개수: <변수>.

Dell 지원팀에 도움을 요청하거나 파일 시스템을 복구하

십시오. 복구에 대해서는 DR Series 유지 관리 모드 정보를 

참조하십시오.

<변수> 데이터스토어의 스트림 참조 개수가 음수

입니다. 레코드 유형: <변수>. 개수: <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 데이터스토어의 총 참조 개수가 임계값에 

도달했습니다. 레코드 유형: <변수>. 개수: <변수>.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

로그 처리 중에 오류가 발생하여 유지 관리 모드로 

전환됩니다.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

최적화 프로그램 파이프라인을 확보하지 못했습니

다. 오류: <변수>.
Dell 지원팀에 지원 또는 개입을 요청하십시오.

최적화 프로그램 이벤트를 생성하지 못했습니다. 
유형: <변수>, 오류: <변수>.

Dell 지원팀에 지원 또는 개입을 요청하십시오.

<변수>밀리초(ms) 후에 <변수> 파이버의 작업 실행 

시간이 초과되었습니다. 파일 서버를 다시 시작하

는 중입니다.

파일 시스템이 다시 시작되었습니다. 진단 로그 파일 번들

을 수집하고 Dell 지원팀에 업로드하십시오.

메모리 할당 오류가 발생했습니다. 진단 로그 파일 번들을 수집하십시오.

배경 압축이 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

배경 압축이 완료되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너에서 최적화가 초기화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너에서 최적화가 종료되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

스케줄에 따라 클리너 프로세스가 시작되었습니

다. <변수>까지 활성 상태가 됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.
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스케줄에 따라 클리너 프로세스가 중지되었습니

다. <변수>에 다시 시작됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

클리너가 <변수>에 중단되었습니다. DR Series 시스템이 유지 관리 모드로 전환되고 클리너 프
로세스가 다시 시작됩니다.

NVRAM의 데이터 이동에 실패했습니다. 시스템이 

유지 관리 모드로 전환됩니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

마지막 이벤트/유효하지 않은 이벤트. 정보용 메시지. Dell 지원팀에 지원 또는 개입을 요청하십

시오.

스케줄에 따라 파일 시스템 클리너 프로세스가 시
작되었습니다(<변수>까지 활성 상태가 됨).

정보용 메시지. 사용자 개입이 필요하지 않습니다.

스케줄에 따라 파일 시스템 클리너 프로세스가 중
지되었습니다(<변수>에 다시 시작됨).

정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이벤트 = 유형 5

관리자가 시스템 종료를 시작했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

관리자가 시스템 재부팅을 시작했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 버전으로 시스템 업그레이드를 시작합니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이름이 <변수>(으)로 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 날짜가 <변수>(으)로 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 시간대가 <변수>(으)로 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

사용자: 관리자의 암호가 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

NTP 서버 <변수>이(가) 추가되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

NTP 서버 <변수>이(가) 삭제되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

NTP 서비스가 활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

NTP 서비스가 비활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

CLI 명령을 사용하여 사용자 데이터가 삭제되었습

니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

사용자 <변수>이(가) 활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

사용자<변수>이(가) 비활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

네트워킹 인터페이스가 다시 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

DHCP 활성화됨: DHCP에 의해 IP 주소가 할당되었

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

정적 IP 주소 <변수>이(가) 할당되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

네트워크 인터페이스 결합 모드가 <변수>(으)로 설
정되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.
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네트워크 MTU 크기가 <변수>(으)로 설정되었습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이름이 <변수>(으)로 설정되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

이메일 경고에 대해 이메일 릴레이 호스트가 <변수
>(으)로 설정되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

이메일 경고의 받는 사람이 <변수>(으)로 설정되었

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 받는 사람이 이메일 경고를 수신하도록 추
가되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 받는 사람이 더 이상 이메일 경고를 수신하

지 않습니다.
이메일 받는 사람이 있는지 또는 사서함이 가득 찼는지 확
인하십시오.

이메일 경고에 대한 관리자 정보가 <변수>(으)로 설
정되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

테스트 이메일을 보냈습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

Windows Active Directory 도메인 <변수>에 가입했

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

Windows Active Directory 도메인 <변수>에서 탈퇴

했습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 진단 패키지 <변수>이(가) 삭제되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

모든 진단 패키지가 삭제되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 진단 패키지 <변수>이(가) 시스템에서 복사

되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

관리자가 시스템 통계를 다시 설정했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 진단 패키지 <변수>이(가) 수집되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 진단 공간 사용량이 임계값을 초과했습니

다. 가장 오래된 패키지를 자동으로 정리 중: <변수
>.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

CIFS 서버가 파일 서비스에 액세스할 수 없습니다. Dell 지원팀에 지원 또는 개입을 요청하십시오. 진단 로그 

파일 번들을 수집하고 Dell 지원팀에 업로드하십시오.

<변수> 호스트가 SNMP 경고 받는 사람 목록에 추
가되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 호스트가 SNMP 경고 받는 사람 목록에서 

삭제되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 호스트가 SNMP 경고에 대해 활성화되었습

니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 호스트가 SNMP 경고에 대해 비활성화되었

습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 사용자가 시스템에 로그인되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.
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CIFS 사용자 <변수>이(가) 추가되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

CIFS 사용자 <변수>이(가) 삭제되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

CIFS 사용자 <변수>의 암호가 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 업그레이드가 <변수> 완료되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 디스크에서 외부 구성이 지워졌습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 사용자가 시스템에 로그인되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 디스크가 핫 스페어로 구성되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 디스크에서 외부 구성이 지워졌습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

텔넷 서비스가 활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

텔넷 서비스가 비활성화되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

DNS 설정이 기본 <변수>, 보조 <변수>, 접미사 <변
수>(으)로 업데이트되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템을 성공적으로 초기화했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수>의 보안 권한이 변경되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

기타 유효하지 않은/마지막 이벤트. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이벤트 = 유형 6

파일 시스템 검사가 다시 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

파일 시스템 확인이 성공적으로 완료되었습니다. 
불일치 항목이 발견되지 않았습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

파일 시스템 검사에서 몇 가지 일관성 오류를 발견

했습니다.
DR Series 시스템 유지 관리 모드 복구 프로세스로 이 문제

를 해결할 수 있습니다. 문제가 지속되면 Dell 지원팀에 지
원 또는 개입을 요청하십시오.

파일 시스템 복구가 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

파일 시스템 복구가 완료되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

파일 시스템 확인 중지가 요청되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

복구 프로세스의 일환으로 하나 이상의 파일이 삭
제되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다. 확인하

려면 DR Series 시스템 CLI maintenance --filesystem --
repair_history verbose 명령을 사용하십시오.

<변수> 컨테이너의 복구 프로세스의 일환으로 하
나 이상의 파일이 삭제되었습니다. 이 컨테이너에 

대한 복제가 중지됩니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

<변수> 컨테이너의 복구 프로세스의 일환으로 하
나 이상의 파일이 삭제되었습니다. 이 컨테이너에 

대한 재동기화가 시작되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템 이벤트 = 유형 7

OST 서버가 성공적으로 시작되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.
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OST 서버 시작에 실패했습니다. OST 서버를 다시 시작하십시오. 문제가 지속되면 Dell 지
원팀에 지원 또는 개입을 요청하십시오.

OST 서버가 성공적으로 중지되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

OST 클라이언트 인증에 실패했습니다. OST 클라이언트 인증을 다시 시도하십시오. 문제가 지속

되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST LSU(Logical Storage Unit) 할당량 초과됨 <변수
>.

정보용 메시지. LSU 수를 줄이십시오. 문제가 지속되면 

Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST 백업 실패 <변수>. OST 백업 작업을 다시 시도하십시오. 문제가 지속되면 

Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST Opdup 실패 <변수>. OST 최적화된 중복 프로세스에 실패했습니다. 문제가 지
속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST 복원 실패 <변수>. OST 복원 프로세스에 실패했습니다. 문제가 지속되면 Dell 
지원팀에 지원 또는 개입을 요청하십시오.

OST 연결 수가 최대 한도를 초과했습니다. 개수: <
변수>, 최대 한도: <변수>

정보용 메시지. OST 연결 수를 줄이십시오. 문제가 지속되

면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST 클라이언트 <변수>에서의 연결이 중단되었습

니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

OST 클라이언트 프로토콜 버전이 지원되지 않습니

다.
정보용 메시지. 사용자 개입이 필요하지 않습니다. Dell DR 
Series 시스템 상호 운용성 안내서에서 지원되는 OST 클라

이언트 버전을 확인하십시오.

시스템이 유지 관리 모드로 전환됩니다. OST LSU 
정보 파일이 손상되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

시스템이 유지 관리 모드로 전환됩니다. OST LSU 
이미지 정보가 손상되었습니다.

정보용 메시지. 사용자 개입이 필요하지 않습니다. 문제가 

지속되면 Dell 지원팀에 지원 또는 개입을 요청하십시오.

OST 클라이언트 연결이 다시 설정되었습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

시스템이 유지 관리 모드로 전환됩니다. OST 메타 

디렉터리가 손상되었습니다.
정보용 메시지. 사용자 개입이 필요하지 않습니다.

OST 서버 초기화에 실패했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

OST 서버 초기화에 성공했습니다. 정보용 메시지. 사용자 개입이 필요하지 않습니다.

진단 서비스 정보

DR Series 시스템의 진단 서비스를 사용하면 시스템의 진단 로그 파일 번들을 표시, 수집, 관리할 수 있습니다. 각 

진단 로그 파일 번들이 제공하는 사항은 다음과 같습니다.

• 현재 시스템 작업의 스냅샷

• 시스템 작업을 이해하는 데 도움을 주는 시스템 관련 정보

• Dell 지원팀의 기술적 도움을 받아야 하는 경우 시스템 작업의 레코드
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이 기능에 액세스하려면 다음 DR Series 시스템 탐색 패널 GUI 옵션을 사용하십시오.

• Support(지원) → Diagnostics(진단) 

시스템에서 문제 또는 오류 상태를 진단할 때 유용한 모든 시스템 관련 정보를 수집하면 진단 서비스가 작동됩

니다.

진단 로그 파일 번들에 대한 자세한 내용은 진단 페이지 및 옵션을 참조하십시오.

진단은 시스템이 구동될 때 서비스로 실행되며 이 프로세스는 들어오는 요청을 수신 대기합니다. 두 가지 방법

으로 진단 수집 프로세스가 시작됩니다.

• 관리자 생성 모드: 관리자가 DR Series 시스템 CLI 또는 DR Series 시스템 GUI 요청을 수행하는 경우(및 표
시되는 기본 이유가 관리자 생성).

• 자동 생성 모드: 프로세스 또는 서비스 장애가 보고되고 DR Series 시스템이 시스템 관련 정보를 수집하
기 시작합니다. 자동 생성 수집이 완료되면 시스템 이벤트가 생성됩니다.

진단 로그 디렉터리가 최대 스토리지 용량을 초과하면 1시간 이상이 된 모든 로그가 자동으로 삭제됩니다. DR 
Series 시스템 GUI를 사용하여 진단 로그 파일을 네트워크에 있는 다른 시스템에 다운로드할 수 있습니다. DR 
Series 시스템은 다른 시스템 관련 정보를 수집하는 별도의 보관 로그 디렉터리도 유지 관리합니다. 이러한 보관 

로그도 최대 용량을 초과하면 자동으로 삭제됩니다.

자세한 내용은 진단 페이지 및 옵션, 진단 로그 파일 생성, 진단 로그 파일 다운로드 및 진단 로그 파일 삭제를 참
조하십시오.

노트: 진단 로그 파일 번들을 생성하면 Dell 지원팀에 기술 지원을 문의할 때 필요한 모든 DR Series 시스템 

정보가 포함됩니다. 진단 로그 파일 번들이 생성되면 이전에 자동으로 생성된 모든 진단이 수집되어 시스

템에서 삭제됩니다.

진단 로그 파일 번들은 Dell System E-Support Tool(DSET) 및 DR Series 시스템 CLI 명령(diagnostics --collect --dset)
을 사용하여 수집하는 것과 동일한 유형의 하드웨어, 스토리지 및 운영 체제 정보를 수집합니다. DR Series 시스

템 명령행 인터페이스 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

시스템에 대해 수집된 DSET 기반 정보는 Dell 지원팀이 DR Series 시스템의 문제를 해결하거나 상태를 평가하는 

데 유용합니다.

진단 컬렉션 이해

진단 서비스 컬렉션 도구 프로세스에서는 다음과 같은 지침을 준수합니다.

• DR Series 시스템이 모든 시스템 프로세스 또는 서비스 장애에 대한 DR Series 시스템 상태의 자동 진단 
로그 컬렉션을 트리거합니다.

• 모든 자동 진단 컬렉션 요청이 대기열에 지정되고 순서대로 실행됩니다.
• DR Series 시스템 GUI는 기존 진단 로그 표시, 새 진단 로그 생성, 기존 진단 로그의 사본 다운로드/저장 또

는 기존 진단 로그 삭제를 수행할 수 있는 옵션을 제공합니다. 자세한 내용은 진단 페이지 및 옵션 및 진
단 서비스 정보를 참조하십시오.

• 또한 DR Series 시스템 GUI는 진단 로그 파일을 관리, 생성 또는 다운로드할 수 있는 방법을 제공합니다. 
자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

About the DR Series System Maintenance Mode
In general, the DR Series system enters the Maintenance mode whenever the file system has encountered an issue that 
prevents it from operating normally.

노트: In this release of the DR Series systems, you can use the Reason code information available in the 
Mainenance mode to call Dell support. All maintenance must be conducted using the DR Series systems Command 
Line Interface.
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When in its Maintenance mode, the filesystem is in a read-only state, and the system runs the following maintenance-
based operations:

노트: Whenever the DR Series systems enters or exits from the Maintenance mode state, all communication via 
CIFS, NFS, RDA, or OST is lost.

• Runs an internal filesystem check.

• Generates a filesystem status report (if the filesystem check finds no issues, the DR Series system switches 
back to Operational mode without user intervention).

If the filesystem check finds issues, you can choose to make repairs (using Confirm Repair Filesystem) or ignore the 
detected issue (using Skip Repair Filesystem), at which point the system switches back to Operational mode.

The Maintenance mode process displays a number of stages, indicated on the Maintenance Mode progress bar, which 
include:

• Preparing for Filesystem Check

• Scan in Progress

• Completed Generating Report

노트: If the Filesystem Check detects any repairable files, it generates a Repair Report that identifies these 
reported files. The Maintenance Mode progress bar halts at the Completed Generating Repair stage, and 
remains in Maintenance mode until you click Confirm Repair Filesystem. The DR Series system does not 
advance to the Switching to Operation Mode stage until the filesystem repair is completed.

• Switching to Operational Mode

• Operational Mode (Normal State)

The Maintenance Mode page provides the following information:

• Maintenance Mode Progress bar:

– Displays the five stages of Maintenance mode

– Updates the progress bar as each stage completes

노트: If an alert displays above the Maintenance Mode progress bar, this indicates that the 
filesystem check has completed, and it has generated a report on the repairable files (which are 
displayed in the Repair Report pane under the Maintenance Mode progress bar). To repair all of 
the reported files listed in the Repair Report, you must click Confirm Repair Filesystem.

• Repair Report:

– Displays a list of repairable filesystem files that were detected in the Filesystem Check.

– Identifies the repairable files by Container ID, File/Inode/Directory location, and a brief reason for 
failure.

– Provides a search capability that allows you to click prev or next to display the previous or next page in 
the Repair Report, or lets you display a specific page number of the Repair Report by entering this 
number in the Goto page and click go.

• System Information pane:

– System Name

– Software Version

– Current Date/Time

– iDRAC IP Address

• Support Information

– Service Tag

– Last Diagnostic Run
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– BIOS Version

노트: When in Maintenance mode, the DR Series system navigation panel displays the following options that are 
links to display the correspond page in the DR Series system GUI:

• Alerts
• Events
• Health
• Usage
• Diagnostics
• Software Upgrade

Once the DR Series system enters Maintenance mode, there can only be two possible outcome states:

• Operational mode (Normal State): where the filesystem check was successful, and no system files need to be 
repaired (Filesystem Check: successful).

• Maintenance mode has halted: where the filesystem check detected one or more repairable files (Filesystem 
Check: unsuccessful).

Filesystem Check — Successful: when the Maintenance mode successfully completes all of its stages, the DR Series 
system displays its status as having entered Operational mode (Normal State). Only after the Maintenance mode has 
successfully completed its internal check can it return to an Operational mode.

To return to the Operational mode, click Go to Dashboard on the Maintenance Mode page options bar. Go to Dashboard 
is only active when all of the internal system checks have completed and the progress bar indicates that all stages have 
been completed.

노트: You may encounter issues when using data management agents (DMAs) such as NetBackup with expired 
backup images when the DR Series system is in its Maintenance mode.

노트: When in Maintenance mode, image expiration fails because the DR Series system is in a read-only state. If 
this occurs, the DMA assumes that the backup images have expired. However, the DR Series system administrator 
may be unaware that the backup data images still reside on the DR Series system.

Filesystem Check — Unsuccessful: when the Maintenance mode halts at the Completed Generating Report stage, this 
indicates that the filesystem check detected some repairable files, and listed them in the Repair Report pane on the 
Maintenance Mode page.

To return to the Operational mode, click Confirm Repair Filesystem on the Maintenance Mode page options bar to repair 
the files listed in the Repair Report. Confirm Repair Filesystem is the only active option you can select when the progress 
bar indicates that some filesystem files are in need of repair.

About the DR Series System Support Mode
Generally, the DR Series system enters its Support mode only because of one of the following reasons:

• The filesystem has encountered an issue that could not be resolved by running the internal Maintenance mode.
• Some system processes failed to start properly.
• The system detected an unsupported configuration.

The Support mode puts the DR Series system into a state in which only the following tasks can be performed:

• Generating a DR Series system diagnostics file. For more information, see Generating a Diagnostics Log File.
• Upgrading the DR Series system software. For more information, see Upgrading the DR Series System Software.
• Installing a license for the data storage expansion shelf enclosure. For more information, see Expansion Shelf 

Licenses and Installing an Expansion Shelf.
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• Contacting Dell Support for technical assistance. For more information, see Contacting Dell.

노트: Dell recommends that you generate a DR Series system diagnostics file whenever the DR Series system is in 
its Maintenance or Support modes if one was not automatically generated.

When in the Support mode, the DR Series system displays the following alert message:
The server is currently in Support mode. To continue, you must contact Dell 
Support at http://www.support.dell.com or contact your Dell support 
representative.

DR Series 시스템 작업 예약

중요한 DR Series 시스템 작업을 예약할 때 숙지해야 할 사항은 실행 중인 다른 중요한 시스템 작업과 겹치거나 
방해되지 않는 시간에 각 작업을 수행해야 합니다.

시스템 작업 실행을 예약할 때 시스템 리소스를 최적화하면 최상의 DR Series 시스템 성능을 달성할 수 있습니

다. 이렇게 하려면 다음과 같은 중요 시스템 작업을 수행할 시간을 계획하여 예약해야 합니다.

• 데이터 통합(DMA에 따라 다름)

• 복제 프로세스

• 클리너 프로세스(공간 확보)

작업을 계획하고 예약하는 목적은 클리너 및 복제 작업이 다른 중요한 시스템 작업과 겹치거나 방해되지 않는 

시간에 실행되도록 하는 것입니다. 적절하게 계획하여 예약하면 시스템에서 이러한 각 주요 작업이 서로 독립적

으로 수행될 수 있습니다.

모범 사례로서, 바쁜 업무 시간이 아닌 시간에 두 작업을 실행하면 다른 백업 또는 통합 작업과 충돌하지 않습니

다. 다시 말해, 효율적인 예약은 시스템 리소스 활용을 극대화합니다.

리소스가 많이 필요한 작업은 다른 시스템 작업이 수행되고 있지 않은 특정 시간에 예약하는 것이 좋습니다. 이 

방법을 기간 조정이라고 하며 특정 시간대(또는 "기간)를 예약해야 합니다. 각 시간대는 시작 및 중지 설정 지점

이 있으므로 다른 작업 실행에 방해가 되지 않고 데이터 통합, 복제 또는 공간 확보 작업을 수행할 수 있습니다.

Creating a Cleaner Schedule
Performing scheduled disk space reclamation operations are recommended as a method for recovering disk space from 
system containers in which files were deleted as a result of deduplication. The best method is to schedule a time when 
you can run the Cleaner on your DR Series system with no other planned processes running. Alternately, another 
method lets the Cleaner process on the DR Series system run whenever it determines that there are no active data 
ingests.

노트: Even if no Cleaner schedule is set, but the system detects that there is disk space that can be reclaimed, the 
Cleaner process runs. However, the Cleaner will not start until the following conditions are met: it detects that 
there are no active data ingests, that two minutes of system idle time have elapsed since the last data file ingest 
was completed, and that the Replication process is not running (the Cleaner process runs as a lower system 
priority operation than the Replication process).

노트: Running the Cleaner while ingesting data, reduces system performance. Ensure that you schedule the 
Cleaner to run when backup or replication is not in progress.

노트: The Cleaner Schedule page displays the current DR Series system time zone and current timestamp (using 
this format: US/Pacific, Fri Nov 2 15:15:10 2012).

To schedule Cleaner operations on your system, complete the following:

1. Select Schedules → Cleaner Schedule.
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The Cleaner Schedule page is displayed.

2. Click Schedule to create a new schedule (or click Edit Schedule to modify an existing schedule).
The Set Cleaner Schedule page is displayed.

3. Select (or modify) the Start Time and Stop Time setpoint values using the Hour and Minutes pull-down lists to 
create a Cleaner schedule.

노트: You must set a corresponding Stop Time for every Start Time set in each Cleaner schedule you create. 
The DR Series system will not support any Cleaner schedule that does not contain a Start Time/Stop Time pair 
of setpoints (daily or weekly).

4. Click Set Schedule for the system to accept your Cleaner schedule (or click Cancel to display the Cleaner Schedule 
page).

노트: To reset all of the values in the current Cleaner schedule, click Reset in the Set Cleaner Schedule 
dialog. To selectively modify values in the current schedule, make your changes to the corresponding hours 
and minutes pull-down lists to represent the Start Time and Stop Time you wish to set, and click Set Schedule.

The current Cleaner Status is represented in the Dashboard page in the System Information pane as one of the three 
following states:

• Pending—displayed when there is any scheduled window set and the current time is outside the scheduled 
window for the Cleaner operation.

• Running—displayed when the Cleaner operation is running during a scheduled window.

• Idle—displayed only if there is no Cleaner operation running during a scheduled window.

Dell recommends that you do not schedule the running of any Cleaner operations during the same time period when 
replication or ingest operations will be running. Failure to follow this practice will affect the time required to complete 
the system operations and/or impact your DR Series system performance.

클리너 통계 표시

추가적인 클리너 통계를 표시하려면 DR Series 시스템 CLI stats --cleaner 명령을 사용하여 다음과 같은 클리너 통
계 카테고리를 표시하십시오.

• 처리된 마지막 실행 파일(클리너에서 처리된 파일 수)

• 처리된 마지막 실행 바이트(클리너에서 처리된 바이트 수)

• 확보된 마지막 실행 바이트(클리너에서 확보된 바이트 수)

• 마지막 실행 시작 시간(마지막으로 클리너 프로세스가 시작된 날짜 및 시간을 나타냄)

• 마지막 실행 종료 시간(마지막으로 클리너 프로세스가 종료된 날짜 및 시간을 나타냄)

• 마지막 실행 완료 시간(클리너 프로세스가 성공적으로 완료된 횟수를 나타냄)

• 마지막 실행 시작 시간(현재 클리너 프로세스가 시작된 날짜 및 시간을 나타냄)

• 처리된 현재 실행 파일(현재 클리너 프로세스에서 처리된 파일 수)

• 처리된 현재 실행 바이트(현재 클리너 프로세스에서 처리된 바이트 수)

• 확보된 현재 실행 바이트(현재 클리너 프로세스에서 확보된 바이트 수)

• 현재 실행 1단계 시작 시간(현재 클리너 프로세스 1단계의 시작 날짜 및 시간을 나타냄)

• 처리된 현재 실행 1단계 레코드(현재 클리너 프로세스 1단계에서 처리된 데이터 레코드 수 나열)

• 현재 실행 1단계 종료 시간(현재 클리너 프로세스 1단계의 종료 날짜 및 시간을 나타냄)

• 현재 실행 2단계 시작 시간(현재 클리너 프로세스 2단계의 시작 날짜 및 시간을 나타냄)

• 처리된 현재 실행 2단계 레코드(현재 클리너 프로세스 2단계에서 처리된 데이터 레코드 수 나열)

• 현재 실행 2단계 종료 시간(현재 클리너 프로세스 2단계의 종료 날짜 및 시간을 나타냄)
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• 현재 실행 3단계 시작 시간(현재 클리너 프로세스 3단계의 시작 날짜 및 시간을 나타냄)

• 처리된 현재 실행 3단계 레코드(현재 클리너 프로세스 3단계에서 처리된 데이터 레코드 수 나열)

• 현재 실행 3단계 종료 시간(현재 클리너 프로세스 3단계의 종료 날짜 및 시간을 나타냄)

• 현재 실행 4단계 시작 시간(현재 클리너 프로세스 4단계의 시작 날짜 및 시간을 나타냄)

• 처리된 현재 실행 4단계 레코드(현재 클리너 프로세스 4단계에서 처리된 데이터 레코드 수 나열)

• 현재 실행 4단계 종료 시간(현재 클리너 프로세스 4단계의 종료 날짜 및 시간을 나타냄)

DR Series 시스템 CLI 명령에 대한 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.
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11
Supported Ports in a DR Series System
The following table lists the application and service ports found on a normally operating DR Series system. There may be 
other ports that are not listed here, that an administrator may need to open and enable to support specific operations 
across the network. Be aware that the ports listed in the following table may not reflect your specific network 
environment, or any planned deployment. While some of these DR Series system ports may not need to be accessible 
through the firewall, this information is made available when deploying the DR Series system in your own network 
because it indicates supported ports that may need to be exposed.

표 9. Supported DR Series System Ports

Port Type Number Port Usage or Description

DR Series System Application Ports

TCP 20 File Transfer Protocol (FTP)—for transferring files.

TCP 23 Telnet—remote terminal access protocol for unencrypted text 
communications.

TCP 80 Hypertext Transfer Protocol (HTTP)—unencrypted protocol communications.

TCP 443 HTTPS—combination of the HTTP with Secure Socket Layer (SSL)/Transport 
Layer Security (TLS).

TCP 1311 Hardware Health Monitor

TCP 9901 Watcher

TCP 9904 Configuration Server (needed for replication operations)

TCP 9911 Filesystem Server (needed for replication operations)

TCP 9915 MetaData Replication (needed for replication operations)

TCP 9916 Data Filesystem Server (needed for replication operations)

TCP 9918 Diagnostics Collector

TCP 9920 Data path used for OST replications

TCP 10011 Control channel (needed for OST operations)

TCP 11000 Data channel (needed for OST operations)

DR Series System Service Ports

TCP 22 Secure Shell (SSH)—used for secure logins, file transfers like SCP (Secure 
Copy) and SFTP (Secure File Transfer Protocol)

TCP 25 Simple Mail Transfer Protocol (SMTP)—used for routing and sending email

TCP 139 SMB daemon—used for SMB protocol-related processes
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Port Type Number Port Usage or Description

TCP 199 SNMP daemon—used by Simple Network Management Protocol (SNMP) 
requests

TCP 801 NFS status daemon
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12
도움말 보기
DR Series 시스템의 문제를 직접 해결할 수 있는 방법 또는 Dell의 기술 지원을 얻는 방법에 대해서는 문제 해결 
및 유지 관리, 오류 조건 문제 해결,Dell 지원팀에 문의하기 전에 및 Dell에 문의하기를 참조하십시오.

Dell 지원팀에 문의하기 전에

오류 상태 또는 작동 문제가 발생한 경우 Dell 지원팀에 기술 지원을 요청하기 전에 Dell DR Series 시스템 지원 문
서를 사용하여 문제를 해결할 수 있는지 확인할 것을 권장합니다.

Dell DR Series 시스템에 발생하는 기본적인 문제를 분리하거나 진단할 수 있도록 다음과 같은 작업을 수행하는 

것이 좋습니다.

• Dell DR Series 시스템 관리자 안내서를 참조하여 문제를 설명하거나 해결할 수 있는 정보가 포함되어 있
는지 확인합니다. 9장, “문제 해결 및 유지 관리”를 참조하십시오.

• Dell DR Series 시스템 명령행 참조 안내서를 검토하여 문제를 설명하거나 해결할 수 있는 정보가 포함되
어 있는지 확인합니다.

• 최신 Dell DR Series 시스템 발행 정보 세트를 검토하여 문제를 설명하거나 해결할 수 있는 정보가 포함되
어 있는지 확인합니다.

• Dell 지원 계정 번호 및 암호를 찾고, DR Series 시스템의 서비스 태그를 찾은 다음, 지원 계정 유형을 파악
한 후, 수행하고 있던 시스템 작업에 대한 특정 세부사항을 제공할 준비가 완료되어야 합니다.

• 상태 또는 오류 대화상자 메시지의 내용과 표시된 순서를 기록합니다.

• 현재 버전 진단 파일을 생성하거나 생성할 수 없는 경우 최신 기존 진단 파일을 찾습니다.

– DR Series 시스템 GUI를 사용하여 Diagnostics(진단) → Generate(생성)를 클릭하여 진단 파일을 생
성합니다.

– DR Series 시스템 CLI를 사용하여 시스템 프롬프트에 diagnostics --collect 명령을 입력하여 진단 
파일을 생성합니다. 자세한 내용은 Dell DR Series 시스템 명령행 참조 안내서를 참조하십시오.

노트: 복제 문제 해결에 대한 최상의 결과를 얻으려면 최대한 적합한 시간에 DR Series 소스와 대상 시스템 

모두에서 진단 파일을 생성해야 합니다.

노트: 생성된 각 진단 파일 번들에는 다음에 대한 최신 데이터와 함께 Dell 지원팀에 도움을 주는 정보가 포
함되어 있습니다.

• 시스템 경고 및 이벤트

• 시스템 구성 상태

• 시스템 로그 파일

• 스토리지 및 복제 컨테이너에 대한 시스템 통계

• 시스템 하드웨어 구성요소 상태

Dell에 문의하기

이 주제에서는 Dell 지원팀에 기술 지원을 요청하는 고객을 위한 과정을 설명합니다. 미국 고객의 경우 800-
WWW-DELL(800-999-3355)로 문의하시기 바랍니다.
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노트: 인터넷이 연결되어 있지 않을 경우 매입서, 패킹 슬립, 청구서 또는 Dell 제품 카탈로그에 연락처 정보

를 찾아볼 수 있습니다.

Dell은 온라인과 전화를 통한 몇 가지 지원 및 서비스 옵션을 제공합니다. 이러한 옵션은 국가 및 제품에 따라 다
르며 일부 서비스의 경우 해당 지역에 제공되지 않을 수 있습니다.

영업 지원, 기술 지원 또는 고객 서비스 문제에 대해 Dell에 문의하려면 다음을 수행합니다.

1. support.dell.com을 참조하십시오.
2. support.dell.com 페이지 하단에 있는 국가/지역을 선택하여 클릭합니다. 전체 목록의 국가 및 지역을 보려면 

All(모두)을 클릭합니다.
Choose a Country/Region(국가/지역 선택) 페이지가 표시됩니다.

3. Americas(미국), Europe, Middle East, & Africa(유럽, 중동 및 아프리카) 또는 Asia Pacific(아시아 태평양) 중에
서 국가/지역을 선택하여 클릭합니다.

4. 필요한 서비스 또는 지원 링크를 선택하십시오.
5. Dell에 문의하는 데 가장 편리한 방법을 선택합니다.
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